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Chapter 1 Introduction

1.1 Overview

This manual describes how to use the Renesas Flexible Software Package (FSP) for writing
applications for the RA microcontroller series.

1.2 Using this Manual

This manual provides a wide variety of information, so it can be helpful to know where to start. Here
is a short description of each main section and how they can be used.

Starting Development - Provides a step by step guide on how to use e? studio and FSP to develop a
project for RA MCUs. This is a good place to start to get up to speed quickly and efficiently.

FSP Architecture - Provides useful background material on key FSP concepts such as Modules,
Stacks, and API standards. Reference this section to extend or refresh your knowledge of FSP
concepts.

API Reference - Provides detailed information on each module and interface including features, API
functions, configuration settings, usage notes, function prototypes and code examples. Board
Support Package (BSP) related API functions are also included.

Note
Much of the information in the API Reference section is available from within the €2 studio tool via the Devel oper
Assistance feature. The information here can be referenced for additional details on API features.

1.3 Documentation Standard

Each Modules section user guide outlines the following:

» Features: A bullet list of high level features provided by the module.

e Configuration: A description of module specific configurations available in the RA
Configuration editor.

e Usage Notes: Module specific documentation and limitations.

e Examples: Example code provided to help the user get started.

¢ APl Reference: Usage notes for each APl in the module, including the function prototype and
hyperlinks to the interface documentation for parameter definitions.

Each Interfaces section user guide outlines the following:

e Detailed Description: A short description and summary of the interface functionality.

e Data Structures: A list and definition of each data structure used by the interface including
the structure of the pointers that define the API and are shared by all modules that
implement the interface.

e Typedefs: A list and description of the typedefs used by the interface.

e Enumerations: A list and description of the enumerations used by the interface.
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1.4 Introduction to FSP

1.4.1 Purpose
The Renesas Flexible Software Package (FSP) is an optimized software package designed to provide

easy to use, scalable, high quality software for embedded system design. The primary goal is to
provide lightweight, efficient drivers that meet common use cases in embedded systems.

1.4.2 Quality

FSP code quality is enforced by peer reviews, automated requirements-based testing, and
automated static analysis.

1.4.3 Ease of Use

FSP provides uniform and intuitive APIs that are well documented. Each module is supported with
detailed user documentation including example code.

1.4.4 Scalability

FSP modules can be used on any MCU in the RA family, provided the MCU has any peripherals
required by the module.

1.4.5 Build Time Configurations

FSP modules also have build time configurations that can be used to optimize the size of the module
for the feature set required by the application.

1.4.6 e2 studio IDE

FSP provides a host of efficiency enhancing tools for developing projects targeting the Renesas RA
series of MCU devices. The e? studio IDE provides a familiar development cockpit from which the key
steps of project creation, module selection and configuration, code development, code generation,
and debugging are all managed.
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Chapter 2 Reference Materials

This section contains miscellaneous reference materials.

Document Summary
Using Registers Directly Overview of register definition files and their
use.
FSP v4.0.0 FreeRTOS Stack Migration Guide Migration guide for FreeRTOS Network stack
users moving to FSP v4.0.0.

2.1 Using Registers Directly

2.1.1 Overview

In some cases users may wish to utilize chip functionality that is not supported yet by FSP. While we
encourage contacting us when new feature requests arise it takes time before any updates are
made. In the meantime, it is recommended to use the register definition files accessed via renesas.h
to add custom functionality as needed. Official ARM CMSIS documentation refers to this format of
related register definition files as device header files. Within Renesas, these files are often referred
to as an 10 define or more commonly iodefine.

2.1.2 What's in an "iodefine"?

lodefine files contain definitions for all the 1/O registers on a device. For RA FSP, one iodefine header
is provided per device group (RA6M3, RA2A1 etc.) that contains all the register definitions provided
in the hardware manual for that group. These headers are accessed via renesas.h, which selects the
appropriate file based on the MCU configured in the project.

Note
Prior to FSP 4.0.0 renesas.h contained a superset of all register definitions for RA MCUSs. This became

unsustainable as new device families were added and was confusing for users, so headers for each device were
created and renesas.h was updated to serve as a selector.

2.1.3 Where are iodefine files located?

In RA FSP, iodefine files are stored in ra/fsp/src/bsp/cmsis/Device/RENESAS/Include. This includes
both renesas.h as well as the device group specific iodefine headers.

2.1.4 Using the register definitions

Each peripheral register set is provided as a struct. In general, the template to follow is:
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R _+ peripheral abbreviation + channel nunber + -> + register nane [ + b. + bitfield

nane]

Basic register access

Registers are most commonly accessed whole. For example, say we want to read the counter on GPT
channel 3:

uint32 t count = R GPT3->GICNT;

As shown in the template, the iodefines can also be used to access bitfields. For example, to start
GPT channel 3:

R_GPT3- >GTCR b. CST = 1;

Bitfield macros

It is worth noting that each bitfield access will cause a full read-modify-write which cannot be
combined by the compiler because the register definitions are by necessity volatile. This can be very
size and speed inefficient, particularly when the peripheral is on a very slow clock. It is
recommended to write whole registers wherever possible. This is made easier by macros that are
provided alongside the register definitions.

Every bitfield has two associated macros: Msk (bitfield mask) and _Pos (bit position). These macros

can be used to manipulate whole registers instead of using bitfield access when multiple bitfields are
modified simultaneously. For example, setting both GPT3 output pins to 100% duty cycle:

ui nt32_t gtuddtyc = R _GPT3->GTUDDTYC

gt uddt yc &= ~(R_GPTO_GTUDDTYC QADTY_Msk |
R _GPTO_GTUDDTYC _OBDTY_MSK) /1 NMask off bits to clear
gt uddt yc | = (3 << R_GPTO_GTUDDTYC_OADTY_Pos) | (3 <<

R _GPTO_GTUDDTYC OBDTY_Pos); // Shift values to bitfield positions
R GPT3- >GTUDDTYC = gt uddt yc;

Note
The macros are all named with channel 0 due to internal process requirements; they can be used with all channels.

Arrays and clusters
Some registers are part of an array. These are typically listed in the manual using indexes like "n" or

"m", but may occasionally be listed with individual numbers or letters. Accessing register arrays is
just like accessing a regular array. For example, the GPT duty cycle registers are GTCCRA through
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GTCCRF. In the iodefine, they are accessed via the GTCCR array:

/* Set GICCRB */
R GPT3->GICCR[ 1] = duty_cycl e_b;

Note
Not all indices may be available in every array. Be sure to check the hardware manual to verify which registersare
provided on the device in use.

Sometimes there are groups of registers that are repeated multiple times. These groups are called a
cluster. Clusters are accessed similarly to arrays, except the actual registers are elements of the
array values instead. For example, mailboxes in the CAN peripheral have several registers each:
/[* Cet data from mail box 3 */
uint32 t mail box = 3;
/* Get the franme data | ength code */
uint32 t data_length = R CANO->MB[ mai | box] . DL_b. DLC;
/* Get message data */
uint8 t data[8];
for (uint32_t i = 0U;, i < data_length; i++)
{
data[i] = p_reg->MB[mai |l box].D[i]; // Copy receive data to buffer

2.1.5 Tips for writing hardware drivers

Channel register access

FSP drivers often calculate a register offset in the Open function. This is typically done by multiplying
the channel by the offset between channels 0 and 1. For example, here is the calculation for GPT:

/* Save register base address. */

uint32 t base _address = (uint32 t) R GPTO + (p_cfg->channel * ((uint32_t) R GPT1 -
(uint32_t) R GPTO));

p_instance ctrl->p reg = (R GPTO_Type *) base_address;

When drivers need to support multiple channels of a peripheral it can be helpful to save the offset in
a persistent variable or structure so that it only needs to be calculated once.
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2.2 FSP v4.0.0 FreeRTOS Stack Migration Guide

Note
This guide only applies to users converting €2 studio projects created with FSP v3.8.0 or earlier
Migration isonly possible for network stacks using CoreMQTT and CoreHTTP modules. Stacks using
deprecated MQTT Client and HTTP Client modules will not be able to be migrated over to FSP v4.0.0 and up.
See the following guide for migrating code from the deprecated Client libraries; https://aws.github.io/aws-iot-
device-sdk-embedded-C/202103.00/docs/doxygen/output/html/mqtt_migration.html

2.2.1 Overview

This migration guide is for moving to the new FreeRTOS Network stacks introduced in FSP v4.0.0. It
will describe steps for moving over stacks as well as changes to make code compile correctly.

2.2.2 Stack Migration Steps

Note
Perform all of the following steps before attempting to save the project. Failure to do so may cause unexpected
errorsin the configuration.xml.

1. Open project to be migrated in e? studio using FSP v4.0.0 or greater. The existing
CoreMQTT/HTTP stack should still exist. Many of the stack components will have No Longer
Supported in the display and have permanent constraint error messages on them:

@ AWS Core MQTT
@
@ Aws Transport Interface on Secure Sockets (No Longer Supported)
@
@ AWS Secure Sockets on FreeRTOS Plus TCP (No Longer Supported)
)
% FreeRTOS+TCP & AWS Secure @ AWS Secure Sockets TLS Support (No Longer Supported)
Sockets Common
{No Longer
@ @ supported) @
4 FreeRTOS+TCP Wrapper to r_ether & AWS 10T Common | | @F FreeRTOS+TLS 4 AWS Logging 4 AWS Demo
(rm_freertos_plus_tcp) (No Longer (No Longer dev_mode_key_p-
Supported) Supported) rovisioning (Mo
@ @ @ Lonaer Supported)
% g_ether0 Ethernet | | @ FreeRTOS Buffer 4 AWS Client % AWS PKCS11 to
(r_ether) Allocation 2 Credentials MbedTLS
) @ ® O}
a T
& g_ether_phy0
Ethernet
(r_ether_phy)
Figure 1: Old MQTT Stack
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2. Add a new network stack (New Stack->Networking->AWS CoreHTTP or AWS CoreMQTT):

4 AWS Core HTTP Q |\ B oot
2% AWS Core MQTT

4 BLE Mesh Access (rm_ble_mesh_access)

% AWS Transport Interface on MbedTLS/PKCS11 (rm_aws_transport_interface_port)
| & suemesh (m_blemesh) _

I % BLE Mesh Bearer (rm_ble_mesh_bearer)

% BLE Mesh Config Client (rm_mesh_config_clt)

Analog 4
4 BLE Mesh Config Server (rm_mesh_config_srv) Artificial Intelligence 3
# BLE Mesh Lower Trans (rm_ble_mesh_lower trans) Audio 3
# BLE Mesh Model Generic Admin Property Server (rm_mesh_generic_admin_prop_srv) Bootloader »
@ BLE Mesh Model Generic Battery Client (rm_mesh_generic_battery_clt) capTouch N
# BLE Mesh Model Generic Battery Server (rm_mesh_generic_battery_srv) Connectivity »
% BLE Mesh Model Generic Client Property Server (rm_mesh_generic_client_prop_srv) DSp »
@ BLE Mesh Model Generic Default Transition Time Client (rm_mesh_generic_dtt_clt) Input »
# BLE Mesh Model Generic Default Transition Time Server (rm_mesh_generic_dtt_srv) Monitoring »
% BLE Mesh Model Generic Level Client (rm_mesh_generic_level_clt) Mator »
@ BLE Mesh Model Generic Level Server (rm_mesh_generic_level_srv)

# BLE Mesh Model Generic Lacation Client {rm_mesh_generic_loc_clt)

Power 4
4 BLE Mesh Model Generic Location Server (rm_mesh_generic_loc_srv) RTOS »
@ BLE Mesh Model Generic Manufacturer Property Server (rm_mesh_generic_mfr_prop_srv) Security »
# BLE Mesh Model Generic On Off Client (rm_mesh_generic_on_off clt) Sensor »
% BLE Mesh Model Generic On Off Server (rm_mesh_generic_on_off_srv) Storage »
@ BLE Mesh Model Generic Power Level Client (rm_mesh_generic_pl_clt) System »
# BLE Mesh Model Generic Power Level Server (rm_mesh_generic_pl_srv) Timers 3
# BLE Mesh Model Generic Power On Off Client (rm_mesh_generic_poo_clt) Transfer »
@ BLE Mesh Model Generic Power On Off Server (rm_mesh_generic_poo_srv) 4 search...

# BLE Mesh Model Generic Property Client {rm_mesh_generic_prop_clt)

Figure 2: Add a New MQTT Stack

3. Choose a sockets wrapper for the new stack (Add Sockets Wrapper).

4 AWS Core MQTT

@

Y
I

@ AWS Transport Interface on MbedTLS/PKCS11 (rm_aws_transport_interface_port)

@
Y
1 I 1
@ AWS PKCS11 to 4 AWS Logging 4 AWS Demo
MbedTLS dev_mode_key p-
rovisioning
@ m 7

% Aws Cellular Sockets Wrapper
% AWS Silex WiFi Sockets Wrapper (rm_aws_sockets_wrapper_silex)

e

Figure 3: Add a Sockets Wrapper

4 AWS TCP Sockets Wrapper

4. The submodule for AWS PKCS11 to MbedTLS will likely be missing. Click Add FreeRTOS
MbedTLS Port and use the existing instance:
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@ AWS PKCS11 to MbedTLS

@

4 AWS Logging 4 AWS Dei
dev_mo
avisionil

@

ry

4 MWS PKCS11 PAL
on LittleFs
(rm_aws_pkes1l_p-

@ al_littlefs)

% Add FreeRTOS
MbedTLS Port

ry

Use

3

4 mws clic
Credenti

28 FreeRTOS MbedTLS Port

Figure 4: FreeRTOS MbedTLS Port

5. Got to the components tab and see if AWS MbedTLS FreeRTOS Port
(AWS]Abstractions|FreeRTOS_Plusjutilities|mbedtls) is checked. If this component is not
checked then check it so that appears like so:

- o AWS
b &% Abstractions
» o c_sdk
b % FreeRTOS
~ % FreeRTOS_Plus
» @ standard
v @ utilities

Figure 5: FreeRTOS MbedTLS Port Component

6. Check that settings/properties are correct on the new stack. Common stack elements

between the old and new stacks should already have previous settings.

7. Remove the old stack.

8. Save project and generate project content. See the next section for things to change in the

code for successful compilation.

2.2.3 List of Code Change Highlights

This is a list of important changes from pre-4.0 code. For more detailed examples see

CoreMQTT/HTTP examples and devassist.

e Any calls to SYSTEM Init() should be removed. mbedtls_platform_setup() now does

initialization that this IoT library function originally did.
» xLoggingTasklnitialize should no longer be called. Logging libraries which create a logging

task no longer exist. Logging by default uses printf when enabled. The user can redefine

vLoggingPrintf(const char * pcFormat, ...) and vLoggingPrint(const char * pcFormat) to

change this behavior.

e The transport interface for CoreMQTT/HTTP will now need to be setup directly by creating a
transport interface and setting the send and receive pointers to TLS_FreeRTOS_recv and
TLS_FreeRTOS_send. See the examples and devassist for more info.

e The user will need to call TLS FreeRTOS_Connect to connect to a server/endpoint before
using CoreMQTT/HTTP APIs to communicate. TLS_FreeRTOS_Disconnect can be used to

disconnect from a server/endpoint.
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Chapter 3 Starting Development

3.1 Starting Development Introduction

The wealth of resources available to learn about and use e? studio and FSP can be overwhelming on
first inspection, so this section provides a Starting Development Guide with a list of the most
important initial steps. Following these highly recommended first 11 steps will bring you up to speed
on the development environment in record time. Even experienced developers can benefit from the
use of this guide, to learn the terminology that might be unfamiliar or different from previous
environments.

1.

Read the section What is e? studio?, up to but not including e? studio Prerequisites. This will
provide a description of the various windows and views to use e? studio to create a project,
add modules and threads, configure module properties, add code, and debug a project. It
also describes how to use key coding 'accelerators' like Developer Assist (to drag and drop
parameter populated API function calls right into your code), a context aware Autocomplete
(to easily find and select from suggested enumerations, functions, types, and many other
coding elements), and many other similar productivity enhancers.

. Read the FSP Architecture, FSP Modules and FSP Stacks sections. These provide the basic

background on how FSP modules and stacks are used to construct your application.
Understanding their definitions and the theory behind how they combine will make it easier
to develop with FSP.

. Read a few Modules sections to see how to use API function calls, structures, enumerations,

types and callbacks. These module guides provide the information you will use to
implement your project code.

. After you have a Kit and you have downloaded and installed e? studio and FSP, you can

build and debug a simple project to test your installation, tool flow, and the kit. (If you do
not have a Kit or have not yet installed the development software, use the links included in
the e? studio Prerequisites for more information.) The simple Tutorial: Your First RA MCU
Project - Blinky will Blink an LED on and off. Follow the instructions for importing and
running this project in section Create a New Project for Blinky. It will use some of the key
steps for managing projects within e2? studio and is a good way to learn the basics.

. Once you have successfully run Blinky you have a good starting point for using FSP for more

complex projects. The Using HAL Drivers Tutorial, available at Tutorial: Using HAL Drivers -
Programming the WDT, shows how to create a project from scratch, using FSP API functions.
Do this next.

. Several Hands-on Quick FSP Labs are available that cover key development topics with

short 15-minute Do it Yourself (DiY) activities targeting the EK-RA6M3. Topics covered
include code development accelerators like Developer Assistance, Autocomplete, Help,
Visual Expressions and using Example Projects. The complete list of available Quick FSP
Labs can be found here: https://en-
support.renesas.com/knowledgeBase/category/31087/subcategory/31090. Doing a couple
of these labs provides further details on using FSP, and is also good practice. Running these
labs is highly recommended.

. The balance of the FSP Architecture sections (that is, those not called out in step 2 above)

contain additional reference material that may be helpful in the future. Scan them so you
know what they contain, in case you need them.

. The balance of the e? studio User Guide, starting with the What is a Project? section up to,

but not including, Writing the Application section, provides a detailed description of each of
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the key steps, windows, and entries used to create, manage, configure, build and debug a
project. Much of this may be familiar after running through the tutorials and Quick Labs.
However, it is important to have a good grasp of what each of the configuration tabs are
used for as that is where the bulk of the project preparation work takes place prior to
writing code. Skim over this section as it may help with any questions in the future.

9. Read the Writing the Application section to get a short introduction to the steps used when
creating application code with FSP. It covers both RTOS-independent and RTOS-dependent
applications. It also includes a short description for several of the code accelerators you
should be familiar with by now. Using additional Quick FSP Labs is a good way to become
familiar with the application development process and links to them are included in the
appropriate places in this section. You can find the complete list of available Quick FSP Labs
here: https://en-support.renesas.com/knowledgeBase/19308277.

10. Scan the Debugging the Project section to see the steps required to download and start a
debug session.

11. Explore the additional material available on the following web pages and bookmark the
resources that look most valuable to you:

. RA Landing Page: https://www.renesas.com/ra

. FSP Landing Page: https://www.renesas.com/fsp

. Example Projects on GitHub: https://github.com/renesas/ra-fsp-examples

. Quick FSP Labs Listing: https://en-support.renesas.com/knowledgeBase/19308277

. RA and FSP Knowledge Base (with articles of interest on RA and FSP): https://en-

support.renesas.com/knowledgeBase/category/31087
f. RA and FSP Renesas Rulz site (Community posted and answered questions):
https://renesasrulz.com/ra/
g. FSP Releases: https://github.com/renesas/fsp/releases
h. FSP Documentation: https://renesas.github.io/fsp
i. Online Technical Support: https://www.renesas.com/us/en/support/contact.html

3.2 e2 studio User Guide

3.2.1 What is e2 studio?

™ QN T QD

Renesas e? studio is a development tool encompassing code development, build, and debug. e?
studio is based on the open-source Eclipse IDE and the associated C/C++ Development Tooling
(CDT).

When developing for RA MCUs, e? studio hosts the Renesas Flexible Software Package (FSP). FSP
provides a wide range of time saving tools to simplify the selection, configuration, and management
of modules and threads, to easily implement complex applications. The time saving tools available in
e? studio and FSP include the following:

* A Graphical User Interface (GUI) (see Adding Threads and Drivers) with numerous wizards
for configuring and auto-generating code

* A context sensitive Autocomplete (see Tutorial: Using HAL Drivers - Programming the WDT)
feature that provides intelligent options for completing a programming element

e A Developer Assistance tool for selection of and drag and drop placement of API functions
directly in application code

¢ A Welcome Window with links to example projects, application notes and a variety of other
self-help support resources

¢ An Information Icon from each module is provided in the graphic configuration viewer that
links to specific design resources, including code 'cheat sheets' that provide useful starting
points for common application implementations.
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RENESAS

e’ studio

( BUILT ON

Figure 6: e? studio Splash Screen

e? studio organizes project work based on Perspectives, Views, Windows, Panes, and Pages
(sometimes called Tabs). A window is a section of the e? studio GUI that presents information on a
key topic. Windows often use tabs to select sub-topics. For example, an editor window might have a
tab available for each open file, so it is easy to switch back and forth between them. A window Pane
is a section of a window. Within a window, multiple Panes can be opened and viewed simultaneously,
as opposed to a tabbed window, where only individual content is displayed. A memory-display
Window, for example, might have multiple Panes that allow the data to be displayed in different
formats, simultaneously. A Perspective is a collection of Views and Windows typical for a specific
stage of development. The default perspectives are a C/C++ Perspective, an FSP Configuration
Perspective and a Debug Perspective. These provide specific Views, Windows, Tabs, and Panes
tailored for the common tasks needed during the specific development stage.

File Edit Navigate Search Project RenesasViews Run Window Help

4 Debug [ Blinky Debug_Flat ‘- | &~/ v w0 AR S RET I SRR i -~
Q igg | BC/C++ | FSP Configuration
[ Project Explorer 32 =% B = O [Blinky FSP Configuration i1 = O g&lPackage & Qe @vEy=0
~ 1% Blinky [Debug] [¥] ~
@ Includes Summary Generate Project Content
@Bra .
5 ra_gen Project Summary Rene A
2 src
& ra_cfg Board: EK-RAGM1 =
& script Device: R7FABM1AD3CFP =
|2 Blinky Debug_Flat.|aunch Toolchain: GCC ARM Embedded 1 %
& configuration.xml Toolchain Version: @ %
[Z R7TFA6M1AD3CFP.pincfg FSP Version: R b=
£ RAGM1-EK pincfg o RTFA6M1AxcoxFP =
(@ Developer Assistance software ponents 100LQFP =
4 =
(Top View) =
Arm CMSIS Version 5 - Care (M) = E
RA6M1-EK Board Support Files = E
Board support package for R7TFAGM1AD3CFP ==
Board support package for RAGM1 2=
Board support package for RA6M1 - FSP Data =
Simple application that blinks an LED. No RTOS included v
Roard Sunnnrt Packana Common Filas
Youlf3 @
D | e
Connection status: . v
Summary| BSP Clocks | Pins| Interrupts| Event Links | Stacks| Components < >
[ Properties 52 ™ § = B  [%PinConflicts % 7y § =0
configuration.xml - Blinky 0 items =
Description Module Pin Location Re
Resource  Property Value
~ Info
derived false
editable true
. e - . 4 mAmA L am s oms e
< > < >
£* configurationxml - Blinky
Figure 7: Default Perspective
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In addition to managing project development, selecting modules, configuring them and simplifying
code development, e? studio also hosts the engine for automatically generating code based on
module selections and configurations. The engine continually checks for dependencies and
automatically adds any needed lower level modules to the module stack. It also identifies any lower
level modules that require configuration (for example, an interrupt that needs to have a priority
assigned). It also provides a guide for selecting between multiple choices or options to make it easy
to complete a fully functional module stack.

The Generate Project Content function takes the selected and configured modules and automatically
generates the complete and correct configuration code. The code is added to the folders visible in
the Project Explorer window in e? studio. The configuration.xml file in the project folder holds all
the generated configuration settings. This file can be opened in the GUI-based RA Configuration
editor to make further edits and changes. Once a project has been generated, you can go back and
reconfigure any of the modules and settings if required using this editor.

&5 Project Explorer & = 8

L

~ 125 Blinky [Debug]

=Y Includes

Bra

= ra_gen

2 src

= ra_cfg

= script
= Blinky Debug_Flat.launch

i configurationxml
= R7TFABMTAD3CFP.pincfg
= RA6M1-EK pincfg

(@ Developer Assistance

Figure 8: Project Explorer Window showing generated folders and configuration.xml file

3.2.2 e? studio Prerequisites

3.2.2.1 Obtaining an RA MCU Kit

To develop applications with FSP, start with one of the Renesas RA MCU Evaluation Kits. The Renesas
RA MCU Evaluation Kits are designed to seamlessly integrate with e? studio.

Ordering information, Quick Start Guides, User Manuals, and other related documents for all RA MCU
Evaluation Kits are available at https://www.renesas.com/ra.

3.2.2.2 PC Requirements
The following are the minimum PC requirements to use e? studio:

¢ Windows 10 with Intel i5 or i7, or AMD A10-7850K or FX
e Memory: 8-GB DDR3 or DDR4 DRAM (16-GB DDR4/2400-MHz RAM is preferred)
e Minimum 250-GB hard disk

3.2.2.3 Installing e? studio, platform installer and the FSP package

Detailed installation instructions for e? studio and FSP are available on the Renesas website
https://www.renesas.com/fsp. Review the release notes for e? studio to ensure that the e studio
version supports the selected FSP version. The starting version of the installer includes all features of
the RA MCUs.
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3.2.2.4 Choosing a Toolchain

e? studio can work with several toolchains and toolchain versions such as the GNU Arm compiler,
Arm AC6, and LLVM Embedded Toolchain for Arm. Versions of the GNU Arm and LLVM compilers
verified for use with FSP are included in the e? studio installer.

3.2.2.5 Licensing

FSP licensing includes full source code, limited to Renesas hardware only.

3.2.3 What is a Project?

In e studio, all FSP applications are organized in RA MCU projects. Setting up an RA MCU project
involves:

1. Creating a Project
2. Configuring a Project

These steps are described in detail in the next two sections. When you have existing projects
already, after you launch e? studio and select a workspace, all projects previously saved in the
selected workspace are loaded and displayed in the Project Explorer window. Each project has an
associated configuration file named configuration.xml, which is located in the project's root directory.

5 Project Explorer 2 = 0

{L(\.I

~ =% Blinky [Debug]

= Includes

Era

 ra_gen

& src

= ra_cfg

= script
= Blinky Debug_Flat.launch

i configurationxml
= RTFABM1TAD3CFP.pincfg
=/ RA6M1-EK pincfg

(@ Developer Assistance

Figure 9: e? studio Project Configuration file

Double-click on the configuration.xml file to open the RA MCU Project Editor. To edit the project
configuration, make sure that the FSP Configuration perspective is selected in the upper right
hand corner of the e? studio window. Once selected, you can use the editor to view or modify the
configuration settings associated with this project.

= | BC/C++ | FSP Configuration
Figure 10: e? studio FSP Configuration Perspective

Note
Whenever the RA project configuration (that is, the configuration.xml file) is saved, a verbose RA Project Report
file (ra_cfg.txt) with all the project settings is generated. The format allows differencesto be easily viewed using a
text comparison tool. The generated file islocated in the project root directory.
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part_number: R7FAGM1AD3CFP
rom_size_bytes: 524288

ram_size_bytes: 262144

data_flash_size bytes: 8192
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~ 1 Blinky [Debug] 2 Board "EK-RAEM1"
& Includes 3 R7FABM1AD3CFP
Bra 2
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= ra_cfg :] package_style: LQFP
&= script 9 package_pins: 108
El Blinky Debug_Flatlaunch 1@
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Figure 11: RA Project Report

>

The RA Project Editor has a number of tabs. The configuration steps and options for individual tabs
are discussed in the following sections.

Note

The tabs available in the RA Project Editor depend on the €2 studio version and the layout may vary slightly,
however the functionality should be easy to follow..

¢ [MyProject] FSP Configuration 2

Summary

Project Summary

Board: EK-RAGM3

Device: R7FA6M3AH3CFC
Toolchain: GCC ARM Embedded
Toolchain Version:

FSP Version:

Selected software components

Arm CMSIS Version 5 - Core (M)

RAGM3-EK Board Suppoert Files

Board support package for R7TFASBM3AH3CFC
Board support package for RAGM3

Board support package for RAGM3 - FSP Data
Board Support Package Common Files

1/Q Port

|Summary BSP | Clocks | Pins| Interrupts | Event Links | Stacks Componentsl

= 0O
(V]

Generate Project Content

RENESAS

Figure 12: RA Project Editor tabs
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e Click on the YouTube icon to visit the Renesas FSP playlist on YouTube
e Click on the Support icon to visit RA support pages at Renesas.com
e Click on the user manual (owl) icon to open the RA software package User's Manual

3.2.4 Creating a Project

During project creation, you specify the type of project, give it a project name and location, and
configure the project settings for version, target board, whether an RTOS is included, the toolchain
version, and the beginning template. This section includes easy-to-follow step-by-step instructions
for all of the project creation tasks. Once you have created the project, you can move to configuring
the project hardware (clocks, pins, interrupts) and the parameters of all the modules that are part of
your application.

3.2.4.1 Creating a New Project
For RA MCU applications, generate a new project using the following steps:

1. Click on File > New > RA C/C++ Project > Renesas RA.

&) workspace - e2 studio
File Edit Navigate Search Project RenesasViews Run Window Help

New Alt+Shift+N > Renesas C/C++ Project > Renesas Debug X
Open File... ™ Project. Renesas RA
L. Open Projects from File System... % Example..
R it Fil >
ecent rres [ Other.. Ctrl+N
Claca Editar el 2\ L

Figure 13: New RA MCU Project

Then click on the type of template for the type of project you are creating.

ﬁ New C/C++ Project O X

Templates for Renesas RA Project

Renesas RA C/C++ Project
CfCrs A Create an executable or static library C/C++ project for Renesas RA.
‘/?j' < Back Next > Finish Cancel

Figure 14: New Project Templates

2. Select a project name and location.
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Q Renesas RA C/C++ Project O X

Renesas RA C/C++ Project p—

Project Name and Location

Project name

| MyProjecﬂ

Use default location
\MyProject Browse...

default

You can download more Renesas packs here

'/?3' < Back Finish Cancel
Figure 15: RA MCU Project Generator (Screen 1)

3. Click Next.
3.2.4.2 Selecting a Board and Toolchain
In the Project Configuration window select the hardware and software environment:

1. Select the FSP version.
2. Select the Board for your application. You can select an existing RA MCU Evaluation Kit or
select Custom User Board for any of the RA MCU devices with your own BSP definition.

3. Select the Device. The Device is automatically populated based on the Board selection.
Only change the Device when using the Custom User Board (Any Device) board
selection.

. To add threads, select RTOS, or No RTOS if an RTOS is not being used.

. The Toolchain selection defaults to GCC Arm Embedded.

. Select the Toolchain version. This should default to the installed toolchain version.

. Select the Debugger. The J-Link Arm Debugger is preselected.

<o u b

8. Click Next.

R11UMO155EU0420 Revision 5.20 RENESANAS Page 27 /5,010
Feb.28.2024



Flexible Software Package User’s Manual

Starting Development > e? studio User Guide > Creating a Project > Selecting a Board and Toolchain

{8 Renesas RA C/C++ Project m] x

Renesas RA C/C++ Project

Device and Tools Selection

Device Selection

FSP Version: ) Board Description
Evaluation kit for RAGM3 MCU Group
Hoauk EEEL ~| Visit https://www.renesas.com/ra/ek-rabm3 to get kit user's
) manual, quick start guide, errata, design package, example
Device: R7FABM3AHICFC e
Core: M4

Language: @ C (O C++

Device Details
TrustZone No
Pins 176
Processor Cortex-M4
Toolchains Debugger
GNU ARM Embedded J-Link ARM ~

LLVM Embedded Toolchain for Arm

‘_ Help < Back Finish Cancel
Figure 16: RA MCU Project Generator (Screen 2)

Note
Click onthe Help icon (?) for user guides, RA contents, and other documents.

3.2.4.3 Selecting Flat or Arm TrustZone Project

If you selected a device or tool based on an Arm® Cortex®-M33, you next select whether to use
Arm® TrustZone® technology in your project. For normal, non-TrustZone projects, select "Flat".
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ﬁ Renesas RA C/C++ Project O X
Renesas RA C/C++ Project —
[
Project Type Selection et |
Project Type Selection

@ Flat (Non-TrustZone) Project
* RA device project without TrustZone separation
* All code, data and peripheral settings will be configured in
this project

() Secure Project

* RA device project for TrustZone secure execution

+ All code, data and peripherals placed in this project will
be initialized as secure

* Secure project settings such as TrustZone partitions, linker
maps and a list of secure peripherals will be passed to a
selected non-secure project

= After initialization, a call to the non-secure startup handler
will be made

() Non-secure Project
* RA device project for TrustZone non-secure execution
+ All code, data and peripherals placed in this project will
be initialized as non-secure
* Must be associated with a secure project or secure bundle
+ Non-secure startup handler will be called after secure
code initialization

@ < Back Finish Cancel

Figure 17: Flat, Secure, or Non-Secure Project

For more information on Arm TrustZone technology, see Primer: Arm TrustZone Project
Development.

3.2.4.4 Selecting a Project Template

In the next window, select the buiild artifact and RTOS.
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Q Renesas RA C/C++ Project

Renesas RA C/C++ Project

Build Artifact and RTOS Selection

Build Artifact Selection
@ Executable
* Project builds to an executable file
(O Static Library
+ Project builds to a static library file
() Executable Using an RA Static Library
* Project builds to an executable file
* Project uses an existing RA static library project

)
@

< Back

RTOS Selection
No RTOS

Cancel

Figure 18: RA MCU Project Generator (Screen 3)

In the next window, select a project template from the list of available templates. By default, this

screen shows the templates that are included in your current RA MCU pack. Once you have selected
the appropriate template, click Finish.

Note

If you want to devel op your own application, select the basic template for your board, Bare Metal - Minimal.
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Q Renesas RA C/C++ Project

Renesas RA C/C++ Project

Project Template Selection

Project Template Selection

O () Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks,
and the C runtime environment.

C) | Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.

Code Generation Settings
Use Renesas Code Formatter

@ < Back Next = Cancel
Figure 19: RA MCU Project Generator (Screen 4)

When the project is created, e? studio displays a summary of the current project configuration in the
RA MCU Project Editor.

& [MyProject] FSP Configuration 2

Summary Generate Project Content
Project Summary
RENESAS
Board: EK-RABM3
Device: R7FABM3AH3CFC
Tooelchain: GCC ARM Embedded
Tooelchain Version:
FSP Version:

Selected software components

Arm CMSIS Version 5 - Core (M)

RAGM3-EK Board Support Files

Board support package for RTFAGM3AH3CFC
Board support package for RAGM3

Board support package for RAGM3 - FSP Data

Board Support Package Common Files
1/O Port

|5ummary BSP| Clocks Pins| Interrupts Event Links| Stacks Componentsl

Figure 20: RA MCU Project Editor and available editor tabs
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On the bottom of the RA MCU Project Editor view, you can find the tabs for configuring multiple
aspects of your project:

e With the Summary tab, you can see all they key characteristics of the project: board,
device, toolchain, and more.

e With the BSP tab, you can change board specific parameters from the initial project
selection.

e With the Clocks tab, you can configure the MCU clock settings for your project.

e With the Pins tab, you can configure the electrical characteristics and functions of each
port pin.

e With the Interrupts tab, you can add new user events/interrupts.

* With the Event Links tab, you can configure events used by the Event Link Controller.

e With the Stacks tab, you can add and configure FSP modules. For each module selected in
this tab, the Properties window provides access to the configuration parameters, interrupt
priorities, and pin selections.

e The Components tab provides an overview of the selected modules. Although you can also
add drivers for specific FSP releases and application sample code here, this tab is normally
only used for reference.

The functions and use of each of these tabs is explained in detail in the next section.
3.2.5 Configuring a Project

Each of the configurable elements in an FSP project can be edited using the appropriate tab in the
RA Configuration editor window. Importantly, the initial configuration of the MCU after reset and
before any user code is executed is set by the configuration settings in the BSP, Clocks and Pins
tabs. When you select a project template during project creation, e? studio configures default values
that are appropriate for the associated board. You can change those default values as needed. The
following sections detail the process of configuring each of the project elements for each of the
associated tabs.

3.2.5.1 Summary Tab
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= 0

Summary

Project Summary

Board: EK-RABM3

Device: R7FABM3AH3CFC
Toolchain: GCC ARM Embedded
Toolchain Version:

FSP Version:

Project Type: Flat

Selected software components

Simple application that blinks an LED. No RTOS
included.

Board Support Package Common Files

1/0 Port

Arm CMSIS Version 5 - Core (M)

Board support package for RTFAGM3AH3CFC
Board support package for RABIM3

Board support package for RABIM3 - FSP Data
RABM3-EK Board Support Files

o|: 4

Summary| BSP | Clocks| Pins | Interrupts | Event Links | Stacks| Components

()]

Generate Project Content

RENESAS

Figure 21: Configuration Summary tab

The Summary tab, seen in the above figure, identifies all the key elements and components of a
project. It shows the target board, the device, toolchain and FSP version. Additionally, it provides a
list of all the selected software components and modules used by the project. This is a more

convenient summary view when compared to the Components tab.

The summary tab also includes handy icons with links to the Renesas YouTube channel, the Renesas
support page and to the RA FSP User Manual that was downloaded during the installation process.

3.2.5.2 Configuring the BSP

The BSP tab shows the currently selected board (if any) and device. The Properties view is located in

the lower left of the Project Configurations view as shown below.

Note

If the Properties view is not visible, click Window > Show View > Properties in the top menu bar.
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Property
~ R7FABM3AHICFC

part_number
rom_size_bytes
ram_size_bytes
data_flash_size_bytes
package_style
package_pins

~ RABM3

series

~ RABM3 Family

OFS0 register settings
OFS1 register settings
MPU

~ RA Common

Main stack size (bytes)
Heap size (bytes)
MCU Vee (mV)

Darammetar charlbinm

Summa locks | Pins | Interrupts | Event Links | Stacks  Components

Value

R7FAEM3AH3CFC
2097152

655360

65536

LOFP

176

&

0400
0
3300

Niczhlad

Figure 22: Configuration BSP tab

=3

The Properties view shows the configurable options available for the BSP. These can be changed
as required. The BSP is the FSP layer above the MCU hardware. e? studio checks the entry fields to
flag invalid entries. For example, only valid numeric values can be entered for the stack size.

When you click the Generate Project Content button, the BSP configuration contents are written

to ra_cfg/fsp_cfg/bsp/bsp_cfg.h

This file is created if it does not already exist.

Warning

Do not edit this file as it is overwritten whenever the Generate Project Content button is

clicked.

3.2.5.3 Configuring Clocks

The Clocks tab presents a graphical view of the MCU's clock tree, allowing the various clock dividers
and sources to be modified. If a clock setting is invalid, the offending clock value is highlighted in

red. It is still possible to generate code with this setting, but correct operation cannot be guaranteed.
In the figure below, the USB clock UCLK has been changed so the resulting clock frequency is 60 MHz
instead of the required 48 MHz. This parameter is colored red.
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& *[MyProject] FSP Configuration &3 =8
(¥}

Clocks Conflguratlon Generate Project Content

EZ Restore Defaults

XTAL 24MHz }\L  ICLK Div /2 v ] ICLK 120MHz \
PLL Src: XTAL v > PCLKA Div /2 || PCLKA 120MHz \
b
PLL Div /2 v > PCLKB Div /4 ~ || PCLKB 60MHz \
b
PLL Mul x20.0 v > PCLKC Div /4 v | PCLKC 60MHz \
b
| USBMCLK 24MHz | | [PLL240MHz |-/ Clock Src: PLL <> PCLKD Div /2 || PCLKD 120MHz \
HOCO 20MHz v SDCLKout On |/ SDCLKout 120MHz \
i
| LOCO 32768Hz | > BCLK Div /2 + [ BCLK 120MHz \
)
| MOCO 8MHz | BCLK/2 || BCLKout 60MHz \
| SUBCLK 32768Hz | " v ucceomz \
\> FCLK Div /4 v [ FCLK 60MHz \
CLKOUT Disabled > CLKOUT Div /1 || CLKOUT 0Hz \

Summary | BS ins Interrupts| Event Links | Stacks| Components

Figure 23: Configuration Clocks tab

When you click the Generate Project Content button, the clock configuration contents are written
to: ra_gen/bsp_clock_cfg.h

This file will be created if it does not already exist.

Warning
Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

3.2.5.4 Configuring Pins

The Pins tab provides flexible configuration of the MCU's pins. As many pins are able to provide
multiple functions, they can be configured on a peripheral basis. For example, selecting a serial
channel via the SCI peripheral offers multiple options for the location of the receive and transmit pins
for that module and channel. Once a pin is configured, it is shown as green in the Package view.

Note

If the Package view window is not open in €2 studio, select Window > Show View > Pin Configurator > Package
from the top menu bar to openit.

The Pins tab simplifies the configuration of large packages with highly multiplexed pins by
highlighting errors and presenting the options for each pin or for each peripheral. If you selected a
project template for a specific board such as the EK-RA6M3, some peripherals connected on the
board are preselected.
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& *[MyProject] FSP Configuration 2 =78

& Package 2 G v|@-M~y=08
. = B [+] i
Pins Cunflguratlun Generate Project Content
Select pin configuration s~ &)
RA6M3-EK pincfg 5 Generate data: | g_bsp_pin_cfg
Pin Selection Pin Configuration

type filter text

Analog:DAC12 ~ Module name: SCI7 fo
Connectivity:CAN Usage: ‘When using Simple 12C mode, ensure 5 _
v Connectivity:ETHERC type is n-ch open drain, RrF‘:i!:i:Fx:ch
~ Connectivity:lIC When switching between I12C and otf (Top View)
~ v Connectivity:SCI disable.
scio Pin Group Selection: _Conly ~
scn
sci2 Operation Mode: Asynchronous UART L
v 5CI3 Input/Output
sCi4 P612
scis oc
5Cl6 v |P614 o
i SGIy v < 5%

Summary |BSP| & Cloc iterrupts | Event Links| Stacks | Components

v
[% Pin Conflicts & es v &= O
€rrors, U warnings, 0 others

Figure 24: Pins Configuration

The pin configurator includes a built-in conflict checker, so if the same pin is allocated to another
peripheral or I/O function the pin will be shown as red in the package view and also with white cross
in a red square in the Pin Selection pane and Pin Configuration pane in the main Pins tab. The
Pin Conflicts view provides a list of conflicts, so conflicts can be quickly identified and fixed.

In the example shown below, port P611 is already used by the CAC, and the attempt to connect this
port to the Serial Communications Interface (SCI) results in a dangling connection error. To fix this

error, select another port from the pin drop-down list or disable the CAC in the Pin Selection pane
on the left side of the tab.

% *[MyProject] FSP Configuration 2 = 8
Pins Configuration e
9 Generate Project Content
Select pin configuration e v &l
RABM3-EK.pincfg e Generate data: | g_bsp_pin_cfg
Pin Selection Pin Configuration
AnalogL Hin Group Selection: _Conly v Py
Connecti Operation Mode: Simple SPI ~
~ Connecti Input/Output
nput/Outpu
v Connecti P P
~ B Connecti v [P613 e d
SClo v |P614 =
s
sci2 v |pe12 e
v SCi3 CTS RIS S5: o ECI =
SCl4 N
<Cl5 None
sc6 ., None %
< > < >
Summary |BSP | & Clocks| @ Pins| Interrupts| Event Links | Stacks| Components
Figure 25: e? studio Pin configurator
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The pin configurator also shows a package view and the selected electrical or functional
characteristics of each pin.

& Package 3% ;}{vlg‘vv'ﬂg

Connection Status
Drive Capacity
~ Mode

Qutput Type
Pull Up

RTFABM3AxaFC
176LOFP

(Top View)

Figure 26: e? studio Pin configurator package view

When you click the Generate Project Content button, the pin configuration contents are written
to: ra_gen\bsp_pin_cfg.h

This file will be created if it does not already exist.

Warning

Do not edit this file as it is overwritten whenever the Generate Project Content button is
clicked.

To make it easy to share pinning information for your project, e? studio exports your pin
configuration settings to a csv format and copies the csv file to ra_gen/<MCU package>.csv.

3.2.5.5 Configuring Interrupts from the Stacks Tab

You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt
priority. Select the driver in the Stacks pane to view and edit its properties.
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% [MyProject] FSP Configuration &3

Stacks Configuration

Threads = HAL/Common Stacks

=0
(]

Generate Project Content

4] New Stack > == Extend Stack > %] Remove

~ &¢ HAL/Common

& g_elc ELC Driver on
r_elc

®

®

& g_uart0 UART Driver on r_sci_uart

rt I/0 Port
4 g_ioport 10 Port Driver on r_ioport ort I . ©
o . ronr_ioport
4 g_elc ELC Driver on r_elc
@ g_uart0 UART Driver on r_sci_uart
Objects
<

Summary |BSP | & Clocks| @ Pins |Interrupts | Event Links | Stacks| Components

[ Properties % . Problems @& Smart Browser
g_uart0 UART Driver on r _sci_uart

Settings  "TOPEMy
Common
~ Module g_uart0 UART Driver on r_sci_uart

General
Baud
Flow Control
Extra

~ Interrupts

Callback

APl Info

& g_transferQ Transfer
Driver on r_dtc SCI0
TXI (Transmit data

® empty)

T
& g_transfer? Transfer
Driver on r_dtc SCI0
RXI (Receive data full)
®

Value

user_uart_callback

Receive Interrupt Priority

Transmit Data Empty Interrupt Priority
Transmit End Interrupt Priority

Error Interrupt Priority

Priority 12
Priority 12
Priority 12
Priority 12

v Pins

Figure 27: Configuring Interrupts in the Stacks tab

Creating Interrupts from the Interrupts Tab

On the Interrupts tab, the user can bypass a peripheral interrupt set by FSP by setting a user-
defined ISR. This can be done by adding a new event via the New User Event button.

¢ [MyProject] FSP Configuration 2

Interrupts Configuration

User Events

(]

Generate Project Content

%] New User Event >

Event ISR
Allocations
Interrupt  Event ISR

0 SCI0 RXI (Receive data full)

1 SCI0 TXI (Transmit data empty)
2 SCI0 TEI (Transmit end)

3 SCI0 ERI (Receive error)

sci_uart_ri_isr
sci_uart_txi_isr
sci_uart_tei_isr

sci_uart_eri_isr

Summary |[BSP | & Clocks | @ Pinvent Links| Stacks | Components
Figure 28: Configuring interrupt in Interrupt Tab
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% [MyPraject] FSP Configuration &3

Interrupts Configuration

User Events

1. & New!

Event

ISR

Allocations

Interrupt
0

1
2
3

Event

SCI0 RXI (Receive data full)
SCI0 TXI (Transmit data empty)
SCI0 TEI (Transmit end)

SCI0 ERI (Receive error)

ISR

sci_uart_rxi_i
sci_uart_txi_i
sci_uart_tei_i
sci_uart_eri_i

Summary |BSP | & Clocks| @ Pins | Interrupts| Event Links | Stacks| Components

[ Properties & Problems Smart Browse

Properties are not available.

ADC
AGT
CAC
CAN
CGC
COMP
CTSU
DMAC
DoC
DRW
DTC
EDMAC
ELC
EPTPC
FCU
GLCDC
GPT
ICU

IiC
IOPORT
IWDT
JPEG
KEY
LPM
VD
0oPS
PDC
POEG
QsPI
RTC
SCE

>

>

> F & Package 2

R7FAGM3AxoxxFC
176LQFP

SCl

>|| 3. 5Ci0

> || 4 SCI0 RXI (Receive data full)
>

Enter the name of ISR for the new user event.

E MNew User Event

SDHIMMC
SPI

SRC

Sl

USBFS
USBHS

Enter the name of the ISR for the new user event:

> S
> SCI2
> SCI3
> SCl4
> SCI5
> SCle

SCIO TXT (Transmit data empty)

SCIO TEI (Transmit end)

SCI0 ERI (Receive error)

SCI0 AM (Address match event)

SCI0 RXI OR ERI (Receive data full/Receive)

Figure 29: Adding user-defined event

| user_defined__sci_uart_rd_i srl

Cancel

Figure 30: User-defined event ISR
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& *[MyProject] FSP Configuration 2 - =
2 ) [¥]
Interrupts Configuration Generate Project Content
User Events #] New User Event > &
Event ISR
SCI0 RXI (Receive data full) user_defined__sci_uart_rxi_isr
Allocations
Interrupt  Event ISR
0 SCI0 RXI (Receive data full) user_defined__sci_uart_rxi_isr
1 SCI0 TXI (Transmit data empty) sci_uart_txi_isr
2 SCIO TEI (Transmit end) sci_uart_tei_isr
3 SCIO ERI (Receive errar) sci_uart_eri_isr

Summary |[BSP | & Clocks @ Pins | Interrupts| Event Links Stacks| Components

Figure 31: Using a user-defined event

3.2.5.6 Viewing Event Links

The Event Links tab can be used to view the Event Link Controller events. The events are sorted by
peripheral to make it easy to find and verify them.

% *[MyProject] FSP Configuration 2 =8
. . . o
Event Links Configuration Generate Project Content
User Events Produced | New User Event > %1 Remove  User Events Consumed | New User Event
Event Peripheral Function Event
GPTO CAPTURE COMPARE A (Compare match A) PORT 1 GPTO CAPTURE COMPARE A (Compare match A)
Allocations /
Peripheral Function / Event (3
DAC12 Channel 0 No allocation
DAC12 Channel 1 No allocation
PORT 1 GPTO CAPTURE COMPARE A (Compare match A)
PORT O allocation v

Summary BSP | Clocks |Pins | Interrupts |Event Links | Stacks| Components

Figure 32: Viewing Event Links

Like the Interrupts tab, user-defined event sources and destinations (producers and consumers) can
be defined by clicking the relevant New User Event button. Once a consumer is linked to a
producer the link will appear in the Allocations section at the bottom.

Note

When selecting an ELC event to receive for a module (or when manually defining an event link), only the events
that are made available by the modules configured in the project will be shown.

3.2.6 Adding Threads and Drivers

Every RTOS-based RA Project includes at least one RTOS Thread and a stack of FSP modules running
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in that thread. The Stacks tab is a graphical user interface which helps you to add the right modules
to a thread and configure the properties of both the threads and the modules associated with each
thread. Once you have configured the thread, e? studio automatically generates the code reflecting
your configuration choices.

For any driver, or, more generally, any module that you add to a thread, e? studio automatically
resolves all dependencies with other modules and creates the appropriate stack. This stack is
displayed in the Stacks pane, which e? studio populates with the selected modules and module
options for the selected thread.

The default view of the Stacks tab includes a Common Thread called HAL/Common. This thread
includes the driver for 1/O control (IOPORT). The default stack is shown in the HAL/Common Stacks
pane. The default modules added to the HAL/Common driver are special in that FSP only requires a
single instance of each, which e? studio then includes in every user-defined thread by default.

In applications that do not use an RTOS or run outside of the RTOS, the HAL/Common thread
becomes the default location where you can add additional drivers to your application.

For a detailed description on how to add and configure modules and stacks, see the following
sections:

e Adding and Configuring HAL Drivers
e Adding Drivers to a Thread and Configuring the Drivers

Once you have added a module either to HAL/Common or to a new thread, you can access the
driver's configuration options in the Properties view. If you added thread objects, you can access
the objects configuration options in the Properties view in the same way.
You can find details about how to configure threads here: Configuring Threads
Note
Driver and module selections and configuration options are defined in the FSP pack and can therefore change
when the FSP version changes.

3.2.6.1 Adding and Configuring HAL Drivers

For applications that run outside or without the RTOS, you can add additional HAL drivers to your
application using the HAL/Common thread. To add drivers, follow these steps:

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to
HAL/Common Stacks.
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& “[MyProject] FSP Configuration £ = b
Click here to add )
Stacks Configuration
g new module Generate Project Content
Threads = HAL/Common Stacks ] New Stack » %] Remove
~ ¥ HAL/Common p p ;
= o U’_ ) A & g_ioport I/O Port & g_wdt0 Watchdog & g_cgc0 CGC Driver on
4 g_ioport 1/O Port Driver on r_ioport . . ;
i Driver on r_ioport Driver on r_wdt r_cgc
& g_wdt0 Watchdog Driver on r_wdt
4 g_cgc0 CGC Driver on r_cgc 6] 6] 6]

Objects

Summary | BSP | Clocks  Pins | Interrupts Ewvent Linblf Stacks domponents

Figure 33: e? studio Project configurator - Adding drivers
2. Click New Stack to see a drop-down list of HAL level drivers available in FSP.

3. Select a driver from the menu New Stack > Driver.

&1 New S1 Analog
Artificial Intelligence
Audio
Bootloader
CapTouch
Connectivity
DSP
Graphics
Input
Monitaring
Motor
Networking
Power
Security
Sensor

_— Storage
Conflicts & |G 2

| System
E Timers Port Output Enable for GPT (r_poeg)
Realtime Clock (r_rtc)

Three-Phase PWM (r_gpt_three_phase)
Timer, General PWM (r_gpt)

Timer, Low-Power (r_agt)

iption

B N e

¢ e ed

Transfer

4" Search...

Figure 34: Select a driver
4. Select the driver module in the HAL/Common Modules pane and configure the driver
properties in the Properties view.
e? studio adds the following files when you click the Generate Project Content button:
e The selected driver module and its files to the ra/fsp directory

e The main() function and configuration structures and header files for your application as
shown in the table below.
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File

Contents

Overwritten by Generate
Project Content?

ra_gen/main.c

Contains main() calling
generated and user code. When
called, the BSP already has
Initialized the MCU.

Yes

ra_gen/hal_data.c

Configuration structures for HAL
Driver only modules.

Yes

ra_gen/hal_data.h

Header file for HAL driver only
modules.

Yes

src/hal_entry.c

User entry point for HAL Driver
only code. Add your code here.

No

The configuration header files for all included modules are created or overwritten in this folder:

ra_cfg/fsp_cfg

3.2.6.2 Adding Drivers to a Thread and Configuring the Drivers

For an application that uses the RTOS, you can add one or more threads, and for each thread at least
one module that runs in the thread. You can select modules from the Driver dropdown menu. To add
modules to a thread, follow these steps:

1. In the Threads pane, click New Thread to add a Thread.
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£ *[MyProject] FSP Configuration % =
. . o
Stacks conﬁguratlon Generate Project Content
Threads | ¢|New Thread fi|Remove =  New Thread Stacks %] New Stack >
w & HAL/Common . Add stacks to the selected thread by using the ‘New Stack =" toolbar button (above), or by

# g ioport I/O Port (r_ioport) Y pasting here from the clipboard.
% New Thread

< >

Objects 4| New Object >

Summary | BSP |Clocks |Pins | Interrupts | Event Links | Stacks| Components

[ Properties & =
New Thread
Settings  Property Enter Name of your
Parformance thread here. Example:
RA My Thread
Interrupts
w Thread
Symbol new threa
Name New Thread
Stack size (bytes) 024
Priority 1
Auto start Enabled

Tirna clicinm intanal Hiebe

Figure 35: Adding a new RTOS Thread on the Stacks tab

2. In the Properties view, click on the Name and Symbol entries and enter a distinctive
name and symbol for the new thread.

Note
€2 studio updates the name of the thread stacks pane to My Thread Stacks.

3. In the My Thread Stacks pane, click on New Stack to see a list of modules and drivers.
HAL-level drivers can be added here.
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5 Stacks Conﬁguration Generate Pr?ject Content
®
g; Threads %] New Thread =|Remove |-| My Thread Stacks & New S - Analog N
w & HAL/Common '0 Add stacks to the selected thread by using the ‘New Stack >’ toolbz Artificial Intelligence > B
4 g_ioport I/O Port (r_ioport) ¥  from the clipboard. Audio 5
My Thread Bootloader >
CapTouch >
#  Azure RTOS USBX HCDC Connectivity >
4 Azure RTOS USBX HHID DSP >
< & & Azure RTOS USBX PAUD Graphics 5
5 : 5 & Azure RTOS USBX PCDC Input 5
TLRES £ New Object > 4 Azure RTOS USBX PHID Monitort s
4 Azure RTOS USBX PMSC Mz:;rorlng 3
@ CAN (r_can) i
% |2C Communication Device (rm_comms_i2c) :]etworklng :
p = wer
Summary |BSP | Clocks |Pins |Interrupts | Event Links | Stacks| Components i :;E ::2: g::([i'_[i;i;teo RTOS >
[ Properties 2 & 12C Shared Bus (rm_comms_i2c) Security > F B
& 12C Slave (r_iic_slave) Sensor >
Ss LD & 125 (r_ssi) Storage > In
Settings Froperty Value @ SPI (r_sci_spi) System >
Performance 4 SPI(r_spi) Timers N
RA % UART (r_sci_uart) TersrT 5
Interrupts % USB Composite (r_usb_composite) g .
« Thread @ USB HCDC (r_usb_hcdc) L carc
Symbol new thread0 & USB HHID (r_usb_hhid)
Name My Thread “  USB HMSC (r_usb_hmsc)
Crark cive fhutac) 14 # USB Host Vendor class {r_usb_hvnd)
< 4 USB PCDC (r_usb_pcdc) >
& USB PHID (r_usb_phid)
& USB PMSC (r_usb_pmsc)
- M % USB Peripheral Vendor class (r_usb_pvnd)

Figure 36: Adding Modules and Drivers to a thread
4. Select a module or driver from the list.

5. Click on the added driver and configure the driver as required by the application by
updating the configuration parameters in the Properties view. To see the selected module
or driver and be able to edit its properties, make sure the Thread containing the driver is
highlighted in the Threads pane.
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8 *[MyProject] FSP Configuration &

Stacks Configuration

Threads

4] New Thread

~ &t HAL/Commaon

& g_ioport I/O Port Driver on r_ioport

~ & New Thread

“# g_wdt0 Watchdog Driver on r_wdt ®

Objects

%] Remove = g_wdt0 Watchdog Driver on r_wdt Stacks

# g_wdt0 Watchdog
Driver on r_wdt

#] New Object >

Summary BSP Clocks |Pins Interrupts Event Links | Stacks| Components

[ Properties 2 [T Problems @ Smart Browser

g_wdt0 Watchdog Driver on r_wdt

Settings
APl Info

Property
Common

Value

v Module g_wdt0 Watchdog Driver on r_wdt

Name
Timeout

Clock Division Ratio
Window Start Position
‘Window End Position

Reset Control
Stop Control
NMI Callback

g_wdt0
16,384 Cycles
PCLK/8192

Reset Output

o

Generate Project Content

4| New Stack >

100% (Window Position Not Specified)
0% (Window Position Not Specified)

WOT Count Disabled in Low Power Mode

NULL

Figure 37: Configuring Module or Driver properties

6. If needed, add another thread by clicking New Thread in the Threads pane.

When you press the Generate Project Content button for the example above, e? studio creates
the files as shown in the following table:

File

Contents

Overwritten by Generate
Project Content?

only code. Add your code here.

ra_gen/main.c Contains main() calling Yes
generated and user code. When
called the BSP will have
initialized the MCU.

ra_gen/my_thread.c Generated thread "my_thread" |Yes
and configuration structures for
modules added to this thread.

ra_gen/my_thread.h Header file for thread Yes
"my_thread"

ra_gen/hal_data.c Configuration structures for HAL | Yes
Driver only modules.

ra_gen/hal_data.h Header file for HAL Driver only |Yes
modules.

src/hal_entry.c User entry point for HAL Driver | No
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src/my_thread_entry.c User entry point for thread No
"my_thread". Add your code
here.

The configuration header files for all included modules and drivers are created or overwritten in the
following folders: ra_cfg/fsp_cfg/<header files>

3.2.6.3 Configuring Threads

If the application uses an RTOS, the Stacks tab can be used to simplify the creation of RTOS
threads, semaphores, mutexes, and event flags.

The components of each thread can be configured from the Properties view as shown below.

1 Properties 2
New Thread

Settings Property Value
v Common
General
Hooks
Stats
Memory Allocation
Timers
Optional Functions

RA
Logging

w Thread
Symbol new_thread0
Name New Thread
Stack size (bytes) 1024
Priority 1
Thread Context NULL
Memaory Allocation Static

Figure 38: New Thread Properties

The Properties view contains settings common for all Threads (Common) and settings for this
particular thread (Thread).

For this thread instance, the thread's name and properties (such as priority level or stack size) can
be easily configured. e? studio checks that the entries in the property field are valid. For example, it
will verify that the field Priority, which requires an integer value, only contains numeric values
between 0 and 9.

To add RTOS resources to a Thread, select a thread and click on New Object in the Thread Objects
pane. The pane takes on the name of the selected thread, in this case My Thread Objects.
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.
8 ©F *[MyProject] FSP Configuration X ==

= = G
Stacks Configuration Generate Project Content

e

Threads %| New Thread =|Remove |- 4| New Stack =
My Thread Stacks

£ wmif

v & HAL/Common

4 g_ioport I/ Port {r_ioport) 2
~ & My Thread (g,wgg] Watchdog
r_wi

# g_wdt0 Watchdog (r_wdt)
@

1 New Ot @ %/ent Flags
Event Flags utex

® Queue
@® Semaphore

Summary |BSP | Clocks | Pins |Interrupts | Event Links | Stacks| Components

T Properties i =0
g_new_queuel Queue
Settings Property Value

MName Mew OQuele

Symbol g_new_queuel

WIC33ayt .Ji CAVVUTUS) 1

Queue Size (Bytes) 20

< >

vﬁ‘

Figure 39: Configuring Thread Object Properties

Make sure to give each thread object a uniqgue name and symbol by updating the Name and
Symbol entries in the Properties view.

3.2.7 Reviewing and Adding Components

The Components tab enables the individual modules required by the application to be included or
excluded. Modules common to all RA MCU projects are preselected (for example: BSP > BSP >
Board-specific BSP and HAL Drivers > all > r_cgc). All modules that are necessary for the
modules selected in the Stacks tab are included automatically. You can include or exclude
additional modules by ticking the box next to the required component.
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& *[MyProject] FSP Configuration 52 = 0
Components Configuration Generate ;?m Content
Filter | Al v
Component Version Description Variant 2
~ ¥ rabm3
device Board support package for R7TFABM3AH3CFC R7FAGM3AHS..
device Board support package for RAGM3
I device Board support package for RTFABM3AF2CBG R7FABM3AF2C...
O device Board support package for R7TFABM3AF2CLK R7FABM3AF2C...
O device Board support package for RTFAGM3AF3CFB R7FAGM3AF3C...
I device Board support package for RTFABM3AF3CFC R7FABM3AF3C...
O device Board support package for RTFABM3AF3CFP R7FAGM3AF3C...
O device Board support package for RTFAGM3AH2CBG R7FAGM3AH2..
I device Board support package for RTFABM3AH2CLK R7FA6M3AHZ...
O device Board support package for R7TFAGM3AH3CFB R7FAGM3AHS..
O device Board support package for RTFAGM3AH3CFP R7FAGM3AHS..
fsp Board support package for RA6M3 - FSP Data
¥ rabm4
¥ rabm5
¥ rabtl
% c_sdk
~ #% CMSIS
v # CMSIS5
CoreM 57.0 Arm CMSIS Version 5 - Core (M)
O coreM 5.6.0 Arm CMSIS Version 5 - Core (M)
[ psp 5.6.0 Arm DSP Library Source
O pse 5.7.0 Arm DSP Library Source
O NN 5.6.0 Arm NN Library Source v

Summary | BSP | Clocks | Pins |Interrupts | Event Links Stac

Figure 40: Components Tab

Clicking the Generate Project Content button copies the .c and .h files for each selected
component into the following folders:

* ra/fsp/inc/api

e ra/fsp/inc/instances

e ra/fsp/src/bsp

e ra/fsp/src/<Driver Name>

e? studio also creates configuration files in the ra_cfg/fsp_cfg folder with configuration options set in
the Stacks tab.

3.2.8 Writing the Application

Once you have added Modules and drivers and set their configuration parameters in the Stacks tab,
you can add the application code that calls the Modules and drivers.

Note
To check your configuration, build the project once without errors before adding any of your own application code.

3.2.8.1 Coding Features

e? studio provides several efficiency improving features that help write code. Review these features
prior to digging into the code development step-by-step sections that follow.

Autocomplete

Autocomplete is a context aware coding accelerator that suggests possible completions for partially
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typed-in code elements. If you can 'guess' the first part of a macro, for example, the Autocomplete
function can suggest options for completing the rest of the macro.

In the following example, a macro related to a BSP_IO setting needs to be found. After typing
BSP_IO_in a source code file, pressing Ctrl + Space opens the Autocomplete list. This list shows a
selection of context aware options for completing the macro. Scroll through the window to find the
desired macro (in this case BSP_IO_LEVEL_HIGH) and click on it to add it to your code.

Protect PFS registers

R_BSP_PinAccessDi;able( );

ogegle level for next rite

if (BSP_IO_LEVEL_LOW == pin_level)

{ pin_level = BSP_IO0_
i lse o BSP_IO_DIRECTION_INPUT ~
{ o BSP_IO_DIRECTION_OUTPUT
pin_level = BSP_ IO L o o
} o BSP_IO_LEVEL_LOW
vTaskDelay(configTICK_RA ° BSP_IO_PORT_00
} o BSP_IO_PORT_00_PIN_00
} o BSP_IO_PORT_00_PIN_01
. o BSP_IO_PORT_00_PIN_02 R v
o BSP_IO_PORT_00_PIN_03
E = r# o BSP_IO_PORT_00_PIN_04
o BSP_IO_PORT_00_PIN_05
o BSP 10 PORT 00 PIN 06 vi Moc

Press ‘Ctrl+Space’ to show Template Proposals

Figure 41: Autocomplete example

Other code elements can use autocomplete too. Some of the more common uses for Autocomplete
include Enumerations, Types, and API functions - but try it in any situation you think the tool may
have enough context to determine what you might be looking for.

For a hands-on experience using Autocomplete use the Quick FSP Labs for Creating Blinky from
Scratch and Creating an RTC Blinky from Scratch. These 15-minute Do it Yourself labs take you
through the step-by-step process of using Autocomplete, Developer Assistance, and the Help
system.

Welcome Window
The e? studio Welcome window displays useful information and common links to assist in

development. Check out these resources to see what is available. They are updated with each
release, so check back to see what has been added after a new release.
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Q workspace - MyProject/configurationxml - e* studio

File Edit MNavigate Search Project RenesasViews Run Window Help

[ D Welcome

tr s AaE==

i)
| e ;
] Welcome to e2 studio
&
&
Create a new e2 studio C/C++ project Get an overview of the features
Import existing e2 studio projects from the Go through tutorials
filesystem or archive
Try out the samples
Download and import sample projects from v b
Renesas website
Find out what is new
Review the IDE's most fiercely contested
preferences
Quickly getting familiar with the tool
Open a file from the filesystem
Always show Welcome at start up

Cheat Sheets

Figure 42: Welcome window

Cheat sheets are macro driven illustrations of some common tasks. They show, step-by-step, what
commands and menus are used. These will be populated with more examples on each release.
Cheat Sheets are available from the Help menu.

views Run Window

= myProjectRTOS

Project] FSP Configurat
#incluc

FSP_CPE
void R_
FSP_CPI

® * mair
“void h:

Help
) Welcome
(@ Help Contents
%' Search
Show Contextual Help

Show Active Keybindings...
Cheat Sheets...

Renesas Help

CMSIS Packs Management
# Add Renesas Toolchains
%8 Perform Setup Tasks..

{ * % Check for Updates
@ Install New Software...
- #if BSI i& AR Embedded Workbench plugin manager...
/* @ About e? studio

Ctrl+Shift+L

5 use

R_BSP_NGNSECUrEERTEr();

Figure 43: Cheat Sheets
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Developer Assistance

FSP Developer Assistance provides developers with module and Application Programming Interface
(API) reference documentation in e? studio. After configuring the threads and software stacks for an
FSP project with the RA Configuration editor, Developer Assistance quickly helps you get started
writing C/C++ application code for the project using the configured stack modules.

1. Expand the project explorer to view Developer Assistance

2

Iy Project Explorer &3 -

v 15 Blinky
! Includes

JoU

 ra
(2 ra_gen
2 src
(= ra_cfg
(= script
|| Blinky Debug.launch
% configuration.xml
2 RTFABM3AH3CFC.pincfg
| ra_cfg.bd
RASM3I-EK pincfg

v (2) Developer Assistance
v g HAL/Common
4 g_ioport I/O Port Driver on r_ioport
42 g_elc ELC Driver on r_elc
@ g_adc0 ADC Driver on r_adc

Figure 44: Developer Assistance

2. Expand a stack module to show its APIs

w () Developer Assistance
v gt HAL/Common
42 g_joport |70 Port Driver on r_ioport
47 g_elc ELC Driver on r_elc
w & g_adch ADC Driver on r_adc

~ @ fsp_err t R_ADC_Open(adc_ctrl_t *p_ctrl, ade_cfg_t const *const p_cfg)
B3 CallR_ADC_Open()

v @ fsp_err t R_ADC ScanCfg(ade_ctrl_t *p_ctrl, adc_channel_cfg_t const *const p_channel_cfg)
|25 CallR_ADC ScanCfg()

v @ fsp_err t R_ADC InfoGet(adc_ctrl_t *p_ctrl, adc_info_t *p_adc_info)
£ Call R_ADC_InfoGet()

v @ fsp_err_t R_ADC ScanStart(adc_ctrl_t *p_ctrl)
|24 Call R_ADC_ScanStart()

v @ fsp_err_t R_ADC_ScanStop(adc_ctrl_t *p_ctrl}
B4 Call R_LADC ScanStop()

v @ fsp_err t R_ADC StatusGet{adc_ctrl_t *p_ctrl, ade_status_t *p_status)
[ Call R_ADC_StatusGet()

~ @ fsp_err t R_ADC_Read(adc_ctrl_t *p_ctrl, adc_channel_t const reg_id, uint16_t *const p_data)
£ Call R_ADC_Read()

w @ fon err tRADC Read?2(ade ctrl t*n ctrl ade channel t const rea id uint3? t*const n datal ¥
>

Figure 45: Developer Assistance APIs
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3. Dragging and dropping an API from Develop Assistance to a source file helps to write source
code quickly.

I Project Explorer 2 =5 W § = B g [MyProject] FSP Configuration [€) *hal_entry.c 52
~ (@ Developer Assistance #include "hal_data.h"
~ &% HAL/Common
& g_ioport I/O Port Driver on r_ioport
~ # g_adc0 ADC Driver on r_adc
fep et RACCOpemet_ctrl_t *p_ctrl, adc_cfg_t
E=2 Call R_ADC_Open()

FSP_CPP_HEADER
void R_BSP_WarmStart(bsp warm_start_event_t event);
FSP_CPP_FODTER

® * main() is generated by the RA Configuration editor and is used to generate threads if an
“void hal_entry(void) {

%

- T VI N

eIt — adc_ctrl_t *p_cCtMewaig co
@ fsp_err_t R_ADC InfoGet(adc_ctrl_t *p_ctrl, adc_infc
@ fsp_err_t R_ADC ScanStart(adc_ctrl_t *p_ctrl)

add vour own code here *

| = R_ADC_Open(&g_adc®_ctrl, &g_adc@_cfg);

@ fsp_err_t R_ADC_ScanStop(adc_ctrl_t *p_ctrl) 14 -
@ fsp_err_t R_ADC_StatusGet(adc_ctri_t *p_ctrl, adc_st L -t (1 SIEClile [y
- = == B = 16 /* Enter non-secure code */
@ fsp_err_t R_ADC_Read(adc_ctrl_t *p_ctrl, adc_chann 17 R_BSP_NonSecureEnter();
® fsp_err_t R_ADC_Read32(adc_ctrl_t *p_ctrl, adc_cha 18 #endif
@ fsp_err_t R_ADC_SampleStateCountSet{adc_ctrl_t * 19 }
@ fsp_err_t R_ADC Close(adc_ctrl_t *p_ctrl) 20
@ fsp_err_t R_ADC_OffsetSet(adc_ctrl_t *const p_ctrl, | %E ® *.Lh;SB;:nGtiogtistizlled at v:r‘iius points dur‘ir;g{the startup process. This implementatic
. N 27 “void R_BSP_WarmStart(bsp warm start event t even
@ fsp_err_t R_ADC_Calibrate(adc_ctrl_t *const p_ctrl, v v . - if (BSP WARM START RESET —— event) £

Figure 46: Dragging and Dropping an API in Developer Assistance

For a hands-on experience using Developer Assistance use the Quick FSP Labs for An Introduction to
Developer Assistance, Creating Blinky from Scratch and Creating an RTC Blinky from Scratch. These
15-minute Do it Yourself labs take you through the step-by-step process of using Autocomplete,
Developer Assistance, and the Help system.

Information Icon
Information icons are available on each module in the thread stack. Clicking on these icons opens a

module folder on GitHub that contains additional information on the module. An example information
Icon is shown below:

47 g_ioport 1/0 Port

\ Driver on r_ioport
2

Figure 47: Information icon

IDE Help

A good source of additional information for many FSP topics is the Help system. To get to the Help
system, click on Help and then select Help Contents as seen below.
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n Window Help

. Welcome #
% [Blinky] ¢ Help Contents
Stacks Show Contextual Help
Show Active Keybindings... Ctrl+Shift+L
Threads Cheat Sheets...
v & He Renesas Help >
& CMSIS Packs Management >
#® # Add Renesas Toolchains
® 4% perform Setup Tasks...
% Check for Updates
@ Install New Software...
i& AR Embedded Workbench plugin manager...
@ About e? studio

Figure 48: Opening the Help System

Once the Help system is open, select the RA Contents entry in the left side Guide-bar. Expand it to
see the main RA Topics.

& Help - € studio - O X

Search: Scope: All topics
Contents &@- ¥-B CohweAl@® 0

+ © Workbench User Guide RA Contents > ~
# € C/C++ Development User Guide

# € e2 studio User Guide Creating an RA pl“Oj ect

% € Eclipse Remote Developer's Guide

1 © EGit Documentation

of GNUARM-NONE/RZ(DS-5) Project Import
4 © Linker Script and Linker Script Editor

A new Renesas RA project is created using one of the RA C or C++ project wizards. The wizard selection page can be opened in one
of the following ways:

# € Oomph P2 M t Doc tati * The e2 studio [File->New->RA C/C++ Project] main menu
# € Oomph Setup Documentation * The Project Explorer view [New->RA C/C++ Project] context menu
= B RA Contents ¢ The 2 studio [New->RA C/C++ Project] toolbar drop-down

RA configuration editor
MCU Package View ‘Wizard selection page
RA user pack creator
RA Developer Assistance The wizard selection page allows you to choose the type of RA wizard to open. Wizards are available for either C or C++ and for an
How to create and use an RA static library RA Executable or Static Library project.
How to create an application project which uses &
Preferences for the RA Configuration Editor
B RAFAQ
% © Renesas Hardware Manuals
+ € Renesas QE for Capacitive Touch[RA]
# € Scripting User Guide

w

DEDD P @

[ New RA C/C++ Project o X

Templates for New RA C/C++ Project

Renesas RA C Executable Project
UG+ FE===N~ A C Executable Project for Renesas RA

Figure 49: RA Content Help

You can also search for help topics by using the Search bar. Below is an example searching for
Visual Expressions, a helpful feature in the e? studio debugger.
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&) Help - € studio - O X
Search: visual expressions Scope: All topics
Search Results = D g D O mwelle 0

e2 studio User Guide > Debugging Projects > Views

6 matches in All topics: Change scope

The Visual Expressions view can show a visual Vlsual EXpreSSlons Vlew
representation of expressions that are presented
in the program's code. It is similar to the
Expressions view but with graphic...

e2 studio Plug-in list

) Visual Expression 3 E-#E -0

e2 studio Plug-ins The table lists some of the

plug-ins available in e2 studio. The table also lists esauss
who were the most recent developers of the view .
or plugin: Plug-in Name... A 4

Tuning Error Parsers PN i
Error Parsers scan build output line by line 2

looking for errors and warnings (also for certain
informational messages). They generate Problem
Markers which visually indicat...

, Overview
B Error Parser Preferences

Use the Error Parsers Tab on Build preference The Visual Expressions view can show a visual representation of expressions that are presented in the program's code. It
panel to define global error parsing options. is similar to the Expressions view but with graphical representations. Each graphically represented expression in the
Error Parsers scan build output looking for Visual Expressions view is referred to as a “visual element”.

potential error or warning messages....

U R ' £ O O U O

Figure 50: e? studio Help from the Search Bar

For a hands-on experience using the Help system use the Quick FSP Labs for An Introduction to
Developer Assistance, Creating Blinky from Scratch and Creating an RTC Blinky from Scratch. These
15-minute Do it Yourself labs take you through the step-by-step process of using Autocomplete,
Developer Assistance, and the Help system.

3.2.8.2 HAL Modules in FSP: A Practical Description

The FSP Architecture section describes FSP stacks, modules and interfaces in significant detail,
providing an understanding of the theory behind them. The following sections provides a quick and
practical introduction on how to use API functions when writing code and where in the API reference
sections you can find useful API related information.

Introduction to HAL Modules

In FSP, HAL module drivers provide convenient API functions that access RA processor peripheral
features. Module properties are defined in the RA GUI configurator, eliminating the tedious and error
prone process of setting peripheral control registers. When configuration is complete, the generator
automatically creates the code needed to implement the associated API functions. API functions are
the main way a developer interacts with the target processor and peripherals.

HAL Driver API Function Call Formats

HAL driver API functions all have a similar format. They all start with "R_" to indicate they are HAL

related functions. Next comes the module name followed by the function and any parameters. This
format is illustrated below:

R _<nodul e>_<functi on>( <par anet er s>) ;

Here are some examples:
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status = R GPT_Qpen(&g tinmer0 _ctrl, &g timer0_cfq);
status = R GPT_Start (& tinmer0_ctrl);

status = R GPT_PeriodSet (&g tinmer0O_ctrl, period);
status = R ADC Open(&g_adcO_ctrl, &g adcO _cfg);
status = R ADC | nfoGet (&g adcO _ctrl, &adc_info);

HAL Driver API Call Reference Information

Each HAL module has a useful API Reference section that includes key details on each function. The
function prototype is presented first, showing the return type (usually fsp_status_t for HAL functions)
and the function parameters. A short description and any warnings or notes follow the function
definition. In some cases, a code snippet is included to illustrate use of the function. Finally, all
possible return values are provided to assist in debugging and error management.

& R_GPT PeriodSet()

t R_GPT_PeriodSet [ tim t *const p_ctrl,
uint32_t const period_counts

Sets period value provided. If the timer is running, the period will be updated after the next counter overflow. If
the timer is stopped, this function resets the counter and updates the period. Implements

Warning
If periodic output is used, the duty cycle buffer registers are updated after the period buffer register. If
this function is called while the timer is running and a GPT overflow occurs during processing, the duty

cycle will not be the desired 50% duty cycle until the counter overflow after processing completes.

Example:

* @Get the source clock frequency (in Hz). There are 3 ways to do this in FSP:
=

- If the PCLKD frequency has not changed since reset, the source clock
frequency is

x BSP_STARTUP_PCLKD_HZ >> timer_cfg_t::source_div

- Use the R_GPT_InfoGet function (it accounts for the divider).

* - Calculate the current PCLKD frequency using R_FSP_SystemClockHzGet
(FSP_PRIV_CLOCK_PCLKD) and right shift

>, by timer_cfg t::source_div.

~

#

* This example uses the 3rd option (R_FSP_SystemClockHzGet).
x4

uint32_t pclkd_freq_hz = R_FSP_SystemClockHzGet(FSP_PRIV_CLOCK_PCLKD) >>
g_timer® _cfg.source_div;

/* Calculate the desired period based on the current clock. Note that this
calculation could overflow if the

* desired period is larger than UINT32 _MAX / pclkd freq_hz. A cast to uinté4 t is
used to prevent this. */

uint32_t period_counts =
(uInt32 t) (((uint64_t) pclkd freq hz * GPT_EXAMPLE_DESTIRED PERTOD_MSEC) /
GPT_EXAMPLE_MSEC_PER_SEC);

/* Set the calculated period. */

err = R_GPT_PeriodSet(&g_timere_ctrl, period counts);

handle_error{err);

Return values
FSP_SUCCESS Period value written successfully.
FSP_ERR_ASSERTION p_ctrl was NULL.
FSP_ERR_NOT_OPEN The instance is not opened.

Figure 51: Module Api Reference Section Example

3.2.8.3 RTOS-Independent Applications

To write application code:
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1. Add all drivers and modules in the Stacks tab and resolve all dependencies flagged by e?
studio such as missing interrupts or drivers.

. Configure the drivers in the Properties view.
3. In the Project Configuration view, click the Generate Project Content button.

N

4. In the Project Explorer view, double-click on the src/hal_entry.c file to edit the source file.

|
o

i Project Explorer 332 = =
-
IS

125 Blinky
T FSP_project

v 15 MyProject [Debug]

#;;b Binaries

[ Includes
Era
(2 ra_gen
v @ src
l€| hal_entry.c
(= Debug
(= ra_cfg
= script
=| A2A1-TBB.pincfg

Note

All configuration structures necessary for the driver to be called in the application are initialized in
ra_gen/hal_data.c.
Warning

Do not modify the files in the directory ra_gen. These files are overwritten every
time you push the Generate Project Content button.

5. Add your application code here:

[€ hal_entry.c 52 | {55 [MyProject] RA Configuration
B 1 #include "hal Hata.h”
2 #include "bsp_pin_cfg.h"
#include "r_ioport.h”
void R_BSP_WarmStart(bsp_warm_start_ever

@ * The RA Configuration tool generates n

11 void hal_entry(void)
12 {

=13 £¥ : add your own code here */
14 17 \

Add your own code here

Figure 52: Adding user code to hal_entry.c

6. Build the project without errors by clicking on Project > Build Project.

The following tutorial shows how execute the steps above and add application code: Tutorial: Using
HAL Drivers - Programming the WDT.

The WDT example is a HAL level application which does not use an RTOS. The user guides for each
module also include basic application code that you can add to hal_entry.c.

3.2.8.4 RTOS Applications
To write RTOS-aware application code using RTOS, follow these steps:

1. Add a thread using the Stacks tab.
2. Provide a uniqgue name for the thread in the Properties view for this thread.
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3. Configure all drivers and resources for this thread and resolve all dependencies flagged by
e? studio such as missing interrupts or drivers.

. Configure the thread objects.

. Provide unique names for each thread object in the Properties view for each object.

. Add more threads if needed and repeat steps 1 to 5.

. In the RA Project Editor, click the Generate Project Content button.

~N o U b~

8. In the Project Explorer view, double-click on the src/my_thread 1 _entry.c file to edit the
source file.

[y Project Explorer 3 = 8

E S ¥

&

v 15 RA_RTOS_Application [Debug]  ~
[ Includes
Era
v 5 ra_gen
[.g] blinky_thread.c
blinky_thread.h
bsp_clock_cfg.h
bsp_pin_cfg.h
[€] common_data.c
comrmon_data.h
lg] hal_data.c
hal_data.h
€] main.c
4g] my_thread_1.c
rmy_thread_1.h
€] pin_data.c
|.g] vector_data.c
vector_data.h
2] ABM3-PK.csv
v B src
lg] blinky_thread_entry.c
lg] hal_entry.c
l.g] my_thread_1_entry.c
(= ra_cfg
(= script
= ABM3-PK.pincfg
& configurationxml
= R7FABM3AH3CFC.pincfg

< >

Figure 53: Generated files for an RTOS application

Note
All configuration structures necessary for the driver to be called in the application are initialized in
ra_gen/my_thread 1.cand my thread 2.c

Warning
Do not modify the files in the directory ra_gen. These files are overwritten every
time you push the Generate Project Content button.

9. Add your application code here:

<_"—:_> [RA_RTOS_Application] RA Configuration S(s’l \€] my_thread_1_entry.c 3% |

A f{"‘,‘i“?:’;Z‘git[P.A_RTOs_i\pp|icatwf‘n_.'ccnﬁguratim.xnﬂ |

void my_thread_1_entry{void *pvParameters)

M
: add your own code here */
while (1)

{

1a wTaskDelay (1);

s);

Figure 54: Adding user code to my_thread_1.entry

10. Repeat steps 1 to 9 for the next thread.
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11. Build your project without errors by clicking on Project > Build Project.

3.2.8.5 Additional Resources for Application Development
Example Projects
A wide variety of Example Projects for FSP and RA MCUs is available on the GitHub site here:

https://github.com/renesas/ra-fsp-examples. Example projects are organized by target kit so it is
easy to find all the examples for your kit of choice.

ek_ra2a1l
ek_radm1
ek radw1
ek_rabm1
ek_rabm2
ek rabm3
ek_rabm3g

Figure 55: FSP Example Projects Organized by Kit

Projects are available as both downloadable zip files and as project source files. Typically, there is a
project for each module. New example projects are being added periodically, so check back if a
particular module isn't yet available.

m acmphs/acmphs_ek_raém3_ep
) adc/ade_ek_rabm3_ep
[Bm agt/agt_ek_rabm3_ep

[m cac/cac_ek_rabm3_ep

B crc/crc_ek_rabm3_ep

m dmac/dmac_ek_rabm3_ep
W clc/elc_ek_rabm3_ep

im flash_hp/flash_hp_ek_raém3_ep
) freertos/freertos_ek_raém3_ep
I gpt/gpt_ek_rabém3_ep

[Bm icuficu_ek _rabm3_ep

[ iic_master/iic_master_ek_rabm3_ep
m iic_slavefiic_slave ek _rabm3_ep

Bm kint/kint_ek_rabm3_ep

i vd/lvd_ek_rabm3_ep

Bm quickstart/quickstart_ek_rabm3

j rtc/rtc_ek_rabm3_ep

Figure 56: A Selection of Example Projects Available on GitHub

Quick Labs

A variety of Hands-on Do It Yourself labs are available on the Renesas RA and FSP Knowledge Base.
Quick FSP Labs target the EK-RA6M3 kit and typically require only 15 minutes to complete. Each lab
covers a couple related development tools and techniques like Autocomplete, Developer Assistance,
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console I/O over RTT, and Visual Expressions, that can speed up the development process. A list of
all available Quick Labs can be found here: https://en-
support.renesas.com/knowledgeBase/19450948

3.2.9 Debugging the Project

Once your project builds without errors, you can use the Debugger to download your application to
the board and execute it.

To debug an application follow these steps:

1. On the drop-down list next to the debug icon, select Debug Configurations.

R MY =

[E7] 1 FSP_project Debug
Debug As >
Debug Configurations...

Organize Favorites...

2. In the Debug Configurations view, click on your project listed as MyProject Debug.

Debug Cenfigurations *
Create, manage, and run configurations %'\
= Y
RS | e Name: | MyProject Debug |
type filter text [ Main %5 Debugger| = Startup| ] Common| K Source

[€] C/C++ Application

[©] C/C++ Remote Applicatic
EASE Script | MyProject Browse...

[£] GDB Hardware Debuggin; || ¢/Ce Application:

[£] GDB OpenOCD Debuggin

GDB Simulator Debuggin:
Java Applet Variables... Search Project... Browse...
Java Application

R Launch Group

= Launch Group (Deprecate Build Configuration: | Use Active i
Remote Java Application

Project:

[ Debug/MyProject.elf

Build (i required) before launching

[ Renesas GDE Hardware D () Enable auto build () Disable auto build
[£7] MyProject Debug (®) Use workspace settings Configure Workspace Settings...
Renesas Simulator Debug
< >
Revert Apply.
Filter matched 14 of 16 items
@

3. Connect the board to your PC via either a standalone Segger J-Link debugger, a Segger J-
Link On-Board (included on all RA EKs), or an E2 or E2 Lite and click Debug.

Note
For details on using J-Link and connecting the board to the PC, see the Quick Sart Guide included in the RA MCU
Kit.

3.2.10 Modifying Toolchain Settings
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There are instances where it may be necessary to make changes to the toolchain being used (for
example, to change optimization level of the compiler or add a library to the linker). Such
modifications can be made from within e2 studio through the menu Project > Properties > C/C++
Build > Settings when the project is selected. The following screenshots show the settings dialogs
for the GNU Arm and LLVM toolchains. The dialog looks slightly different depending upon the

toolchain being used.

Properties for Blinky

Resource
Builders
v C/C++ Build
Build Variables
Environment
Logging
Settings
Tool Chain Editor
CfC++ General
MCU
Project Natures
Project References
Refactoring History
Renesas QE
Run/Debug Settings
Task Tags
Validation

N
&

Settings

Configuration: | Debug [ Active ]

& Tool Settings 3 Toolchain

Build Steps

(& Target Processor
(& Optimization
(& Wamings
(& Debugging
w 3 GNUARM Cross Assembler
(£ Preprocessor
(2 Includes
(£ Warnings
(2 Miscellaneous
~w B3 GNU ARM Cross C Compiler
(£ Preprocessor
(2 Includes
(£ Optimization
(£ Warnings
(2 Miscellaneous
w ) GNU ARM Cross C Linker
(2 General
(£ Libraries
(2 Miscellaneous

(2 General
o BB AN ADRA eee eint Cinn

~w &3 GNU ARM Cross Create Flash Image

~ | | Manage Cenfigurations...

Build Artifact Binary Parsers 3 Error Parsers
ARM family cortex-m4
Architecture Toolchain default

Instruction set Thumb (-mthumb)

] Thumb interwork (-mthumb-interwork)

Endianness Toolchain default
Float ABI FP instructions (hard)
FPU Type fpvd-sp-di16

Unaligned access | Toolchain default

Generic (-mcpu=generic)

Toolchain default
Toolchain default
Toolchain default

Enabled (+simd)

Small (-mecmodel=small)

Apply and Close

w

v

Cancel

Figure 57: e? studio Project toolchain settings for GNU Arm
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Settngs G

Resource
Builders
~ C/C++ Build Configuration: |Debug [Active] ~ | | Manage Configurations...

Build Variables

Environment

Logging m %3 Toolchain Build Steps Build Artifact | [5i} Binary Parsers| @ Error Parsers

Settings

Tool Chain Editor (2 Py ARM family cortex-m4 ~
C/C++ General (% Optimization
Praject Natures (2 Debug
Project References (£ Warnings Instructionset | Thumb (-mthumb) v
Renesas QF ~ I8 Library Generator

Run/Debug Settings (22 Settings
Task Tags ~ B Compiler Endian Little endian (-mlittle-endian) ~

Architecture Toolchain default ~
[] Thumb interwark

. 5
Validation - ouree Float ABI FP instructions (hard) ~
(2 Includes

~ B Assembler FPU Type fpvd-sp-d16 ~
2 Source
22 Includes

~ BB Linker [] TrustZone (-mcmse)

Unaligned access  Toolchain default ~

By
(£2 Source Other CPU options |
# Archives

(# Miscellaneous
(# Other
~ B Objcopy
# General
~ B Print Size
# General

Restore Defaults Apply

|/';?>| Cancel
Figure 58: e? studio Project toolchain settings for LLVM

The scope for the settings is project scope which means that the settings are valid only for the
project being modified.

The settings for the linker which control the location of the various memory sections are contained in
a script file specific for the device being used. This script file is included in the project when it is
created and is found in the script folder (for example, /script/aém3.Id).

3.2.11 Creating RA project with Arm Compiler 6 in e? studio

e? studio does not include the Arm Compiler 6 (AC6) toolchain by default. Follow the steps below to
integrate ACG6 into e? studio and create an AC6 RA project.

Note
It is assumed that the user is already familiar with RA project creation in €2 studio. € studio does not include Arm
Compiler 6 (AC6) toolchain by default.

Steps 1 through 8 describe the process for integrating Arm Compiler 6 into e? studio.

1. Download, install, and configure license for the AC6 toolchain
(https://developer.arm.com/tools-and-software/embedded/arm-
compiler/downloads/version-6).

. Launch e? studio.

3. Go to Window > Preferences > Toolchains.

N
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4. Click Add.

& Preferences | X

type filter text Toolchains Pvo v § ‘
~

Doxygen Add/Remove toolchains

Help ‘
Install/Update ;
Java Remove
Library Hover
LinkerScript

MCuU

Comph

Remote Developn
Renesas
Run/Debug
Scripting
Terminal

Toolchains

Tracing
Validation Name: Mo Toolchain Selected
Version Control (T Path:
XML v

< >

Figure 59: Add Toolchain

Apply

5. Browse to the path where AC6 toolchain is installed and select the \bin folder. Click Next.

B Add a new Toolchain O X

Select Toolchain Path

Please enter the path to the toolchain's binaries directory.

Path to toolchain binaries: | C:\Program Files\ARMCompiler6.14\bin ||Browse...l

Download toolchains from ds.arm.com

@ < Back Finish Cancel
Figure 60: Browse to AC6 Compiler

6. Toolchain information in displayed. Click Finish.
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E Add a new Toolchain

Discovered Toolchain Information

Toolchain ARM Compiler 6.14 was discovered from C:\Program Files\ARMCompiler6.14\bin

Compiler: armclang.exe
Assembler: armasm.exe
Linker: armlink.exe
Archiver: armar.exe

Image Converter: fromelf.exe

If this information is correct, click Finish to add the toolchain, otherwise click Next to edit/correct

this information.

Next >

Figure 61: Toolchain Information

7. Click Apply and Close.

8. Click Restart Eclipse when prompted.

E Preferences

type filter text

Library Hover
LinkerScript
MCU

Mylyn
Oomph
Remote Development
Renesas QF
Run/Debug
Scripting
Team
Terminal
Toolchains
Tracing
Validation
XML

@®

~

X
Toolchains =i
Add/Remove toolchains
Name Add...
Remove

Name: ARM Compiler 6.14

Path:

C\Program Files\ARMCompiler6.14\bin

Apply

Apply and Close Cancel

Figure 62: Apply and Close
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E Confirm Restart Eclipse

I-e'-‘ Eclipse must be restarted in order for the changes to be visible.

Figure 63: Restart Eclipse

9. When creating a new RA C/C++ project, select ARM Compiler 6 included in the Toolchains
section.

E e2 studio - Project Configuration (RA C Executable Project)

e2 studio - Project Configuration (RA C Executable Project)
Specify the new project details.

Project Toolchains
Project name | ARM_Compiler_Test ‘ GNU ARM Embedded
Use default location

|ARM Compiler 6.14 |

Figure 64: Select Arm Compiler

3.2.12 Importing an Existing Project into e2 studio
1. Start by opening e? studio.

2. Open an existing Workspace to import the project and skip to step d. If the workspace
doesn't exist, proceed with the following steps:

a. At the end of e? studio startup, you will see the Workspace Launcher Dialog box as
shown in the following figure.
H Eclipse Launcher

*
Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts.

RIS ETEWEC \Users\\ < user_namele2studio\workspace]

Browse...

[] Use this as the default and do not ask again
» Recent Workspaces

Cancel
Figure 65: Workspace Launcher dialog
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b. Enter a new workspace name in the Workspace Launcher Dialog as shown in the
following figure. e? studio creates a new workspace with this name.

m Eclipse Launcher

*
Select a directory as workspace

& studio uses the workspace directory to store its preferences and development artifacts,

IR ET N Users\ <username > \e2studiol\new workspace] Browse...

[] Use this as the default and de not ask again

b Recent Workspaces

Cancel
Figure 66: Workspace Launcher dialog - Select Workspace

c. Click Launch.

d. When the workspace is opened, you may see the Welcome Window. Click on the

Hide arrow button to proceed past the Welcome Screen as seen in the following
figure.

Welcome to e? studio

Figure 67: Workbench arrow button

3. You are now in the workspace that you want to import the project into. Click the File menu
in the menu bar, as shown in the following figure.

Q fspWorkspace - FSPproject/confit
File Edit Navigate Search Proje €= Menu bar
45 Debug <« Tool bar

| - E

Figure 68: Menu and tool bar

4. Click Import on the File menu or in the menu bar, as shown in the following figure.
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File Edit Mavigate Search Project Renesas Views Ru

New
Open File...

. Open Projects from File System...
Recent Files

Close

Close All

Save

Save As...

Save Al

Revert

Move...

Rename...

Refresh

Convert Line Delimiters To

Print...

B

i Export...
Properties

Switch Workspace
Restart
Bt

Figure 69: File drop-down menu

Alt+Shift+N

Ctrl+W
Ctrl+Shift+W

Ctrl+5

Ctrl+Shift+5

Ctrl+P

Alt+Enter

>

>

>

5. In the Import dialog box, as shown in the following figure, choose the General option, then
Existing Projects into Workspace, to import the project into the current workspace.

| @ Import
Select

| Create new projects from an archive file or directory.

Select an import wizard:

| type filter text

~ [= General
LI Archive File
4 CMSIS Pack
1= Existing Projects into Workspace
L File System
[l Preferences
4 Projects from Folder or Archive

1=f Rename & Import Existing C/C++ Project into Workspace

) -

Figure 70: Project Import dialog with "Existing Projects into Workspace" option selected

6. Click Next.

7. To import the project, use either Select archive file or Select root directory.

a. Click Select archive file as shown in the following figure.
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Q Import

O X
Import Projects B
Select a directory to search for existing Eclipse projects. A
() Select root directory: Browse...
@ Select archive file: | | Browse...
Projects:
Select All
Deselect All
Refresh
Options
Search for nested projects
Copy projects into workspace
[] Close newly imported projects upon completion
[ 1Hide projects that already exist in the workspace
Working sets
] Add project to working sets New.
Select...
@ < Back Next > Finish Cancel

Figure 71: Import Existing Project dialog 1 - Select archive file

b. Click Select root directory as shown in the following figure.
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Q Import O X
Import Projects ‘I:
Select a directory to search for existing Eclipse projects. A
(@ Select root directory: | | ~ Browse...
(O Select archive file: Browse...
Projects:
Select All
Deselect All
Refresh
Options
[]search for nested projects
[ICopy projects into workspace
[] Close newly imported projects upon completion
[ 1Hide projects that already exist in the workspace
Working sets
] Add project to working sets New...
Select...
'/?3‘ < Back Next > Finish Cancel

Figure 72: Import Existing Project dialog 1 - Select root directory

. Click Browse.

. For Select archive file, browse to the folder where the zip file for the project you want to
import is located. For Select root directory, browse to the project folder that you want to
import.

10. Select the file for import. In our example, it is CAN_HAL_MG_AP.zip or CAN_HAL_MG_AP.

11. Click Open.

O 00

12. Select the project to import from the list of Projects, as shown in the following figure.

Projects:

CAN_HAL MG_AP (CAN_HAL_MG_AP/}

Figure 73: Import Existing Project dialog 2

13. Click Finish to import the project.

3.2.13 Using Semihosting in a Project

Note
printf requires use of the heap (BSP Tab -> Properties -> RA Common -> Heap size (bytes))

When using certain standard C I/O functions such as printf and scanf semihosting must be initialized
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for them to work correctly with the Renesas Debug Virtual Console. In order to setup semihosting
a call to initialise_monitor_handles should be added somewhere in your application before any
semihosting related calls are made. Here is an example declaration and call:

extern void initialise nonitor_handl es(void); /* Add this declaration before calling.
*/

initialise_nonitor_handles(); /* Add this call to your application. */

3.3 Tutorial: Your First RA MCU Project - Blinky

3.3.1 Tutorial Blinky

The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the
steps of creating a simple application using e? studio and running that application on an RA MCU
board.

3.3.2 What Does Blinky Do?

The application used in this tutorial is Blinky, traditionally the first program run in a new embedded
development environment.

Blinky is the "Hello World" of microcontrollers. If the LED blinks you know that:

The toolchain is setup correctly and builds a working executable image for your chip.
The debugger has installed with working drivers and is properly connected to the board.
The board is powered up and its jumper and switch settings are probably correct.

The microcontroller is alive, the clocks are running, and the memory is initialized.

The Blinky example application used in this tutorial is designed to run the same way on all boards
offered by Renesas that hold the RA microcontroller. The code in Blinky is completely board
independent. It does the work by calling into the BSP (board support package) for the particular
board it is running on. This works because:

e Every board has at least one LED connected to a GPIO pin.

e That one LED is always labelled LED1 on the silk screen.

e Every BSP supports an API that returns a list of LEDs on a board, and their port and pin
assignments.

3.3.3 Prerequisites
To follow this tutorial, you need:

Windows based PC

e? studio

Flexible Software Package
An RA MCU board kit

3.3.4 Create a New Project for Blinky

The creation and configuration of an RA MCU project is the first step in the creation of an application.
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The base RA MCU pack includes a pre-written Blinky example application that is simple and works on

all Renesas RA MCU boards.

Follow these steps to create an RA MCU project:

1. In e? studio, click File > New > C/C++ Project > Renesas RA and select Renesas RA

C/C++ Project.
2. Assign a name to this new project. Blinky is a good name to use for this tutorial.

3. Click Next. The Project Configuration window shows your selection.

Q Renesas RA C/C++ Project

Renesas RA C/C++ Project

Project Name and Location

Project name
[ Blinig

Use default location

Browse...

default

You can download more Renesas packs here

'/?3' < Back Finish Cancel

Figure 74: e? studio Project Configuration window (part 1)

4. Select the board support package by selecting the name of your board from the Device

Selection drop-down list and click Next.
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Q Renesas RA C/C++ Project

O >
Renesas RA C/C++ Project —
Device and Tools Selection =
Device Selection
ESP Version: .| Board Description
Board: EK-RABM3 v
Device: R7FABM3AH3CFC
Language: @C OC++
Device Details
TrustZone No
Pins 176
Processor cortex-m4
Toolchains Debugger
GNU ARM Embedded J-Link ARM ~
L] b4
@' < Back Finish Cancel
Figure 75: e? studio Project Configuration window (part 2)
5. Select the build artifact and RTOS.
{8 Renesas RA C/C++ Project O X
Renesas RA C/C++ Project —
Build Artifact and RTOS Selection L —
Build Artifact Selection RTOS Selection
@ Executable No RTOS v
* Project builds to an executable file
() static Library
¢ Project builds to a static library file
) Executable Using an RA Static Library
* Project builds to an executable file
s Project uses an existing RA static library project
@' < Back Finish Cancel

Figure 76: e? studio Project Configuration window (part 3)
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6. Select the Blinky template for your board and click Finish.

& Renesas RA C/C++ Project

Renesas RA C/C++ Project

Project Template Selection

Project Template Selection

© — _ .
0} Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks,
and the C runtime environment.

o “¢ | Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.

Code Generation Settings
Use Renesas Code Formatter

A
|‘3/.

< Back Next = Cancel

Figure 77: e? studio Project Configuration window (part 4)

Once the project has been created, the name of the project will show up in the Project
Explorer window of e? studio. Now click the Generate Project Content button in the top
right corner of the Project Configuration window to generate your board specific files.

{:Ei[Bhnky] FSP Conflguratloné =

s o
ummary Generate Project Content

Project Summary

LENESAS
Board: EK-RABM1

Device: R7FAEM1AD3CFP
Toelchain: GCC ARM Embedded
Toelchain Version:

FSP Version:

Selected software components

Figure 78: e? studio Project Configuration tab

Your new project is now created, configured, and ready to build.

3.3.4.1 Details about the Blinky Configuration
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The Generate Project Content button creates configuration header files, copies source files from
templates, and generally configures the project based on the state of the Project Configuration
screen.

For example, if you check a box next to a module in the Components tab and click the Generate
Project Content button, all the files necessary for the inclusion of that module into the project will
be copied or created. If that same check box is then unchecked those files will be deleted.

3.3.4.2 Configuring the Blinky Clocks

By selecting the Blinky template, the clocks are configured by e? studio for the Blinky application.
The clock configuration tab (see Configuring Clocks) shows the Blinky clock configuration. The Blinky
clock configuration is stored in the BSP clock configuration file (see BSP Clock Configuration).
3.3.4.3 Configuring the Blinky Pins

By selecting the Blinky template, the GPIO pins used to toggle the LED1 are configured by e? studio
for the Blinky application. The pin configuration tab shows the pin configuration for the Blinky
application (see Configuring Pins). The Blinky pin configuration is stored in the BSP configuration file
(see BSP Pin Configuration).

3.3.4.4 Configuring the Parameters for Blinky Components

The Blinky project automatically selects the following HAL components in the Components tab:

e r_ioport

To see the configuration parameters for any of the components, check the Properties tab in the
HAL window for the respective driver (see Adding and Configuring HAL Drivers).

3.3.4.5 Where is main()?

The main function is located in < project >/ra_gen/main.c. It is one of the files that are generated
during the project creation stage and only contains a call to hal_entry(). For more information on
generated files, see Adding and Configuring HAL Drivers.

3.3.4.6 Blinky Example Code

The blinky application is stored in the hal_entry.c file. This file is generated by e? studio when you
select the Blinky Project template and is located in the project's src/ folder.

The application performs the following steps:
1. Get the LED information for the selected board by bsp_leds_t structure.
2. Define the output level HIGH for the GPIO pins controlling the LEDs for the selected board.
3. Get the selected system clock speed and scale down the clock, so the LED toggling can be
observed.
4. Toggle the LED by writing to the GPIO pin with R_BSP_PinWrite((bsp_io_port_pin_t) pin,
pin_level);
3.3.5 Build the Blinky Project

Highlight the new project in the Project Explorer window by clicking on it and build it.

There are three ways to build a project:
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1. Click on Project in the menu bar and select Build Project.
2. Click on the hammer icon.
3. Right-click on the project and select Build Project.

B workspace - & studio

File Edit Navigate Searc

OF B a

¢ &

a. Project->Build Project

R s Views Run Window

b. Click hammer icon

¢. Right click->Build Project

Figure 79: e? studio Project Explorer window

Once the build is complete a message is displayed in the build Console window that displays the
final image file name and section sizes in that image.

7oy s = [l Console &2
CDT Build Censele [Blinky]

'Finished buil;ing: ‘I./ra/bcard/raﬁm}_ek/board_leds..:‘
"Finished building: ../ra/board/raém3_ek/board_init.c’

"Finished building: ../ra/board/raém3_ek/board_gspi.c’

'Building target: Blinky.elf'
"Invoking: GNU ARM Cross C Linker'
arm-none-eabi-gcc @"Blinky.elf.in"
"Finished building target: Blinky.elf'

"Invoking: GNU ARM Cross Create Flash Image'
arm-none-eabi-objcopy -0 srec "Blinky.elf™ "Blinky.srec™
"Invoking: GNU ARM Cross Print Size'
arm-none-eabi-size --format=berkeley "Blinky.elf"

text data bss dec hex filename

4249 8 1152 5488 1518 Blinky.elf
"Finished building: Blinky.srec'
"Finished building: Blinky.siz'

11:5@:45 Build Finished. @ errors, @ warnings. (took 19s5.208ms)

Figure 80: e? studio Project Build console

3.3.6 Debug the Blinky Project

3.3.6.1 Debug prerequisites

To debug the project on a board, you need

* The board to be connected to e? studio
* The debugger to be configured to talk to the board
e The application to be programmed to the microcontroller

Applications run from the internal flash of your microcontroller. To run or debug the application, the
application must first be programmed to the microcontroller's flash. There are two ways to do this:

e JTAG debugger

e Built-in boot-loader via UART or USB

Some boards have an on-board JTAG debugger and others require an external JTAG debugger

connected to a header on the board.
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Refer to your board's user manual to learn how to connect the JTAG debugger to e? studio.
3.3.6.2 Debug steps
To debug the Blinky application, follow these steps:
1. Configure the debugger for your project by clicking Run > Debugger Configurations ...

Run Window Help

Renesas Device Partition Manager

@ TraceX >
& Tracealyzer >
@, Run Ctrl+F11
#, Debug F11

Run History >
O Runas >

Run Configurations...

Debug History >
4 Debug As >

| Debug Configurations.. |

@ External Tools >

Figure 81: e? studio Debug icon

or by selecting the drop-down menu next to the bug icon and selecting Debugger
Configurations ...

e Qo vig y -

Debug As >
Debug Configurations...
Organize Favorites.

Figure 82: e? studio Debugger Configurations selection option

2. Select your debugger configuration in the window. If it is not visible then it must be created
by clicking the New icon in the top left corner of the window. Once selected, the Debug
Configuration window displays the Debug configuration for your Blinky project.
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E Debug Cenfigurations X

Create, manage, and run configurations

[ EBR|E 3 | Name: [ Blinky Debug |

type filter text 2 Main ﬁDahugge? i Startup | B Source| [} Common
[T] C/C++ Application
[E] C/C++ Remote Applicz
5[ EASE Script [ Blinky Browse...
[©] GDB Hardware Debugg
[£] GDB Open0CD Debuge
[c7] GDB Simulator Debugg
Java Applet Variables... Search Project... Browse...
Java Application
 Launch Group

Project:

C/C++ Application:
[ Debug/Blinky.elf

Build (if required) before launching

@ Launch Group (Deprec: Build Configuration: | Use Active bl
Remote Java Applicatio _ : .
« [E¥ Renesas GDB Hardware () Enable auto build () Disable auto build
Blinky Debug (®) Use workspace settings Configure Workspace Settings...

[c7] Renesas Simulator Debt

< >

Revert Appl
Filter matched 14 of 16 items -

|_/'?\ Close
Figure 83: e? studio Debugger Configurations window with Blinky project

3. Click Debug to begin debugging the application.

4. Extracting RA Debug.

Progress Information m] X

Extracting RA Debug

Configuring GDB

3.3.6.3 Details about the Debug Process
In debug mode, e? studio executes the following tasks:

1. Downloading the application image to the microcontroller and programming the image to
the internal flash memory.

. Setting a breakpoint at main().

. Setting the stack pointer register to the stack.

. Loading the program counter register with the address of the reset vector.

. Displaying the startup code where the program counter points to.

ubhWwWwN
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Program Counter

{8% [Blinky] RA Configgfation L€l hal_entry.c Lg startup.c 2

@ * MCU starts executing here out of re
void Reset Handler (void)

L
/* Initialize system using BSP. */
SystemInit();

/* Call user application. */
main();

while (1)
1

Figure 84: e? studio Debugger memory window

3.3.7 Run the Blinky Project

While in Debug mode, click Run > Resume or click on the Play icon twice.

L U

Figure 85: e? studio Debugger Play icon

The LEDs on the board marked LED1, LED2, and LED3 should now be blinking.

3.4 Tutorial: Using HAL Drivers - Programming the WDT

3.4.1 Application WDT

This tutorial illustrates the creation of a simple application that uses the Watchdog Timer module to
monitor program operation. The tutorial shows each step in the development process and in
particular identifies the auto-generated files and project structure created when using FSP and its
GUI based configurator. The level of detail provided here is more than is normally needed during
development but can be helpful in explaining how FSP works behind the scenes to simplify your
work.

This application makes use of the following FSP modules:

e MCU Board Support Package
e Watchdog (r_wdt)
e |/O Port (r_ioport)

3.4.2 Creating a WDT Application Using the RA MCU FSP and e? studio

3.4.2.1 Using FSP and e? studio

The Flexible Software Package (FSP) from Renesas provides a complete driver library for developing
RA MCU applications. FSP provides Hardware Abstraction Layer (HAL) drivers, Board Support Package
(BSP) drivers for the developer to use to create applications. FSP is integrated into Renesas e? studio
based on eclipse providing build (editor, compiler and linker) and debug phases with an extended
GNU Debug (GDB) interface.

3.4.2.2 The WDT Application
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The flowchart for the WDT application is shown below.

Program start

BSP initializes
clocks, pins etc

Tum on red
LED for 125 ms
Feed WDT

Tum off red
LED for 125 ms

Feed WDT

==307
Yes

Tum on green
LED for 250 ms
‘WDT counts
without refresh
Tum off green
LED for 250 ms
Underflow

( WOT resets MCU )
Figure 86: WDT Application flow diagram

Initialize and
start WDT

3.4.2.3 WDT Application flow
The main sections of the WDT application are:

1. The BSP initializes the clocks, pins and other elements of the MCU readying the application
to run.

2. main() calls hal_entry(). The function hal_entry() is created by FSP with a placeholder for
user code. The code for the WDT is added to this function.

3. Initialize the WDT, but do not start it.

4. Start the WDT by refreshing it.

5. In the first loop the red LED flashes 30 times and refreshes the watchdog each time the LED
state is changed.

6. In the second loop, the green LED flashes, but the program DOES NOT refresh the
watchdog. After the watchdog timeout period the device will reset which can be observed
by the red LED flashing again as the sequence repeats.

3.4.3 Creating the Project with e? studio

Start e? studio and choose a workspace folder in the Workspace Launcher. Configure a new RA MCU
project as follows.

1. Select File > New > RA C/C++ Project. Then select the template for the project.
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File Edit MNavigate Search Project RenesasViews Run Window Help

New Alt+Shift+N > Renesas C/C++ Project > g
Open File.. (& C/C++ Project [ Croate a new Coor C++ project F
. Open Projects from File System... T4 Project..
Recent Files * 9 Example..
Close Editor Ctrl+W % Other... Ctrl+N
Close All Editors Ctrl+Shift+W | | Project Summary
@ New C/C++ Project O X
Templates for New C/C++ Project
All Renesas RA C/C+ + Project
CMake FEE=™ Create an executable or static library C/C++ project for Renesas RA.
Make
Renesas Debug
Renesas RZ

Figure 87: Creating a new project

2. In the e? studio Project Configuration (RA Project) window enter a project name, for
example, WDT_Application. In addition, select the toolchain. If you want to choose new
locations for the project unselect Use default location. Click Next.
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e studio - Project Configuration (RA C Executable Project) O x

e2 studio - Project Configuration (RA C Executable Project)
Specify the new project details,

Project Toolchains

Project name | WDT_Application GNU ARM Embedded

Use default location
C\Users\Austin.Hansen\e2_studio\workspace deme| | Browse...

default

'/?) < Back Next > Einish Cancel

Figure 88: Project configuration (part 1)

3. This application runs on the EK-RA6M3 board. So, for the Board select EK-RA6M3.

This will automatically populate the Device drop-down with the correct device used on this

board. Select the Toolchain version. Select J-Link ARM as the Debugger. Click Next to
configure the project.

R11UMO155EU0420 Revision 5.20 RENESANS Page 81/5,010
Feb.28.2024



Flexible Software Package

User’s Manual
Starting Development > Tutorial: Using HAL Drivers - Programming the WDT > Creating the Project with e? studio

Q Renesas RA C/C++ Project

O >
Renesas RA C/C++ Project et
Device and Tools Selection L a,
Device Selection
ESP Version: Board Description
Board: EK-RABM3 v
Device: R7FABM3AH3CFC
Language: @C OC++
Device Details
TrustZone No
Pins 176
Processor cortex-m4
Toolchains Debugger
GNU ARM Embedded J-Link ARM ~
» b4
@' < Back Finish Cancel

Figure 89: Project configuration (part 2)

The project template is now selected. As no RTOS is required select Bare Metal - Blinky

Q Renesas RA C/C++ Project

Renesas RA C/C+ + Project

Project Template Selection

Project Template Selection

® Bare Metal - Blinky
- Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks,
and the C runtime environment.
O

| Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.

Code Generation Settings
Use Renesas Code Formatter

< Back Next > Cancel
Figure 90: Project configuration (part 3)
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4. Click Finish.

e? studio creates the project and opens the Project Explorer and Project Configuration
Settings views with the Summary page showing a summary of the project configuration.

3.4.4 Configuring the Project with e? studio

e? studio simplifies and accelerates the project configuration process by providing a GUI interface for
selecting the options to configure the project.

e? studio offers a selection of perspectives presenting different windows to the user depending on
the operation in progress. The default perspectives are C/C++, FSP Configuration and Debug. The
perspective can be changed by selecting a new one from the buttons at the top right.

‘ BE C/C++ 45 RA Configuration % Debug

Figure 91: Selecting a perspective

The C/C++ perspective provides a layout selected for code editing. The FSP Configuration
perspective provides elements for configuring a RA MCU project, and the Debug perspective
provides a view suited for debugging.

1. In order to configure the project settings ensure the FSP Configuration perspective is
selected.

2. Ensure the Project Configuration [WDT Application] is open. It is already open if the
Summary information is visible. To open the Project Configuration now or at any time make
sure the RA Configuration perspective is selected and double-click on the
configuration.xml file in the Project Explorer pane on the right side of e? studio.

[ Project Explorer 52 = "§V| =
LI Blinky
w 1.5 WDT_Application [Debug]
[ Includes
v [Bra
= arm
(7= board
& fsp
2 ra_gen
v [ src
[ hal_entry.c
= ra_cfg
5% configurationml
=| R7FABM3AHICFC pincfg
=| RABM3-EK.pincfg
=| WDT_Application Debug.launch
(7) Developer Assistance

Figure 92: RA MCU Project Configuration Settings

At the base of the Project Configuration view there are several tabs for configuring the project. A
project may require changes to some or all of these tabs. The tabs are shown below.
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& [WDT_Application] FSP Configuration 2

Summary

Project Summary

Board: EK-RAGM3

Device: R7FABM3AH3CFC
Toolchain: GCC ARM Embedded
Toolchain Version:

FSP Version:

Project Type: Flat

Selected software components

Simple application that blinks an LED. No RTOS included
Board Support Package Comman Files

1/Q Port

Arm CMSIS Version 5 - Core (M)

Board support package for R7TFAGM3AH3CFC

Board support package for RAGM3

Board support package for RAGM3 - FSP Data

o= [

Summary | BSP| Clocks Pins|Interrupts Event Links| Stacks Components

Figure 93: Project Configuration Tabs

3.4.4.1 BSP Tab

= 0
o
Generate Project Content
~
RENESAS
v

The BSP tab allows the Board Support Package (BSP) options to be modified from their defaults. For
this particular WDT project no changes are required. However, if you want to use the WDT in auto-
start mode, you can configure the settings of the OFS0O (Option Function Select Register 0) register in
the BSP tab. See the RA Hardware User's Manual for details on the WDT autostart mode.

3.4.4.2 Clocks Tab

The Clocks tab presents a graphical view of the clock tree of the device. The drop-down boxes in the
GUI enables configuration of the various clocks. The WDT uses PCLCKB. The default output frequency

for this clock is 60 MHz. Ensure this clock is outputting this value.
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& [WDT_Application] FSP Configuration & = 0
[¥)

Clocks Configuration Generate Project Content

EZ Restore Defaults

| XTAL 24MHz }\L > ICLK Div /2 ] ICLK 120MHz \
PLL Src: XTAL v > PCLKA Div /2 v | PCLKA 120MHz \
|
PLL Div /2 v > PCLKB Div /4 || PCLKB 60MHz \
b
PLL Mul x20.0 v > PCLKC Div /4 | PCLKC 60MHz \
\ USBMCLK 24MHz | | PLL 240MHz }—> Clock Src: PLL 4 pLKD Div /2 v —>| PCLKD 120MHz \
HOCO 20MHz v SDCLKout On || sDCLKout 120MHz \
f
| LOCO 32768Hz | k> BCLK Div /2 ~ [/ BCLK 120MHz \
}
\ MOCO 8MHz | BCLK/2 v —>| BCLKout 60MHz \
| SUBCLK 32768Hz | = UCLK Div /5 || uCLK 48z \
‘> FCLK Div /4 w || FCLK 60MHz \
CLKOUT Disabled = CLKOUT Div /1 v ] CLKOUT 0Kz \

Summary |BSP | Clocks Pins| Interrupts | Event Links | Stacks| Components

Figure 94: Clock configuration

3.4.4.3 Interrupts Tab

The Interrupts tab is used to add new user events or interrupts. No new interrupts or events are
needed by the application, so no edits in this tab are required.

3.4.4.4 Event Links Tab

The Event Links tab is used to configure events used by the Event Link Controller (ELC). This
project doesn't use the ELC, so no edits in this tab are required.

3.4.4.5 Pins Tab

The Pins tab provides a graphical tool for configuring the functionality of the pins of the device. For
the WDT project no pin configuration is required. Although the project uses two LEDs connected to
pins on the device, these pins are pre-configured as output GPIO pins by the BSP.

3.4.4.6 Stacks Tab

You can add any driver to the project using the Stacks tab. The HAL driver 10 port pins are added
automatically by e? studio when the project is configured. The WDT application uses no RTOS
Resources, so you only need to add the HAL WDT driver.
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& [WDT_Application] FSP Configuration & = [
[¥]

Stacks Configuration Generate Project Content

Threads = HAL/Common Stacks | New Stack >

~ £ HAL/Comman
¥ g_IopOl ort Driver on r_ioport

& g_ioport I/0 Port
Driver on r_ioport

@

Objects

Summary |BSP | Clocks | Pins |Interrupts | Event Links | Stacks| Components

Figure 95: Stacks tab

1. Click on the HAL/Common Panel in the Threads Window as indicated in the figure above.

The Stacks Panel becomes a HAL/Common Stacks panel and is populated with the
modules preselected by e? studio.

2. Click on New Stack to find a pop-up window with the available HAL level drivers.
3. Select WATCHDOG Driver on r_wdt.

£ [WDT_Application] FSP Configuration X 3 =8
Stacks Configuration Generate Pr?ject Content
Threads =I  HAL/Common Stacks 4| New Stack »
~ &¢ HAL/Common I aled ’
£ g_ioport 10 Port (r_ioport) g_ioport I/O Port Artificial Intelligence >
(r_ioport) Audio 3>
® Bootloader >
CapTouch >
Connectivity >
Dsp >
Graphics >
Input >
4 CRC (r_cr) Monitoring >
4 Clock Accuracy Circuit {r_cac) Motor >
- # Data Operation Circuit (r_doc) Networking >
Objects 4 Independent Watchdog (r_iwdt) Peras 5
4 Low Voltage Detection (r_lvd) Security 5
+  Watchdog (r_wdt)
Sensor >
Storage >
System >
Timers >
Summary | BSP |Clocks |Pins | Interrupts | Event Links | Stacks| Components Transfer 5

Figure 96: Module Selection

The selected HAL WDT driver is added to the HAL/Common Stacks Panel and the Property
Window shows all configuration options for the selected module. The Property tab for the WDT
should be visible at the bottom left of the screen. If it is not visible, check that the FSP
Configuration perspective is selected.
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& “[\WDT_Application] FSP Configuration = "
[¥]

Stacks Configuration Generate Project Content

Threads %] Remove = ] New Stack »
g_wdt0 Watchdog Driver on r_wdt Stacks

~ & HAL/Comman
4 g_ioport I/O Port Driver on r_ioport

& g_wdt0 Watchdog Driver on r_wdt @ g_wdtﬂ Watchdog
Driver on r_wdt

@
Objects
| Summary FSP Clocks |Pins | Interrupts | Event Links | Stacks| Components

[ Properties 2 Problems 5 Browse

g_wdt0 Watchdog Driver on r_wdt

Settings Property Value

APlinfo | | Common
Parameter Checking Default (BSP)
Register Start NMI Support Disabled

v Module g_wdt0 Watchdog Driver on r_wdt

Name g_wdt0
Timeout 16,384 Cycles
Clock Division Ratio PCLK/8192
‘Window Start Position 100% (Window Position Not Specified)
Window End Position 0% (Window Position Not Specified)
Reset Control Reset Output
Stop Control WDT Count Disabled in Low Power Mode
KIMAL Pl M

Figure 97: Module Properties

All parameters can be left with their default values.

[34 Pin Conflicts =# MCU Package [Z) Console | [T Properties 7 | 4% Debug

g wdt0 Watchdog Driver on r wdt

Settings Property Value

w Common
Parameter Checking Default (BSP)
Register Start NM| Support Disabled

v Module g_wdtd Watchdog Driver on r_wdt
Mame g_wdth
Timeout 16,384 Cycles
Clock Division Ratio PCLK/81532
Window Start Position 100% (Window Position Mot Specified)
Window End Position 0% (Window Position Mot Specified)
Reset Control Reset Qutput
Stop Control 'WOT Count Disabled in Low Power Mode
NMI Callback NULL

Figure 98: g wdt WATCHDOG Driver on WDT properties

With PCLKB running at 60 MHz the WDT will reset the device 2.23 seconds after the last refresh.

WDT clock = 60 MHz / 8192 = 7.32 kHz
Cycle time =1/ 7.324 kHz = 136.53 us
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Timeout = 136.53 us x 16384 = 2.23 seconds

Save the Project Configuration file and click the Generate Project Content button in the top
right corner of the Project Configuration pane.

& [WDT_Application] FSP Canfiguration &£ =

m]
Stacks Configuration e
9 Generate Project Content
Threads = HAL/Common Stacks 4] New Stack >
i¥ HAL/Common = -
Ve e U_ [t 1/0 Port Dri . " L4 g_ioport I/O Port @ g_wdt0 Watchdog
g foport /O Po rlv-er onr_lopo Driver on r_ioport Driver on r_wdt
# g_wdt0 Watchdog Driver on r_wdt
©) ©)

Objects

Summary | BSP | Clocks | Pins |Interrupts | Event Links Stacks Components

Figure 99: Generate Project Content button

e? studio generates the project files.

3.4.4.7 Components Tab

The components tab is included for reference to see which modules are included in the project.
Modules are selected automatically in the Components view after they are added in the Stacks Tab.

For the WDT project ensure that the following modules are selected:

1. HAL Drivers -> r_ioport
2. HAL_Drivers -> r_wdt
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Note

3.4.5 WDT Generated Project Files

& [WDT_Application] FSP Configuration 2

Components Configuration

Component Version
@ rcu
[ r_jic_master
[T riic_slave
r_ioport
O r_iwdt
v jpeg
[ r_kint
O ripm
T r vd
O r opamp
O r_ospi
O r_pde
O r_poeg
O r_gspi
[T rrte
[T r_sce_ra?
[ r_sce_rad
[T r sce rab
O r_sce9_rab_plaintext
[T r_sce9_ra6_wrapped
[T r_sci_i2c
O r_sci_spi
[T r_sci_uart
[T r_sdadc
[ r_sdhi
[T r_sledc
O r_spi
O r_ssi
[T r_usb_basic
[7] r_usb_hedc
[ r_usb_hhid
[T r_usb_hmsc
2 r_usb_pcde
O r_usb_phid
O r_usb_pmsc
r_wdt
O rm_psa_crypto
[T rm_wifi_onchip_silex
% Heaps
% Libraries

swummary | BSP |Clocks Pins | Interrupts Event Links |Stacks Components

[

Generate Project Contt

~ || Search.

Description Variant

Filter |All

External Interrupt

12C Master Interface

12C Slave Interface

1/0 Port

Independent Watchdog Timer

JPEG Codec

Key Input

Low Power Modes

Low Voltage Detection

Operational Amplifier

Octa Serial Peripheral Interface Flash

Parallel Data Capture

Port Output Enable for GPT

Quad Serial Peripheral Interface Flash

Real Time Clock

Secure Cryptography Engine on RA2

Secure Cryptography Engine on RA4

Secure Cryptography Engine on RAS

Secure Cryptography Engine9 on RAG6 Plaintext
Secure Cryptography Engine9 on RA6 Wrapped
SCII2C Master Interface

Serial Peripheral Interface on Serial Communications Interf...
SCI UART

Sigma Delta A/D Converter

SD/MMC Host Interface

Segment LCD Controller/Driver

Serial Peripheral Interface

Serial Sound Interface

USB Basic

USB Host Communications Device Class

USB Host Human Interface Device Class

USB Host Mass Storage Class

USB Peripheral Communications Device Class
USB Peripheral Human Interface Device Class
USB Peripheral Mass Storage Class
Watchdog Timer

MbedCrypto H/W Acceleration

WiFi Onchip Silex

Figure 100: Component Selection

Thelist of modules displayed in the Components tab depends on the installed FSP version.

Clicking the Generate Project Content button performs the following tasks.

e r_wdt folder and WDT driver contents created at:

ra/fsp/src
e r_wdt_api.h created in:

ra/fsp/inc/api
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e r_wdt.h created in:
ra/fsp/inc/instances
The above files are the standard files for the WDT HAL module. They contain no specific project
contents. They are the driver files for the WDT. Further information on the contents of these files can
be found in the documentation for the WDT HAL module.
Configuration information for the WDT HAL module in the WDT project is found in:

ra_cfg/fsp_cfg/r_wdt_cfg.h

The above file's contents are based upon the Common settings in the g_wdt WATCHDOG Driver
on WDT Properties pane.

[ Properties 54 | [2] Problems @ Smart Browser

g wdt0 Watchdog Driver on r_wdt

Settings  Froperty T {5} [WDT_Application] RA Configuration | [B] r_wdt_cfgh 52
APlinia | ~ Common . 1 |* generated configuration header file - de not edit */
Parameter Checking Default (BSP) kel BT Cre
Register Start NMI Suppart Disabled \ #define R_WDT_CFG_H_
~ Module g_wdtd Watchdog Driver on r_wdt #define WDT_CFG_PARAM CHECKING ENABLE (BSP_CFG_PARAM CHECKING ENABLE)
Name g_wdtD » #def?ne .\‘JDT_Cfg
Timeout 16,284 Cycles g endirlz sk DRIcke
Clock Division Ratie PCLK/8192
Window Start Pasition 100% (Window Position Not Specified]
Window End Pasition 0% (Window Position Not Specified)
Reset Control Reset Output
Stap Control WDT Count Disabled in Low Power Mode
NMI Callback NULL

Figure 101: r_wdt_cfg.h contents

Warning
Do not edit any of these files as they are recreated every time the Generate Project Content
button is clicked and so any changes will be overwritten.

The r_ioport folder is not created at ra/fsp/src as this module is required by the BSP and so already
exists. It is included in the WDT project in order to include the correct header file in
ra_gen/hal_data.c-see later in this document for further details. For the same reason the other
IOPORT header files- ra/fsp/inc/api/r_ioport_api.handra/fsp/inc/instances/r_ioport.h-are not created as
they already exist.

In addition to generating the HAL driver files for the WDT and IOPORT files e2 studio also generates
files containing configuration data for the WDT and a file where user code can safely be added.
These files are shown below.
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5 Project Explorer 52 ey s =
~ =% WDT_Application [Debug]

> &l Includes

~ Era
> = arm
> = board
> = fsp
 ra_gen
~ (2 sre

> [2 hal_entry.c
~ = ra_cfg

~ (= fsp_cfg

» & bsp
@ r_ioport_cfg.h

i

o

(= script

& configuration.xml
R7FABM3AH3CFC.pincfg

ra_cfg.txt

WOT_Application Debug_Flat.launch
» (@ Developer Assistance

Figure 102: WDT project files

3.4.5.1 WDT hal_data.h

The contents of hal_data.h are shown below.
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hal_data.h contains the header files required by the generated project. In addition this file includes
external references to the g_wdt0 instance structure which contains pointers to the configuration,
control, api structures used for WDT HAL driver.

Warning
This file is regenerated each time Generate Project Content is clicked and must not be
edited.

3.4.5.2 WDT hal_data.c

The contents of hal_data.c are shown below.
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hal_data.c contains g_wdtO_ctrl which is the control structure for this instance of the WDT HAL
driver. This structure should not be initialized as this is done by the driver when it is opened.

The contents of g wdt0 _cfg are populated in this file using the Watchdog Driver on g_wdt0 pane
in the Project Configuration Stacks tab. If the contents of this structure do not reflect the settings
made in the IDE, ensure the Project Configuration settings are saved before clicking the
Generate Project Content button.

Warning
This file is regenerated each time Generate Project Content is clicked and so should not be
edited.

3.4.5.3 WDT main.c

Contains main() called by the BSP start-up code. main() calls hal_entry() which contains user
developed code (see next file). Here are the contents of main.c.
/* generated main source file - do not edit*/
#i ncl ude "hal data.h"
int main (void)
{
hal _entry();

return O;

Warning
This file is regenerated each time Generate Project Content is clicked and so should not be
edited.

3.4.5.4 WDT hal_entry.c

This file contains the function hal_entry() called from main(). User developed code should be placed
in this file and function.

For the WDT project edit the contents of this file to contain the code below. This code implements
the flowchart in overview section of this document.

#i ncl ude "hal data. h"
#i ncl ude "bsp_pin_cfg.h"

#i ncl ude "r_ioport.h"
#define RED LED NO OF FLASHES 30

#define RED_LED PIN BSP_| O PORT_01_PI N 00
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The WDT HAL driver API functions are defined in r_wdt.h. The WDT HAL driver is opened through the
open API call using the instance structure defined in r_wdt_api.h:

/* Open the WDT */
R WDT_Open(&g_wdtO0_ctrl, & wdtO cfg);

The first passed parameter is the pointer to the control structure g wdtO_ctrl instantiated in
hal data.c. The second parameter is the pointer to the configuration data g wdto cfg instantiated in
the same hal_data.c file.

The WDT is started and refreshed through the API call:

/[* Start the WDT by refreshing it */
R WDOT Refresh(&g_wdtO_ctrl);

Again the first (and only in this case) parameter passed to this API is the pointer to the control
structure of this instance of the driver.

3.4.6 Building and Testing the Project

Build the project in e2 studio by clicking Build > Build Project or by clicking the build icon. The
project should build without errors.

To debug the project
1. Connect the USB cable between the target board debug port and host PC.

2. In the Project Explorer pane on the left side of e? studio, right-click on the WDT project
WDT_Application and select Debug As > Debug Configurations.

3. Under Renesas GDB Hardware Debugging select WDT_Application Debug as shown
below.
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Debug Configurations

User’s Manual

Create, manage, and run configurations . “%‘
IR Name: [ WDT_Application Debug
type filter text [E] Main %% Debugger| = Startup| ] Common £ Source
=
[&] C/C++ Application Project:
[c] C/C++ Remote Application
EASE Script ‘ WOT_Application Browse...
[£] GDB Hardware Debugging C/C++ Application:
[t] GDB OpenOCD Debugging
Debug/WDT_Application.elf
[ GDB Simulator Debugging (RH850) | Debug/WET_Applicetion
Java Applet Variables... Search Project... Browse...
Java Application Build (if required) before launching
@ Launch Group
= Launch Group (Deprecated) Build Configuration: |Use Active e
Remote Java Application
i E Renesas GDB Hardware Debugging (O Enable auto build (C) Disable aute build
[ WDT_Application Debug (®) Use workspace settings Configure Workspace Settings...
[£7] Renesas Simulator Debugging (RX, RL72)
< >
Revert Apply
Filter matched 14 of 16 items -
@

Figure 103: Debug configuration

4. Click the Debug button. Click Yes to the debug perspective if asked.

Progress Information m] X

Extracting RA Debug

Configuring GDB

Details > >

Cancel

5. The code should run the Reset_Handler() function.

6. Resume execution via Run > Resume. Execution will stop in main() at the call to
hal_entry().
7. Resume execution again.

The red LED should start flashing. After 30 flashes the green LED will start flashing and the red LED
will stop flashing.

While the green LED is flashing the WDT will underflow and reset the device resulting in the red LED
to flash again as the sequence repeats.

1. Stop the debugger in e? studio via Run > Terminate.
2. Click the reset button on the target board. The LEDs begin flashing.

3.5 Primer: Arm TrustZone Project Development

This section will introduce the user to the tools supporting Arm® TrustZone® technology
configuration for the RA Family of microcontrollers. It is intended to be read by development
engineers implementing RA Arm TrustZone projects for the first time. It will introduce basic concepts
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followed by workflow and tooling functions designed to simplify and accelerate their first Arm
TrustZone development. A background knowledge of e? studio and RA device hardware is expected.

3.5.1 Target Device
RA Cortex®-M33 and Cortex®-M85 devices with Arm TrustZone security extension. As shown in the

following table, most RA devices that include TrustZone support also support Device Lifecycle
Management (DLM).

MCU Groups with TrustZone MCU Groups with TrustZone MCU Groups with TrustZone
and DLM and no DLM and Alternate DLM

RA4E1, RA4AM2, RA4M3, RAGEL, | RA4E2, RA4T1, RAGE2, RA6T3 RASM1
RA6M4, RA6M5, RA6GT2

3.5.2 Renesas Implementation of Arm TrustZone Technology

The following section is supplied for reference only. For full details of TrustZone implementation,
refer to Arm documentation (https://developer.arm.com/ip-products/security-ip/trustzone) and the
MCU user manual.

Arm TrustZone technology divides the MCU and therefore the application into Secure and Non-
Secure partitions. Secure applications can access both Secure and Non-Secure memory and
resources. Non-Secure code can access Non-Secure memory and resources as well as Secure
resources through a set of so-called veneers located in the Non-Secure Callable (NSC) region. This
ensures a single access point for Secure code when called from the Non-Secure partition. The MCU
starts up in the Secure partition by default. The security state of the CPU can be either Secure or Non-
Secure.

The MCU code flash, data flash, and SRAM are divided into Secure (S) and Non-Secure (NS) regions.
Code flash and SRAM include a further region known as Non-Secure Callable (NSC). The method to
set these memory security attributes depends on whether the device supports DLM:

e For devices that support DLM, memory security attributes are set into the non-volatile
memory through SCI or USB boot mode commands when the device lifecycle is Secure
Software Debug (SSD) state. The memory security attributes are loaded into the
Implementation Defined Attribution Unit (IDAU) peripheral and the memory controller
before application execution and cannot be updated by application code.

e For devices that do not support DLM, memory security attributes are written to IDAU
registers at startup by application code using secure accesses.
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Code Flash Data Flash

Non-Secure

Non-Secure Non-Secure

Non-Secure callable Non-Secure callable

Secure

Secure

Secure

0x0000_0000 0x0800_0000 0x2000_0000

Figure 104: Secure and Non-Secure Regions

Note: All external memory accesses are considered to be Non-Secure.

Code Flash and SRAM can be divided into Secure, Non-Secure, and Non-Secure Callable. All secure
memory accesses from the Non-Secure region MUST go through the Non-Secure Callable gateway
and target a specific Secure Gateway (SG) assembler instruction. This forces access to Secure APIs
at a fixed location and prevents calls to sub-functions and so on. Failing to target an SG instruction
will generate a TrustZone exception.

TrustZone enabled compilers will manage generation of the NSC veneer automatically using CMSE
extensions.

3.5.2.1 Calling from Non-Secure to Secure

A new instruction SG (Secure Gateway) has been added to the Armv8-M architecture. This MUST be
the destination instruction for any branch within the Non-Secure Callable region. If an attempt is
made to branch to any other instruction from the Non-Secure partition, a TrustZone exception will be
thrown.

Non Secure Non Secure Callable Secure
NSC
Func_A_Entry
Func_A_Entry SG, Valid entry Func_A
p I Y BFUNC_A e ..; Function
BXNS LR

Figure 105: Calling from Non-Secure to Secure Functions

3.5.2.2 Calling from Secure to Non-Secure

Secure code uses B(L)XNS instructions to make direct calls to Non-Secure functions. While this is
certainly possible, it can create a security vulnerability in the application. It is also challenging for
the Secure application to determine the address of the non-secure function during build phase. From
the RA Tools and FSP point view, calling directly from Secure to Non-Secure via FSP API is not
supported.
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Preference is for the Secure code to initialise as necessary from reset, then pass control to the Non-
Secure partition. It will manage any data transfers and so forth via FSP call-backs as security checks.
For example, secure data can be copied to Non-Secure RAM.

Non Secure Secure

BLXNS RO

t

\_

Figure 106: Calling from Secure to Non-Secure Functions

3.5.3 Workflow

Arm TrustZone MCU development normally consists of two projects within a workspace, Secure and
Non-Secure. General project workflows are described in the following sections. The Renesas project
generator also supports development with "Flat project" model with no Arm TrustZone awareness.

3.5.3.1 Secure Project

1. Start a new Secure project in e? studio.
2. Select and configure pins and drivers/stacks that need to be initialized and used in Secure
mode. This should be kept to a minimum to reduce the security attack surface.
3. Expose top of stacks as Non-Secure Callable (NSC) if they need to be accessed from Non-
Secure partition. Again, this should be kept to a minimum.
4. Generate project content and write Secure code such as key handling and opening drives as
needed.
. Modify/remove any unnecessary "Guard" functions as needed to control access via NSC.
. Build project.
. A Non-Secure project will be needed before debugging. If necessary, prepare a "dummy"
Non-Secure project or replace R_BSP_NonSecureEnter(); with while(1); in hal_entry.c.

~N O U

3.5.3.2 Non-Secure Project

1. Start a new Non-Secure project.

2. If you have access to the Secure project, choose this option. However, if you only have
access to a device with pre-programmed Secure code (commonly referred to as provisioned
device) choose "Secure Bundle".

3. Select and configure pins and drivers/stacks that need to be initialized and used in Non-

Secure mode.

. Note that you can add NSC drivers and stacks as needed.

. Generate project content and write Non-Secure code as needed

. Access NSC drivers and Stacks via Guard functions.

. Build and debug project.

N O Ul b

3.5.3.3 Flat Project

A flat project does not technically use Arm TrustZone as the developer has made a decision to place
the entire application in Secure partition from restart.

Notes:

e Any code placed in external memory (such as OSPI or QSPI) will be Non-Secure.
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* The Ethernet EDMAC is designed to be a Non-Secure bus master so associated Ethernet
RAM buffers will be placed in Non-Secure RAM. The tooling will automatically manage this.

The workflow is as follows:

1. Start a new Flat project.

2. Select and configure pins and drivers/stacks as needed.
3. Generate project content and write code as needed.

4. Build and debug project.

3.5.4 RA Project Generator (PG)

The RA project generators have been created to help users through setting up new TrustZone
enabled projects. User will be prompted for project settings such as Project Type (Secure, Non-
Secure, or Flat), compiler, RTOS and debugger. Care is needed when setting up a TrustZone project
to ensure that the connection between Secure and Non-Secure partitions are managed correctly.

8} Renesas RA C/C++ Project O X

Renesas RA C/C++ Project —
Project Type Selection

Project Type Selection

() Fiat (Non-TrustZone) Project

® Renesas RA device project without TrustZone
separation

* All code, data and peripheral settings will be
configured in this project

* Renesas RA device will remain in secure mode

& EDMAC RAM buffers will automatically be placed
in non-secure RAM

(®) TrustZone Secure Project

& Renesas RA device project for TrustZone secure
execution M

& All code, data and peripherals placed in this project
will be initialized as secure

& Secure project settings such as TrustZone
partitions, linker maps and a list of secure
peripherals will be passed to a selected nen-secure
project

& After initialization, a call to the non-secure startup
handler will be made

-

(O TrustZone Non-secure Project

* Renesas RA device project for TrustZone non-
secure execution

* All code, data and peripherals placed in this project
will be initialized as non-secure

* Must be associated with a secure project or secure
bundle

* Mon-secure startup handler will be called after
secure code initialization

‘/?:' < Back Next > Einish Cancel

Figure 107: Secure Project (following Arm notation as green)
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User’s Manual

(B Renesas RA C/C++ Project O x
Renesas RA C/C++ Project —
Project Type Selection |

Project Type Selection

() Flat (Non-TrustZone) Project

® Renesas RA device project without TrustZone
separation

® All code, data and peripheral settings will be
configured in this project

* Renesas RA device will remain in secure mode

® EDMAC RAM buffers will automatically be placed
in non-secure RAM

(O TrustZone Secure Project

* Renesas RA device project for TrustZone secure
execution

* All code, data and peripherals placed in this project
will be initialized as secure

* Secure project settings such as TrustZone
partitions, linker maps and a list of secure
peripherals will be passed to a selected non-secure
project

= After initialization, a call to the non-secure startup
handler will be made

(@ TrustZone Non-secure Project

* Renesas RA device project for TrustZone non-
secure execution

* All code, data and peripherals placed in this project
will be initialized as non-secure

* Must be associated with a secure project or secure
bundle

* Non-secure startup handler will be called after
secure code initialization

< Back Next > Finish Cancel

Figure 108: Non-Secure Project (following Arm notation as

&) Renesas RA C/C++ Project u] X

Renesas RA C/C++ Project —

Project Type Selection

Project Type Selection

®) Flat (Non-TrustZone) Project

& Renesas RA device project without TrustZone
separation

& All code, data and peripheral settings will be
cenfigured in this project

® Renesas RA device will remain in secure mode

& EDMAC RAM buffers will automatically be placed
in non-secure RAM

(O TrustZone Secure Project

* Renesas RA device project for TrustZone secure
execution

* All code, data and peripherals placed in this project
will be initialized as secure

* Secure project settings such as TrustZone
partitions, linker maps and a list of secure
peripherals will be passed to a selected non-secure
project

® After initialization, a call to the non-secure startup
handler will be made

() TrustZone Non-secure Project

® Renesas RA device project for TrustZone non-
secure execution

* All code, data and peripherals placed in this project
will be initialized as non-secure

® Must be associated with a secure project or secure
bundle

® Mon-secure startup handler will be called after
secure code initialization

<Back [ Neds Finish Cancel

Figure 109: Flat Project

3.5.4.1 Secure Project Set Up

red)

All code, data, and peripherals in this project will be configured as Secure using the device Peripheral
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Security Attribution (PSA) registers. Although it is very application specific, we recommend keeping
the Secure project code as small as possible to reduce the attack surface. For example, secure key
handling may be the only application code in the secure project.

Necessary values to set up the TrustZone memory partition (IDAU registers) will be automatically
calculated after the project is built to ensure they match the code and data size, keeping the attack
surface as small as possible.

Typically, ANSI C start up code (clearing of RAM, variable initialisation, etc) , clock, and secure
peripheral initialisation will occur in this project.

At the end of the Secure code, a call will be made to R_BSP_NonSecureEnter(); to pass control to the
Non-Secure partition.

Non-Secure Callable (NSC) "Guard" functions are added to the project and expose selected modules
to Non-Secure projects. User can add application-specific access checks as needed in these
functions.

Output of this project type will be an elf file that must be either pre-programmed (provisioned) into a
device or referenced by a Non-Secure project (via Secure bundle *.SBD) to build a final image.

This project type will NOT typically be debugged in isolation and will normally require a Non-Secure
project such as a call to a R_BSP_NonSecureEnter() to be made. This can be replaced with while(1); if
needed.

3.5.4.2 RTOS Support in TrustZone Project

Although the RTOS kernel and user tasks will reside in the Non-Secure partition, the Secure partition
needs to allocate stack space and so on. It is essential when starting a new RTOS project that the
TrustZone Secure RTOS-Minimal template is selected. This will add the Arm TrustZone Context RA
Port as below.
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Q Renesas RA C/C++ Project O X
Renesas RA C/C++ Project =
|
Project Template Selection
Project Template Selection

o (} Bare Metal - Minimal

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.

®© (:} TrustZone Secure - Minimal project with support for Non-secure RTOS
- Empty TrustZone Secure project with Non-secure callable RTOS context functions that will allow threads in a Non-secure application
to call Secure services. This is not support for using an RTOS in a Secure project. Without these RTOS context functions, there could be
issues if a context switch occurs while a thread in the Non-secure application is executing a Secure service. This will support any RTOS
as long as the RTOS uses the CMSIS TrustZone Context Management AP This project will initialize the MCU using the BSP.

Code Generation Settings
Use Renesas Code Formatter

'/'_7)‘ < Back Next > Cancel

HAL/Common Stacks 4| New Stack >
& g_ioport I/O Port 4 ARM TrustZone
(r_ioport) Context RA Port

(rm_tz_context)

@ @

Figure 110: Secure RTOS-Minimal Template

3.5.4.3 Peripheral Security Attribution

Each peripheral can be configured to be Secure or Non-Secure. Peripherals are divided into two
types.

Type-1 peripherals have one security attribute. Access to all registers is controlled by one security
attribute. The Type-1 peripheral security attribute is set in the PSARx (x = B to E) register by the
secure application.

Type-2 peripherals have the security attribute for each register or for each bit. Access to each
register or bit field is controlled according to these security attributes. The Type-2 peripheral security
attribute is set in the Security Attribution register in each module by the Secure application. For
more information about the Security Attribution register, see sections in the Appropriate MCU's
User's Manual for each peripheral.

Table 1. Secure and Non-Secure Peripherals
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Type Peripheral

Type 1 SCI, SPI, USBFS, CAN, IIC, SCE9, DOC, SDHI,
SSIE, CTSU, CRC, CAC, TSN, ADC12, DAC12,
POEG, AGT, GPT, RTC, IWDT, WDT

Type 2 System control (Resets, LVD, Clock Generation
Circuit, Low Power Modes, Battery Backup
Function), FLASH CACHE, SRAM controller, CPU
CACHE, DMAC, DTC, ICU, MPU, BUS, Security
setting, ELC, 1/O ports

Always Non-Secure CS Area Controller, QSPI, OSPI, ETHERC, EDMAC

FSP will initialise the arbitration registers during Secure project BSP start up. User code may also be
written to set or clear further arbitration. However care must be taken not to undermine FSP.

3.5.4.4 Non-Secure

All code, data, and peripherals in this project will be configured as Non-Secure. This project type
must be associated with a Secure project to enable access to secure code, peripherals, linker scripts
and others.

3.5.4.5 Flat Project Type

All code, data, and peripherals are configured in a Secure single partition except for the EDMAC RAM
buffers that will remain in the Non-Secure partition. Effectively, TrustZone is disabled.

3.5.4.6 Secure Connection to Non-Secure Project
When starting a new Non-Secure Project, the user will be prompted for either a Secure Project or
Secure Bundle. In each case, details of the linker settings, Non-Secure Callable functions, and Secure

peripherals will be read to enable the Non-Secure project setup.

Should the Secure project or bundle be rebuilt, the Non-Secure editor will detect this and prompt
user to regenerate the Non-Secure project configuration.

R11UMO155EU0420 Revision 5.20 RENESANAS Page 105 /5,010
Feb.28.2024



Flexible Software Package User’s Manual

Starting Development > Primer: Arm TrustZone Project Development > RA Project Generator (PG) > Secure Connection to Non-Secure Project

&) Renesas RA C/C++ Project u] X

Renesas RA C/C++ Project —
€3 No preceding project selected

(®) Preceding Project: ~

Choase this option if you have access to the preceding TrustZone Secure Project source code.
A debug configuration for Secure Software Debug (S5D) state will be generated and both
secure and non-secure images will be downloaded to the target device. Should you wish to test
Non-Secure Software Debug (NSECSD) state, use the Renesas Device Partition Manager to
change the Device Lifecycle state as needed.

() Smart Bundle:

Workspace... File System... Variables...

Preceding Project/Smart Bundle Details

FSP version
Toolchain
Toolchain version
Board

Device

Zones

@ < Back Next > Finish Cancel

Figure 111: Secure Project or Bundle Selection

Secure Project (Combined)

A Secure project must reside in the same Workspace as the Non-Secure project and will typically be
used when a design engineer has access to both the Secure and Non-Secure project sources. This is
sometimes known as "Combined model".

A Secure .elf file will be referenced and included in the debug configuration for download to the
target device. The development engineer will have visibility of Secure and Non-Secure project source
code and configuration.

Secure Bundle (Split)

A Secure Bundle will ONLY include linker memory ranges, symbol references, and details of locked
Secure peripheral configuration settings but no access to Secure source code (APl header files will be
included as necessary).

The Secure bundle file (*.SBD) must be supplied to the Non-Secure developer by the Secure project
developer.

The development engineer will typically not have access to the Secure project or .elf file which MUST
be pre-programmed or provisioned into the target MCU.

For devices that support DLM, the DLM state of the target device should then be switched to NSECSD
(see section 6.2) before the device is provided to the non-secure developer.

This is often referred to as "Split model" where a basic security set up is developed by a Secure team
and then passed to the Non-Secure team in the same facility or at a third party. The Non-Secure
team has no access to the Secure source code and cannot directly access Secure peripherals, data,
or APIs.
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3.5.4.7 Debug Configurations

After each project type has been selected, a suitable debug configuration will be generated.
Non-Secure with Secure Project (Combined)

Both Secure and Non-Secure .elf files will be downloaded.

A debug configuration called <project name>_SSD will be generated.

Non-Secure with Secure Bundile (Split)

Only a Non-Secure elf will be downloaded. This configuration must be used with a pre-provisioned
device (Secure project pre-programmed into MCU Flash).

A debug configuration called <project name>_NSECSD will be generated.
Flat Debug
A single .elf file will be downloaded.

A debug configuration called <project name>_FLAT will be generated.
3.5.5 Secure Projects

As mentioned, Secure code will be called immediately after device reset and run ANSI C start up,
clock, interrupt vector table, and secure peripheral initialization before starting user code. All
selected peripheral configuration settings will be automatically initialised as Secure.

3.5.5.1 Secure Clock

Device clock settings are the possible exception in that they will be initialised in the Secure project
(to enable faster start up from reset) but can be set as Secure or Non-Secure as user application may
need to change settings during execution (for low-power mode and so on). The Secure and Non-
Secure FSP BSPs can both change the clock settings.

However, clock settings can be locked as Secure should the developer choose to do so.

Restore Defaults

3) Secure |[

Div /1 Sets the clock circuit to be secure (override disabled

KA Div /2 « —s| PCLKA 100MHz

Figure 112: Secure Clock Setting

3.5.5.2 Setting Drivers as NSC

Some driver and middleware stacks in the Secure project may need to be accessed by the Non-
Secure partition. To enable generation of NSC veneers, set "Non-Secure Callable" from the right-click
context menu for the selected modules in the Configurator.
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Note: It is only possible to "expose" top of stacks as NSC.

4 g_uart) UART Driver on r_sci_uart
s
@ Team >
A
1 Resource Configurations >
5 Add DTC Driver for B Ac
Transmission R I Valits
[Recommended but re 1" Cut Ctrl+X
optionsl] 5] Copy Ctrl+C

Paste Crl+V
B Delete

+  Non-secure Callable

FpOIT...
iy Export...
(L) Module Resources...

QO Runas
45 DebugAs
Profile As
X Compare With
rminated 21 May 2020, 13:38:46) Replace With

B

T Secure_g_timerD
g
s |Timer Driver on r_gpt

j MNon-secure callable L—

Figure 113: Generate NSC Veneers

The top of the stack will be marked with a new icon and tool tip to signify NSC access.
3.5.5.3 Guard Functions

Access to NSC drivers from a Non-Secure project is possible through the Guard APIls. FSP will
automatically generate Guard functions for all the top of stack/driver APls added to the project as
Non-Secure Callable.

User can choose to add further levels of access control or delete guard function if they wish to only
expose a limited range of APIs to a Non-Secure developer.
BSP_CVSE_NONSECURE _ENTRY fsp_err_t g uartO_open_guar d(
uart _ctrl _t *const p_api_ctrl, uart_cfg_t const *const p_cfg) {

/* User can add security checks here */

FSP_PARAMETER NOT _USED(p_api _ctrl);

FSP_PARAVETER NOT_USED(p_cf g);

return R SClI UART Open(&g uartO ctrl, & uart0_cfQ);

For example, an SCI channel may be opened and configured for a desired baud rate by the Secure
developer, but only enable the Write API to the Non-Secure developer. In which case, all but
g_uart0_write_guard() could be deleted. CTRL structures are not required as they will be added on
the Secure side.
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For example, the call from the Non-Secure partition would be as follows:

err = g uartO_open_guard(O0, 0);

3.5.6 Non-Secure projects

Configuration of the project can continue as for other RA devices, but certain resources will be locked
if they have been previously set up as Secure.

The Non-Secure project will be called from the Secure project via R_BSP_NonSecureEnter();

3.5.6.1 Clock Set Up

You may recall that clocks can be set as Secure or Non-Secure. If they are set as Secure, settings will
only be available to view, and user will not be able to change them. The Override button will be

greyed. This is useful to preserve CGC sync with secure project by not overriding unless necessary. If
it is NOT set as Secure, user can choose to override the initial Secure settings

Gemerage Project Content

& Override

Hz

Figure 114: Clock Setting as Non-Secure

MHz | 2

00MHz |

OMHz |

Figure 115: Clock Setting as Secure

3.5.6.2 Selecting NSC Drivers

Drivers declared as NSC in a Secure project can be selected and added to Non-Secure project and
will be decorated as before.

@ g_uart0 UART Driver

on r_sci_uart
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4] New Stack >

Arm
Driver »
FreeRTOS
FreeRTOS+ »
Middleware

RTOS >

¥ Search..

Use Secure 3 "$ g uart0 UART Driver on r,sci_uart

Figure 116: Selecting NSC Drivers

3.5.6.3 Locked Resources

When a NSC Secure driver is added to a Non-Secure project, the configuration settings are locked

and are available for information only. A padlock is added for indication.

O] Properties 27
D_uano UART Driver on r_sci_uart

Settings  Propery
APlinfe |~ Commen

Parameter Checking

FIFO Support

DIC Support

RS232/RS485 Flow Control Support

~ Module g_uan) UART Driver on r_s¢i_uart

General

Baud

Flow Control

Extra

Interrupts

Value

Defaule (BSP)
Disable
Disable
Disable

Figure 117: Locked Resources

3.5.6.4 Locked Channels

In a peripheral with multiple channels, for example, DMA, if a Non-Secure developer tries to select a
channel that has already been defined as Secure, the following error message type will be displayed.

GENeTate

& | New Stack > =

rt gb g_transfer) Transfer
ort Driver on r_dmac No
ELC Trigger

PTOJECT COTEmNT

A stack element with a bar of this color indicates 'g_tra
This instance may be referenced by one other module

k:rcr: Peripheral 'DMA_DMACO

is secure l

Figure 118: Error Message when Selecting a Secure Channel

3.5.7 IDAU registers

Renesas RA TrustZone-enabled devices include a set of registers known as Implementation Defined
Attribution Unit (IDAU) that are used to set up partitions between Secure, Non-Secure Callable, and

Non-Secure regions.

For devices that use DLM, the IDAU registers can only be programmed during MCU boot mode and
NOT through the debug interfaces. Because of this, special debugger firmware has been developed
to manage bringing the device up in SCI boot mode to set up the IDAU registers (automatically
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drives MD pin) and then switch back to debug mode as needed.

Note: Please be aware of the extra signal connection (MD pin) needed on the debug interface
connector. The Renesas Evaluation Kit (EK) for your selected device is a good reference.

Pin No. SWD JTAG Serial Programming using
SCI

1 vcc vcc vcc

2 P108/SWDIO P108/TMS NC

4 P300/SWCLK P300/TCK P201/MD
Wired OR with MD Wired OR with MD

6 P109/SWO/TXD9 P109/TDO/TXD9 P109/TXD9

8 P110/RXD9 P110/TDL/RXD9 P110/RXD9

9 GNDdetect GNDdetect GNDdetect

10 nRESET nRESET nRESET

12 P214/TRACECLK P214/TRACECLK NC

14 P211/TRACEDATA[0] P211/TRACEDATA[0] NC

16 P210/TRACEDATA[1] P210/TRACEDATAJ1] NC

18 P2Z09/TRACEDATA[2] P209/TRACEDATA[2] NC

20 P208/TRACEDATA[3] P208/TRACEDATA[3] NC

3.5,15.17. GND GND GND

19

7 NC NC NC

11,13 NC NC NC

The e? studio build phase automatically extracts the IDAU partition register settings from the Secure
.elf file and programs them into the device during debug connection, which can be observed in the
console.

This is an important phase of TrustZone development as the Secure partitions should be set as small
as possible to ensure that the security attack surface is as small as possible.

However, should the developer wish to make these partitions larger to accommodate, for example
during field firmware updates, const or data arrays should be placed in the Secure project as
needed.

2 Console 2
New_PC_Non_Secure Debug_SSD [Renesas GDB Hardware Debugging]

[*] Problems G Debugger Console @ Smart Brows

Starting server with the following options:
Raw options : C:\Users\b3sea2se\

Connecting to E2, ARM target
GDBServer endian : little
Target power :on
Starting target connection

Current status of the RA TrustZone device

DLM state : 550

Debug level : 2

IDAU memory regions
Code Flash Secure size (kB)
Code Flash NSC size (kB)
Data Flash Secure size (kB)
SRAM Secure size (k8)
SRAM NSC size (kB)

LN NEN- ]
A

Figure 119: RA TrustZone Device Current Status

It is also possible to manually set up the partition registers through the Renesas Device Partition
Manager.
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ws  Run  Window Help

re d| Renesas Device Partition Manager I

= ] Tracex
b &) Tracealyzer

Device Family: | Renesas RA. |

Action

[ Read current device i

[ Set TrustZone secure / nen-secure boundaries | [] Intislize device back to factory default

Target MCU connection: | J-Link v]

Serial Mo:

Debugger supply voltage (V): 0

Baud rate:

DLM state to change to: SSD - Secure Software Development

Mermory panition sizes
Code Flash Secure (KE): [ 5
Code Flash NSC (KB | 27
Data Flash Secure (KB): |0
SRAM Secure (KB |2

SRAM NSC (KB): 8

Command line tool

Figure 120: Renesas Device Partition Manager

Close

[JChange device lifecycle management state

In e2 studio, when manually setting partitions, make sure to disable setting partitions in the debug
configuration to prevent the settings from being overridden when a debug session is launched.

3.5.7.1 SCI Boot Mode

GDB Settings  Connection Settings  Debug Tool Settings

Identifier
Tunnel Server
Port Number
Password
v Interface
Type SWD
Speed (kHz) 4000
~ ITAG Scan Chain
Multiple Devices No
IRPre 0
DRPre 0
v Connection
Register initialization No
Reset at the beginning of connection Yes
Reset at the end of connection No
Reset before download Yes
Reset after download Yes
ID Code (Bytes) FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFE
Hold reset during connect Yes
Set CPSR(3bit) after download Mo
Prevent Releasing the Reset of the CM3 Core Yes
Secure Vector Address
Men-secure Vector Address
Hot Plug No
Disconnection Mede Stop
w SWV
Core clock (MHz) o
w TrustZone

Set TrustZone secure/non-secure boundaries

€ € € €«

€ i

Authenticate device to Authentication Level (AL)|Yes
Authentication key
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Example of MD mode pin connection to debugger connector (from EK schematic).

v
TTTTTIAG T 1 e o112 JTAG/SWDIO
i HIAG : 3 ) TTAGSWCLE
| GNDDETECT | TIAGITE0
! ] TTAG/TDI
E0, [
Jumsper Tr: t . &
_________________
]
130
POSTDATAS TDATAZ
POSTDATAY TOATA2
PALOTDATAL TDATAL
P21UTDATAD TDATAD
PUSTCLE TOK
ne
PLIOTDI O 1 2
3 3
PLOSTDO ToOi/swo) [ 5 []
]
PLOS/SWDIO ™S
NRPNG4IPAEN-RC
PIOOSWCLE TCX
15
P2OLMD 1 3
1

Figure 121: Example of MD Mode Pin Connection to Debugger Connector (from EK schematic

3.5.7.2 DLM States

Device lifecycle defines the current phase of the device and controls the capabilities of the debug
interface, the serial programming interface and Renesas test mode. The following illustration shows
the lifecycle definitions and capability in each lifecycle.

‘—Pf K }'(:—_t::/NSECSD\{ Y DPL\ > \

—»{ RMA_REQ —»{ RMA_ACK

-
N S\ T\

— Transition with authentication

N

I —— Transition without authentication

N

Figure 122: Lifecycle Stages

--— 3 All erase

\/

Note: All authentication key exchange and transitioning to LCK_DBG, LCK_BOOT, RMA_REQ is only

managed by Renesas Flash Programmer (RFP) or other production programming tools, and NOT
within e? studio.
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Lifecycle Definition Debug level Serial programming Test mode
& “Chip Manufacturing” _— Available, cannot access Not available
The state when the customer received the device. code/data flash
Available
“Secure Software Development” X
SSD The secure part of anplication is being developad DBG2 can program/erase/read all |Not available
1 .
P PP e P code/data flash area
“Non-SECure Software Development” Available
NSECSD The non-secure part of application is being DBG1 can program/erase/read all |Not available
developed. code/data flash area
Available
“DePLoyed” ! X
DPL o DBGO cannot access code/data flash | Not available
The device is in-field.
area
“LoCKed DeBuG” Available
LCK_DBG . ) . DBGO cannot access code/data flash | Not available
- The debug interface is permanently disabled. area
“LoCKed BOOT interface”
LCK_BOOT The debug interface and the serial DBGO Not available Not available
programming interface are permanently disabled.
“Return Material Authorization REQuest” Available
RMA_REQ| Requestfor RMA. The customer must send the DBGO cannot access code/data flash | Not available
device to Renesas in this state. area
. Available
“Return Material Authorization ACKnowledged” N
RMA_ACK R L DBG2 cannot access code/data flash| Available
Failure analysis in Renesas area

Figure 123: Lifecycle Stages and Debug Levels

There are three debug access levels. The debug access level changes according to the lifecycle

state.

» DBG2: The debugger connection is allowed, and no restriction to access memories and

peripherals

* DBG1: The debugger connection is allowed, and restricted to access only Non-Secure
memory regions and peripherals
e DBGO: The debugger connection is not allowed

State transitions can be performed using the Renesas Flash Programmer (RFP, see section below) or
using the Renesas Device Partition Manager (limited number of states possible). It is possible to
secure transitions between states using authentication keys. For more information on DLM states
and transitions (device specific), please refer to device user manual.

3.5.7.3 Devices with Alternate DLM States

Some devices have an alternate implementation of Device Lifecycle Management (See Target Device
). While the concept is the same, the DLM states are a little different. The following illustration shows
the lifecycle definitions and capability in each lifecycle.
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Authentication using RMA_KEY is required Authentication using RMA_ACK_KEY is required
Transition is not possible when AL2_KEY is disabled RMA_ACK_KEY is Renesas specific key
( cMm s OEM \ » RMAREQ ——»( RMAACK +—»( RMARET \
I\ Transition is possible unless disabled
[ texkBoar |

Figure 124: Lifecycle Stages

Note: All authentication key exchange and transitioning to LCK BOOT, and RMA_REQ is only
managed by Renesas Flash Programmer (RFP) or other production programming tools, and NOT
within e? studio.

Renesas test
Lifecycle Definition Protection level | Debug function Serial programming mode
CM “Chip Manufacturing” PL2 Available in the Available Not available
The device is out of Renesas factory. secure and non- Cannot access code/data
Th|e customer receives the device in this secure debug flash area
state.
OEM “Original Equipment Manufacturer” PL2 or PL1 or Depend on the authentication level Not available
The device is owned by the customer. PLO
LCK_BOOT | “LoCKed BOOT interface” PLO Not available Not available Not available

The debug interface and the serial
programming interface are permanently

disabled.

RMA_REQ |“Return Material Authorization REQuest™ | PLO Not available Available Not available
Request for RMA. The customer must Cannot access code/data
send the device to Renesas in this state. flash area

RMA_ACK | “Return Material Authorization PL2 Available in the Available Available
ACKnowledged” secure and non- Cannot access code/data
Failure analysis in Renesas secure debug flash area

RMA_RET | “Return Material Authorization RETurn” | PLO Not available Not available Not available

The device is back to the customer. The
device does not boot.

Figure 125: Lifecycle Stages and Debug Levels

There are three authentication levels. The available authentication levels change according to the
lifecycle state and determine the memory and resources that are accessible by the debugger.

e AL2: The debugger connection is allowed, and no restriction to access memories and
peripherals

e AL1: The debugger connection is allowed, and restricted to access only Non-Secure memory
regions and peripherals

e ALO: The debugger connection is not allowed
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State transitions can be performed using the Renesas Flash Programmer (RFP, see section below) or
using the Renesas Device Partition Manager (limited number of states possible). It is possible to
secure transitions between states using authentication keys. For more information on DLM states
and transitions (device specific), please refer to device user manual.

In addition to having different DLM States, these devices also handle memory partitioning differently.
Code Flash and Data Flash partitions are divided into secure and non-secure regions using SCI or
USB boot mode commands. All other memory regions are set in IDAU and SAU registers in the secure
application during the BSP startup procedure. All memory regions and peripherals that are
configured as non-secure must be accessed using an aliased non-secure address. This non-secure
address is calcualted by setting bit 28 in the address.

3.5.7.4 Devices without DLM
For devices that do not have DLM, the IDAU registers are programmed by secure application code at

startup. Devices without DLM do not support IDAU register programming using boot mode
commands.

3.5.8 Debug

By default, devices supporting DLM will be in SSD mode and so allow access to Secure and Non-
Secure partitions. In this mode both Secure and Non-Secure .elf files will be downloaded.

The current debugger status is displayed in the lower left corner and includes the DLM state (SSD or

NSECSD) and current partition (Secure, Non-Secure, or Non-Secure Callable) when the debugger is
stopped, for example.

Figure 126: Current Debugger Status

3.5.8.1 Non-Secure Debug
Once the device is transitioned to NSECSD mode, only Non-Secure Flash, RAM and Peripherals can

be accessed. In this mode, a Secure .elf must be pre-programmed (provisioned) into the device, and
only a Non-Secure .elf file will be downloaded.

In NSECSD mode, it is not possible to set breakpoints on Secure code or data.

It is not possible to step into Secure code; the debugger will perform a step-over of any Secure
function calls. Should the user press the Suspend button during execution, the debugger will stop at
the next Non-Secure code access.

Assuming Secure memory region finishes at 32K (0x8000) in NSECSD debug mode (colour coding
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added for indication only), memory will be displayed as shown in the following figure.

0xB000 : 08000 <Hex Integer> £3 . o New Renderings...

Address e -3 4 -7 E-8 C-F
2002000000007FD2 4
B20000RRRR0RTFER

BE0EAARARRATFFA

[ZEEEEEEAEEEE ) 28602498

Disassembly will be displayed as shown in the following figure.

22 Disassembly 2 w3000 ~||

Cannot access memory at address @x7ffc
eeee7ffd: Failed to execute MI command:
-data-disassemble -s 32765 -e 32797 -- 3
Error message from debugger back end:
Cannot access memory at address @x7ffc
eeee7ffe: Failed to execute MI command:
-data-disassemble -5 32766 -e 32798 -- 3
Error message from debugger back end:
Cannot access memory at address @x7ffe
@eee7fff:  Failed to execute MI command:
~data-disassemble -s 32767 -e 32799 -- 3
Error message from debugger back end:
Cannot access memory at address @x7ffe

movs  r4, %152 ; ex9s
movs re, %0

ldrh 1, [r7, #12]

movs @, ro

ldrh rs, [ra, #a]

Figure 128: Disassembly Display in NSECSD Debug Mode

3.5.9 Debugger support
Renesas E2, E2 Lite, and SEGGER J-Link are supported in e? studio for TrustZone projects.

Debugger Support for TrustZone Projects

Feature E2 Lite E2 J-Link J-Link OB ULINK IAR |-jet

JTAG Yes Yes Yes No Yes Yes

SWD Yes Yes Yes Yes Yes Yes

ETB trace Yes Yes Yes Yes Yes Yes
ETM trace No Yes Yes No Yes Yes
TrustZone Yes Yes Yes Yes No Yes
partition

programmin

9

Non secure |Yes Yes Yes Yes No Yes

debug

e? studio Yes Yes Yes Yes No No
IAR EW Arm | Yes Yes Yes Yes No Yes
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Keil MDK Under Under Yes Yes Yes No
consideratio | consideratio
n n

3.5.10 Third-Party IDEs

Third-party IDEs such as IAR Systems EWARM and Keil MDK (uVision) are supported by the RA Smart
Configurator (RASC).

In general, RASC offers the same configurator functionality as e? studio documented above. Project
generators are available to initialise workspaces in the target IDEs as well as setting up debug
configurations and so forth. However, there are some limitations that need to be noted especially

with regards to IDAU TrustZone partition register programming. See the specific RASC
documentation for usage details.

3.5.11 Renesas Flash Programmer (RFP)

Updated versions of Renesas Flash Programmer (RFP) are available to support setting of partitions,
DLM state and Authentication keys.

RFP can be downloaded free of charge on the Renesas web site.

A new mode has been added to Program Flash Options as shown in the following graphics.

16 Fiemesas Flash Programener EL0T000-RA (Prsliminary Version) - X
Eie  DevceInformation  bielp
Opertion [ Doseaton Satings | Bock Setrgs Rash Opticrs Correct Setrgs Uique Code. Uses Keys
Command Erase Qyptons
O e Erase Selected Bocks
O Eregam

h.

T Oty

Program & Veety Optiona
] Ermse Bfone Program

Chechaum Type

7] Cade Flash / User Bost Eox Settrgs
[ Dga Rash ] Eratin sioons chock of program e

(RO p—

Figure 129: RFP Program Flash Options

Options to set partition boundaries are shown in the following figure.

Figure 130: RFP Partition Boundaries
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Options to set DLM state, Authentication keys, and Security settings are shown in the following
figure.

&

File  Device Information  Help

Operaticn Oparaion Settrngs_Bock Setings Fash Optiors Comect Semngs  Uigue Code  User Keys.

Figure 131: RFP DLM State, Authentication Keys, and Security Settings

Great care is needed here as some DLM states can **permanently** turn off debug and boot mode
on the devices. Equally programming a security access authentication key can lead to permanently
locked devices if the key is lost.

3.5.12 Glossary

IDAU

Implementation Defined Attribute Unit. Used to program TrustZone partitions.
NSECSD

Non-Secure Software Development mode

SSD

Secure Software Development mode

NSC

Non-Secure Callable. Special Secure memory region used for Veneer to allow access to Secure APIs
from Non-Secure code.

Provisioned
Device with Secure code pre-programmed and DLM state set to NSECSD
Flat project

All code, data and peripherals are configured as secure with the exception of the EDMAC RAM buffer
which are placed in Non-Secure RAM due to the configuration of the internal bus masters.

Veneer
Code that resides in Non-Secure Callable region

Combined model
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Development engineer has access to both Secure and Non-Secure project and source code
Split model

Development Engineer has access to only the Non-Secure partition. No visibility of Secure source
code. Secure code will be provisioned into device.

3.5.12.1 Configurator Icon Glossary

Vi .
Non Secure % Secure_g_timerD
Callable - Timer Driver on r_gpt
™t
Link to FSP
documentation

4 g_adc0 ADC Driver on

Standard r adc

driver
®

Figure 132: Configurator Icons

3.6 RASC User Guide for MDK and IAR

3.6.1 What is RASC?

The Renesas RA Smart Configurator (RASC) is a desktop application designed to configure device
hardware such as clock set up and pin assignment as well as initialization of FSP software
components for a Renesas RA microcontroller project when using a 3rd-party IDE and toolchain.

The RA Smart Configurator can currently be used with

1. Keil MDK and the Arm compiler toolchain.
2. IAR EWARM with IAR toolchain for Arm

Projects can be configured and the project content generated in the same way as in e? studio. Please
refer to Configuring a Project section for more details.

3.6.2 Using RA Smart Configurator with Keil MDK

3.6.2.1 Prerequisites

e Keil MDK and Arm compiler are installed and licensed. Please refer to the RASC Release
notes for the version to be installed.

e Import the RA device pack. Download the RA device pack archive file (ex:
MDK_Device_Packs_2.x.x.zip) from the FSP GitHub release page. Extract the archive file to
locate the RA device pack. To import the RA device pack, launch the Packinstaller.exe from
<keil_mdk_install_dir>\UV4. Select the menu item File > Import... and browse to the
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extracted .pack file.

e Verify that the latest updates for RA devices are included in Keil MDK. To verify, select the
menu "Packs" in Pack Installer and verify that the menu item Check for Updates on

Launch is selected. If not, select Check for Updates on Launch and relaunch Pack
Installer.

e For flashing and debugging, the latest Segger J-Link DLL is installed into Keil MDK.
e |nstall RASC and FSP using the Platform Installer from the GitHub release page.

3.6.2.2 Create new RA project

The following steps are required to create an RA project using Keil MDK, RASC and FSP:

1. Start the RA Smart Configurator.

2. Enter a project folder and project name.

6 New Renesas RA FSP Project m] *

New Renesas RA F5P Project

Project Name and Location

Project name

Mew_MDK_Project

Location: | c:\MyProjectPath] Browse...

< Back Next » Finish Cancel

Figure 133: RASC project settings

3. Select the target device and IDE.
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E Mew Renesas RA FSP Project

New Renesas RA FSP Project

Device and Tools Selection

Device Selection

Board Description

FSP Version: ~
Evaluation kit for RAGMA MCU Group
Boart B ¥ Visit hitps://www.renesas.com/ra/ek-rabmd to get kit user's
. - manual, quick start guide, errata, design package, example
Device: R7FAEMAAFICFB R O
Language: @ C (OC++
Device Details
TrustZone Yes
Pins 144
Processar cortex-m33
IDE Project Type
IAR EWARM Version 8 ~
IAR EWARM Version 8
Keil MDK Version 5
~
< Back Mext = Finish Cancel

Figure 134: Target device and IDE selection

4. The rest of the project generator and FSP configuration is the same as e? studio. Please
refer to the previous sections for details.
5. On completion of FSP configuration, press "Generate Project Content"

6. A new Keil MDK project file will be generated in the project path. Double click this file to
open MDK and continue development as usual.

Project

= 1% Project: RTFAEM3AH3CFC -
=l Target1
. Source Group 1
-l-i. Renesas RA Smart Configurator:Common Sources

Figure 135: uVision

3.6.2.3 Modify existing RA project

_] blinky_thread_entry.c

_1 hal_entry.c

Flex Software

event_groups.c (Components:ra)
list.c (Components:ra)

queue.c (Components:ra)
stream_buffer.c (Components:ra)

tasks.c (Components:ra)

timers.c (Components:ra)

board_init.c (Components:ra)

TEEEEEEE

rm

project workspace with imported project data

Once an initial project has been generated and configured, it is also possible to make changes using

RASC as follows.
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Note

This setup only needs to be done once per project.

Set up the following links to RASC:

To reconfigure an existing project select Tools > RA Smart Configurator

a. RA Smart Configurator:

1. In Keil MDK uVision, select Tools > Customize Tools Menu....
2. Select the new icon and fill in the fields as follows for each tool:

= Menu item name: Enter: RA Smart Configurator
= Command: Select "..." and navigate to rasc.exe

= Arguments: En

Initial Folder: Enter: $P

ter: configuration.xml

b. Device Partition Manager:

Arguments: En

ter: -application

Menu item name: Enter: Device Partition Manager
Command: Select "..." and navigate to rasc.exe
Initial Folder: Enter: $P

com.renesas.cdt.ddsc.dpm.ui.dpmapplication configuration.xml "$L%L"

To reconfigure the TrustZone partitions select Tools > Device Partition Manager

3.6.2.4 Build and Debug RA project

The project can be built by selecting the menu item Project > Build Target or tool bar item
Rebuild or the keyboard shortcut F7.

Assembler, Compiler, Linker and Debugger settings can be changed in Options for Target dialog,
which can be launched using the menu item Project > Options for Target, the tool bar item
Options for Target or the keyboard shortcut Alt+F7.

KA Options for Target 'Target 1'

Device | Target | Output | Listing | User |
" Use Simulator with restrictions

[ Limit Speed to Real-Time

¥ Load Application at Startup
Initialization File:

Restore Debug Session Settings
[v Breakpoints V¥ Toolbox

v Watch Windows & Peformance Analyzer
¥ System Viewer

[v¥ Memory Display

¥ Run to main()

C/Co+(ACE) | Asm | Linker Debug | uites |

Settings | | ' Use: |J-LINK/J-TRACE Cortex

¥ Load Application at Startup
Initialization File:

I Runto main()

o ]

Restore Debug Session Settings
[ Breakpoints v Toolbox
[V Watch Windows
[v¥ Memory Display

[v System Viewer
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Figure 136: Options for Target
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RASC will set up the uVision project to debug the selected device using J-Link or J-Link OB debugger
by default.

A Debug session can be started or stopped by selecting the menu item Debug > Start/Stop Debug
Session or keyboard shortcut CTRL+F5. When debugging for the first time, J-Link firmware update
may be needed if requested by the tool.

Refer to the documentation from Keil to get more information on the debug features in uVision. Note
that not all features supported by uVision debugger are implemented in the J-Link interface. Consult
SEGGER J-Link documentation for more information.
3.6.2.5 Notes and Restrictions

1. When debugging a TrustZone based project, the Secure project image MUST be

downloaded before the Non Secure project.

2. For TrustZone enabled devices, the user will need to manually set up the memory partitions
using the "Renesas Device Partition Manager" from inside RASC before downloading.

RA Smart Configurator
Help  Run
& [te Renesas Device Partition Manager

Board Support Package Configuration

Figure 137: Renesas Device partition Manager

3. RA FSP contains a full set of drivers and middleware and may not be compatible with other
CMSIS packs from Keil, Arm or third parties.
4. Flash programming is currently only supported through the debugger connection.

3.6.3 Using RA Smart Configurator with IAR EWARM

IAR Systems Embedded Workbench for Arm (EWARM) includes support for Renesas RA devices.
These can be set up as bare metal designs within EWARM. However, most RA developers will want to
integrate RA FSP drivers and middleware into their designs. RASC will facilitate this.

RASC generates a "Project Connection" file that can be loaded directly into EWARM to update project
files.

3.6.3.1 Prerequisites
* |AR EWARM installed and licensed. Pleae refer to the Release notes for the version to be
installed.
e RASC and FSP Installed
3.6.3.2 Create new RA project
The following steps are required to create an RA project using IAR EWARM, RASC and FSP:

1. Start the RA Smart Configurator.
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2. Enter a project folder and project name.

G New Renesas RA FSP Project O X

New Renesas RA FSP Project

Project Name and Location

Project name

| MNew_IAR_Project

Location: | c\MyProjectPath Browse...

< Back Next > Finish Cancel

Figure 138: RASC project settings

3. Select the target device and IDE.

G New Renesas RA FSP Project m] *

New Renesas RA FSP Project

Device and Tools Selection

Device Selection

Board Description

FSP Version: |2.1.0 ~
Evaluation kit for RAGMA MCU Group
Boart B ¥ Visit hitps://www.renesas.com/ra/ek-rabmd to get kit user's
. - manual, quick start guide, errata, design package, example
Device: R7FAEMAAFICFB R O
Language: @ C (OC++
Device Details
TrustZone Yes
Pins 144
Processar cortex-m33
IDE Project Type
IAR EWARM Version 8 ~
Toolchains
IAR Toolchain for ARM
~
< Back Mext = Finish Cancel

Figure 139: Target device and IDE selection

4. The rest of the project generator and FSP configuration operates the same as e? studio.
Refer to the previous sections for details.

5. On completion of FSP configuration, press Generate Project Content.

6. A new IAR EWARM project file will be generated in the project path. Double click this file to
open IAR EWARM and continue development as usual.

7. To Use RASC with EWARM, RASC needs to configured as a tool in EWARM by selecting the
menu item Tools > Configure Tools.... Select New to create a new tool in the dialog
shown and add the following information:

o Menu Text: RA Smart Configurator
a. Command: Select Browse... and navigate to rasc.exe in the installed
RASC
b. Argument: configuration.xml
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C. Initial Directory: $PROJ_DIR$
d. Tool Available: Always
o Menu Text: Device Partition Manager
a. Command: Select Browse... and navigate to rasc.exe in the installed
RASC
b. Argument: -application com.renesas.cdt.ddsc.dpm.ui.dpmapplication
configuration.xml "$TARGET_PATH$"
C. Initial Directory: $PROJ_DIR$
d. Tool Available: Always
8. RASC can now be re-launched from EWARM using the menu item Tools > RA Smart
Configurator.
9. A Project connection needs to be set up in EWARM to build the project. Select Project >
Add Project Connection in EWARM and select AR Project Connection. Navigate to the
project folder and select buildinfo.ipcf and click Open. The project can now build in EWARM.

3.6.3.3 Notes and Restrictions
When starting a TrustZone enabled debug session Partition sizes are checked automatically.

e |f partition sizes are set correctly, the debug session will launch as normal.

e If partition sizes need to be changed, IAR EWARM will prompt to run the Renesas Device
Partition Manager. Select Yes. The Device Partition Manager will start with the required
partition sizes prefilled.

* Select Set TrustZone secure / non-secure boundaries as the only action.

e Enter debugger details, if required.

e Select Run to program the partitions.

e Return to the IDE and relaunch the debug session
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Chapter 4 FSP Architecture

4.1 FSP Architecture Overview

This guide describes the Renesas Flexible Software Package (FSP) architecture and how to use the
FSP Application Programming Interface (API).

4.1.1 C99 Use
FSP uses the ISO/IEC 9899:1999 (C99) C programming language standard. Specific features

introduced in C99 that are used include standard integer types (stdint.h), booleans (stdbool.h),
designated initializers, and the ability to intermingle declarations and code.

4.1.2 Doxygen

Doxygen is the default documentation tool used by FSP. You can find Doxygen comments throughout
the FSP source.

4.1.3 Weak Symbols

Weak symbols are used occasionally in FSP. They are used to ensure that a project builds even when
the user has not defined an optional function.

4.1.4 Memory Allocation

Dynamic memory allocation through use of the malloc() and free() functions are not used in FSP
modules; all memory required by FSP modules is allocated in the application and passed to the
module in a pointer. Exceptions are considered only for ports of 3rd party code that require dynamic
memory.

4.1.5 FSP Terms

Term Description Reference

BSP Short for Board Support MCU Board Support Package
Package. In FSP, the BSP
provides just enough
foundation to allow other FSP
modules to work together
without issue.
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Module

Modules can be peripheral
drivers, purely software, or
anything in between. Each
module consists of a folder with
source code, documentation,
and anything else that the
customer needs to use the code
effectively. Modules are
independent units, but they
may depend on other modules.
Applications can be built by
combining multiple modules to
provide the user with the
features they need.

FSP Modules

Driver

A driver is a specific kind of
module that directly modifies
registers on the MCU.

Interface

An interface contains API
definitions that can be shared
by modules with similar
features. Interfaces are
definitions only and do not add
to code size.

FSP Interfaces

Stacks

The FSP architecture is
designed such that modules
work together to form a stack.
A stack consists of a top level
module and all its
dependencies.

FSP Stacks

Module Instance

Single and independent
instantiation of a module. An
application may require two
GPT timers. Each of these
timers is a module instance of
the r_gpt module.

Application

Code that is owned and
maintained by the user.
Application code may be based
on sample application code
provided by Renesas, but it is
the responsibility of the user to
maintain as necessary.
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Callback Function

This term refers to a function
that is called when an event
occurs. As an example, suppose
the user would like to be
notified every second based on
the RTC. As part of the RTC
configuration, a callback
function can be supplied that
will be jumped to during each
RTC interrupt. When a single
callback services multiple
events, the arguments contain
the triggering event. Callback
functions for interrupts should
be kept short and handled
carefully because when they
are called the MCU is still inside
of an interrupt, delaying any
pending interrupts.

4.2 FSP Modules

Modules are the core building block of FSP. Modules can do many different things, but all modules
share the basic concept of providing functionality upwards and requiring functionality from below.

*

Provides

Requires

Figure 140: Modules

The amount of functionality provided by a module is determined based on functional use cases.
Common functionality required by multiple modules is often placed into a self-contained submodule
so it can be reused. Code size, speed and complexity are also considered when defining a module.

The simplest FSP application consists of one module with the Board Support Package (BSP) and the

user application on top.
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Application

FSP Module

<

Figure 141: Module with application

The Board Support Package (BSP) is the foundation for FSP modules, providing functionality to
determine the MCU used as well as configuring clocks, interrupts and pins. For the sake of clarity,
the BSP will be omitted from further diagrams.

4.2.1 Module Sources

Some modules distributed alongside FSP originate from outside sources. A full list of sources for FSP
modules, including versions and hyperlinks, can be found in the Third Party Software section of the
release notes for each release.

4.2.2 Module Distribution

All modules distributed with FSP are packaged as CMSIS components in CMSIS packs. Each module
consists of source files and a tooling support file used to integrate the module with e? studio or
RASC. The tooling support file defines the configurations used to generate code in the ra_gen and
ra_cfg folders.

4.2.3 Module Versioning

Module versions can be seen on the Components tab of the FSP Configuration editor. The FSP
Configuration editor automatically selects compatible components.

All third party modules have a semantic version are versioned with their original semantic version
plus added metadata fsp.<fsp_semantic_version>. The metadata is added to reflect the tooling
support file added for the FSP configuration tool.

Third party modules versioned with +renesas.<counter> in the metadata have been forked and
updated for FSP. If +renesas.<counter> is not in the metadata, the third party code is unchanged
from its original source.

If changes are made to third party module source code to support FSP, the changes are pushed to a
public Renesas GitHub fork of the original source. Links to Renesas forks are provided in the Third
Party Software section of the release notes for each release.

Modules that originate from outside sources that do not have a semantic version are versioned with
the FSP version.

All modules that are part of FSP or integrated with FSP are tested as a package. Mixing versions is
not encouraged and may lead to support issues.
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4.3 FSP Stacks

When modules are layered atop one another, an FSP stack is formed. The stacking process is
performed by matching what one module provides with what another module requires. For example,
the SPI module (SPI (r_spi)) requires a module that provides the transfer interface (Transfer Interface
) to send or receive data without a CPU interrupt. The transfer interface requirement can be fulfilled
by the DTC driver module (Transfer (r_dtc)).

Through this methodology the same code can be shared by several modules simultaneously. The

example below illustrates how the same DTC module can be used with SPI (SPI (r_spi)), UART (UART
(r_sci_uart)) and SDHI (SD/MMC (r_sdhi)).

Application

Provides: SPI Provides: UART Provides: SD/MMC

UART Driver

SD Card Driver

Requires: Transfer

Requires: Transfer

Requires: Transfer

Provides:|Transfer

Figure 142: Stacks -- Shared DTC Module

The ability to stack modules ensures the flexibility of the architecture as a whole. If multiple
modules include the same functionality issues arise when application features must work across
different user designs. To ensure that modules are reusable, any dependent modules must be
capable of being swapped out for other modules that provide the same features. The FSP
architecture provides this flexibility to swap modules in and out through the use of FSP interfaces.

4.4 FSP Interfaces

At the architecture level, interfaces are the way that modules provide common features. This
commonality allows modules that adhere to the same interface to be used interchangeably.
Interfaces can be thought of as a contract between two modules - the modules agree to work
together using the information that was established in the contract.

On RA hardware there is occasionally an overlap of features between different peripherals. For
example, 12C communications can be achieved through use of the IIC peripheral or the SCI
peripheral. However, there is a difference in the level of features provided by both peripherals; in 12C
mode the SCI peripheral will only support a subset of the capabilities of the fully-featured IIC.

Interfaces aim to provide support for the common features that most users would expect. This
means that some of the advanced features of a peripheral (such as 1IC) might not be available in the
interface. In most cases these features are still available through interface extensions.

In FSP design, interfaces are defined in header files. All interface header files are located in the folder
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ra/fsp/inc/api and end with *_api.h. Interface extensions are defined in header files in the folder
ra/fsp/inc/instances. The following sections detail what makes up an interface.

4.4.1 FSP Interface Enumerations

Whenever possible, interfaces use typed enumerations for function parameters and structure
members.

typedef enum e i 2c_nmster _addr _node

{
| 2C_MASTER ADDR MODE 7BIT = 1, /1/< Use 7-bit addressing node

| 2C_MASTER _ADDR_MODE_10BI T = 2, /1] < Use 10-bit addressing node

} i2c_naster_addr_node t;

Enumerations remove uncertainty when deciding what values are available for a parameter. FSP
enumeration options follow a strict naming convention where the name of the type is prefixed on the
available options. Combining the naming convention with the autocomplete feature available in e2
studio (Ctrl + Space) provides the benefits of rapid coding while maintaining high readability.

4.4.2 FSP Interface Callback Functions

Callback functions allow modules to asynchronously alert the user application when an event has
occurred, such as when a byte has been received over a UART channel or an IRQ pin is toggled. FSP
driver modules define and handle the interrupt service routines for RA MCU peripherals to ensure
any required hardware procedures are implemented. The interrupt service routines in FSP modules
then call the user-defined callbacks to allow the application to respond.

Callback functions must be defined in the user application. They always return void and take a
structure for their one parameter. The structure is defined in the interface for the module and is
named <interface>_callback_args_t. The contents of the structure may vary depending on the
interface, but two members are common: event and p_context.

The event member is an enumeration defined in the interface used by the application to determine
why the callback was called. Using the UART example, the callback could be triggered for many
different reasons, including when a byte is received, all bytes have been transmitted, or a framing
error has occurred. The event member allows the application to determine which of these three
events has occurred and handle it appropriately.

The p_context member is used for providing user-specified data to the callback function. In many
cases a callback function is shared between multiple channels or module instances; when the
callback occurs, the code handling the callback needs context information so that it can determine
which module instance the callback is for. For example, if the callback wanted to make an FSP API
call in the callback, then at a minimum the callback will need a reference to the relevant control
structure. To make this easy, the user can provide a pointer to the control structure as the
p_context. When the callback occurs, the control structure is passed in the p_context element of the
callback structure.

Callback functions are called from within an interrupt service routine. For this reason callback
functions should be kept as short as possible so they do not affect the real time performance of the
user's system. An example skeleton function for the flash interface callback is shown below.
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}
case FLASH EVENT ERR CMVD_LOCKED:
{
/* Handl e error. */
br eak;
}
case FLASH EVENT ERR FAl LURE:
{
/* Handl e error. */
br eak;
}
case FLASH EVENT ERR ONE BI T:
{
/* Handl e error. */
br eak;
}
}
}

When a module is not directly used in the user application (that is, it is not the top layer of the
stack), its callback function will be handled by the module above. For example, if a module requires
a UART interface module the upper layer module will control and use the UART's callback function. In
this case the user would not need to create a callback function for the UART module in their
application code.

4.4.3 FSP Interface Data Structures

At a minimum, all FSP interfaces include three data structures: a configuration structure, an API
structure, and an instance structure.

4.4.3.1 FSP Interface Configuration Structure

The configuration structure is used for the initial configuration of a module during the
<MODULE>_Open() call. The structure consists of members such as channel number, bitrate, and
operating mode.

The configuration structure is used purely as an input into the module. It may be stored and
referenced by the module, so the configuration structure and anything it references must persist as
long as the module is open.

The configuration structure is allocated for each module instance in files generated by the RA
Configuration editor.
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When FSP stacks are used, it is also important to understand that configuration structures only have
members that apply to the current interface. If multiple layers in the same stack define the same
configuration parameters then it becomes difficult to know where to modify the option. For example,
the baud rate for a UART is only defined in the UART module instance. Any modules that use the
UART interface rely on the baud rate being provided in the UART module instance and do not offer it
in their own configuration structures.

4.4.3.2 FSP Interface API Structure

All interfaces include an API structure which contains function pointers for all the supported interface
functions. An example structure for the DAC is shown below.

typedef struct st _dac_api

{

/** Initial configuration.

*

* @aranfin] p_ctrl Pointer to control block. Miust be declared by user. Elenents
set here.

* @aranfin] p_cfg Pointer to configuration structure. Al elenments of this
structure must be set by user.

*/

fsp_err_t (* open)(dac_ctrl _t * const p_ctrl, dac_cfg t const * const p_cfqQ);

/** Close the D/ A Converter.

*

* @aranfin] p_ctrl Control block set in @ef dac_api _t::open call for this
tinmer.

*/

fsp err_t (* close)(dac _ctrl _t * const p_ctrl);

/** Wite sanple value to the D/ A Converter.

*

* @aranfin] p_ctrl Control block set in @ef dac_api _t::open call for this
tinmer.

* @aranfin] value Sanple value to be witten to the D/A Converter.

*/

fsp err t (* wite)(dac_ctrl_t * const p_ctrl, uintl6_ t val ue);

/[** Start the D/ A Converter if it has not been started yet.

*

* @aranfin] p_ctrl Control block set in @ef dac_api _t::open call for this

timer.
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*/
fsp err t (* start)(dac _ctrl _t * const p_ctrl);
/** Stop the D/A Converter if the converter is running.

*

* @aranfiin] p_ctrl Control block set in @ef dac_api _t::open call for this
tiner.

*/

fsp err t (* stop)(dac_ctrl _t * const p_ctrl);

} dac_api _t;

The API structure is what allows for modules to easily be swapped in and out for other modules that
are instances of the same interface. Let's look at an example application using the DAC interface
above.

RA MCUs have an internal DAC peripheral. If the DAC API structure in the DAC interface is not used

the application can make calls directly into the module. In the example below the application is
making calls to the R_DAC_Write() function which is provided in the r_dac module.

Application

r_dac
R_DAC_Write()

Figure 143: DAC Write example

Now let's assume that the user needs more DAC channels than are available on the MCU and
decides to add an external DAC module named dac_external using 12C for communications. The
application must now distinguish between the two modules, adding complexity and further
dependencies to the application.
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Application

Is External?

r_dac
R_DAC_Write()

dac_external

DAC_EXTERNAL Write()

Figure 144: DAC Write with two write modules

The use of interfaces and the API structure allows for the use of an abstracted DAC. This means that
no extra logic is needed if the user's dac_external module implements the FSP DAC interface, so the
application no longer depends upon hard-coded module function names. Instead the application now
depends on the DAC interface APl which can be implemented by any number of modules.

Application

Internal DAC External DAC 1

External DAC 2

Figure 145: DAC Interface

4.4.3.3 FSP Interface Instance Structure

Every FSP interface also has an instance structure. The instance structure encapsulates everything
required to use the module:

¢ A pointer to the instance API structure (FSP Instance API)
¢ A pointer to the configuration structure
¢ A pointer to the control structure

The instance structure is not required at the application layer. It is used to connect modules to their
dependencies (other than the BSP).

Instance structures have a standardized name of <interface>_instance_t. An example from the
Transfer Interface is shown below.
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typedef struct st _transfer_instance

{
transfer _ctrl t * p_ctrl; ///< Pointer to the control structure for this
i nstance
transfer _cfg t const * p _cfg; /1/< Pointer to the configuration structure
for this instance
transfer_api _t const * p_api; /1/< Pointer to the APl structure for this
i nstance

} transfer_instance_ t;

Note that when an instance structure variable is declared, the API is the only thing that is instance
specific, not module instance specific. This is because all module instances of the same module
share the same underlying module source code. If SPI is being used on SCI channels 0 and 2 then
both module instances use the same API while the configuration and control structures are typically
different.

4.5 FSP Instances

While interfaces dictate the features that are provided, instances actually implement those features.
Each instance is tied to a specific interface. Instances use the enumerations, data structures, and API
prototypes from the interface. This allows an application that uses an interface to swap out the
instance when needed.

On RA MCUs some peripherals are used to implement multiple interfaces. In the example below the
IIC and SPI peripherals map to only one interface each while the SCI peripheral implements three
interfaces.

Interface: 12C Interface: UART Interface: SPI
r_i2c_api.h r_uart_api.h r_spi_api.h

Peripheral: IIC Peripheral: SCI Peripheral: 5CI Peripheral: 5CI Peripheral: SPI
Module: r_riic Module: r_sci_i2c Module: r_sci_uart Module: r_sci_spi Module: r_rspi

Figure 146: Instances

In FSP design, instances consist of the interface extension and API defined in the instance header
file located in the folder ra/fsp/inc/instances and the module source ra/fsp/src/<module>.

4.5.1 FSP Instance Control Structure

The control structure is used as a unique identifier for the module instance and contains memory
required by the module. Elements in the control structure are owned by the module and must not be
modified by the application. The user allocates storage for a control structure, often as a global
variable, then sends a pointer to it into the <MODULE>_Open() call for a module. At this point, the
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module initializes the structure as needed. The user must then send in a pointer to the control
structure for all subsequent module calls.

4.5.2 FSP Interface Extensions

In some cases, instances require more information than is provided in the interface. This situation
can occur in the following cases:

* An instance offers extra features that are not common to most instances of the interface.
An example of this is the start source selection of the GPT (Timer, General PWM (r_gpt)).
The GPT can be configured to start based on hardware events such as a falling edge on a
trigger pin. This feature is not common to all timers, so it is included in the GPT instance.

e An interface must be very generic out of necessity. As an interface becomes more generic,
the number of possible instances increases. An example of an interface that must be
generic is a block media interface that abstracts functions required by a file system.
Possible instances include SD card, SPI Flash, SDRAM, USB, and many more.

The p_extend member provides this extension function.

Use of interface extensions is not always necessary. Some instances do not offer an extension since
all functionality is provided in the interface. In these cases the p_extend member can be set to NULL.
The documentation for each instance indicates whether an interface extension is available and
whether it is mandatory or optional.

4.5.2.1 FSP Extended Configuration Structure

When extended configuration is required it can be supplied through the p_extend parameter of the
interface configuration structure.

The extended configuration structure is part of the instance, but it is also still considered to be part
of the configuration structure. All usage notes about the configuration structure described in FSP
Interface Configuration Structure apply to the extended configuration structure as well.

The extended configuration structure and all typed structures and enumerations required to define it
make up the interface extension.

4.5.3 FSP Instance API

Each instance includes a constant global variable tying the interface API functions to the functions
provided by the module. The name of this structure is standardized as
g_<interface>_on_<instance>. Examples include g_spi_on_spi, g_transfer _on_dtc, and
g_adc_on_adc. This structure is available to be used through an extern in the instance header file
(r_spi.h, r_dtc.h, and r_adc.h respectively).

4.6 FSP APl Standards

4.6.1 FSP Function Names

FSP functions start with the uppercase module name (<MODULE>). All modules have
<MODULE>_Open() and <MODULE>_Close() functions. The <MODULE>_Open() function must be
called before any of the other functions.

Other functions that will commonly be found are <MODULE>_Read(), <MODULE>_Write(),
<MODULE>_InfoGet(), and <MODULE>_StatusGet(). The <MODULE>_StatusGet() function provides

R11UMO155EU0420 Revision 5.20 RENESANAS Page 139 /5,010
Feb.28.2024



Flexible Software Package User’s Manual

FSP Architecture > FSP API Standards > FSP Function Names

a status that could change asynchronously, while <MODULE>_InfoGet() provides information that
cannot change after open or can only be updated by API calls. Example function names include:

R_SPI_Read(), R_SPI_Write(), R_SPI_WriteRead()

R_SDHI_StatusGet()

e R RTC_CalendarAlarmSet(), R RTC CalendarAlarmGet()
R_FLASH_HP_AccessWindowSet(), R_FLASH HP_AccessWindowClear()

4.6.2 Use of const in APl parameters

The const qualifier is used with APl parameters whenever possible. An example case is shown below.

fsp err t R FLASH HP Open(flash _ctrl _t * const p_api_ctrl, flash cfg t const * const

p_cfg);

In this example, flash_cfg_t is a structure of configuration parameters for the r_flash_hp module. The
parameter p_cfg is a pointer to this structure. The first const qualifier on p_cfg ensures the
flash_cfg_t structure cannot be modified by R_ FLASH _HP_Open(). This allows the structure to be
allocated as a const variable and stored in ROM instead of RAM.

The const qualifier after the pointer star for both p_ctrl and p_cfg ensures the FSP function does not
modify the input pointer addresses. While not fool-proof by any means this does provide some extra
checking inside the FSP code to ensure that arguments that should not be altered are treated as
such.

4.6.3 FSP Version Information

The BSP provides a function R_FSP_VersionGet() which fills in a structure of type fsp_pack version_t.
This can be used to determine the FSP version at runtime.

There are also FSP_VERSION_* macros in fsp_version.h that can be used to determine the FSP
version at build time.

4.7 FSP Build Time Configurations

All modules have a build-time configuration header file. Most configuration options are supplied at
run time, though options that are rarely used or apply to all instances of a module may be moved to
build time. The advantage of using a build-time configuration option is to potentially reduce code
size reduction by removing an unused feature.

All modules have a build time option to enable or disable parameter checking for the module. FSP
modules check function arguments for validity when possible, though this feature is disabled by
default to reduce code size. Enabling it can help catch parameter errors during development and
debugging. By default, each module's parameter checking configuration inherits the BSP parameter
checking setting (set on the BSP tab of the RA Configuration editor). Leaving each module's
parameter checking configuration set to Default (BSP) allows parameter checking to be enabled or
disabled globally in all FSP code through the parameter checking setting on the BSP tab.

If an error condition can reasonably be avoided it is only checked in a section of code that can be
disabled by disabling parameter checking. Most FSP APIs can only return FSP_SUCCESS if parameter
checking is disabled. An example of an error that cannot be reasonably avoided is the "bus busy"
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error that occurs when another master is using an 12C bus. This type of error can be returned even if
parameter checking is disabled.

4.8 FSP File Structure

The high-level file structure of an FSP project is shown below.

ra_gen
ra
+---fsp
+---inc
| +---api
| \---instances
\---src
+---bsp
\---r_nodul e
ra_cfg
+---fsp _cfg
+---bsp

+---driver

Directly underneath the base ra folder the folders are split into the source and include folders.
Include folders are kept separate from the source for easy browsing and easy setup of include paths.

The ra_gen folder contains code generated by the RA Configuration editor. This includes global
variables for the control structure and configuration structure for each module.

The ra_cfg folder is where configuration header files are stored for each module. See FSP Build Time
Configurations for information on what is provided in these header files.

4.9 FSP TrustZone Support

TrustZone support for FSP is primarily handled in the RA Configuration Tool.

4.9.1 FSP TrustZone Projects

During development of a TrustZone project, users create an RA TrustZone Secure Project first,
followed by an RA TrustZone Non-secure Project that is linked to the RA TrustZone Secure Project.
Allocation of secure memory is handled automatically within the tooling. The non-secure project
starts at the required alignment boundary beyond the memory taken by the secure project.

4.9.2 Non-Secure Callable Guard Functions

The tooling generates guard functions for any module marked as Non-secure Callable. These guard

R11UMO155EU0420 Revision 5.20 RENESANAS Page 141 /5,010
Feb.28.2024



Flexible Software Package User’s Manual

FSP Architecture > FSP TrustZone Support > Non-Secure Callable Guard Functions

functions are owned by the application once generated, so they can be modified as necessary by the
secure application developer.

The default non-secure callable guard functions limit the configuration and control structure to the
structures generated in the secure project. They also check any input pointers to ensure the caller
does not overwrite secure memory.

4.9.3 Callbacks in Non-Secure from Non-Secure Callable Modules

If the non-secure project needs a callback function from a non-secure callable module, the callback
can be registered after the module is opened using the callback set() guard function.

4.9.4 Migrating TrustZone Project to newer FSP Version

The TrustZone projects can be migrated to newer FSP version as mentioned in the following
resource.

e Migrating Projects to New FSP Version (Application Note)

Additional steps are required if newer FSP version introduces new guard function. In such case,
simply migrating the project would result in the build failure for non secure project. Following extra
steps are required:

e If xxx_guard.c file in src folder of secure project was not modified earlier
1. Delete the xxx_guard.c file in secure project before generating the Project Files.
2. Generate Project contents and build the secure project.
3. Follow the steps in Application Note to migrate the Non-Secure project.
e |f xxx_guard.c file in src folder of secure project was modified earlier
1. Take the backup of existing xxx_guard.c file and delete it from src folder of secure
project before generating the Project Files.
2. Generate Project contents. It creates a new guard.c file. Compare the contents of
the older file and newly generated guard.c file.
3. Copy the modified code from the older file (i.e Security checks added by user) and
add it to newly generated file.
4. Follow the steps in Application Note to migrate the Non-Secure project.

4.9.5 Additional TrustZone Information

The following resources provide technical background, application notes and example projects that
demonstrate key TrustZone concepts and implementation procedures.

e The Benefits of Using Arm® TrustZone® in Your Design (Brochure)

¢ RA Arm® TrustZone® Tooling Primer (Application Note)

e Renesas RA Family Security Design with Arm® TrustZone® - IP Protection (Application
Note)

e Renesas RA Family Securing Data at Rest Using the Arm® TrustZone® (Application Note)

4.10 FSP Architecture in Practice

4.10.1 FSP Connecting Layers

FSP modules are meant to be both reusable and stackable. It is important to remember that modules
are not dependent upon other modules, but upon other interfaces. The user is then free to fulfill the
interface using the instance that best fits their needs.
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Interface: X
FSP Module 1
Dependency:

Interface:
FSP Module 2

Dependency:

Interface: /
FSP Module 3
Dependency: None

Figure 147: Connecting layers

In the image above interface Y is a dependency of interface X and has its own dependency on
interface Z. Interface X only has a dependency on interface Y. Interface X has no knowledge of
interface Z. This is a requirement for ensuring that layers can easily be swapped out.

4.10.2 Using FSP Modules in an Application

The typical use of an FSP module involves generating required module data then using the APl in the
application.

4.10.2.1 Create a Module Instance in the RA Configuration Editor

The RA Configuration editor (available both in the Renesas e? studio IDE as well as through the
standalone RA Smart Configurator) provides a graphical user interface for setting the parameters of
the interface and instance configuration structures. It also automatically includes those structures
(once they are configured in the GUI) in application-specific header files that can be included in
application code.

The RA Configuration editor allocates storage for the control structures, all required configuration
structures, and the instance structure in generated files in the ra_gen folder. Use the Properties
window to set the values for the members of the configuration structures as needed. Refer to the
Configuration section of the module usage notes for documentation about the configuration options.

If the interface has a callback function option then the application must declare and define the
function. The return value is always of type void and the parameter to the function is a typed
structure of name <interface>_callback args t. Once the function has been defined, assign its name
to the p_callback member of the configuration structure. Callback function names can be assigned
through the Properties window for the selected module.

4.10.2.2 Use the Instance API in the Application
Call the module's <MODULE>_Open() function. Pass pointers to the generated control structure and
configuration structure. The names of these structures are based on the 'Name' field provided in the

configuration editor. The control structure is <Name>_ctrl and the configuration structure is
<Name>_cfg. An example <MODULE>_Open() call for an r_rtc module instance named g_clock is:

R RTC Open(&g _clock ctrl, &g _clock cfg);
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Note

Each layer in the FSP Sack isresponsible for calling the API functions of its dependencies. This means that users
are only responsible for calling the API functions at the layer at which they are interfacing. Using the example
above of a SPI module with a DTC dependency, the application uses only SPI APIs. The application starts by
calling R_SPI_Open(). Internally, the SPI module opensthe DTC. It locates R_DTC_Open() by accessing the
dependent transfer interface function pointers from the pointers DTC instances (spi_cfg_t::p_transfer_tx and
spi_cfg t::p_transfer_rx) to open the DTC.

Refer to the module usage notes for example code to help get started with any particular module.
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Chapter 5 APl Reference

This section includes the FSP APl Reference for the Module and Interface level functions.

VvBSP
BSP I/O access

Common Error Codes

»MCU Board Support Package

V¥YModules

»Analog

»-Al

»Audio
»Bootloader
»CapTouch
»Connectivity
»DSP
»Graphics
»Input
»Monitoring
»Motor
»Networking
»Power
»RTOS
»Security
»Sensor
»Storage
»System
»Timers

»Transfer

Common code shared by FSP drivers

This module provides basic read/write access to
port pins

The BSP is responsible for getting the MCU from
reset to the user's application. Before reaching
the user's application, the BSP sets up the
stacks, heap, clocks, interrupts, C runtime
environment, and stack monitor

Modules are the smallest unit of software
available in FSP. Each module implements one
interface

Analog Modules
Artifical Intelligence Modules
Audio Modules
Bootloader Modules
CapTouch Modules
Connectivity Modules
DSP Modules
Graphics Modules
Input Modules
Monitoring Modules
Motor Modules
Networking Modules
Power Modules

RTOS Modules
Security Modules
Sensor Modules
Storage Modules
System Modules
Timers Modules

Transfer Modules
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»TrustZone Arm TrustZone Modules

Vinterfaces FSP interfaces provide APIs for common
functionality. They can be implemented by one
or more modules. Modules can use other
modules as dependencies using this interface

layer

»Analog Analog Interfaces
»Al Al Interfaces
»Audio Audio Interfaces
»CapTouch CapTouch Interfaces
»Connectivity Connectivity Interfaces
»DSP DSP Interfaces
»Graphics Graphics Interfaces
»Input Input Interfaces
»Monitoring Monitoring Interfaces
»Motor Motor Interfaces
»Networking Networking Interfaces
»Power Power Interfaces
»Security Security Interfaces
»Sensor Sensor Interfaces
»Storage Storage Interfaces
»System System Interfaces
»Timers Timers Interfaces
»Transfer Transfer Interfaces
RSIP Interface Interface for Renesas Secure IP (RSIP) functions
LVD

5.1 BSP

Detailed Description

Common code shared by FSP drivers.

Modules

BSP 1/0 access
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Data Structures

Macros

union

#define

#define

#define

#define

#define

#define

This module provides basic read/write access to port pins.

Common Error Codes

MCU Board Support Package

The BSP is responsible for getting the MCU from reset to the user's
application. Before reaching the user's application, the BSP sets up
the stacks, heap, clocks, interrupts, C runtime environment, and

stack monitor.

fsp_pack version_t

FSP_VERSION_MAJOR
FSP_VERSION_MINOR
FSP_VERSION_PATCH
FSP_VERSION_BUILD
FSP_VERSION_STRING

FSP_VERSION_BUILD_STRING

Data Structure Documentation

¢ fsp_pack_version_t

union fsp_pack_version_t

FSP Pack version structure

Data Fields

uint32_t

version_id

Version id

struct version_id b s

version_id b

Macro Definition Documentation

¢ FSP_VERSION_MAJOR

#define FSP_VERSION_MAJOR

FSP pack major version.
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¢ FSP_VERSION_MINOR
#define FSP_VERSION_MINOR

FSP pack minor version.

¢ FSP_VERSION_PATCH
#define FSP_VERSION_PATCH

FSP pack patch version.

¢ FSP_VERSION_BUILD
#define FSP_VERSION_ BUILD

FSP pack version build number (currently unused).

¢ FSP_VERSION_STRING
#define FSP_VERSION_STRING

Public FSP version name.

¢ FSP_VERSION_BUILD STRING
#define FSP_VERSION_BUILD_STRING

Unique FSP version ID.

5.1.1 BSP 1I/O access
BSP

Functions

__STATIC_INLINE uint32_ t R _BSP_PinRead (bsp_io_port _pin_t pin)
__STATIC_INLINE void R_BSP_PinWrite (bsp_io_port_pin_t pin, bsp_io_level_t level)
__STATIC_INLINE void R_BSP_PinCfg (bsp_io_port_pin_t pin, uint32_t cfg)

__STATIC_INLINE void R _BSP_PinAccessEnable (void)
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__STATIC_INLINE void R_BSP_PinAccessDisable (void)

Detailed Description

This module provides basic read/write access to port pins.

Enumerations

enum bsp_io_level t
enum bsp_io_direction_t
enum bsp_io _port t
enum bsp_io_port_pin_t
Enumeration Type Documentation

¢ bsp_io_level t

enum bsp_io_level_t

Levels that can be set and read for individual pins

Enumerator
BSP 10 _LEVEL LOW Low.
BSP_1I0_LEVEL HIGH High.
¢ bsp_io_direction_t
enum bsp_io_direction_t
Direction of individual pins
Enumerator
BSP_10_DIRECTION_INPUT Input.
BSP_I0_DIRECTION_OUTPUT Output.
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¢ bsp_io_port_t

enum bsp_io_port t

Superset list of all possible 10 ports.

Enumerator
BSP_10_PORT_00 10 port 0.
BSP_10_PORT 01 10 port 1.
BSP_IO_PORT 02 10 port 2.
BSP_|O_PORT_03 10 port 3.
BSP_IO_PORT_04 10 port 4.
BSP_IO_PORT_05 10 port 5.
BSP_10_PORT_06 IO port 6.
BSP_I0_PORT 07 10 port 7.
BSP |0 PORT 08 10 port 8.
BSP_10_PORT_09 IO port 9.
BSP_IO_PORT 10 10 port 10.
BSP_I0_PORT 11 10 port 11.
BSP_IO_PORT_12 10 port 12.
BSP 10 _PORT_13 10 port 13.
BSP_IO_PORT 14 10 port 14.
¢ bsp_io_port_pin_t
enum bsp_io_port pin_t
Superset list of all possible 10 port pins.
Enumerator
BSP_|0_PORT_00_PIN_00 10 port 0 pin 0.
BSP_IO_PORT_00_PIN 01 10 port 0 pin 1.
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BSP_IO_PORT_00_PIN_02

IO port 0 pin 2.
BSP_|O_PORT_00 _PIN_03 |0 port 0 pin 3.
BSP_IO_PORT_00_PIN_04 IO port 0 pin 4.
BSP_I0_PORT 00 PIN_05 10 port 0 pin 5.
BSP_I0_PORT 00 PIN_06 10 port 0 pin 6.
BSP_IO_PORT_00_PIN_07 |0 port 0 pin 7.
BSP_IO_PORT_00_PIN_08 IO port 0 pin 8.
BSP_I0_PORT 00 PIN_09 10 port 0 pin 9.

BSP_|O_PORT_00 PIN_ 10

IO port 0 pin 10.

BSP_IO_PORT 00 PIN_ 11

IO port O pin 11.

BSP_10_PORT 00 PIN_12

IO port 0 pin 12.

BSP_IO_PORT 00 PIN 13

IO port 0 pin 13.

BSP_IO_PORT_00 PIN_14

IO port 0 pin 14.

BSP_IO_PORT 00 PIN_15

IO port 0 pin 15.

BSP_10_PORT 01 _PIN_00

10 port 1 pin 0.
BSP |0 _PORT 01 PIN 01 10 port 1 pin 1.
BSP_I0_PORT 01 PIN 02 10 port 1 pin 2.
BSP_IO_PORT_01_PIN_03 10 port 1 pin 3.
BSP_IO_PORT_01_PIN_04 |0 port 1 pin 4.
BSP_I0_PORT 01 PIN_05 10 port 1 pin 5.
BSP_I0_PORT 01 PIN_06 10 port 1 pin 6.
BSP_IO_PORT_01_PIN_07 10 port 1 pin 7.
BSP_IO_PORT_01_PIN_08 |0 port 1 pin 8.
BSP_I0_PORT 01 PIN_09 10 port 1 pin 9.
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BSP_IO_PORT_01_PIN_10

IO port 1 pin 10.

BSP_|O_PORT 01_PIN_ 11

IO port 1 pin 11.

BSP_10_PORT 01 PIN_12

0 port 1 pin 12.

BSP_IO_PORT 01 PIN 13

IO port 1 pin 13.

BSP_IO_PORT_01_PIN_14

IO port 1 pin 14.

BSP_IO_PORT 01 PIN_15

IO port 1 pin 15.

BSP_10_PORT _02_PIN_00

10 port 2 pin 0.
BSP_I0_PORT 02 PIN 01 10 port 2 pin 1.
BSP_I0_PORT_02_PIN 02 10 port 2 pin 2.
BSP_IO_PORT_02_PIN_03 10 port 2 pin 3.
BSP_IO_PORT_02_PIN_04 |0 port 2 pin 4.
BSP_I0_PORT 02 _PIN_05 10 port 2 pin 5.
BSP_I0_PORT 02 PIN_06 10 port 2 pin 6.
BSP_IO_PORT_02_PIN_07 |0 port 2 pin 7.
BSP_IO_PORT_02_PIN_08 |0 port 2 pin 8.
BSP_I0_PORT 02 PIN_09 10 port 2 pin 9.

BSP_IO_PORT_02_PIN_10

IO port 2 pin 10.

BSP_|O_PORT 02_PIN_11

IO port 2 pin 11.

BSP_10_PORT 02 PIN_12

0 port 2 pin 12.

BSP_IO_PORT_02_PIN 13

IO port 2 pin 13.

BSP_IO_PORT_02_PIN_14

IO port 2 pin 14.

BSP_IO_PORT 02_PIN_15

IO port 2 pin 15.

BSP_10_PORT 03 _PIN_00

10 port 3 pin 0.
BSP_IO_PORT_03_PIN_01 10 port 3 pin 1.
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BSP_IO_PORT_03_PIN_02

IO port 3 pin 2.
BSP_|O_PORT_03_PIN_03 |0 port 3 pin 3.
BSP_IO_PORT_03_PIN_04 IO port 3 pin 4.
BSP_I0_PORT_03_PIN_05 10 port 3 pin 5.
BSP_I0_PORT 03 PIN_06 10 port 3 pin 6.
BSP_IO_PORT_03_PIN_07 |0 port 3 pin 7.
BSP_IO_PORT_03_PIN_08 IO port 3 pin 8.
BSP_10_PORT_03_PIN_09 10 port 3 pin 9.

BSP_|O_PORT 03 _PIN_10

IO port 3 pin 10.

BSP_|O_PORT 03_PIN_11

IO port 3 pin 11.

BSP_10_PORT 03_PIN_12

|0 port 3 pin 12.

BSP_IO_PORT 03_PIN 13

IO port 3 pin 13.

BSP_IO_PORT_03_PIN_14

IO port 3 pin 14.

BSP_IO_PORT 03_PIN_15

IO port 3 pin 15.

BSP_I0_PORT 04 _PIN_00

10 port 4 pin 0.
BSP_I0_PORT_04_PIN_01 10 port 4 pin 1.
BSP_I0_PORT 04 PIN 02 10 port 4 pin 2.
BSP_IO_PORT_04_PIN_03 |0 port 4 pin 3.
BSP_IO_PORT_04_PIN_04 |0 port 4 pin 4.
BSP_I0_PORT 04 PIN_05 10 port 4 pin 5.
BSP_I0_PORT 04 PIN_06 10 port 4 pin 6.
BSP_IO_PORT_04_PIN_07 |0 port 4 pin 7.
BSP_IO_PORT_04_PIN_08 |0 port 4 pin 8.
BSP_I0_PORT 04 PIN_09 10 port 4 pin 9.
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BSP_|O_PORT 04 PIN_10

IO port 4 pin 10.

BSP_IO_PORT 04 PIN_11

IO port 4 pin 11.

BSP_10_PORT 04 PIN_12

|0 port 4 pin 12.

BSP_IO_PORT 04 PIN 13

IO port 4 pin 13.

BSP_IO_PORT_04_PIN_14

IO port 4 pin 14.

BSP_IO_PORT 04 PIN_15

IO port 4 pin 15.

BSP_10_PORT 05 _PIN_00

IO port 5 pin 0.
BSP_I0_PORT 05 PIN 01 10 port 5 pin 1.
BSP_I0_PORT_05 PIN 02 10 port 5 pin 2.
BSP_IO_PORT_05_PIN_03 10 port 5 pin 3.
BSP_IO_PORT_05_PIN_04 |0 port 5 pin 4.
BSP_IO_PORT_05_PIN_05 |0 port 5 pin 5.
BSP_IO_PORT_05_PIN_06 10 port 5 pin 6.
BSP_IO_PORT_05_PIN_07 |0 port 5 pin 7.
BSP_IO_PORT_05_PIN_08 |0 port 5 pin 8.
BSP_IO_PORT_05_PIN_09 |0 port 5 pin 9.

BSP_|O_PORT_ 05 PIN_10

IO port 5 pin 10.

BSP_IO_PORT 05 PIN_ 11

IO port 5 pin 11.

BSP_10_PORT 05 PIN_12

IO port 5 pin 12.

BSP_IO_PORT 05 PIN 13

IO port 5 pin 13.

BSP_IO_PORT_05 PIN_14

IO port 5 pin 14.

BSP_IO_PORT 05 PIN_15

IO port 5 pin 15.

BSP_I0_PORT 06 _PIN_00

10 port 6 pin 0.
BSP_IO_PORT_06_PIN_01 10 port 6 pin 1.
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BSP_IO_PORT_06_PIN_02

IO port 6 pin 2.
BSP_|O_PORT_06_PIN_03 |0 port 6 pin 3.
BSP_IO_PORT_06_PIN_04 IO port 6 pin 4.
BSP_I0_PORT 06 _PIN_05 10 port 6 pin 5.
BSP_I0_PORT 06 _PIN_06 10 port 6 pin 6.
BSP_IO_PORT_06_PIN_07 |0 port 6 pin 7.
BSP_IO_PORT_06_PIN_08 IO port 6 pin 8.
BSP_I0_PORT 06 _PIN_09 10 port 6 pin 9.

BSP_IO_PORT 06 _PIN_ 10

IO port 6 pin 10.

BSP_IO_PORT 06 _PIN_ 11

IO port 6 pin 11.

BSP_I0_PORT 06 PIN_12

IO port 6 pin 12.

BSP_IO_PORT 06 _PIN 13

IO port 6 pin 13.

BSP_IO_PORT_06_PIN_14

IO port 6 pin 14.

BSP_IO_PORT 06_PIN_15

IO port 6 pin 15.

BSP_10_PORT 07_PIN_00

10 port 7 pin 0.
BSP_I0_PORT 07 _PIN 01 10 port 7 pin 1.
BSP_I0_PORT_07_PIN_ 02 10 port 7 pin 2.
BSP_IO_PORT_07_PIN_03 |0 port 7 pin 3.
BSP_IO_PORT_07_PIN_04 |0 port 7 pin 4.
BSP_I0_PORT 07 _PIN_05 10 port 7 pin 5.
BSP_I0_PORT 07 _PIN_06 10 port 7 pin 6.
BSP_IO_PORT_07_PIN_07 |0 port 7 pin 7.
BSP_IO_PORT_07_PIN_08 |0 port 7 pin 8.
BSP_I0_PORT_07_PIN_09 10 port 7 pin 9.
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BSP_IO_PORT_07_PIN_10

IO port 7 pin 10.

BSP_IO_PORT 07_PIN_11

IO port 7 pin 11.

BSP_10_PORT 07 PIN_12

IO port 7 pin 12.

BSP_IO_PORT_07_PIN_13

IO port 7 pin 13.

BSP_IO_PORT_07_PIN_14

IO port 7 pin 14.

BSP_IO_PORT 07_PIN_15

IO port 7 pin 15.

BSP_I0_PORT _08_PIN_00

IO port 8 pin 0.
BSP_I0_PORT 08 PIN 01 10 port 8 pin 1.
BSP_I0_PORT_08 PIN 02 10 port 8 pin 2.
BSP_IO_PORT_08 PIN_03 |0 port 8 pin 3.
BSP_IO_PORT_08_PIN_04 |0 port 8 pin 4.
BSP_IO_PORT_08_PIN_05 |0 port 8 pin 5.
BSP_IO_PORT_08_PIN_06 |0 port 8 pin 6.
BSP_IO_PORT_08 PIN_07 |0 port 8 pin 7.
BSP_IO_PORT_08 PIN_08 |0 port 8 pin 8.
BSP_IO_PORT_08_PIN_09 |0 port 8 pin 9.

BSP_|O_PORT 08 _PIN_10

IO port 8 pin 10.

BSP_|O_PORT 08_PIN 11

IO port 8 pin 11.

BSP_10_PORT 08_PIN_12

IO port 8 pin 12.

BSP_IO_PORT 08 _PIN 13

IO port 8 pin 13.

BSP_IO_PORT_08_PIN_14

IO port 8 pin 14.

BSP_IO_PORT 08_PIN_15

IO port 8 pin 15.

BSP_I0_PORT 09 PIN_00

10 port 9 pin 0.

BSP_IO_PORT_09 PIN_01

10 port 9 pin 1.
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BSP_IO_PORT_09 PIN_02

IO port 9 pin 2.
BSP_IO_PORT_09 PIN_03 |0 port 9 pin 3.
BSP_IO_PORT_09 PIN_04 IO port 9 pin 4.
BSP_I0_PORT 09 PIN_05 10 port 9 pin 5.
BSP_I0_PORT 09 PIN_06 10 port 9 pin 6.
BSP_IO_PORT_09 PIN_07 |0 port 9 pin 7.
BSP_IO_PORT_09 PIN_08 IO port 9 pin 8.
BSP_I0_PORT_09 PIN_09 10 port 9 pin 9.

BSP_|O_PORT 09 PIN_ 10

IO port 9 pin 10.

BSP_IO_PORT 09 PIN 11

IO port 9 pin 11.

BSP_10_PORT 09 PIN_12

IO port 9 pin 12.

BSP_IO_PORT 09 PIN 13

IO port 9 pin 13.

BSP_IO_PORT_09 PIN_14

IO port 9 pin 14.

BSP_IO_PORT 09 PIN_15

IO port 9 pin 15.

BSP_10_PORT 10 PIN_00

IO port 10 pin 0.

BSP_IO_PORT_10_PIN_01

IO port 10 pin 1.

BSP_IO_PORT_10_PIN_02

IO port 10 pin 2.

BSP_IO_PORT 10 _PIN_03

IO port 10 pin 3.

BSP_I0_PORT 10 PIN_04

IO port 10 pin 4.

BSP_IO_PORT 10 PIN_ 05

IO port 10 pin 5.

BSP_IO_PORT 10 _PIN 06

IO port 10 pin 6.

BSP_IO_PORT 10 _PIN_07

IO port 10 pin 7.

BSP_10_PORT 10 PIN_08

IO port 10 pin 8.

BSP_IO_PORT_ 10 _PIN_09

IO port 10 pin 9.
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BSP_IO_PORT_10_PIN_10

IO port 10 pin 10.

BSP_|O_PORT 10 PIN_11

IO port 10 pin 11.

BSP_10_PORT 10 PIN_12

|0 port 10 pin 12.

BSP_IO_PORT_10_PIN 13

IO port 10 pin 13.

BSP_IO_PORT_10_PIN_14

IO port 10 pin 14.

BSP_IO_PORT 10 _PIN_15

IO port 10 pin 15.

BSP_10_PORT 11 _PIN_00

0 port 11 pin 0.

BSP_IO_PORT_11_PIN_01

0 port 11 pin 1.

BSP_IO_PORT_11_PIN_02

IO port 11 pin 2.

BSP_|O_PORT 11 PIN_03

IO port 11 pin 3.

BSP_I0_PORT 11 PIN_04

0 port 11 pin 4.

BSP_IO_PORT_11_PIN_05

IO port 11 pin 5.

BSP_IO_PORT_11_PIN_06

IO port 11 pin 6.

BSP_|O_PORT 11 PIN_07

IO port 11 pin 7.

BSP_10_PORT 11 PIN_08

0 port 11 pin 8.

BSP_IO_PORT_11_PIN_09

IO port 11 pin 9.

BSP_IO_PORT_11_PIN_10

IO port 11 pin 10.

BSP_|0_PORT 11 PIN 11

IO port 11 pin 11.

BSP_10_PORT 11 PIN_12

10 port 11 pin 12.

BSP_IO_PORT 11 PIN 13

IO port 11 pin 13.

BSP_IO_PORT_11_PIN_14

IO port 11 pin 14.

BSP_IO_PORT 11 PIN_15

IO port 11 pin 15.

BSP_10_PORT 12_PIN_00

0 port 12 pin 0.

BSP_IO_PORT_12_PIN_01

IO port 12 pin 1.
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BSP_IO_PORT_12_PIN_02

IO port 12 pin 2.

BSP_IO_PORT 12 _PIN_03

IO port 12 pin 3.

BSP_I0_PORT 12_PIN_04

0 port 12 pin 4.

BSP_IO_PORT_12_PIN_05

IO port 12 pin 5.

BSP_IO_PORT_12_PIN_06

IO port 12 pin 6.

BSP_IO_PORT 12 _PIN_07

IO port 12 pin 7.

BSP_10_PORT 12_PIN_08

IO port 12 pin 8.

BSP_IO_PORT_12_PIN_09

IO port 12 pin 9.

BSP_IO_PORT_12_PIN_10

IO port 12 pin 10.

BSP_|O_PORT 12_PIN_11

IO port 12 pin 11.

BSP_10_PORT 12 PIN_12

10 port 12 pin 12.

BSP_IO_PORT_12_PIN 13

IO port 12 pin 13.

BSP_IO_PORT_12_PIN_14

IO port 12 pin 14.

BSP_IO_PORT 12 PIN_15

IO port 12 pin 15.

BSP_10_PORT 13 _PIN_00

IO port 13 pin 0.

BSP_IO_PORT_13_PIN_01

IO port 13 pin 1.

BSP_IO_PORT_13_PIN_02

IO port 13 pin 2.

BSP_IO_PORT 13_PIN_03

IO port 13 pin 3.

BSP_I0_PORT 13_PIN_04

IO port 13 pin 4.

BSP_IO_PORT 13 _PIN 05

IO port 13 pin 5.

BSP_IO_PORT 13 _PIN_06

IO port 13 pin 6.

BSP_IO_PORT 13_PIN_07

IO port 13 pin 7.

BSP_10_PORT 13 _PIN_08

IO port 13 pin 8.

BSP_IO_PORT 13 _PIN_09

IO port 13 pin 9.
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BSP_IO_PORT_13_PIN_10

IO port 13 pin 10.

BSP_|O_PORT 13 PIN_11

IO port 13 pin 11.

BSP_10_PORT 13 PIN_12

10 port 13 pin 12.

BSP_IO_PORT_13_PIN 13

|0 port 13 pin 13.

BSP_IO_PORT_13_PIN_14

IO port 13 pin 14.

BSP_IO_PORT 13_PIN_15

IO port 13 pin 15.

BSP_10_PORT 14 PIN_00

IO port 14 pin 0.

BSP_IO_PORT_14_PIN_01

IO port 14 pin 1.

BSP_IO_PORT_14_PIN_02

IO port 14 pin 2.

BSP_IO_PORT 14 PIN_03

IO port 14 pin 3.

BSP_I0_PORT 14 PIN_04

|0 port 14 pin 4.

BSP_IO_PORT 14 PIN 05

IO port 14 pin 5.

BSP_IO_PORT 14 PIN 06

IO port 14 pin 6.

BSP_IO_PORT 14 _PIN_07

IO port 14 pin 7.

BSP_10_PORT 14 PIN_08

IO port 14 pin 8.

BSP_IO_PORT 14 PIN_09

IO port 14 pin 9.

BSP_IO_PORT_ 14 PIN_10

IO port 14 pin 10.

BSP_|O_PORT 14 PIN_ 11

IO port 14 pin 11.

BSP_10_PORT 14 PIN_12

|0 port 14 pin 12.

BSP_IO_PORT 14 PIN 13

IO port 14 pin 13.

BSP_IO_PORT_ 14 PIN_14

IO port 14 pin 14.

BSP_IO_PORT 14 PIN_15

IO port 14 pin 15.

Function Documentation
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¢ R_BSP_PinRead()

__STATIC_INLINE uint32_t R_BSP_PinRead ( bsp_io_port_pin_t pin)

Read the current input level of the pin.

Parameters

[in] pin The pin

Return values

Current input level

4 R_BSP_PinWrite()

__STATIC_INLINE void R_BSP_PinWrite ( bsp_io_port pin_t pin, bsp_io_level t level )

Set a pin to output and set the output level to the level provided. If PFS protection is enabled,
disable PFS protection using R_BSP_PinAccessEnable() before calling this function.

Parameters
[in] pin The pin
[in] level The level

¢ R_BSP_PinCfg()

__STATIC_INLINE void R_BSP_PinCfg ( bsp_io_port_pin_t pin, uint32_t cfg )

Configure a pin. If PFS protection is enabled, disable PFS protection using R_BSP_PinAccessEnable()
before calling this function.

Parameters
[in] pin The pin
[in] cfg Configuration for the pin
(PmnPFS register setting)

¢ R_BSP_PinAccessEnable()

__STATIC_INLINE void R_BSP_PinAccessEnable ( void )

Enable access to the PFS registers. Uses a reference counter to protect against interrupts that
could occur via multiple threads or an ISR re-entering this code.
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¢ R_BSP_PinAccessDisable()

__STATIC_INLINE void R_BSP_PinAccessDisable ( void )

Disable access to the PFS registers. Uses a reference counter to protect against interrupts that
could occur via multiple threads or an ISR re-entering this code.

5.1.2 Common Error Codes
BSP

Detailed Description

All FSP modules share these common error codes.

Macros

#define FSP_PARAMETER_NOT_USED(p)
#define FSP_CPP_HEADER

#define FSP_HEADER

#define FSP_SECURE_ARGUMENT

Enumerations

enum fsp_err_t

Macro Definition Documentation

¢ FSP_PARAMETER_NOT _USED

#define FSP_PARAMETER_NOT _USED ( p)

This macro is used to suppress compiler messages about a parameter not being used in a function.
The nice thing about using this implementation is that it does not take any extra RAM or ROM.

& FSP_CPP_HEADER

#define FSP_CPP_HEADER

Determine if a C++ compiler is being used. If so, ensure that standard C is used to process the API
information.
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¢ FSP_HEADER

#define FSP_HEADER

FSP Header and Footer definitions

& FSP_SECURE_ARGUMENT

#define FSP_SECURE_ARGUMENT

Macro to be used when argument to function is ignored since function call is NSC and the
parameter is statically defined on the Secure side.

Enumeration Type Documentation

¢ fsp_err_t

enum fsp_err_t

Common error codes

Enumerator

FSP_ERR_ASSERTION

A critical assertion has failed.

FSP_ERR_INVALID_POINTER

Pointer points to invalid memory location.

FSP_ERR_INVALID_ARGUMENT

Invalid input parameter.

FSP_ERR_INVALID_CHANNEL

Selected channel does not exist.

FSP_ERR_INVALID_MODE

Unsupported or incorrect mode.

FSP_ERR_UNSUPPORTED

Selected mode not supported by this API.

FSP_ERR_NOT OPEN

Requested channel is not configured or API not
open.

FSP_ERR_IN_USE

Channel/peripheral is running/busy.

FSP_ERR_OUT_OF_MEMORY

Allocate more memory in the driver's cfg.h.

FSP_ERR_HW_LOCKED

Hardware is locked.

FSP_ERR_IRQ_BSP_DISABLED

IRQ not enabled in BSP.

FSP_ERR_OVERFLOW

Hardware overflow.

FSP_ERR_UNDERFLOW
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Hardware underflow.

FSP_ERR_ALREADY OPEN

Requested channel is already open in a
different configuration.

FSP_ERR_APPROXIMATION

Could not set value to exact result.

FSP_ERR_CLAMPED

Value had to be limited for some reason.

FSP_ERR_INVALID_RATE

Selected rate could not be met.

FSP_ERR_ABORTED An operation was aborted.

FSP_ERR_NOT_ENABLED Requested operation is not enabled.

FSP_ERR_TIMEOUT Timeout error.

FSP_ERR_INVALID_BLOCKS Invalid number of blocks supplied.

FSP_ERR_INVALID_ADDRESS Invalid address supplied.

FSP_ERR_INVALID_SIZE Invalid size/length supplied for operation.

FSP_ERR_WRITE_FAILED Write operation failed.

FSP_ERR_ERASE_FAILED Erase operation failed.

FSP_ERR_INVALID_CALL Invalid function call is made.

FSP_ERR_INVALID_HW_CONDITION Detected hardware is in invalid condition.

FSP_ERR_INVALID_FACTORY_FLASH Factory flash is not available on this MCU.

FSP_ERR_INVALID_STATE API or command not valid in the current state.

FSP_ERR_NOT_ERASED Erase verification failed.

FSP_ERR_SECTOR_RELEASE_FAILED Sector release failed.

FSP_ERR_NOT_INITIALIZED Required initialization not complete.

FSP_ERR_NOT_FOUND The requested item could not be found.

FSP_ERR_NO_CALLBACK_MEMORY Non-secure callback memory not provided for

non-secure callback.

FSP_ERR_BUFFER_EMPTY No data available in buffer.

FSP_ERR_INVALID_DATA

Accuracy of data is not guaranteed.
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FSP_ERR_INTERNAL Internal error.

FSP_ERR_WAIT_ABORTED Wait aborted.

FSP_ERR_FRAMING Framing error occurs.

FSP_ERR_BREAK_DETECT Break signal detects.

FSP_ERR_PARITY Parity error occurs.

FSP_ERR_RXBUF_OVERFLOW Receive queue overflow.

FSP_ERR_QUEUE_UNAVAILABLE Can't open s/w queue.

FSP_ERR_INSUFFICIENT_SPACE Not enough space in transmission circular

buffer.

FSP_ERR_INSUFFICIENT_DATA Not enough data in receive circular buffer.

FSP_ERR_TRANSFER_ABORTED The data transfer was aborted.

FSP_ERR_MODE_FAULT Mode fault error.

FSP_ERR_READ_OVERFLOW Read overflow.

FSP_ERR_SPI_PARITY Parity error.

FSP_ERR_OVERRUN Overrun error.

FSP_ERR_CLOCK_INACTIVE Inactive clock specified as system clock.

FSP_ERR_CLOCK_ACTIVE Active clock source cannot be modified without

stopping first.

FSP_ERR_NOT_STABILIZED Clock has not stabilized after its been turned
on/off.

FSP_ERR_PLL_SRC_INACTIVE PLL initialization attempted when PLL source is
turned off.

FSP_ERR_OSC_STOP_DET_ENABLED lllegal attempt to stop LOCO when Oscillation
stop is enabled.

FSP_ERR_OSC_STOP_DETECTED The Oscillation stop detection status flag is
set.

FSP_ERR_OSC_STOP_CLOCK_ACTIVE Attempt to clear Oscillation Stop Detect Status

with PLL/MAIN_OSC active.
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FSP_ERR_CLKOUT_EXCEEDED

Output on target output clock pin exceeds
maximum supported limit.

FSP_ERR_USB_MODULE_ENABLED

USB clock configure request with USB Module
enabled.

FSP_ERR_HARDWARE_TIMEOUT

A register read or write timed out.

FSP_ERR_LOW_VOLTAGE_MODE

Invalid clock setting attempted in low voltage
mode.

FSP_ERR_PE_FAILURE

Unable to enter Programming mode.

FSP_ERR_CMD _LOCKED

Peripheral in command locked state.

FSP_ERR_FCLK

FCLK must be >= 4 MHz.

FSP_ERR_INVALID_LINKED_ADDRESS

Function or data are linked at an invalid region
of memory.

FSP_ERR_BLANK_CHECK_FAILED

Blank check operation failed.

FSP_ERR_INVALID_CAC_REF_CLOCK

Measured clock rate < reference clock rate.

FSP_ERR_INVALID_RESULT

The result of one or more calculations was +/-
infinity.

FSP_ERR_CLOCK_GENERATION

Clock cannot be specified as system clock.

FSP_ERR_INVALID_TIMING_SETTING

Invalid timing parameter.

FSP_ERR_INVALID_LAYER SETTING

Invalid layer parameter.

FSP_ERR_INVALID_ALIGNMENT

Invalid memory alignment found.

FSP_ERR_INVALID_GAMMA_SETTING

Invalid gamma correction parameter.

FSP_ERR_INVALID_LAYER_FORMAT

Invalid color format in layer.

FSP_ERR_INVALID_UPDATE_TIMING

Invalid timing for register update.

FSP_ERR_INVALID_CLUT ACCESS

Invalid access to CLUT entry.

FSP_ERR_INVALID_FADE_SETTING

Invalid fade-in/fade-out setting.

FSP_ERR_INVALID_BRIGHTNESS_SETTING

Invalid gamma correction parameter.

FSP_ERR_JPEG_ERR

JPEG error.
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FSP_ERR _JPEG_SOI_NOT_DETECTED

SOl not detected until EOl detected.

FSP_ERR_JPEG_SOF1_TO_SOFF _DETECTED

SOF1 to SOFF detected.

FSP_ERR_JPEG_UNSUPPORTED_PIXEL_FORMAT

Unprovided pixel format detected.

FSP_ERR_JPEG_SOF _ACCURACY_ERROR

SOF accuracy error: other than 8 detected.

FSP_ERR_JPEG_DQT_ACCURACY_ERROR

DQT accuracy error: other than 0 detected.

FSP_ERR_JPEG_COMPONENT_ERROR1

Component error 1: the number of SOF0
header components detected is other than 1,
3, or4.

FSP_ERR_JPEG_COMPONENT_ERROR2

Component error 2: the number of components
differs between SOF0 header and SOS.

FSP_ERR_JPEG_SOF0_DQT DHT NOT DETECTED

SOFO0, DQT, and DHT not detected when SOS
detected.

FSP_ERR_JPEG_SOS_NOT DETECTED

SOS not detected: SOS not detected until EOI
detected.

FSP_ERR_JPEG_EOI_NOT_DETECTED

EOI not detected (default)

FSP_ERR JPEG_RESTART_INTERVAL DATA_NUMB
ER_ERROR

Restart interval data number error detected.

FSP_ERR_JPEG_IMAGE_SIZE_ERROR

Image size error detected.

FSP_ERR JPEG_LAST_MCU_DATA_NUMBER_ERRO
R

Last MCU data number error detected.

FSP_ERR_JPEG_BLOCK_DATA_NUMBER_ERROR

Block data number error detected.

FSP_ERR_JPEG_BUFFERSIZE_NOT_ENOUGH

User provided buffer size not enough.

FSP_ERR_JPEG_UNSUPPORTED_IMAGE_SIZE

JPEG Image size is not aligned with MCU.

FSP_ERR_CALIBRATE_FAILED

Calibration failed.

FSP_ERR_IIRFA_ECC_1BIT

1-bit ECC error detected

FSP_ERR_IIRFA_ECC_2BIT

2-bit ECC error detected

FSP_ERR_IP_HARDWARE_NOT _PRESENT

Requested IP does not exist on this device.

FSP_ERR_IP_UNIT_NOT_PRESENT

Requested unit does not exist on this device.

FSP_ERR_IP_CHANNEL_NOT PRESENT

Requested channel does not exist on this
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device.

FSP_ERR_NO_MORE_BUFFER No more buffer found in the memory block

pool.

FSP_ERR_ILLEGAL_BUFFER_ADDRESS Buffer address is out of block memory pool.

FSP_ERR_INVALID_WORKBUFFER_SIZE Work buffer size is invalid.

FSP_ERR_INVALID_MSG_BUFFER_SIZE Message buffer size is invalid.

FSP_ERR_TOO_MANY_BUFFERS Number of buffer is too many.

FSP_ERR_NO_SUBSCRIBER_FOUND No message subscriber found.

FSP_ERR_MESSAGE_QUEUE_EMPTY No message found in the message queue.

FSP_ERR_MESSAGE_QUEUE_FULL No room for new message in the message

queue.

FSP_ERR_ILLEGAL_SUBSCRIBER_LISTS Message subscriber lists is illegal.

FSP_ERR_BUFFER_RELEASED Buffer has been released.

FSP_ERR_D2D_ERROR_INIT D/AVE 2D has an error in the initialization.

FSP_ERR_D2D_ERROR_DEINIT D/AVE 2D has an error in the initialization.

FSP_ERR_D2D_ERROR_RENDERING D/AVE 2D has an error in the rendering.

FSP_ERR_D2D_ERROR_SIZE D/AVE 2D has an error in the rendering.

FSP_ERR_ETHER_ERROR_NO_DATA No Data in Receive buffer.

FSP_ERR_ETHER_ERROR_LINK ETHERC/EDMAC has an error in the Auto-
negotiation.

FSP_ERR_ETHER_ERROR_MAGIC_PACKET_MODE As a Magic Packet is being detected, and

transmission/reception is not enabled.

FSP_ERR_ETHER_ERROR_TRANSMIT BUFFER FUL

L Transmit buffer is not empty.

FSP_ERR_ETHER_ERROR_FILTERING Detect multicast frame when multicast frame

filtering enable.

FSP_ERR_ETHER_ERROR_PHY_COMMUNICATION ETHERC/EDMAC has an error in the phy
communication.

FSP_ERR_ETHER_RECEIVE_BUFFER_ACTIVE Receive buffer is active.
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FSP_ERR_ETHER_PHY_ERROR_LINK

PHY is not link up.

FSP_ERR_ETHER _PHY_NOT_READY

PHY has an error in the Auto-negotiation.

FSP_ERR_QUEUE_FULL

Queue is full, cannot queue another data.

FSP_ERR_QUEUE_EMPTY

Queue is empty, no data to dequeue.

FSP_ERR_CTSU_SCANNING

Scanning.

FSP_ERR_CTSU_NOT_GET_DATA

Not processed previous scan data.

FSP_ERR_CTSU_INCOMPLETE_TUNING

Incomplete initial offset tuning.

FSP_ERR_CTSU_DIAG_NOT_YET

Diagnosis of data collected no yet.

FSP_ERR_CTSU_DIAG_LDO_OVER_VOLTAGE

Diagnosis of LDO over voltage failed.

FSP_ERR_CTSU_DIAG_CCO_HIGH

Diagnosis of CCO into 19.2uA failed.

FSP_ERR_CTSU_DIAG_CCO_LOW

Diagnosis of CCO into 2.4uA failed.

FSP_ERR_CTSU_DIAG_SSCG

Diagnosis of SSCG frequency failed.

FSP_ERR_CTSU_DIAG_DAC

Diagnosis of non-touch count value failed.

FSP_ERR_CTSU_DIAG_OUTPUT VOLTAGE

Diagnosis of LDO output voltage failed.

FSP_ERR_CTSU_DIAG_OVER_VOLTAGE

Diagnosis of over voltage detection circuit
failed.

FSP_ERR_CTSU_DIAG_OVER_CURRENT

Diagnosis of over current detection circuit
failed.

FSP_ERR_CTSU_DIAG_LOAD_RESISTANCE

Diagnosis of LDO internal resistance value
failed.

FSP_ERR_CTSU DIAG_CURRENT SOURCE

Diagnosis of Current source value failed.

FSP_ERR_CTSU_DIAG_SENSCLK_GAIN

Diagnosis of SENSCLK frequency gain failed.

FSP_ERR_CTSU_DIAG_SUCLK_GAIN

Diagnosis of SUCLK frequency gain failed.

FSP_ERR_CTSU DIAG CLOCK_RECOVERY

Diagnosis of SUCLK clock recovery function
failed.

FSP_ERR_CTSU DIAG_CFC_GAIN

Diagnosis of CFC oscillator gain failed.

FSP_ERR_CARD_INIT_FAILED
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SD card or eMMC device failed to initialize.

FSP_ERR_CARD_NOT INSERTED

SD card not installed.

FSP_ERR_DEVICE_BUSY

Device is holding DATO low or another
operation is ongoing.

FSP_ERR_CARD_NOT_INITIALIZED

SD card was removed.

FSP_ERR_CARD_WRITE_PROTECTED

Media is write protected.

FSP_ERR_TRANSFER_BUSY

Transfer in progress.

FSP_ERR_RESPONSE

Card did not respond or responded with an
error.

FSP_ERR_MEDIA_FORMAT_FAILED

Media format failed.

FSP_ERR_MEDIA_OPEN_FAILED

Media open failed.

FSP_ERR_CAN_DATA UNAVAILABLE

No data available.

FSP_ERR_CAN_MODE_SWITCH_FAILED

Switching operation modes failed.

FSP_ERR_CAN_INIT_FAILED

Hardware initialization failed.

FSP_ERR_CAN_TRANSMIT NOT READY

Transmit in progress.

FSP_ERR_CAN_RECEIVE_MAILBOX

Mailbox is setup as a receive mailbox.

FSP_ERR_CAN_TRANSMIT_MAILBOX

Mailbox is setup as a transmit mailbox.

FSP_ERR_CAN_MESSAGE_LOST

Receive message has been overwritten or
overrun.

FSP_ERR_CAN_TRANSMIT FIFO_FULL

Transmit FIFO is full.

FSP_ERR_WIFI_CONFIG_FAILED

WiFi module Configuration failed.

FSP_ERR_WIFI_INIT_FAILED

WiFi module initialization failed.

FSP_ERR_WIFI_TRANSMIT_FAILED

Transmission failed.

FSP_ERR_WIFI_INVALID_MODE

API called when provisioned in client mode.

FSP_ERR_WIFI_FAILED

WiFi Failed.

FSP_ERR_WIFI_SCAN_COMPLETE

Wifi scan has completed.
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FSP_ERR_WIFI_AP_NOT_CONNECTED

WiFi module is not connected to access point.

FSP_ERR_WIFI_UNKNOWN_AT_CMD

DA16200 Unknown AT command Error.

FSP_ERR_WIFI_INSUF_PARAM

DA16200 Insufficient parameter.

FSP_ERR_WIFI_TOO_MANY_PARAMS

DA16200 Too many parameters.

FSP_ERR_WIFI_INV_PARAM VAL

DA16200 Wrong parameter value.

FSP_ERR_WIFI_NO_RESULT

DA16200 No result.

FSP_ERR_WIFI_RSP_BUF OVFLW

DA16200 Response buffer overflow.

FSP_ERR_WIFI_FUNC_NOT_CONFIG

DA16200 Function is not configured.

FSP_ERR_WIFI_NVRAM_WR_FAIL

DA16200 NVRAM write failure.

FSP_ERR_WIFI_RET_MEM_WR_FAIL

DA16200 Retention memory write failure.

FSP_ERR_WIFI_UNKNOWN_ERR

DA16200 unknown error.

FSP_ERR_CELLULAR_CONFIG_FAILED

Cellular module Configuration failed.

FSP_ERR_CELLULAR_INIT_FAILED

Cellular module initialization failed.

FSP_ERR_CELLULAR_TRANSMIT_FAILED

Transmission failed.

FSP_ERR_CELLULAR_FW _UPTODATE

Firmware is uptodate.

FSP_ERR_CELLULAR_FW_UPGRADE_FAILED

Firmware upgrade failed.

FSP_ERR_CELLULAR_FAILED

Cellular Failed.

FSP_ERR_CELLULAR_INVALID STATE

API Called in invalid state.

FSP_ERR_CELLULAR_REGISTRATION_FAILED

Cellular Network registration failed.

FSP_ERR_BLE_FAILED

BLE operation failed.

FSP_ERR_BLE_INIT_FAILED

BLE device initialization failed.

FSP_ERR_BLE_CONFIG_FAILED

BLE device configuration failed.

FSP_ERR_BLE_PRF_ALREADY ENABLED

BLE device Profile already enabled.

FSP_ERR_BLE_PRF_NOT_ENABLED

BLE device not enabled.
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FSP_ERR_BLE_ABS_INVALID_OPERATION

Invalid operation is executed.

FSP_ERR_BLE_ABS_NOT_FOUND

Valid data or free space is not found.

FSP_ERR_CRYPTO_CONTINUE

Continue executing function.

FSP_ERR_CRYPTO_SCE_RESOURCE_CONFLICT

Hardware resource busy.

FSP_ERR_CRYPTO_SCE_FAIL

Internal 1/O buffer is not empty.

FSP_ERR_CRYPTO_SCE_HRK_INVALID_INDEX

Invalid index.

FSP_ERR_CRYPTO_SCE_RETRY

Retry.

FSP_ERR_CRYPTO_SCE_VERIFY_FAIL

Verify is failed.

FSP_ERR_CRYPTO_SCE_ALREADY_OPEN

HW SCE module is already opened.

FSP_ERR_CRYPTO_NOT OPEN

Hardware module is not initialized.

FSP_ERR_CRYPTO_UNKNOWN

Some unknown error occurred.

FSP_ERR_CRYPTO_NULL_POINTER

Null pointer input as a parameter.

FSP_ERR_CRYPTO_NOT_IMPLEMENTED

Algorithm/size not implemented.

FSP_ERR_CRYPTO_RNG_INVALID_PARAM

An invalid parameter is specified.

FSP_ERR_CRYPTO RNG_FATAL ERROR

A fatal error occurred.

FSP_ERR_CRYPTO_INVALID_SIZE

Size specified is invalid.

FSP_ERR_CRYPTO_INVALID_STATE

Function used in an valid state.

FSP_ERR_CRYPTO_ALREADY_OPEN

control block is already opened

FSP_ERR_CRYPTO_INSTALL_KEY FAILED

Specified input key is invalid.

FSP_ERR_CRYPTO_AUTHENTICATION_FAILED

Authentication failed.

FSP_ERR_CRYPTO_SCE_KEY_SET FAIL

Failure to Init Cipher.

FSP_ERR_CRYPTO_SCE_AUTHENTICATION

Authentication failed.

FSP_ERR_CRYPTO_SCE_PARAMETER

Input date is illegal.

FSP_ERR_CRYPTO_SCE_PROHIBIT_FUNCTION

An invalid function call occurred.
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FSP_ERR_CRYPTO_RSIP_RESOURCE_CONFLICT

Hardware resource is busy.

FSP_ERR_CRYPTO_RSIP_FATAL

Hardware fatal error or unexpected return.

FSP_ERR_CRYPTO_RSIP_FAIL

Internal error.

FSP_ERR_CRYPTO_RSIP_KEY_SET FAIL

Input key type is illegal.

FSP_ERR_CRYPTO_RSIP_AUTHENTICATION

Authentication failed.

FSP_ERR_CRYPTO_COMMON_NOT OPENED

Crypto Framework Common is not opened.

FSP_ERR_CRYPTO_HAL_ERROR

Cryoto HAL module returned an error.

FSP_ERR_CRYPTO_KEY_BUF_NOT_ENOUGH

Key buffer size is not enough to generate a
key.

FSP_ERR_CRYPTO_BUF_OVERFLOW

Attempt to write data larger than what the
buffer can hold.

FSP_ERR_CRYPTO_INVALID_OPERATION_MODE

Invalid operation mode.

FSP_ERR_MESSAGE_TOO_LONG

Message for RSA encryption is too long.

FSP_ERR_RSA DECRYPTION_ERROR

RSA Decryption error.

FSP_ERR_SENSOR_INVALID_DATA

Data is invalid.

Note
S=_CRYPTO APIs may return an error code
starting from 0x10000 which is of Crypto module.
Refer to sf_cryoto_err.h for Crypto error codes.

FSP_ERR_SENSOR_IN_STABILIZATION

Sensor is stabilizing.

FSP_ERR_SENSOR_MEASUREMENT_NOT_FINISHE
D

Measurement is not finished.

FSP_ERR_COMMS_BUS_NOT OPEN

Bus is not open.

5.1.3 MCU Board Support Package
BSP

Functions

fsp_err t

R_FSP_VersionGet (fsp_pack_version_t *const p_version)
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BSP_SECTION_FLASH_GAP Systemlnit (void)
void

void R_BSP_WarmStart (bsp_warm_start_event_t event)
void Reset Handler (void)

void Default Handler (void)

void NMI_Handler (void)

BSP_SECTION_FLASH_GAP R_BSP_RegisterProtectEnable (bsp_reg protect t regs_to_protect)
void

BSP_SECTION_FLASH GAP R_BSP_RegisterProtectDisable (bsp_reg protect t regs_to_unprotect)
void

BSP_SECTION _FLASH GAP R _BSP IrgClearPending (IRQn_Type irq)
void

BSP_SECTION_FLASH_GAP R_BSP_IrgCfg (IRQn_Type const irg, uint32_t priority, void
void *p_context)

BSP_SECTION_FLASH GAP R _BSP_IrgEnableNoClear (IRQn_Type const irq)
void

BSP_SECTION_FLASH GAP R BSP_IrgEnable (IRQn_Type const irq)
void

BSP_SECTION_FLASH GAP R BSP IrgDisable (IRQn_Type const irqg)
void

BSP_SECTION_FLASH GAP R _BSP_IrgCfgEnable (IRQn_Type const irq, uint32_t priority, void
void *p_context)

uint32_ t R _BSP_SourceClockHzGet (fsp_priv_source clock t clock)
__ STATIC_INLINE IRQn_Type R_FSP_CurrentlrgGet (void)
__ STATIC_INLINE uint32 t R_FSP SystemClockHzGet (fsp_priv_clock t clock)
__STATIC_INLINE uint32_t R _FSP_ClockDividerGet (uint32_t ckdivcr)

__STATIC_INLINE R_BSP_UniqueldGet (void)
bsp_unique_id_t const *

__STATIC_INLINE void R_BSP_FlashCacheDisable (void)

__STATIC_INLINE void R_BSP_FlashCacheEnable (void)
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BSP_SECTION_FLASH GAP R _BSP SoftwareDelay (uint32_t delay, bsp_delay units_t units)
void

BSP_SECTION_FLASH GAP R _BSP_GrouplrqWrite (bsp_grp_irq_t irq,
fsp_err t void(*p_callback)(bsp_grp_irg_t irq))

Detailed Description

The BSP is responsible for getting the MCU from reset to the user's application. Before reaching the
user's application, the BSP sets up the stacks, heap, clocks, interrupts, C runtime environment, and
stack monitor.

e BSP Features

e BSP Clock Configuration

e System Interrupts

Group Interrupts

External and Peripheral Interrupts

Error Logging

BSP Weak Symbols

Warm Start Callbacks

Sub Clock Stabilization Wait Callback

C Runtime Initialization

Register Protection

ID Codes

TrustZone Security Attribution Registers
Software Delay

Trignometric Function

Digital Signal Processing with 32-bit Multiply-Accumulator
Octal-SPI Clock Update

Limited D-Cache Support

Non-Cacheable Buffer Placement Example
Configuration

Overview

BSP Features
BSP Clock Configuration

All system clocks are set up during BSP initialization based on the settings in bsp_clock cfg.h. These
settings are derived from clock configuration information provided from the RA Configuration editor
Clocks tab.

e Clock configuration is performed prior to initializing the C runtime environment to speed up
the startup process, as it is possible to start up on a relatively slow (that is, 32 kHz) clock.

e The BSP implements the required delays to allow the selected clock to stabilize.

e The BSP will configure the CMSIS SystemCoreClock variable after clock initialization with the
current system clock frequency.

System Interrupts
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As RA MCUs are based on the Arm Cortex-M architecture, the NVIC Nested Vectored Interrupt
Controller (NVIC) handles exceptions and interrupt configuration, prioritization and interrupt
masking. In the Arm architecture, the NVIC handles exceptions. Some exceptions are known as
System Exceptions. System exceptions are statically located at the "top" of the vector table and
occupy vector numbers 1 to 15. Vector zero is reserved for the MSP Main Stack Pointer (MSP). The
remaining 15 system exceptions are shown below:

Reset

NMI

Cortex-M4 Hard Fault Handler
Cortex-M4 MPU Fault Handler
Cortex-M4 Bus Fault Handler
Cortex-M4 Usage Fault Handler
Reserved

Reserved

Reserved

Reserved

Cortex-M4 SVCall Handler

Cortex-M4 Debug Monitor Handler

Reserved
Cortex-M4 PendSV Handler
Cortex-M4 SysTick Handler

NMI and Hard Fault exceptions are enabled out of reset and have fixed priorities. Other exceptions
have configurable priorities and some can be disabled.

Group Interrupts

Group interrupt is the term used to describe the 12 sources that can trigger the Non-Maskable
Interrupt (NMI). When an NMI occurs the NMI Handler examines the NMISR (status register) to
determine the source of the interrupt. NMI interrupts take precedence over all interrupts, are usable
only as CPU interrupts, and cannot activate the RA peripherals Data Transfer Controller (DTC) or

Direct Memory Access Controller (DMAC).

Possible group interrupt sources include:

IWDT Underflow/Refresh Error
WDT Underflow/Refresh Error
Voltage-Monitoring 1 Interrupt
Voltage-Monitoring 2 Interrupt
VBATT monitor Interrupt
Oscillation Stop is detected
NMI pin

RAM Parity Error

RAM ECC Error

MPU Bus Slave Error

MPU Bus Master Error

MPU Stack Error

TrustZone Filter Error A user may enable notification for one or more group interrupts by
registering a callback using the BSP API function R_BSP_GrouplrgWrite(). When an NMI
interrupt occurs, the NMI handler checks to see if there is a callback registered for the
cause of the interrupt and if so calls the registered callback function.

External and Peripheral Interrupts
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User configurable interrupts begin with slot 16. These may be external, or peripheral generated
interrupts.

Although the number of available slots for the NVIC interrupt vector table may seem small, the BSP
defines up to 512 events that are capable of generating an interrupt. By using Event Mapping, the
BSP maps user-enabled events to NVIC interrupts. For an RA6M3 MCU, only 96 of these events may
be active at any one time, but the user has flexibility by choosing which events generate the active
event.

By allowing the user to select only the events they are interested in as interrupt sources, we are able
to provide an interrupt service routine that is fast and event specific.

For example, on other microcontrollers a standard NVIC interrupt vector table might contain a single
vector entry for the SCIO (Serial Communications Interface) peripheral. The interrupt service routine
for this would have to check a status register for the 'real' source of the interrupt. In the RA
implementation there is a vector entry for each of the SCI0O events that we are interested in.

BSP Weak Symbols

You might wonder how the BSP is able to place ISR addresses in the NVIC table without the user
having explicitly defined one. All that is required by the BSP is that the interrupt event be given a
priority.

This is accomplished through the use of the 'weak' attribute. The weak attribute causes the
declaration to be emitted as a weak symbol rather than a global. A weak symbol is one that can be
overridden by an accompanying strong reference with the same name. When the BSP declares a
function as weak, user code can define the same function and it will be used in place of the BSP
function. By defining all possible interrupt sources as weak, the vector table can be built at compile
time and any user declarations (strong references) will be used at runtime.

Weak symbols are supported for ELF targets and also for a.out targets when using the GNU
assembler and linker.

Note that in CMSIS system.c, there is also a weak definition (and a function body) for the Warm Start
callback function R_BSP_WarmStart(). Because this function is defined in the same file as the weak
declaration, it will be called as the 'default' implementation. The function may be overridden by the
user by copying the body into their user application and modifying it as necessary. The linker
identifies this as the 'strong' reference and uses it.

Warm Start Callbacks

As the BSP is in the process of bringing up the board out of reset, there are three points where the
user can request a callback. These are defined as the 'Pre Clock Init', 'Post Clock Init' and 'Post C'
warm start callbacks.

As described above, this function is already weakly defined as R_BSP_WarmStart(), so it is a simple
matter of redefining the function or copying the existing body from CMSIS system.c into the
application code to get a callback. R_BSP_WarmStart() takes an event parameter of type
bsp_warm_start_event t which describes the type of warm start callback being made.

This function is not enabled/disabled and is always called for both events as part of the BSP startup.
Therefore it needs a function body, which will not be called if the user is overriding it. The function
body is located in system.c. To use this function just copy this function into your own code and
modify it to meet your needs.
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Sub Clock Stabilization Wait Callback

When Sub-Clock oscillator is populated in the application, the BSP startup code waits for some
time(sub-clock stabilization time) to allow Sub-clock to stabilize. Enabling the watchdog (IWDT or
WDT) timer with Auto start mode in an application using Sub-clock may cause system to generate
Reset or NMI interrupt before reaching the application code if watchdog refresh register is not
updated in the configured refresh Window. To overcome this problem a weakly defined callback
R_BSP_SubClockStabilizeWait() can be overridden. Redefine the callback function in the application
code and add code to update the watchdog refresh register. R_BSP_SubClockStabilizeWait() takes a
parameter delay of type uint32_t which describes the time in milliseconds required to stabilize the
sub-clock.

Sub Clock Stabilization Wait After Reset callback

After Power-On-Reset, the BSP startup code may have to wait for some time(sub-clock stabilization
time) to allow Sub-clock to stabilize. This can cause problem to RTC in case device is to be reset
frequently. If Sub-Clock registers are not initialized during a reset, BSP actually does not have to wait
for Sub-clock to stabilize. To overcome this problem, a weakly defined callback
R_BSP_SubClockStabilizeWaitAfterReset() is provided. Reimplement the callback function in the
application code to determine whether BSP has to wait for stabilization time based on the current
reset type. R_BSP_SubClockStabilizeWaitAfterReset() takes a parameter delay of type uint32_t which
describes the time in milliseconds required to stabilize the sub-clock.

C Runtime Initialization

This BSP configuration allows the user to skip the FSP C runtime initialization code by setting the "C
Runtime Initialization" to "Disabled" on the BSP tab of the RA Configuration editor. Disabling this
option is useful in cases where a non-standard linker script is being used or other modifications to
the runtime initialization are desired. If this macro is disabled, the user must use the 'Post Clock Init'
event from the warm start (described above) to run their own runtime initialization code.

Heap Allocation

The relatively low amount of on-chip SRAM available and lack of memory protection in an MCU
means that heap use must be very carefully controlled to avoid memory leaks, overruns and
attempted overallocation. Further, many RTOSes provide their own dynamic memory allocation
system. For these reasons the default heap size is set at 0 bytes, effectively disabling dynamic
memory. If it is required for an application setting a positive value to the "Heap size (bytes)" option
in the RA Common configurations on the BSP tab will allocate a heap.

Note
When using printf/sprintf (and other variants) to output floating point numbers a heap is required. A minimum size
of 0x1000 (4096) bytes is recommended when starting development in this case.

Error Logging

When error logging is enabled, the error logging function can be redefined on the command line by
defining FSP_ERROR_LOG(err) to the desired function call. The default function implementation is
FSP_ERROR_LOG(err)=fsp_error_log(err, FILE, LINE). This implementation uses the predefined
macros FILE and LINE to help identify the location where the error occurred. Removing the line from
the function call can reduce code size when error logging is enabled. Some compilers may support
other predefined macros like FUNCTION, which could be helpful for customizing the error logger.

Register Protection
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The BSP register protection functions utilize reference counters to ensure that an application which
has specified a certain register and subsequently calls another function doesn't have its register
protection settings inadvertently modified.

Each time R_BSP_RegisterProtectDisable() is called, the respective reference counter is incremented.
Each time R_BSP_RegisterProtectEnable() is called, the respective reference counter is decremented.

Both functions will only modify the protection state if their reference counter is zero.

/* Enable witing to protected CGC registers */

R BSP_Regi st er Pr ot ect Di sabl e( BSP_REG PROTECT CCC) ;
/* Insert code to nodify protected CGC registers. */
/* Disable witing to protected CCC regi sters */

R BSP_Regi st er Pr ot ect Enabl e( BSP_REG PROTECT CCC) ;

Option-setting memory

Option-setting memory includes OFS registers OFS0 and OFS1, OSIS debugger ID code, and block
protections settings BPS and PBPS. Option-setting memory is MCU specific, and not all MCUs
implement all option-setting registers. Option-setting configurations available on the selected device
are configurable in the BSP properties. These configurations are placed in sections to be loaded at
the required flash address by the linker.

The ID code is a 16-byte value that can be used to protect the MCU from being connected to a
debugger or from connecting in Serial Boot Mode. There are different settings that can be set for the
ID code; please refer to the hardware manual for your device for available options.

On MCUs that support TrustZone, option-setting registers are placed in a different locations for Non-
Secure projects than for Secure or Flat projects. This is handled automatically by the BSP and linker
scripts.

All * SEL registers default to allowing both Secure and Non-Secure access unless otherwise noted
here. If block protection is configured in a Secure project, the BSP sets the corresponding
configuration to Secure access only by updating the corresponding *_SEL register. Similarly, the LVD
related settings in the OFSn_SEL registers are automatically set to Secure if the corresponding LVD
monitor is used in the Secure project.

TrustZone Security Attribution Registers

On MCUs that support TrustZone, Security Attribution Registers for modules used in the Secure
project are configured to allow Secure access only as part of the startup code of the Secure project.
This logic is skipped for Flat projects.

Software Delay

Implements a blocking software delay. A delay can be specified in microseconds, milliseconds or
seconds. The delay is implemented based on the system clock rate.

/* Delay at |east 1 second. Depending on the nunber of wait states required for the
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regi on of menory

* that the software _delay | oop has been linked in this could take | onger. The
default is 4 cycles per |oop.

* This can be nodified by redefining DELAY LOOP_CYCLES. BSP_DELAY UN TS SECONDS,
BSP_DELAY_UNI TS_M LLI SECONDS,

* and BSP_DELAY _UNI TS M CROSECONDS can all be used with R BSP_Sof t wareDel ay. */
R BSP_Sof t war eDel ay(1, BSP_DELAY_UNI TS_SECONDS) ;

Trignometric Function

Implements Trignometric math inline functions utilizing TFU hardware. These functions can calculate
sine, cosine, arctangent and hypotenuse. The trigonometric library functions sinf(), cosf(), atan2f(),
and hypotf() can be mapped to respective TFU functions by enabling TFU Mathlib property in FSP
Configuration tool. Extended functions sincosf() and atan2hypotf() are also available when the TFU
Mathlib property is enabled in the RA Configuration editor.

TFU functions are not reentrant. Disable the TFU Mathlib property in RA Configuration editor if
reentrant access to trigonometric library functions is required.

Note
Refer to the MCU hardware user's manual or datasheet to determineif it has TFU support.

Digital Signal Processing With 32-bit Multiply-Accumulator

Implements DSP (digital signal processing) functions via MACL (32-bit Multiply-Accumulator)
hardware. These functions will support CMSIS DSP APIs to perform the calculation, the activation of
MACL can be controlled by stack MACL (rm_cmsis_dsp) in the RA Configuration editor.

When stack MACL (rm_cmsis_dsp) is added, the CMSIS DSP APIs will generate normal functions which
overrides weak functions of Arm and use hardware for calculating. When stack MACL (rm_cmsis_dsp)

is not added, CMSIS DSP APIs will perform the calculation by using software.

For examples, how to use the CMSIS DSP APIs refer to the link: https://github.com/ARM-
software/CMSIS-DSP/tree/main/Examples/ARM.

CMSIS APIs supported by MACL list:

No CMSIS DSP API MACL BSP API Description
1 arm_mult g31 R _BSP_MacIMulQ31 Q31 vector
multiplication
2 arm_scale_qg31 R_BSP_MaclScaleQ31 Multiplies a Q31 vector
by a scalar
3 arm_mat_mult _g31 R_BSP_MaclMatMultQ3 Q31 matrix
1 multiplication
4 arm_mat_vec_mult q31 R BSP_MacIMatVecMul Q31 matrix and vector
Q31 multiplication
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10

11

12

13

14

15

Note

arm_mat_scale gq31

arm_biquad_cascade_d
fl_g31

arm_conv_partial_g31

arm_conv_qg31

arm_correlate _q31

arm_fir_decimate_q31

arm_fir_interpolate_q31

arm_fir_q31

arm_fir_sparse _q31

arm_lms_norm_qg31

arm_Ims_q31

R_BSP_MaclMatScaleQ3
1

R_BSP_MaclIBiquadCsd
Df1Q31

R_BSP_MaclConvPartial
Q31

R_BSP_MaclConvQ31

R _BSP_MaclCorrelateQ
31

R_BSP_MaclFirDecimat
eQ31

R_BSP_MaclFirinterpola
teQ31
R_BSP_MaclFirQ31

R _BSP_MaclFirSparseQ
31

R_BSP_MaclLmsNormQ
31

R_BSP_MaclLmsQ31

Q31 matrix scaling

Processing function for
the Q31 Biquad
cascade filter

Partial convolution of
Q31 sequences

Convolution of Q31
sequences

Correlation of Q31
sequences

Processing function for
the Q31 FIR decimator

Processing function for
the Q31 FIR
interpolator

Processing function for
Q31 FIR filter

Processing function for
the Q31 sparse FIR
filter

Processing function for
Q31 normalized LMS
filter

Processing function for
Q31 LMS filter

Refer to the MCU hardware user's manual or datasheet to determineif it has MACL support.

Critical Section Macros

Implements a critical section. Some MCUs (MCUs with the BASEPRI register) support allowing high
priority interrupts to execute during critical sections. On these MCUs, interrupts with priority less
than or equal to BSP_CFG_IRQ_MASK_LEVEL_FOR_CRITICAL_SECTION are not serviced in critical
sections. Interrupts with higher priority than BSP_CFG_IRQ_MASK_LEVEL_FOR_CRITICAL_SECTION still
execute in critical sections.

FSP_CRI TI CAL_SECTI ON_DEFI NE;

/* Store the current

i nterrupt posture. */

FSP_CRI TI CAL_SECTI ON_ENTER;

/* Interrupts cannot

run in this section unless their

BSP_CFG | RQ MASK_LEVEL_FOR CRI TI CAL_SECTI ON. */

/* Restore saved interrupt

posture. */

priority is less than
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FSP_CRI Tl CAL_SECTI ON_EXI T:

OctaClock Update

Supports changing the Octal-SPI Clock (OCTACLK) during runtime if supported by the MCU. The
OCTACLK source and clock divisor can be updated. It is user's responsibility to ensure the selected
clock source is running before attempting to update OCTACLK.

Sealing the Main Stack (TrustZone Secure Projects)

In TrustZone secure projects, the BSP seals the main stack by placing the value OXFEF5EDA5S above
the stack top. For more information, refer to section 3.5 "Sealing a Stack" in "Secure software
guidelines for ARMv8-M": https://developer.arm.com/documentation/100720/0300.

Limited D-Cache Support

For MCUs with Cortex-M85 cores with D-Cache, limited support is available for enabling the D-Cache
and automatically configuring predefined non-cacheable regions via the MPU during BSP
initialization. For these MCUs, D-Cache is disabled by default because certain existing drivers do not
support data coherency with D-Cache enabled. Enabling the D-Cache requires that data coherency
be considered in any circumstance where a core interacts with other bus members.

Non-Cacheable Buffer Placement Example

The predefined non-cacheable regions configured by the MPU when D-Cache is enabled can be used
to contain data that should not be cached, ensuring data coherency for that data. To use the
predefined non-cacheable regions, place the data into the corresponding non-cacheable section
defined by the linker script for the chosen toolchain. The predefined non-cacheable regions are not
initialized by the BSP.

Use one of the .nocache sections to place non-cacheable data.

uint8 t uncached uninitialized buffer_sran{1024] BSP_PLACE |IN _SECTI ON(". nocache");

Section names differ by data region and compiler. Names predefined by the BSP are shown below.

Region Name (GCC, IAR, LLVM) Name (AC6)
SRAM .nocache .bss.nocache
SDRAM .nocache_sdram .bss.nocache_sdram
Configuration

The BSP is heavily data driven with most features and functionality being configured based on the
content from configuration files. Configuration files represent the settings specified by the user and
are generated when the project is built and/or when the Generate Project Content button is clicked in
the RA Configuration editor.
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Build Time Configurations for fsp_common

The following build time configurations are defined in fsp_cfg/bsp/bsp_cfg.h:

Configuration Options Default Description
Main stack size (bytes) Value must be an 0x400 Set the size of the main
integer multiple of 8 program stack.
and between 8 and
OxFFFFFFFF NOTE: This entry is for

the main stack. When
using an RTOS, thread
stacks can be
configured in the
properties for each

thread.
Heap size (bytes) Value mustbeOoran O The main heap is
integer multiple of 8 disabled by default. Set
between 8 and the heap size to a
OXFFFFFFFF. positive integer
divisible by 8 to enable
it.

A minimum of 4K
(0x1000) is
recommended if
standard library
functions are to be

used.
MCU Vcc (mV) Value must between 0 3300 Some peripherals
and 5500 (5.5V) require different

settings based on the
supplied voltage.
Entering Vcc here (in
mV) allows the relevant
driver modules to
configure the
associated peripherals

accordingly.
Parameter checking ¢ Enabled Disabled When enabled,
¢ Disabled parameter checking for

the BSP is turned on. In
addition, any modules
whose parameter
checking configuration
is set to 'Default (BSP)'
will perform parameter
checking as well.

Assert Failures e Return FSP_ERR Return Define the behavior of
_ASSERTION FSP_ERR_ASSERTION the FSP_ASSERTY()
e Call macro.

fsp_error_log
then Return FSP
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Error Log

Clock Registers not
Reset Values during
Startup

Main Oscillator

Populated

PFS Protect

C Runtime Initialization

Early BSP Initialization

Main Oscillator Clock
Source

_ERR_ASSERTIO
N

Use assert() to
Halt Execution
Disable checks
that would
return FSP_ERR
_ASSERTION

No Error Log
Errors Logged
via
fsp_error_log

No Error Log

Disabled
Enabled

Disabled

Populated
Not Populated

Populated

Disabled
Enabled

Enabled

Enabled
Disabled

Enabled

Enabled
Disabled

Disabled

External
Oscillator

Crystal or Resonator

Specify error logging
behavior.

If enabled, registers
are assumed to be set
to their reset value
during startup. Enable
this if another
application such as a
bootloader or Secure
project has already
configured the clocks
before the startup code
runs.

Select whether or not
there is a main
oscillator (XTAL) on the
board. This setting can
be overridden in
board_cfg.h.

Keep the PFS registers
locked when they are
not being modified. If
disabled they will be
unlocked during
startup.

Select if the C runtime
initialization in the BSP
is to be used. If
disabled, use the BSP_
WARM_START POST CL
OCK event to run user
defined equivalent.

Enable this option to
use BSP functions
before C runtime
initialization (BSP_WAR
M_START RESET or BSP
_WARM_START_POST C
LOCK).

Select the main
oscillator clock source.
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e Crystal or This setting can be
Resonator overridden in
board cfg.h
Subclock Populated e Populated Populated Select whether or not
e Not Populated there is a subclock

crystal on the board.
This setting can be
overridden in

board_cfg.h.
Subclock Drive (Drive e Standard/Norm Standard/Normal mode Select the subclock
capacitance availability al mode oscillator drive
varies by MCU) e Low/Low power capacitance. This
mode 1 setting can be
e Low power overridden in
mode 2 board _cfg.h
e Low power
mode 3
Subclock Stabilization ~ Value must between 0 1000 Select the subclock
Time (ms) and 10000 oscillator stabilization
time. This is only used
in the startup code if
the subclock is
selected as the system
clock on the Clocks tab
or if the HOCO FLL
function is enabled.
This setting can be
overridden in
board_cfg.h
Modules
RAOE1
RA2A1
RA2A2
RA2E1
RA2E2
RA2E3
RA2L1
RA4E1
RA4E2
RA4AM1
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Macros

#define

#define

#define

#define

#define

#define

RA4M2

RA4M3

RA4T1

RA4W1

RAGE1

RAGE?2

RA6M1

RA6M2

RA6M3

RA6M4

RA6M5

RA6T1

RAGT2

RAGT3

RA8D1

RASM1

RA8T1

BSP_STACK_ALIGNMENT

BSP_IRQ_DISABLED

FSP_LOG_PRINT(X)

FSP_RETURN(err)

FSP_ERROR_LOG(err)

FSP_ASSERT(a)
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#define FSP_ERROR_RETURN(a, err)

#define FSP_CRITICAL_SECTION_ENTER

#define FSP_CRITICAL SECTION_EXIT

#define FSP_INVALID_VECTOR

#define BSP_CFG_HANDLE_UNRECOVERABLE_ERROR(x)
#define R_BSP_MODULE_START(ip, channel)

#define R_BSP_MODULE_STOP(ip, channel)

Enumerations

enum bsp_reg_protect_t

enum bsp_delay_units t
enum bsp warm_start_event t
enum fsp_priv_source_clock t
enum bsp grp_irg_t

enum fsp_ ip t

enum fsp_signal_t

Variables

uint32_t SystemCoreClock BSP_SECTION_EARLY_INIT

Macro Definition Documentation

¢ BSP_STACK_ALIGNMENT

#define BSP_STACK_ALIGNMENT

Stacks (and heap) must be sized and aligned to an integer multiple of this number.

¢ BSP_IRQ_DISABLED

#define BSP_IRQ_DISABLED

Used to signify that an ELC event is not able to be used as an interrupt.
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& FSP_LOG_PRINT

#define FSP_LOG_PRINT ( X)

Macro that can be defined in order to enable logging in FSP modules.

¢ FSP_RETURN

#define FSP_RETURN ( err)

Macro to log and return error without an assertion.

o FSP_ERROR_LOG

#define FSP_ERROR_LOG ( err)

This function is called before returning an error code. To stop on a runtime error, define
fsp_error_log in user code and do required debugging (breakpoints, stack dump, etc) in this
function.

o FSP_ASSERT

#define FSP_ASSERT ( a)

Default assertion calls FSP_ERROR_RETURN if condition "a" is false. Used to identify incorrect use of
API's in FSP functions.

¢ FSP_ERROR_RETURN

#define FSP_ERROR_RETURN ( a, err )

All FSP error codes are returned using this macro. Calls FSP_ERROR_LOG function if condition "a" is
false. Used to identify runtime errors in FSP functions.

¢ FSP_CRITICAL_SECTION_ENTER

#define FSP_CRITICAL_SECTION_ENTER

This macro temporarily saves the current interrupt state and disables interrupts.

¢ FSP_CRITICAL_SECTION_EXIT

#define FSP_CRITICAL_SECTION_EXIT

This macro restores the previously saved interrupt state, reenabling interrupts.
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& FSP_INVALID_VECTOR

#define FSP_INVALID_VECTOR

Used to signify that the requested IRQ vector is not defined in this system.

& BSP_CFG_HANDLE_UNRECOVERABLE_ERROR

#define BSP_CFG_HANDLE_UNRECOVERABLE_ERROR ( x)

In the event of an unrecoverable error the BSP will by default call the _ BKPT() intrinsic function
which will alert the user of the error. The user can override this default behavior by defining their
own BSP_CFG_HANDLE_UNRECOVERABLE_ERROR macro.

¢ R_BSP_MODULE_START

#define R_BSP_MODULE_START ( ip, channel )

Cancels the module stop state.

Parameters
ip fsp_ip_t enum value for the module to be
stopped
channel The channel. Use channel 0 for modules
without channels.

¢ R_BSP_MODULE_STOP

#define R_BSP_MODULE_STOP ( ip, channel )

Enables the module stop state.

Parameters
ip fsp_ip_t enum value for the module to be
stopped
channel The channel. Use channel 0 for modules
without channels.

Enumeration Type Documentation
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¢ bsp_reg protect_t

enum bsp_reg protect t

The different types of registers that can be protected.

Enumerator

BSP_REG_PROTECT_CGC Enables writing to the registers related to the

clock generation circuit.

BSP_REG_PROTECT_OM_LPC_BATT Enables writing to the registers related to

operating modes, low power consumption, and
battery backup function.

BSP_REG_PROTECT_LVD Enables writing to the registers related to the

LVD: LVCMPCR, LVDLVLR, LVD1CRO, LVD1CR1,
LVD1SR, LVD2CRO, LVD2CR1, LVD2SR.

BSP_REG_PROTECT_SAR Enables writing to the registers related to the

security function.

¢ bsp_delay_units_t

enum bsp_delay_units_t

Available delay units for R_ BSP_SoftwareDelay(). These are ultimately used to calculate a total # of
microseconds

Enumerator

BSP_DELAY_UNITS_SECONDS Requested delay amount is in seconds.

BSP_DELAY_UNITS_MILLISECONDS Requested delay amount is in milliseconds.

BSP_DELAY_UNITS_MICROSECONDS Requested delay amount is in microseconds.
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¢ bsp_warm_start_event_t

enum bsp_warm_start_event _t

Different warm start entry locations in the BSP.

Enumerator

BSP_WARM_START_RESET Called almost immediately after reset. No C

runtime environment, clocks, or IRQs.

BSP_WARM_START_POST_CLOCK Called after clock initialization. No C runtime

environment or IRQs.

BSP_WARM_START_POST_C Called after clocks and C runtime environment

have been set up.

¢ fsp_priv_source_clock_t

enum fsp_priv_source_clock t

Enumerator

FSP_PRIV_CLOCK_HOCO The high speed on chip oscillator.

FSP_PRIV_CLOCK_MOCO The middle speed on chip oscillator.

FSP_PRIV_CLOCK_LOCO The low speed on chip oscillator.

FSP_PRIV_CLOCK_SUBCLOCK The subclock oscillator.

FSP_PRIV_CLOCK_PLL The PLL oscillator.
FSP_PRIV_CLOCK_PLL2 The PLL2 oscillator.
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¢ bsp _grp_irq_t

enum bsp_grp_irg_t

Which interrupts can have callbacks registered.

Enumerator

BSP_GRP_IRQ_IWDT_ERROR

IWDT underflow/refresh error has occurred.

BSP_GRP_IRQ_WDT_ERROR

WDT underflow/refresh error has occurred.

BSP_GRP_IRQ_LVD1

Voltage monitoring 1 interrupt.

BSP_GRP_IRQ_LVD2

Voltage monitoring 2 interrupt.

BSP_GRP_IRQ_OSC_STOP_DETECT

Oscillation stop is detected.

BSP_GRP_IRQ_NMI_PIN

NMI Pin interrupt.

BSP_GRP_IRQ_MPU_BUS_TZF

MPU Bus or TrustZone Filter Error.

BSP_GRP_IRQ_COMMON_MEMORY

SRAM ECC or SRAM Parity Error.

BSP_GRP_IRQ_LOCKUP

LockUp Error.

BSP_GRP_IRQ_IWDT_ERROR

IWDT underflow/refresh error has occurred.

BSP_GRP_IRQ_WDT_ERROR

WDT underflow/refresh error has occurred.

BSP_GRP_IRQ_LVD1

Voltage monitoring 1 interrupt.

BSP_GRP_IRQ_LVD2

Voltage monitoring 2 interrupt.

BSP_GRP_IRQ_VBATT

VBATT monitor interrupt.

BSP_GRP_IRQ_OSC_STOP_DETECT

Oscillation stop is detected.

BSP_GRP_IRQ_NMI_PIN

NMI Pin interrupt.

BSP_GRP_IRQ_RAM_PARITY

RAM Parity Error.

BSP_GRP_IRQ_RAM_ECC

RAM ECC Error.

BSP_GRP_IRQ_MPU_BUS_SLAVE

MPU Bus Slave Error.

BSP_GRP_IRQ_MPU_BUS_MASTER

MPU Bus Master Error.

BSP_GRP_IRQ_MPU_STACK

MPU Stack Error.
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BSP_GRP_IRQ_TRUSTZONE

MPU Stack Error.

BSP_GRP_IRQ_CACHE_PARITY

MPU Stack Error.

BSP_GRP_IRQ_IWDT_ERROR

IWDT underflow/refresh error has occurred.

BSP_GRP_IRQ_WDT_ERROR

WDT underflow/refresh error has occurred.

BSP_GRP_IRQ_LVD1

Voltage monitoring 1 interrupt.

BSP_GRP_IRQ_LVD2

Voltage monitoring 2 interrupt.

BSP_GRP_IRQ_OSC_STOP DETECT

Oscillation stop is detected.

BSP_GRP_IRQ_NMI_PIN

NMI Pin interrupt.

BSP_GRP_IRQ_MPU_BUS_TZF

MPU Bus or TrustZone Filter Error.

BSP_GRP_IRQ_COMMON_MEMORY

SRAM ECC or SRAM Parity Error.

BSP_GRP_IRQ_LOCKUP

LockUp Error.

BSP_GRP_IRQ_IWDT_ERROR

IWDT underflow/refresh error has occurred.

BSP_GRP_IRQ_WDT_ERROR

WDT underflow/refresh error has occurred.

BSP_GRP_IRQ_LVD1

Voltage monitoring 1 interrupt.

BSP_GRP_IRQ_LVD2

Voltage monitoring 2 interrupt.

BSP_GRP_IRQ_OSC_STOP_DETECT

Oscillation stop is detected.

BSP_GRP_IRQ_NMI_PIN

NMI Pin interrupt.

BSP_GRP_IRQ_MPU_BUS_TZF

MPU Bus or TrustZone Filter Error.

BSP_GRP_IRQ_COMMON_MEMORY

SRAM ECC or SRAM Parity Error.

BSP_GRP_IRQ_LOCKUP

LockUp Error.
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¢ fsp_ip_t

enum fsp_ip_t

Available modules.

Enumerator

FSP_IP_CFLASH Code Flash.

FSP_IP_DFLASH Data Flash.

FSP_IP_RAM RAM.

FSP_IP_LVD Low Voltage Detection.

FSP_IP_CGC Clock Generation Circuit.

FSP_IP_LPM Low Power Modes.

FSP_IP_FCU Flash Control Unit.

FSP_IP_ICU Interrupt Control Unit.

FSP_IP_DMAC DMA Controller.

FSP_IP_DTC Data Transfer Controller.
FSP_IP_IOPORT I/O Ports.

FSP_IP_PFS Pin Function Select.

FSP_IP_ELC Event Link Controller.

FSP_IP_MPU Memory Protection Unit.
FSP_IP_MSTP Module Stop.

FSP_IP_MMF Memory Mirror Function.

FSP_IP_KEY Key Interrupt Function.

FSP_IP_CAC Clock Frequency Accuracy Measurement

Circuit.
FSP_IP_DOC Data Operation Circuit.
FSP_IP_CRC Cyclic Redundancy Check Calculator.
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FSP_IP_SCI Serial Communications Interface.
FSP_IP_IIC I2C Bus Interface.

FSP_IP_SPI Serial Peripheral Interface.
FSP_IP_CTSU Capacitive Touch Sensing Unit.
FSP_IP_SCE Secure Cryptographic Engine.
FSP_IP_SLCDC Segment LCD Controller.
FSP_IP_AES Advanced Encryption Standard.
FSP_IP_TRNG True Random Number Generator.
FSP_IP_FCACHE Flash Cache.

FSP_IP_SRAM SRAM.

FSP_IP_ADC A/D Converter.

FSP_IP_DAC 12-Bit D/A Converter

FSP_IP_TSN Temperature Sensor.
FSP_IP_DAAD

D/A A/D Synchronous Unit.

FSP_IP_ACMPHS

High Speed Analog Comparator.

FSP_IP_ACMPLP

Low Power Analog Comparator.

FSP_IP_OPAMP Operational Amplifier.
FSP_IP_SDADC Sigma Delta A/D Converter.
FSP_IP_RTC Real Time Clock.

FSP_IP_WDT Watch Dog Timer.
FSP_IP_IWDT Independent Watch Dog Timer.
FSP_IP_GPT General PWM Timer.
FSP_IP_POEG Port Output Enable for GPT.
FSP_IP_OPS

Output Phase Switch.
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FSP_IP_AGT Asynchronous General-Purpose Timer.

FSP_IP_CAN Controller Area Network.

FSP_IP_IRDA Infrared Data Association.

FSP_IP_QSPI Quad Serial Peripheral Interface.

FSP_IP_USBFS USB Full Speed.

FSP_IP_SDHI SD/MMC Host Interface.

FSP_IP_SRC Sampling Rate Converter.

FSP_IP_SSI Serial Sound Interface.

FSP_IP_DALI Digital Addressable Lighting Interface.

FSP_IP_ETHER Ethernet MAC Controller.

FSP_IP_EDMAC Ethernet DMA Controller.

FSP_IP_EPTPC Ethernet PTP Controller.

FSP_IP_PDC Parallel Data Capture Unit.

FSP_IP_GLCDC Graphics LCD Controller.

FSP_IP_DRW 2D Drawing Engine

FSP_IP_JPEG JPEG.

FSP_IP_DACS8 8-Bit D/A Converter

FSP_IP_USBHS USB High Speed.

FSP_IP_OSPI Octa Serial Peripheral Interface.

FSP_IP_CEC HDMI CEC.

FSP_IP_TFU Trigonometric Function Unit.

FSP_IP_IIRFA lIR Filter Accelerator.

FSP_IP_CANFD CAN-FD.

FSP_IP_ULPT Ultra Low Power Timer ULPT.
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FSP_IP_SAU Serial Array Unit.
FSP_IP_IICA Serial Interface IICA.
FSP_IP_UARTA Serial Interface UARTA.
FSP_IP_TAU Timer Array Unit.
FSP_IP_TML32 32-bit Interval Timer
FSP_IP_MACL 32-bit Multiply-Accumulator

¢ fsp_signal_t

enum fsp_signal _t

Signals that can be mapped to an interrupt.

Enumerator

FSP_SIGNAL_ADC_COMPARE_MATCH

ADC COMPARE MATCH.

FSP_SIGNAL_ADC_COMPARE_MISMATCH

ADC COMPARE MISMATCH.

FSP_SIGNAL_ADC_SCAN_END

ADC SCAN END.

FSP_SIGNAL_ADC_SCAN_END_B

ADC SCAN END B.

FSP_SIGNAL_ADC_WINDOW A

ADC WINDOW A.

FSP_SIGNAL_ADC_WINDOW_B

ADC WINDOW B.

FSP_SIGNAL_AES_RDREQ

AES RDREQ.

FSP_SIGNAL_AES_WRREQ

AES WRREQ.

FSP_SIGNAL_AGT_COMPARE_A

AGT COMPARE A.

FSP_SIGNAL_AGT_COMPARE_B

AGT COMPARE B.

FSP_SIGNAL_AGT_INT

AGT INT.

FSP_SIGNAL_CAC_FREQUENCY_ERROR

CAC FREQUENCY ERROR.

FSP_SIGNAL_CAC_MEASUREMENT_END

CAC MEASUREMENT END.

FSP_SIGNAL_CAC_OVERFLOW

CAC OVERFLOW.
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FSP_SIGNAL_CAN_ERROR CAN ERROR.
FSP_SIGNAL _CAN_FIFO_RX CAN FIFO RX.
FSP_SIGNAL_CAN_FIFO_TX CAN FIFO TX.
FSP_SIGNAL_CAN_MAILBOX RX CAN MAILBOX RX.
FSP_SIGNAL_CAN_MAILBOX_ TX CAN MAILBOX TX.
FSP_SIGNAL CGC_MOSC_STOP CGC MOSC STOP.
FSP_SIGNAL_LPM_SNOOZE_REQUEST LPM SNOOZE REQUEST.
FSP_SIGNAL_LVD LVD1 LVD LVDL1.
FSP_SIGNAL_LVD_ LVD?2 LVD LVD2.
FSP_SIGNAL VBATT_LVD VBATT LVD.
FSP_SIGNAL LVD VBATT LVD VBATT.
FSP_SIGNAL_ACMPHS_INT ACMPHS INT.
FSP_SIGNAL_ACMPLP_INT ACMPLP INT.
FSP_SIGNAL_CTSU_END CTSU END.
FSP_SIGNAL_CTSU_READ CTSU READ.
FSP_SIGNAL_CTSU WRITE CTSU WRITE.
FSP_SIGNAL_DALI_DElI DALI DEI.
FSP_SIGNAL DALI _CLI DALI CLI.
FSP_SIGNAL_DALI_SDI DALI SDI.
FSP_SIGNAL_DALI BPI DALI BPI.
FSP_SIGNAL_DALI_FEI DALI FEI.
FSP_SIGNAL DALI SDI_OR_BPI DALI SDI OR BPI.
FSP_SIGNAL DMAC_INT DMAC INT.
FSP_SIGNAL DOC_INT DOC INT.
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FSP_SIGNAL_DRW_INT

DRW INT.

FSP_SIGNAL_DTC_COMPLETE

DTC COMPLETE.

FSP_SIGNAL_DTC_END

DTC END.

FSP_SIGNAL_EDMAC_EINT

EDMAC EINT.

FSP_SIGNAL_ELC_SOFTWARE_EVENT_0

ELC SOFTWARE EVENT 0.

FSP_SIGNAL_ELC_SOFTWARE_EVENT 1

ELC SOFTWARE EVENT 1.

FSP_SIGNAL_EPTPC_IPLS EPTPC IPLS.
FSP_SIGNAL_EPTPC_MINT EPTPC MINT.
FSP_SIGNAL_EPTPC_PINT EPTPC PINT.

FSP_SIGNAL_EPTPC_TIMERO_FALL

EPTPC TIMERO FALL.

FSP_SIGNAL_EPTPC_TIMERO_RISE

EPTPC TIMERO RISE.

FSP_SIGNAL_EPTPC_TIMER1_FALL

EPTPC TIMER1 FALL.

FSP_SIGNAL_EPTPC_TIMER1_RISE

EPTPC TIMER1 RISE.

FSP_SIGNAL_EPTPC_TIMER2_FALL

EPTPC TIMER2 FALL.

FSP_SIGNAL_EPTPC_TIMER2_RISE

EPTPC TIMER2 RISE.

FSP_SIGNAL_EPTPC_TIMER3_FALL

EPTPC TIMER3 FALL.

FSP_SIGNAL_EPTPC_TIMER3_RISE

EPTPC TIMER3 RISE.

FSP_SIGNAL_EPTPC_TIMER4_FALL

EPTPC TIMER4 FALL.

FSP_SIGNAL_EPTPC_TIMER4 RISE

EPTPC TIMER4 RISE.

FSP_SIGNAL_EPTPC_TIMER5_FALL

EPTPC TIMERS5 FALL.

FSP_SIGNAL_EPTPC_TIMER5_RISE

EPTPC TIMERS RISE.

FSP_SIGNAL_FCU_FIFERR

FCU FIFERR.

FSP_SIGNAL_FCU_FRDYI

FCU FRDYI.

FSP_SIGNAL_GLCDC_LINE_DETECT

GLCDC LINE DETECT.
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FSP_SIGNAL_GLCDC_UNDERFLOW_1

GLCDC UNDERFLOW 1.

FSP_SIGNAL_GLCDC_UNDERFLOW 2

GLCDC UNDERFLOW 2.

FSP_SIGNAL_GPT_CAPTURE_COMPARE_A

GPT CAPTURE COMPARE A.

FSP_SIGNAL_GPT_CAPTURE_COMPARE_B

GPT CAPTURE COMPARE B.

FSP_SIGNAL_GPT_COMPARE_C

GPT COMPARE C.

FSP_SIGNAL_GPT_COMPARE_D

GPT COMPARE D.

FSP_SIGNAL_GPT_COMPARE_E

GPT COMPARE E.

FSP_SIGNAL_GPT_COMPARE_F

GPT COMPARE F.

FSP_SIGNAL_GPT_COUNTER_OVERFLOW

GPT COUNTER OVERFLOW.

FSP_SIGNAL_GPT_COUNTER_UNDERFLOW

GPT COUNTER UNDERFLOW.

FSP_SIGNAL_GPT AD TRIG_A

GPT AD TRIG A.

FSP_SIGNAL_GPT_AD_TRIG B

GPT AD TRIG B.

FSP_SIGNAL_OPS_UVW_EDGE

OPS UVW EDGE.

FSP_SIGNAL_ICU_IRQO ICU IRQO.
FSP_SIGNAL_ICU_IRQ1 ICU IRQ1.
FSP_SIGNAL ICU_IRQ2 ICU IRQ2.
FSP_SIGNAL ICU IRQ3 ICU IRQ3.
FSP_SIGNAL_ICU_IRQ4 ICU IRQ4.
FSP_SIGNAL_ICU_IRQ5 ICU IRQ5.
FSP_SIGNAL _ICU_IRQ6 ICU IRQ6.
FSP_SIGNAL _ICU_IRQ7 ICU IRQ7.
FSP_SIGNAL_ICU_IRQ8 ICU IRQS.
FSP_SIGNAL_ICU_IRQ9 ICU IRQO.
FSP_SIGNAL ICU_IRQ10 ICU IRQ10.
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FSP_SIGNAL_ICU_IRQ11

ICU IRQ11.
FSP_SIGNAL_ICU_IRQ12 ICU IRQ12.
FSP_SIGNAL_ICU_IRQ13 ICU IRQ13.
FSP_SIGNAL_ICU_IRQ14 ICU IRQ14.
FSP_SIGNAL_ICU_IRQ15 ICU IRQ15.

FSP_SIGNAL_ICU_SNOOZE_CANCEL

ICU SNOOZE CANCEL.

FSP_SIGNAL_IIC_ERI

[IC ERI.
FSP_SIGNAL_IIC_RXI [IC RXI.
FSP_SIGNAL_IIC_TEI IIC TEI.
FSP_SIGNAL_IIC_TXI [IC TXI.
FSP_SIGNAL_IIC_WUI IIC WUI.

FSP_SIGNAL_IOPORT_EVENT 1

IOPORT EVENT 1.

FSP_SIGNAL_IOPORT_EVENT 2

IOPORT EVENT 2.

FSP_SIGNAL_IOPORT EVENT 3

IOPORT EVENT 3.

FSP_SIGNAL_IOPORT _EVENT 4

IOPORT EVENT 4.

FSP_SIGNAL_IOPORT_EVENT B

IOPORT EVENT B.

FSP_SIGNAL_IOPORT_EVENT_C

IOPORT EVENT C.

FSP_SIGNAL_IOPORT_EVENT D

IOPORT EVENT D.

FSP_SIGNAL_IOPORT _EVENT E

IOPORT EVENT E.

FSP_SIGNAL_IWDT_UNDERFLOW

IWDT UNDERFLOW.

FSP_SIGNAL_JPEG_JDTI

JPEG JDTI.
FSP_SIGNAL_JPEG_JEDI JPEG JEDI.
FSP_SIGNAL_KEY_INT KEY INT.

FSP_SIGNAL_PDC_FRAME_END

PDC FRAME END.
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FSP_SIGNAL_PDC_INT

PDC INT.

FSP_SIGNAL_PDC_RECEIVE_DATA_READY

PDC RECEIVE DATA READY.

FSP_SIGNAL_POEG_EVENT POEG EVENT.
FSP_SIGNAL_QSPI_INT QSPI INT.
FSP_SIGNAL_RTC_ALARM RTC ALARM.
FSP_SIGNAL_RTC_PERIOD RTC PERIOD.
FSP_SIGNAL_RTC_CARRY RTC CARRY.

FSP_SIGNAL_SCE_INTEGRATE_RDRDY

SCE INTEGRATE RDRDY.

FSP_SIGNAL_SCE_INTEGRATE_WRRDY

SCE INTEGRATE WRRDY.

FSP_SIGNAL_SCE_LONG_PLG

SCE LONG PLG.

FSP_SIGNAL_SCE_PROC_BUSY

SCE PROC BUSY.

FSP_SIGNAL_SCE_RDRDY_O SCE RDRDY 0.
FSP_SIGNAL_SCE_RDRDY_1 SCE RDRDY 1.
FSP_SIGNAL_SCE_ROMOK SCE ROMOK.

FSP_SIGNAL_SCE_TEST BUSY

SCE TEST BUSY.

FSP_SIGNAL_SCE_WRRDY_0 SCE WRRDY 0.
FSP_SIGNAL_SCE_WRRDY 1 SCE WRRDY 1.
FSP_SIGNAL _SCE_WRRDY 4 SCE WRRDY 4.
FSP_SIGNAL SCI_AM SCI AM.
FSP_SIGNAL SCI_ERI SCI ERI.
FSP_SIGNAL_SCI_RXI SCI RXI.
FSP_SIGNAL_SCI_RXI_OR_ERI SCI RXI OR ERI.
FSP_SIGNAL_SCI_TEI SCI TEL.
FSP_SIGNAL_SCI _TXI SCl TXI.
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FSP_SIGNAL_SDADC_ADI

SDADC ADI.

FSP_SIGNAL_SDADC_SCANEND

SDADC SCANEND.

FSP_SIGNAL_SDADC_CALIEND

SDADC CALIEND.

FSP_SIGNAL_SDHIMMC_ACCS

SDHIMMC ACCS.

FSP_SIGNAL_SDHIMMC_CARD

SDHIMMC CARD.

FSP_SIGNAL_SDHIMMC_DMA_REQ

SDHIMMC DMA REQ.

FSP_SIGNAL_SDHIMMC_SDIO

SDHIMMC SDIO.

FSP_SIGNAL_SPI_ERI

SPI ERI.
FSP_SIGNAL_SPI_IDLE SPI IDLE.
FSP_SIGNAL_SPI_RXI SPI RXI.
FSP_SIGNAL _SPI_TEI SPI TEI.
FSP_SIGNAL SPI_TXI SP| TXI.

FSP_SIGNAL_SRC_CONVERSION_END

SRC CONVERSION END.

FSP_SIGNAL_SRC_INPUT_FIFO_EMPTY

SRC INPUT FIFO EMPTY.

FSP_SIGNAL_SRC_OUTPUT FIFO_FULL

SRC OUTPUT FIFO FULL.

FSP_SIGNAL_SRC_OUTPUT_FIFO_OVERFLOW

SRC OUTPUT FIFO OVERFLOW.

FSP_SIGNAL_SRC_OUTPUT_FIFO_UNDERFLOW

SRC OUTPUT FIFO UNDERFLOW.

FSP_SIGNAL_SSI_INT SSI INT.
FSP_SIGNAL_SSI_RXI SSI RXI.
FSP_SIGNAL_SSI_TXI SSI TXI.
FSP_SIGNAL_SSI_TXI_RXI SSI TXI RXI.
FSP_SIGNAL_TRNG_RDREQ TRNG RDREQ.
FSP_SIGNAL_USB_FIFO_0 USB FIFO 0.
FSP_SIGNAL_USB_FIFO_1 USB FIFO 1.
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FSP_SIGNAL_USB_INT

USB INT.

FSP_SIGNAL_USB_RESUME

USB RESUME.

FSP_SIGNAL_USB_USB_INT_RESUME

USB USB INT RESUME.

FSP_SIGNAL_WDT_UNDERFLOW

WDT UNDERFLOW.

FSP_SIGNAL_ULPT_COMPARE_A

ULPT COMPARE A.

FSP_SIGNAL_ULPT_COMPARE_B

ULPT COMPARE B.

FSP_SIGNAL_ULPT_INT

ULPT INT.

Function Documentation

¢ R_FSP_VersionGet()

fsp_err_t R_FSP_VersionGet ( fsp_pack version_t *const p_version)

Parameters

Get the FSP version based on compile time macros.

[out]

p_version

Memory address to return
version information to.

Return values

FSP_SUCCESS

Version information stored.

FSP_ERR_ASSERTION

The parameter p_version is NULL.

¢ Systeminit()

BSP_SECTION_FLASH_GAP void Systeminit ( void )

Initialize the MCU and the runtime environment.
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4 R_BSP_WarmsStart()

void R_BSP_WarmStart ( bsp_warm_start_event_t event)

This function is called at various points during the startup process. This function is declared as a
weak symbol higher up in this file because it is meant to be overridden by a user implemented
version. One of the main uses for this function is to call functional safety code during the startup
process. To use this function just copy this function into your own code and modify it to meet your
needs.

Parameters

[in] event Where the code currently is
in the start up process

This function is called at various points during the startup process. This implementation uses the
event that is called right before main() to set up the pins.

Parameters
[in] event Where at in the start up
process the code is currently
at

¢ Reset_Handler()

BSP_SECTION_FLASH_GAP void Reset Handler ( void )

MCU starts executing here out of reset. Main stack pointer is set up already.

¢ Default_Handler()

BSP_SECTION_FLASH_GAP void Default Handler ( void )

Default exception handler.

¢ NMI_Handler()

BSP_SECTION_FLASH_GAP void NMI_Handler ( void )

Non-maskable interrupt handler. This exception is defined by the BSP, unlike other system
exceptions, because there are many sources that map to the NMI exception.
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¢ R_BSP_RegisterProtectEnable()

BSP_SECTION_FLASH GAP void R_BSP_RegisterProtectEnable ( bsp_reg protect t regs to_protect)

Enable register protection. Registers that are protected cannot be written to. Register protection is
enabled by using the Protect Register (PRCR) and the MPC's Write-Protect Register (PWPR).

Parameters

[in] regs_to_protect Registers which have write
protection enabled.

& R_BSP_RegisterProtectDisable()

BSP_SECTION_FLASH GAP void R_BSP_RegisterProtectDisable ( bsp_reg_protect t
regs_to_unprotect)

Disable register protection. Registers that are protected cannot be written to. Register protection is
disabled by using the Protect Register (PRCR) and the MPC's Write-Protect Register (PWPR).

Parameters

[in] regs_to_unprotect Registers which have write
protection disabled.

¢ R_BSP_IrqClearPending()

BSP_SECTION_FLASH_GAP void R_BSP_IrqClearPending ( IRQn_Type irq)
Clear the interrupt status flag (IR) for a given interrupt and clear the NVIC pending interrupt.
Parameters
[in] irq Interrupt for which to clear
the IR bit. Note that the
enums listed for IRQn_Type
are only those for the Cortex
Processor Exceptions
Numbers.
Warning
Do not call this function for system exceptions where the IRQn Type value is < 0.
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& R_BSP_IrqCfg()

BSP_SECTION_FLASH_GAP void R_BSP_IrqCfg ( IRQn_Type const irg, uint32_t priority, void *
p_context )

Sets the interrupt priority and context.

Parameters
[in] irq The IRQ to configure.
[in] priority NVIC priority of the interrupt
[in] p_context The interrupt context is a
pointer to data required in
the ISR.
Warning

Do not call this function for system exceptions where the IRQn_Type value is < 0.

4 R_BSP_IrqEnableNoClear()

BSP_SECTION_FLASH GAP void R_BSP_IrqEnableNoClear ( IRQn_Type const irq)

Enable the IRQ in the NVIC (Without clearing the pending bit).

Parameters
[in] irq The IRQ to enable. Note that
the enums listed for
IRQn_Type are only those for
the Cortex Processor
Exceptions Numbers.
Warning

Do not call this function for system exceptions where the IRQn Type value is < 0.
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4 R_BSP_IrqEnable()

BSP_SECTION_FLASH_GAP void R_BSP_IrqEnable ( IRQn_Type const irq)

Clears pending interrupts in both ICU and NVIC, then enables the interrupt.

Parameters

[in] irq Interrupt for which to clear

the IR bit and enable in the
NVIC. Note that the enums
listed for IRQn_Type are only
those for the Cortex
Processor Exceptions
Numbers.

Warning

Do not call this function for system exceptions where the IRQn Type value is < 0.

¢ R_BSP_IrgqDisable()

BSP_SECTION FLASH GAP void R_BSP IrgDisable ( IRQn_Type const irq)

Disables interrupts in the NVIC.

Parameters

[in] irq The IRQ to disable in the

NVIC. Note that the enums
listed for IRQn_Type are only
those for the Cortex
Processor Exceptions
Numbers.

Warning

Do not call this function for system exceptions where the IRQn_Type value is < 0.
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& R_BSP_IrqCfgEnable()

BSP_SECTION_FLASH_GAP void R_BSP_IrqCfgEnable ( IRQn_Type const irqg, uint32_t priority, void *
p_context )

Sets the interrupt priority and context, clears pending interrupts, then enables the interrupt.

Parameters
[in] irq Interrupt number.
[in] priority NVIC priority of the interrupt
[in] p_context The interrupt context is a
pointer to data required in
the ISR.
Warning

Do not call this function for system exceptions where the IRQn_Type value is < 0.

4 R_BSP_SourceClockHzGet()

uint32_t R BSP_SourceClockHzGet ( fsp_priv_source clock t clock)

Gets the frequency of a source clock.

Parameters
[in] clock Pointer to Octaclk setting
structure which provides
information regarding
Octaclk source and divider
settings to be applied.
Returns

Frequency of requested clock in Hertz.

¢ R_FSP_CurrentirqGet()

__STATIC_INLINE IRQn_Type R_FSP_CurrentlrqGet ( void )

Return active interrupt vector number value

Returns
Active interrupt vector number value
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¢ R_FSP_SystemClockHzGet()

__STATIC_INLINE uint32_t R_FSP_SystemClockHzGet ( fsp_priv_clock_t clock)

Gets the frequency of a system clock.

Returns
Frequency of requested clock in Hertz.

4 R_FSP_ClockDividerGet()

__STATIC_INLINE uint32_t R_FSP_ClockDividerGet ( uint32_t ckdivcr)

Returns
Clock Divider

Converts a clock's CKDIVCR register value to a clock divider (Eg: SPICKDIVCR).

4 R_BSP_UniqueldGet()

__STATIC_INLINE bsp_unique_id_t const* R_BSP_UniqueldGet ( void )

Get unique ID for this device.

Returns
A pointer to the unique identifier structure

4 R_BSP_FlashCacheDisable()

__STATIC_INLINE void R_BSP_FlashCacheDisable ( void )

Disables the flash cache.

4 R_BSP_FlashCacheEnable()

__STATIC_INLINE void R_BSP_FlashCacheEnable ( void )

Enables the flash cache.
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¢ R_BSP_SoftwareDelay()

BSP_SECTION_FLASH_GAP void R_BSP_SoftwareDelay ( uint32_t delay, bsp_delay units_t units )

Delay for at least the specified duration in units and return.

Parameters
[in] delay The number of 'units' to
delay.
[in] units The 'base’

(bsp_delay_units_t) for the
units specified. Valid values
are:

BSP_DELAY _UNITS_SECONDS
, BSP_DELAY_UNITS_MILLISE
CONDS, BSP_DELAY_UNITS _
MICROSECONDS.

For example:

At 1 MHz one cycle takes 1
microsecond (.000001
seconds).

At 12 MHz one cycle takes
1/12 microsecond or 83
nanoseconds.

Therefore one run through b
sp_prv_software_delay_loop(
) takes: ~ (83 *

BSP_DELAY LOOP_CYCLES)
or 332 ns. A delay of 2 us
therefore requires
2000ns/332ns or 6 loops.

The 'theoretical' maximum delay that may be obtained is determined by a full 32 bit loop count
and the system clock rate. @120MHz: ((OxFFFFFFFF loops * 4 cycles /loop) / 120000000) = 143
seconds. @32MHz: ((OxFFFFFFFF loops * 4 cycles /loop) / 32000000) = 536 seconds

Note that requests for very large delays will be affected by rounding in the calculations and the
actual delay achieved may be slightly longer. @32 MHz, for example, a request for 532 seconds will
be closer to 536 seconds.

Note also that if the calculations result in a loop_cnt of zero, the bsp_prv_software_delay _loop()
function is not called at all. In this case the requested delay is too small (nanoseconds) to be
carried out by the loop itself, and the overhead associated with executing the code to just get to
this point has certainly satisfied the requested delay.

Note
Thisfunction callsbsp_cpu_clock get() which ultimately callsR_ CGC_SystemClockFreqGet() and therefore
requires that the BSP has already initialized the CGC (which it does as part of the Sysinit). Care should be taken to
ensure this remains the case if in the future this function were to be called as part of the BSP initialization.
This function will delay for at least the specified duration. Due to overhead in calculating the correct number of
loops to delay, very small delay values (generally 1-5 microseconds) may be significantly longer than specified.
Approximate overhead for this function is as follows:

o CM4: 20-50 cycles
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o CM33: 10-60 cycles

o CM23: 75-200 cycles
If more accurate microsecond timing must be performed in software it is recommended to use
bsp_prv_software _delay loop() directly. In this case, use BSP_DELAY LOOP_CYCLESor
BSP_DELAY_LOOPS CALCULATE() to convert a calculated delay cycle count to a number of software delay
loops.
Delays may be longer than expected when compiler optimization is turned off.

Warning

The delay will be longer than specified on CM23 devices when the core clock is greater than
32 MHz. Setting BSP_DELAY LOOP_CYCLES to 6 will improve accuracy at 48 MHz but will
result in shorter than expected delays at lower speeds.

4 R_BSP_GrouplrqWrite()

BSP_SECTION_FLASH GAP fsp_err t R BSP_GrouplrqWrite ( bsp_grp_irq_t irq, void(*)(bsp_grp_irg_t
irq) p_callback )

Register a callback function for supported interrupts. If NULL is passed for the callback argument
then any previously registered callbacks are unregistered.

Parameters
[in] irq Interrupt for which to
register a callback.
[in] p_callback Pointer to function to call
when interrupt occurs.

Return values
FSP_SUCCESS Callback registered

FSP_ERR_ASSERTION Callback pointer is NULL

Variable Documentation

o BSP_SECTION_EARLY_INIT

uint32_t SystemCoreClock BSP_SECTION_EARLY_INIT

System Clock Frequency (Core Clock)

5.1.3.1 RAOE1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra0el fsp
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The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration

Options

Default

Description

OFSO register settings

OFSO register settings > Independent WDT

Start Mode

Timeout Period

Dedicated Clock

Frequency Divisor

Window End Position

Window Start Position

Reset Interrupt

Request Select

Stop Control

OFS1 register settings

IWDT is
Disabled

IWDT is
automatically
activated after
a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

IWDT is Disabled

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby
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Voltage Detection O
Circuit Start

Voltage Detection O
Level

Enable or disable Flash
Read Protection

Flash Read Protection
Start

Flash Read Protection
End

P206/RES pin selection

Enable inline BSP IRQ
functions

Main Oscillation
Stabilization Time

Use Low Voltage Mode

ID Code Mode

* Voltage monitor
O reset is
enabled after
reset

¢ Voltage monitor
0 reset is
disabled after
reset

3.88V
291V
2.62V
2.33V
1.86V
165V

e Enabled
¢ Disabled

Value must be an
integer between 0x01
and 0x3F (ROM)

Value must be an
integer between 0x01
and Ox3F

e PORT(P206)
e RES input

e Enabled
e Disabled

278/X1

279/X1

2710/X1
2711/X1
2713/X1
2715/X1
2717/X1
2718/X1

Not Supported

¢ Unlocked
(lgnore ID)
e Locked with All

Voltage monitor 0 reset
is disabled after reset

1.86V

Disabled

0x01

Ox3F

RES input

Disabled

2718/X1

config.bsp.low_voltage_
mode.disabled

Unlocked (Ignore ID)

Using static inline
functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in
return.

Use the low voltage
mode. This limits the
ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least 4
when oscillation stop
detection is used.

When set to 'Locked
with All Erase support’,
the ID Code must be
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ID Code (32 Hex

Erase support
e Locked

Value must be a 32

Characters) character long hex
string
Fill Flash Gap ¢ Do not fill gap
¢ Fill gap
Macros
#define
Enumerations
enum elc event t
enum icu_event t
enum elc_peripheral _t

Macro Definition Documentation

FFFFFFFFFFFFFFFFFFFF
FFFFFFFFFFFF

Fill gap

BSP_ELC_PERIPHERAL_MASK

set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked',
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.

A section of code flash
exists between the end
of the vector table
(near the start of flash)
and the ROM registers
(at address 0x400).
Selecting 'Fill gap' will
fill this area with a
preselected set
functions in order to
reduce the amount of
code flash used by FSP.
If you would like to fill
this area with your own
code or data, select 'Do
not fill gap' and
manually place items in
the section '.flash_gap'.
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¢ BSP_ELC_PERIPHERAL_MASK

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Note

Thislist is device specific.

Sources of event signals to be linked to other peripherals or the CPU

¢ icu_event_t

enum icu_event t

Fixed vector enumeration

Note

Thislist is device specific.

¢ elc_peripheral_t

enum elc_peripheral_t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

5.1.3.2 RA2A1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra2al_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration Options

Default

Description
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OFSO register settings

OFSO0 register settings > Independent WDT

Start Mode

Timeout Period

Dedicated Clock

Frequency Divisor

Window End Position

Window Start Position

Reset Interrupt
Request Select

Stop Control

OFSO register settings > WDT
Start Mode Select

IWDT is
Disabled

IWDT is
automatically
activated after
a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start

IWDT is Disabled

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
(register-start mode)
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mode)

e Stop WDT after
a reset (register-
start mode)

Timeout Period 1024 cycles 16384 cycles
4096 cycles
8192 cycles

16384 cycles

Clock Frequency o 4 128
Division Ratio * 64

e 128

e 512

e 2048

e 8192

Window End Position 75% 0% (no window end
50% position)

25%

0% (no window

end position)

Window Start Position e 25% 100% (no window start
* 50% position)
e 75%
* 100% (no
window start
position)
Reset Interrupt e NMI Reset
Request e Reset
Stop Control ¢ Counting Stop counting when
continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings
Voltage Detection 0 ¢ Voltage monitor Voltage monitor O reset
Circuit Start 0 reset is is disabled after reset
enabled after
reset
e Voltage monitor
0 reset is
disabled after
reset
Voltage Detection 0 e 3.84V 1.90V
Level e 282V
e 251V
e 190V
e« 1.70V
HOCO Oscillation HOCO oscillation is HOCO oscillation is HOCO must be enabled
Enable enabled after reset enabled after reset out of reset because
the MCU starts up in
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MPU

Enable or disable PC
Region 0

PCO Start

PCO End

Enable or disable PC
Region 1

PC1 Start

PC1 End

Enable or disable
Memory Region 0

Memory Region 0 Start

Memory Region 0 End

Enable or disable
Memory Region 1

Memory Region 1 Start

Memory Region 1 End

e Enabled
e Disabled

Value must be an
integer between 0 and
Ox000FFFFC (ROM) or
between 0x1FFO0000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxO00OFFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

e Enabled
e Disabled

Value must be an
integer between 0 and
0x000FFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxO00OFFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

e Enabled
e Disabled

Value must be an
integer between 0 and
Ox000FFFFC

Value must be an
integer between

0x00000003 and
OxO00FFFFF

e Enabled
e Disabled

Value must be an
integer between

0Ox1FF00000 and

0x200FFFFC

Value must be an

Disabled

O0x000FFFFC

O0xO000FFFFF

Disabled

O0x000FFFFC

OxO000FFFFF

Disabled

Ox000FFFFC

OxO000FFFFF

Disabled

0x200FFFFC

0x200FFFFF

low voltage mode and
the HOCO must be
operating in low
voltage mode.
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integer between
0x1FF00003 and

0x200FFFFF
Enable or disable e Enabled Disabled
Memory Region 2 e Disabled
Memory Region 2 Start Value must be an Ox407FFFFC

integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Memory Region 2 End  Value must be an Ox407FFFFF
integer between
0x400C0003 and
Ox400DFFFF or
between 0x40100003
and 0x407FFFFF

Enable or disable e Enabled Disabled
Memory Region 3 e Disabled
Memory Region 3 Start Value must be an 0x400DFFFC

integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Memory Region 3 End  Value must be an Ox400DFFFF
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and 0x407FFFFF

Enable inline BSP IRQ
functions

Enabled Disabled Using static inline

Disabled functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in

return.
Use Low Voltage Mode e Enabled Disabled Use the low voltage
e Disabled mode. This limits the

ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least 4
when oscillation stop
detection is used.

Main Oscillator Wait e 2 cycles 262144 cycles Number of cycles to
Time e 1024 cycles wait for the main
e 2048 cycles oscillator clock to
¢ 4096 cycles stabilize.
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ID Code Mode

ID Code (32 Hex
Characters)

Macros

8192 cycles
16384 cycles
32768 cycles
65536 cycles
131072 cycles
262144 cycles

e Unlocked
(lgnore ID)

¢ Locked with All
Erase support

e Locked

Value must be a 32
character long hex
string

Unlocked (Ignore ID)

FFFFFFFFFFFFFFFFFFFF
FFFFFFFFFFFF

#define BSP_ELC_PERIPHERAL_MASK

Enumerations

enum

elc_event t

enum elc _peripheral t

Macro Definition Documentation

& BSP_ELC_PERIPHERAL_MASK

When set to 'Locked
with All Erase support',
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked',
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation
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¢ elc_event_t

enum elc_event_t

Note

Thislist is device specific.

Sources of event signals to be linked to other peripherals or the CPU

¢ elc_peripheral_t

enum elc_peripheral t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

5.1.3.3 RA2A2
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra2a2 fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options

Default

Description

OFSO0 register settings
OFSO0 register settings > Independent WDT

Start Mode e IWDT is

Disabled
e IWDT is

automatically
activated after
a reset
(Autostart
mode)

Timeout Period e 128 cycles
e 512 cycles
e 1024 cycles
e 2048 cycles

Dedicated Clock o1
Frequency Divisor e 16
e 32

IWDT is Disabled

2048 cycles

128
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Window End Position

Window Start Position

Reset Interrupt
Request Select

Stop Control

OFSO0 register settings > WDT
Start Mode Select

Timeout Period

Clock Frequency
Division Ratio

Window End Position

64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

1024 cycles
4096 cycles
8192 cycles
16384 cycles

4
64
128
512
2048
8192

75%
50%
25%

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
(register-start mode)

16384 cycles

128

0% (no window end
position)
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Window Start Position

Reset Interrupt
Request

Stop Control

OFS1 register settings

Internal Clock Supply
Architecture Type

Voltage Detection 0
Circuit Start

Voltage Detection 0
Level

HOCO Oscillation
Enable

¢ 0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

e NMI
e Reset

e Counting
continues

e Stop counting
when entering
Sleep mode

e Type B
e Type A

¢ Voltage monitor

0 reset is
enabled after
reset

e Voltage monitor

O reset is
disabled after
reset

3.84V
2.82V
251V
190V
1.70V

e HOCO
oscillation is
enabled after
reset

e HOCO
oscillation is
disabled after

100% (no window start
position)

Reset

Stop counting when
entering Sleep mode

Type A

Voltage monitor 0 reset
is disabled after reset

190V

HOCO oscillation is
enabled after reset

HOCO must be enabled
out of reset because
the MCU starts up in
low voltage mode and
the HOCO must be
operating in low
voltage mode.

Feb.28.2024

reset
MPU
Enable or disable PC e Enabled Disabled
Region 0 e Disabled
PCO Start Value must be an Ox000FFFFC
integer between 0 and
0x000FFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)
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PCO End

Enable or disable PC
Region 1

PC1 Start

PC1 End

Enable or disable
Memory Region 0

Memory Region 0 Start

Memory Region 0 End

Enable or disable
Memory Region 1

Memory Region 1 Start

Memory Region 1 End

Enable or disable
Memory Region 2

Memory Region 2 Start

Memory Region 2 End

Value must be an
integer between
0x00000003 and
OxO00OFFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

e Enabled
¢ Disabled

Value must be an
integer between 0 and
Ox000FFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxO00OFFFFF (ROM) or
between 0x1FF00003
and 0x200FFFFF (RAM)

e Enabled
¢ Disabled

Value must be an
integer between 0 and
0x000FFFFC

Value must be an
integer between

0x00000003 and
O0x000FFFFF

e Enabled
e Disabled

Value must be an
integer between

0x1FF00000 and

0x200FFFFC

Value must be an
integer between

Ox1FF00003 and

Ox200FFFFF

e Enabled
e Disabled

Value must be an
integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Value must be an

OXOOOFFFFF

Disabled

0x000FFFFC

OxOO0OFFFFF

Disabled

0x000FFFFC

OXOOOFFFFF

Disabled

0x200FFFFC

Ox200FFFFF

Disabled

O0x407FFFFC

0x407FFFFF
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integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and Ox407FFFFF

Enable or disable e Enabled Disabled
Memory Region 3 e Disabled
Memory Region 3 Start Value must be an 0x400DFFFC

integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Memory Region 3 End  Value must be an Ox400DFFFF
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and 0x407FFFFF

Enable inline BSP IRQ e Enabled Disabled Using static inline

functions * Disabled functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in

return.
Use Low Voltage Mode Not Supported config.bsp.low_voltage_ Use the low voltage
mode.disabled mode. This limits the

ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least 4
when oscillation stop
detection is used.

Main Oscillator Wait e 2 cycles 262144 cycles Number of cycles to
Time e 1024 cycles wait for the main
e 2048 cycles oscillator clock to
e 4096 cycles stabilize.
e 8192 cycles
e 16384 cycles
e 32768 cycles
e 65536 cycles
e 131072 cycles
e 262144 cycles
ID Code Mode ¢ Unlocked Unlocked (Ignore ID) When set to 'Locked
(lgnore ID) with All Erase support',
e Locked with All the ID Code must be
Erase support set in the debugger to
e Locked read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
R11UMO0155EU0420 Revision 5.20 RENESI.\S Page 226 / 5,010

Feb.28.2024



Flexible Software Package User’s Manual

API| Reference > BSP > MCU Board Support Package > RA2A2

When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is

provided.
ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF  Set the ID Code for
Characters) character long hex FFFFFFFFFFFF locking debug access.
string This setting is only

used when the ID Code
Mode is not set to
Unlocked.

Macros

#define BSP_ELC_PERIPHERAL_MASK

Enumerations

enum elc_event t
enum icu_event_t

enum elc_peripheral_t

Macro Definition Documentation

¢ BSP_ELC_PERIPHERAL_MASK

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Sources of event signals to be linked to other peripherals or the CPU

Note
Thislist is device specific.

¢ icu_event_t

enum icu_event t

Events to be used with the IELSR register to link interrupt events to the NVIC

Note

Thislist is device specific.
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¢ elc_peripheral_t

enum elc_peripheral_t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

5.1.3.4 RA2E1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra2el_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration Options

Default

Description

OFSO register settings
OFSO register settings > Independent WDT

Start Mode e IWDT is

Disabled
e IWDT is

automatically
activated after
a reset
(Autostart
mode)

Timeout Period 128 cycles
512 cycles
1024 cycles

2048 cycles

1
16
32
64
128
256

Dedicated Clock
Frequency Divisor

75%

50%

25%

0% (no window
end position)

Window End Position

IWDT is Disabled

2048 cycles

128

0% (no window end
position)
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Window Start Position

Reset Interrupt
Request Select

Stop Control

OFSO register settings > WDT

Start Mode Select

Timeout Period

Clock Frequency

Division Ratio

Window End Position

Window Start Position

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

1024 cycles
4096 cycles
8192 cycles
16384 cycles

4
64
128
512
2048
8192

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
(register-start mode)

16384 cycles

128

0% (no window end
position)

100% (no window start
position)
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Reset Interrupt
Request

Stop Control

OFS1 register settings

Internal Clock Supply
Architecture Type

Voltage Detection 0
Circuit Start

Voltage Detection 0
Level

HOCO Oscillation
Enable

MPU

Enable or disable PC
Region 0

PCO Start

PCO End

Enable or disable PC
Region 1

e NMI
¢ Reset

e Counting
continues

e Stop counting
when entering
Sleep mode

e Type B
e Type A

¢ Voltage monitor
O reset is
enabled after
reset

¢ Voltage monitor
0 reset is
disabled after
reset

3.84V
2.82V
251V
190V
1.70Vv

e HOCO
oscillation is
enabled after
reset

e HOCO
oscillation is
disabled after
reset

e Enabled
e Disabled

Value must be an
integer between 0 and
0x000FFFFC (ROM) or
between 0x1FF00000
and Ox200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
O0x000FFFFF (ROM) or
between 0x1FF00003
and 0x200FFFFF (RAM)

e Enabled
e Disabled

Reset

Stop counting when
entering Sleep mode

Type A

Voltage monitor 0 reset
is disabled after reset

190V

HOCO oscillation is
enabled after reset

HOCO must be enabled
out of reset because
the MCU starts up in
low voltage mode and
the HOCO must be
operating in low
voltage mode.

Disabled

Ox000FFFFC

OxO000FFFFF

Disabled
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PC1 Start

PC1 End

Enable or disable
Memory Region 0

Memory Region 0 Start

Memory Region 0 End

Enable or disable
Memory Region 1

Memory Region 1 Start

Memory Region 1 End

Enable or disable
Memory Region 2

Memory Region 2 Start

Memory Region 2 End

Enable or disable
Memory Region 3

Memory Region 3 Start

Value must be an
integer between 0 and
OxO000FFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
0x000FFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

e Enabled
e Disabled

Value must be an
integer between 0 and
0x000FFFFC

Value must be an
integer between

0x00000003 and
Ox000FFFFF

e Enabled
e Disabled

Value must be an
integer between

Ox1FF00000 and

0x200FFFFC

Value must be an
integer between

0Ox1FF00003 and

Ox200FFFFF

e Enabled
e Disabled

Value must be an
integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Value must be an
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and Ox407FFFFF

e Enabled
e Disabled

Value must be an

Ox000FFFFC

OxO000FFFFF

Disabled

Ox000FFFFC

OxO000FFFFF

Disabled

0x200FFFFC

0x200FFFFF

Disabled

0x407FFFFC

O0x407FFFFF

Disabled

0x400DFFFC
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integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC

Memory Region 3 End  Value must be an Ox400DFFFF
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and 0x407FFFFF

Enable inline BSP IRQ e Enabled Disabled Using static inline

functions e Disabled functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in

return.
Use Low Voltage Mode Not Supported config.bsp.low_voltage_ Use the low voltage
mode.disabled mode. This limits the

ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least 4
when oscillation stop
detection is used.

Main Oscillator Wait e 2 cycles 262144 cycles Number of cycles to
Time e 1024 cycles wait for the main
e 2048 cycles oscillator clock to
e 4096 cycles stabilize.
e 8192 cycles
e 16384 cycles
e 32768 cycles
e 65536 cycles
e 131072 cycles
e 262144 cycles
ID Code Mode e Unlocked Unlocked (Ignore ID) When set to 'Locked
(Ignore ID) with All Erase support’,
e Locked with All the ID Code must be
Erase support set in the debugger to
¢ Locked read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.
ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF  Set the ID Code for
Characters) character long hex FFFFFFFFFFFF locking debug access.
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string This setting is only
used when the ID Code
Mode is not set to
Unlocked.

Macros

#define BSP_ELC_PERIPHERAL_MASK

Enumerations

enum elc_event t
enum icu_event_t

enum elc_peripheral_t

Macro Definition Documentation

¢ BSP_ELC_PERIPHERAL_MASK

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist is device specific.

¢ icu_event_t

enum icu_event t

Events to be used with the IELSR register to link interrupt events to the NVIC

Note

Thislist is device specific.
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¢ elc_peripheral_t

enum elc_peripheral_t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

5.1.3.5 RA2E2
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra2e2_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration Options

Default

Description

OFSO register settings
OFSO register settings > Independent WDT

Start Mode e IWDT is

Disabled
e IWDT is

automatically
activated after
a reset
(Autostart
mode)

Timeout Period 128 cycles
512 cycles
1024 cycles

2048 cycles

1
16
32
64
128
256

Dedicated Clock
Frequency Divisor

75%

50%

25%

0% (no window
end position)

Window End Position

IWDT is Disabled

2048 cycles

128

0% (no window end
position)
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Window Start Position

Reset Interrupt
Request Select

Stop Control

OFSO register settings > WDT

Start Mode Select

Timeout Period

Clock Frequency

Division Ratio

Window End Position

Window Start Position

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

1024 cycles
4096 cycles
8192 cycles
16384 cycles

4
64
128
512
2048
8192

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
(register-start mode)

16384 cycles

128

0% (no window end
position)

100% (no window start
position)

R11UMO0155EU0420 Revision 5.20
Feb.28.2024

RLENESAS

Page 235/5,010



Flexible Software Package

API| Reference > BSP > MCU Board Support Package > RA2E2

User’s Manual

Reset Interrupt
Request

Stop Control

OFS1 register settings

Internal Clock Supply
Architecture Type

Voltage Detection 0
Circuit Start

Voltage Detection 0
Level

HOCO Oscillation
Enable

MPU

Enable or disable PC
Region 0

PCO Start

PCO End

Enable or disable PC
Region 1

e NMI
¢ Reset

e Counting
continues

e Stop counting
when entering
Sleep mode

e Type B
e Type A

¢ Voltage monitor
O reset is
enabled after
reset

¢ Voltage monitor
0 reset is
disabled after
reset

3.84V
2.82V
251V
190V
1.70Vv

e HOCO
oscillation is
enabled after
reset

e HOCO
oscillation is
disabled after
reset

e Enabled
e Disabled

Value must be an
integer between 0 and
0x000FFFFC (ROM) or
between 0x1FF00000
and Ox200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
O0x000FFFFF (ROM) or
between 0x1FF00003
and 0x200FFFFF (RAM)

e Enabled
e Disabled

Reset

Stop counting when
entering Sleep mode

Type A

Voltage monitor 0 reset
is disabled after reset

190V

HOCO oscillation is
enabled after reset

HOCO must be enabled
out of reset because
the MCU starts up in
low voltage mode and
the HOCO must be
operating in low
voltage mode.

Disabled

Ox000FFFFC

OxO000FFFFF

Disabled
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PC1 Start

PC1 End

Enable or disable
Memory Region 0

Memory Region 0 Start

Memory Region 0 End

Enable or disable
Memory Region 1

Memory Region 1 Start

Memory Region 1 End

Enable or disable
Memory Region 2

Memory Region 2 Start

Memory Region 2 End

Enable or disable
Memory Region 3

Memory Region 3 Start

Value must be an
integer between 0 and
OxO000FFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
0x000FFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

e Enabled
e Disabled

Value must be an
integer between 0 and
0x000FFFFC

Value must be an
integer between

0x00000003 and
Ox000FFFFF

e Enabled
e Disabled

Value must be an
integer between

Ox1FF00000 and

0x200FFFFC

Value must be an
integer between

0Ox1FF00003 and

Ox200FFFFF

e Enabled
e Disabled

Value must be an
integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Value must be an
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and Ox407FFFFF

e Enabled
e Disabled

Value must be an

Ox000FFFFC

OxO000FFFFF

Disabled

Ox000FFFFC

OxO000FFFFF

Disabled

0x200FFFFC

0x200FFFFF

Disabled

0x407FFFFC

O0x407FFFFF

Disabled

0x400DFFFC
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Memory Region 3 End

Enable inline BSP IRQ

functions

Use Low Voltage Mode

ID Code Mode

integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC

Value must be an
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and Ox407FFFFF

e Enabled
e Disabled

Not Supported

e Unlocked
(Ignore ID)

e Locked with All
Erase support

e Locked

0x400DFFFF

Disabled

config.bsp.low_voltage_
mode.disabled

Unlocked (Ignore ID)

ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF
Characters) character long hex FFFFFFFFFFFF
string
Macros
#define BSP_ELC_PERIPHERAL_MASK
Enumerations
enum elc_event t

Using static inline
functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in
return.

Use the low voltage
mode. This limits the
ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least 4
when oscillation stop
detection is used.

When set to 'Locked
with All Erase support’,
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked',
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.
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enum icu_event_t

enum elc_peripheral _t

Macro Definition Documentation

¢ BSP_ELC_PERIPHERAL_MASK

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist is device specific.

¢ icu_event_t

enum icu_event t

Events to be used with the IELSR register to link interrupt events to the NVIC

Note

Thislist is device specific.

¢ elc_peripheral _t

enum elc_peripheral_t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

5.1.3.6 RA2E3
BSP » MCU Board Support Package
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Detailed Description

Build Time Configurations for ra2e3 fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration

Options

Default

Description

OFSO0 register settings

OFSO0 register settings > Independent WDT

Start Mode

Timeout Period

Dedicated Clock

Frequency Divisor

Window End Position

Window Start Position

Reset Interrupt
Request Select

Stop Control

IWDT is
Disabled

IWDT is
automatically
activated after
a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
Stop counting
when in Sleep,
Snooze mode,

IWDT is Disabled

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby
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or Software
Standby

OFSO register settings > WDT

Start Mode Select e Automatically Stop WDT after a reset
activate WDT (register-start mode)
after a reset
(auto-start
mode)

e Stop WDT after
a reset (register-
start mode)

Timeout Period 1024 cycles 16384 cycles
4096 cycles
8192 cycles

16384 cycles

4 128
64

128

512

2048

8192

Clock Frequency
Division Ratio

Window End Position 75% 0% (no window end
* 50% position)
e 25%
e 0% (no window
end position)

Window Start Position * 25% 100% (no window start
* 50% position)
e 75%
e 100% (no
window start
position)
Reset Interrupt e NMI Reset
Request ¢ Reset
Stop Control e Counting Stop counting when
continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings
Internal Clock Supply e Type B Type A
Architecture Type e Type A
Voltage Detection 0 ¢ Voltage monitor Voltage monitor O reset
Circuit Start 0 reset is is disabled after reset
enabled after
reset
¢ Voltage monitor
0 reset is
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Voltage Detection 0
Level

HOCO Oscillation
Enable

MPU

Enable or disable PC
Region 0

PCO Start

PCO End

Enable or disable PC
Region 1

PC1 Start

PC1 End

Enable or disable
Memory Region 0

Memory Region 0 Start

disabled after
reset

3.84V
2.82V
251V
190V
1.70V

e HOCO
oscillation is
enabled after
reset

e HOCO
oscillation is
disabled after
reset

e Enabled
e Disabled

Value must be an
integer between 0 and
OxO000FFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxOO0O0FFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

e Enabled
e Disabled

Value must be an
integer between 0 and
Ox000FFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxO00OFFFFF (ROM) or
between 0x1FF00003
and 0x200FFFFF (RAM)

e Enabled
¢ Disabled

Value must be an
integer between 0 and
0x000FFFFC

190V

HOCO oscillation is
enabled after reset

Disabled

O0xO000FFFFC

Ox000FFFFF

Disabled

0x000FFFFC

Ox000FFFFF

Disabled

0x000FFFFC

HOCO must be enabled
out of reset because
the MCU starts up in
low voltage mode and
the HOCO must be
operating in low
voltage mode.
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Memory Region 0 End

Enable or disable
Memory Region 1

Memory Region 1 Start

Memory Region 1 End

Enable or disable
Memory Region 2

Memory Region 2 Start

Memory Region 2 End

Enable or disable
Memory Region 3

Memory Region 3 Start

Memory Region 3 End

Enable inline BSP IRQ
functions

Value must be an
integer between

0x00000003 and
Ox000FFFFF

e Enabled
¢ Disabled

Value must be an
integer between

0x1FF00000 and

0x200FFFFC

Value must be an
integer between

Ox1FF00003 and

O0x200FFFFF

e Enabled
¢ Disabled

Value must be an
integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Value must be an
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and Ox407FFFFF

e Enabled
e Disabled

Value must be an
integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Value must be an
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and Ox407FFFFF

e Enabled
¢ Disabled

OXOOOFFFFF

Disabled

0x200FFFFC

0x200FFFFF

Disabled

O0x407FFFFC

0x407FFFFF

Disabled

0x400DFFFC

O0x400DFFFF

Disabled

Using static inline
functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in
return.
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Use Low Voltage Mode

Main Oscillator Wait
Time

ID Code Mode

Not Supported

e 2 cycles
e 1024 cycles

e 2048 cycles

¢ 4096 cycles

e 8192 cycles

e 16384 cycles
e 32768 cycles
e 65536 cycles
e 131072 cycles
e 262144 cycles

e Unlocked
(Ignore ID)

e Locked with All
Erase support

e Locked

config.bsp.low_voltage
mode.disabled

262144 cycles

Unlocked (Ignore ID)

Use the low voltage
mode. This limits the
ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least 4
when oscillation stop
detection is used.

Number of cycles to
wait for the main
oscillator clock to
stabilize.

When set to 'Locked
with All Erase support',
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF  Set the ID Code for
Characters) character long hex FFFFFFFFFFFF locking debug access.
string This setting is only
used when the ID Code
Mode is not set to
Unlocked.
Macros
#define BSP_ELC_PERIPHERAL MASK
Enumerations
enum elc_event t
enum icu_event_t
enum elc_peripheral _t

Macro Definition Documentation
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¢ BSP_ELC_PERIPHERAL_MASK

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist is device specific.

¢ icu_event_t

enum icu_event t

Events to be used with the IELSR register to link interrupt events to the NVIC

Note

Thislist is device specific.

¢ elc_peripheral_t

enum elc_peripheral_t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

5.1.3.7 RA2L1
BSP » MCU Board Support Package

Functions

bsp_power_mode t R _BSP_PowerModeSet (bsp_power_mode_t mode)

Detailed Description

Build Time Configurations for ra2ll_fsp
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The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration

Options

Default

Description

OFSO register settings

OFSO register settings > Independent WDT

Start Mode

Timeout Period

Dedicated Clock

Frequency Divisor

Window End Position

Window Start Position

Reset Interrupt
Request Select

Stop Control

IWDT is
Disabled

IWDT is
automatically
activated after
a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

IWDT is Disabled

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

OFSO0 register settings > WDT
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Start Mode Select e Automatically Stop WDT after a reset
activate WDT (register-start mode)
after a reset
(auto-start
mode)

e Stop WDT after
a reset (register-
start mode)

Timeout Period 1024 cycles 16384 cycles
4096 cycles
8192 cycles

16384 cycles

4 128
64

128

512

2048

8192

Clock Frequency
Division Ratio

Window End Position e 75% 0% (no window end
* 50% position)
e 25%
e 0% (no window
end position)

Window Start Position * 25% 100% (no window start
* 50% position)
e 75%
e 100% (no
window start
position)
Reset Interrupt e NMI Reset
Request ¢ Reset
Stop Control e Counting Stop counting when
continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings
Internal Clock Supply e Type B Type A
Architecture Type e Type A
Voltage Detection 0 ¢ Voltage monitor Voltage monitor O reset
Circuit Start 0 reset is is disabled after reset
enabled after
reset
e Voltage monitor
0 reset is
disabled after
reset
Voltage Detection 0 e 3.84V 1.90V
Level e 282V
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HOCO Oscillation
Enable

MPU

Enable or disable PC
Region 0

PCO Start

PCO End

Enable or disable PC
Region 1

PC1 Start

PC1 End

Enable or disable
Memory Region O

Memory Region 0 Start

Memory Region 0 End

251V
190V
1.70Vv

e HOCO
oscillation is
enabled after
reset

e HOCO
oscillation is
disabled after
reset

e Enabled
e Disabled

Value must be an
integer between 0 and
OxO000FFFFC (ROM) or
between 0x1FFO0000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxO00OFFFFF (ROM) or
between 0x1FF00003
and 0x200FFFFF (RAM)

e Enabled
e Disabled

Value must be an
integer between 0 and
Ox000FFFFC (ROM) or
between 0x1FFO0000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxO00OFFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

e Enabled
e Disabled

Value must be an
integer between 0 and
Ox000FFFFC

Value must be an
integer between

0x00000003 and
0x000FFFFF

HOCO oscillation is
enabled after reset

Disabled

0x000FFFFC

O0xO000FFFFF

Disabled

0x000FFFFC

OxO000FFFFF

Disabled

O0x000FFFFC

O0xO000FFFFF

HOCO must be enabled
out of reset because
the MCU starts up in
low voltage mode and
the HOCO must be
operating in low
voltage mode.
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Enable or disable
Memory Region 1

Memory Region 1 Start

Memory Region 1 End

Enable or disable
Memory Region 2

Memory Region 2 Start

Memory Region 2 End

Enable or disable
Memory Region 3

Memory Region 3 Start

Memory Region 3 End

Power

DC-DC Regulator

e Enabled
e Disabled

Value must be an
integer between

0Ox1FF00000 and
0x200FFFFC

Value must be an
integer between

0x1FF00003 and

0x200FFFFF

e Enabled
¢ Disabled

Value must be an
integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Value must be an
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and Ox407FFFFF

e Enabled
e Disabled

Value must be an
integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Value must be an
integer between
0x400C0003 and
Ox400DFFFF or
between 0x40100003
and Ox407FFFFF

e Disabled

e Enabled

e Enabled at
startup

Disabled

0x200FFFFC

0x200FFFFF

Disabled

0x407FFFFC

0x407FFFFF

Disabled

0x400DFFFC

0x400DFFFF

Disabled

To use the DCDC
regulator an external
inductor and capacitor
must be connected as
specified in chapter 40
of the RA2L1 manual.
In addition the supply
voltage must be above
2.4V and ICLK must be
2 MHz or higher.
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When set to 'Enabled
at startup' the BSP will
switch to the DCDC
regulator during
startup using the
voltage range specified

below.
DC-DC Supply Range e 2.4V to 2.7V 2.7V to 3.6V Set this to the
e 2.7V to 3.6V expected MCU supply
e 3.6V to 4.5V voltage (Vcc) at startup
e 45V to 5.5V when using the DCDC
regulator.
Enable inline BSP IRQ e Enabled Disabled Using static inline
functions e Disabled functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in
return.
Use Low Voltage Mode Not Supported config.bsp.low_voltage_ Use the low voltage
mode.disabled mode. This limits the
ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least 4
when oscillation stop
detection is used.
Main Oscillator Wait e 2 cycles 262144 cycles Number of cycles to
Time e 1024 cycles wait for the main
e 2048 cycles oscillator clock to
e 4096 cycles stabilize.
e 8192 cycles
e 16384 cycles
e 32768 cycles
e 65536 cycles
e 131072 cycles
e 262144 cycles
ID Code Mode e Unlocked Unlocked (Ignore ID) When set to 'Locked
(lgnore ID) with All Erase support’,
¢ Locked with All the ID Code must be
Erase support set in the debugger to
e Locked read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.
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ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF  Set the ID Code for
Characters) character long hex FFFFFFFFFFFF locking debug access.
string This setting is only

used when the ID Code
Mode is not set to
Unlocked.

Common macro for FSP header files. There is also a corresponding FSP_FOOTER macro at the end of
this file.

Macros

#define BSP_ELC_PERIPHERAL_MASK

Enumerations

enum elc_event_t
enum icu_event t
enum elc_peripheral t

enum bsp_power_mode_t

Macro Definition Documentation

¢ BSP_ELC_PERIPHERAL_MASK

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist is device specific.

¢ icu_event_t

enum icu_event t

Events to be used with the IELSR register to link interrupt events to the NVIC

Note

Thislist is device specific.
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¢ elc_peripheral_t

enum elc_peripheral_t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

¢ bsp_power_mode_t

enum bsp_power_mode_t
Voltage regulator mode

Enumerator
BSP_POWER_MODE_DCDC 2V4 TO 2V7 DCDC mode; 2.4V to 2.7V supply.
BSP_POWER_MODE_DCDC_2V7_TO_3V6 DCDC mode; 2.7V to 3.6V supply.
BSP_POWER_MODE_DCDC_3V6_TO_4V5 DCDC mode; 3.6V to 4.5V supply.
BSP_POWER_MODE_DCDC_4V5_TO_5V5 DCDC mode; 4.5V to 5.5V supply.
BSP_POWER_MODE_LDO LDO mode.

Function Documentation

¢ R_BSP_PowerModeSet()

bsp_power mode_t R_ BSP_PowerModeSet ( bsp_power mode_t mode)

Select either the LDO or DCDC regulator and/or update the MCU supply voltage range. Returns the
previously selected mode.

Note
DCDC mode has the following limitations:
o SQupply voltage must be 2.4V or greater
o Low- and Subosc-speed modes are not available
o Software Standby is not available Ensure these limitations are respected before entering DCDC mode.
If supply voltage may drop below 2.4V during operation, configure a LVD channel to interrupt or reset
the MCU near thisthreshold to switch back to the LDO.
Switching to DCDC mode temporarily disables all interrupts and blocks for 22 microseconds; switching to LDO
from DCDC temporarily disables all peripherals and interrupts and blocks for 60 microseconds.
If the supply voltage falls outside the range originally specified when starting the DCDC regulator, call this
function again with the updated supply voltage.
Returns
The previously selected power mode.
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5.1.3.8 RA4E1l
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for radel_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description

Security

Security > Exceptions

Exception Response ¢ Non-Maskable Non-Maskable Interrupt Configure the result of
Interrupt a TrustZone Filter
e Reset exception. This

exception is generated
when a the TrustZone
Filter detects access to
a protected region.

This setting is only
valid when building
projects with

TrustZone.
BusFault, HardFault, e Non-Secure Secure State Value for SCB->AIRCR
and NMI Target State register bit
e Secure State BFHFNMINS. Defines

whether BusFault and
NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with

TrustZone.
Prioritize Secure e Enabled Disabled Value for SCB->AIRCR
Exceptions e Disabled register bit PRIS. When

enabled, all Non-secure
interrupt priorities are
automatically demoted
by right shifting their
priority by one then
setting the most
significant bit. As there
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Security > SRAM Accessibility

SRAM Protection

SRAM ECC

Standby RAM

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Regions 7-0 are
all Secure.
Region 7 is Non-
secure. Regions
6-0 are Secure.
Regions 7-6 are
Non-secure.
Regions 5-0 are
Secure.
Regions 7-5 are
Non-secure.
Regions 4-0 are
Secure.
Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.
Regions 7-3 are
Non-secure.
Regions 2-0 are
Secure.
Regions 7-2 are

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

config.bsp.fsp.tz.stbra
msar.both

is effectively one less
bit care must be taken
to ensure the
prioritization of non-
secure interrupts is
correct.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
SRAMPRCR is write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether SRAM
ECC registers are write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
Standby RAM registers
are accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.
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Security > BUS Accessibility

Bus Security Attribution
Register A

Bus Security Attribution
Register B

System Reset Request
Accessibility

System Reset Status
Accessibility

Non-secure.
Regions 1-0 are
Secure.
Regions 7-1 are
Non-secure.
Region 0 is
Secure.
Regions 7-0 are
all Non-secure.

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Both Secure Secure State
and Non-Secure
State

Secure State

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Defines whether the
Slave Bus Control
Registers
(BUSSCNT<slave>) are
write accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Bus and DMAC/DTC
Error Clear Registers
are write accessible for
the Non-secure
application.

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit
SYSRESETREQS.
Defines whether the
SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
reset status registers
(RSTSRN) can be
cleared from the Non-
secure application.

This setting is only
valid when building
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Battery Backup
Accessibility

Uninitialized Non-
Secure Application
Fallback

Both Secure

Both Secure and Non-

and Non-Secure Secure State

State

Secure State

Enable
Uninitialized
Non-Secure

Enable Uninitialized
Non-Secure Application
Fallback

Application
Fallback

e Disable
Uninitialized
Non-Secure
Application
Fallback

OFSO register settings
OFSO register settings > Independent WDT

Start Mode e [WDT is

Disabled
e IWDT is

automatically
activated after
a reset
(Autostart
mode)

IWDT is Disabled

Timeout Period e 128 cycles
e 512 cycles
e 1024 cycles

2048 cycles

projects with
TrustZone.

Defines whether the
battery backup
registers are accessible
for the Non-secure
application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRN
registers which are
both read and write
protected.

This setting is only
valid when building
projects with
TrustZone.

If enabled, the secure
application checks if
the non-secure
application has been
programmed in non-
secure flash before
branching. If the non-
secure application has
not been programmed,
then the secure
application branches to
an infinite loop in non-
secure RAM. This
prevents an issue
where the debugger
may not connect if the
MCU is configured in
the NSECSD lifecycle
state.
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Dedicated Clock
Frequency Divisor

Window End Position

Window Start Position

Reset Interrupt
Request Select

Stop Control

OFSO register settings > WDT
Start Mode Select

2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after
a reset (register-

start mode)

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
(register-start mode)

Timeout Period e 1024 cycles 16384 cycles
e 4096 cycles
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Clock Frequency
Division Ratio

Window End Position

Window Start Position

Reset Interrupt
Request

Stop Control

OFS1 SEL register settings

Voltage Detection 0
Level Security
Attribution

Voltage Detection 0
Circuit Start Security
Attribution

OFS1 register settings

Voltage Detection 0
Circuit Start

8192 cycles
16384 cycles

4
64
128
512
2048
8192

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI
Reset

Counting
continues
Stop counting
when entering
Sleep mode

VDSEL setting
loads from
OFS1_SEC
VDSEL setting
loads from
OFs1

LVDAS setting
loads from
OFS1_SEC
LVDAS setting
loads from
OFS1

Voltage monitor

0 reset is
enabled after
reset

Voltage monitor

0 reset is
disabled after
reset

128

0% (no window end
position)

100% (no window start
position)

Reset

Stop counting when
entering Sleep mode

VDSEL setting loads
from OFS1_SEC

LVDAS setting loads
from OFS1_SEC

Voltage monitor 0 reset
is disabled after reset
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Voltage Detection O e 294V 2.80V
Level e 287V
e 280V
HOCO Oscillation e HOCO HOCO oscillation is
Enable oscillation is enabled after reset
enabled after
reset
e HOCO

oscillation is
disabled after

reset
Block Protection Settings (BPS)
BPS Refer to the RA ou Configure Block
Configuration tool for Protection Register

available options.

Permanent Block Protection Settings (PBPS)

PBPS Refer to the RA ou Configure Permanent
Configuration tool for Block Protection
available options. Register

Clocks

HOCO FLL Function e Enabled Disabled Setting this option to

¢ Disabled Enabled improves

HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not

available.
Enable inline BSP IRQ e Enabled Enabled Using static inline
functions e Disabled functions will slightly

increase code size, but
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Main Oscillator Wait
Time

3 cycles 8163 cycles
35 cycles

67 cycles

131 cycles

259 cycles

547 cycles

1059 cycles

2147 cycles

4291 cycles

8163 cycles

Macros

#define BSP_ELC_PERIPHERAL_MASK

Enumerations

enum elc_event t
enum elc_peripheral t

Macro Definition Documentation

¢ BSP_ELC_PERIPHERAL_MASK

will slightly decrease
cycles taken in ISRs in
return.

Number of cycles to
wait for the main
oscillator clock to
stabilize.

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist is device specific.

¢ elc_peripheral_t

enum elc_peripheral_t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.
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5.1.3.9 RA4E2
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for rade2_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description

Security

Security > Exceptions

Exception Response ¢ Non-Maskable Non-Maskable Interrupt Configure the result of
Interrupt a TrustZone Filter
e Reset exception. This

exception is generated
when the TrustZone
Filter detects access to
a protected region.

This setting is only
valid when building
projects with

TrustZone.
BusFault, HardFault, e Non-Secure Secure State Value for SCB->AIRCR
and NMI Target State register bit
e Secure State BFHFNMINS. Defines

whether BusFault and
NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with

TrustZone.
Prioritize Secure e Enabled Disabled Value for SCB->AIRCR
Exceptions e Disabled register bit PRIS. When

enabled, all Non-secure
interrupt priorities are
automatically demoted
by right shifting their
priority by one then
setting the most
significant bit. As there
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Security > SRAM Accessibility

SRAM Protection

SRAM ECC

Standby RAM

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Regions 7-0 are
all Secure.
Region 7 is Non-
secure. Regions
6-0 are Secure.
Regions 7-6 are
Non-secure.
Regions 5-0 are
Secure.
Regions 7-5 are
Non-secure.
Regions 4-0 are
Secure.
Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.
Regions 7-3 are
Non-secure.
Regions 2-0 are
Secure.
Regions 7-2 are

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

config.bsp.fsp.tz.stbra
msar.both

is effectively one less
bit care must be taken
to ensure the
prioritization of non-
secure interrupts is
correct.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
SRAMPRCR is write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether SRAM
ECC registers are write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
Standby RAM registers
are accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.
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Security > BUS Accessibility

Bus Security Attribution
Register A

Bus Security Attribution
Register B

System Reset Request
Accessibility

Cache Accessibility

Non-secure.
Regions 1-0 are
Secure.
Regions 7-1 are
Non-secure.
Region 0 is
Secure.
Regions 7-0 are
all Non-secure.

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Both Secure Secure State
and Non-Secure
State

Secure State

Both Secure Both Secure and Non-
and Non-Secure Secure State
State

e Secure State

Defines whether the
Slave Bus Control
Registers
(BUSSCNT<slave>) are
write accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Bus and DMAC/DTC
Error Clear Registers
are write accessible for
the Non-secure
application.

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit
SYSRESETREQS.
Defines whether the
SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Cache registers are
write accessible for the
Non-secure application.

This setting is only
valid when building
protjects with
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TrustZone.
System Reset Status e Both Secure Both Secure and Non-  Defines whether the
Accessibility and Non-Secure Secure State reset status registers
State (RSTSRn) can be
e Secure State cleared from the Non-

secure application.

This setting is only
valid when building
projects with

TrustZone.
Battery Backup e Both Secure Both Secure and Non-  Defines whether the
Accessibility and Non-Secure Secure State battery backup
State registers are accessible
e Secure State for the Non-secure

application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRN
registers which are
both read and write
protected.

This setting is only
valid when building
projects with

TrustZone.

Uninitialized Non- e Enable Enable Uninitialized If enabled, the secure
Secure Application Uninitialized Non-Secure Application application checks if
Fallback Non-Secure Fallback the non-secure

Application application has been

Fallback programmed in non-

e Disable secure flash before

Uninitialized branching. If the non-

Non-Secure secure application has

Application not been programmed,

Fallback then the secure

application branches to
an infinite loop in non-
secure RAM. This
prevents an issue
where the debugger
may not connect if the
MCU is configured in
the NSECSD lifecycle

state.
OFSO register settings
OFSO register settings > Independent WDT
Start Mode e |WDT is IWDT is Disabled
Disabled
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Timeout Period

Dedicated Clock

Frequency Divisor

Window End Position

Window Start Position

Reset Interrupt
Request Select

Stop Control

OFSO register settings > WDT
Start Mode Select

IWDT is
automatically
activated after
a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
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activate WDT (register-start mode)
after a reset
(auto-start
mode)
e Stop WDT after
a reset (register-
start mode)

Timeout Period 1024 cycles 16384 cycles
4096 cycles
8192 cycles

16384 cycles

4 128
64

128

512

2048

8192

Clock Frequency
Division Ratio

Window End Position 75% 0% (no window end
* 50% position)
e 25%
e 0% (no window
end position)

Window Start Position * 25% 100% (no window start
* 50% position)
e 75%
e 100% (no
window start
position)
Reset Interrupt e NMI Reset
Request ¢ Reset
Stop Control e Counting Stop counting when
continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings
Voltage Detection 0 e Voltage monitor Voltage monitor 0 reset
Circuit Start 0 reset is is disabled after reset
enabled after
reset
* Voltage monitor
0 reset is
disabled after
reset
Voltage Detection 0 e 294V 2.80V
Level e 287V
e 280V
HOCO Oscillation e HOCO HOCO oscillation is
Enable oscillation is disabled after reset
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Block Protection Settings (BPS)

BPSO

enabled after
reset

HOCO
oscillation is
disabled after
reset

Flash Block 0 ou
Flash Block 1
Flash Block 2
Flash Block 3
Flash Block 4
Flash Block 5
Flash Block 6
Flash Block 7
Flash Block 8
Flash Block 9

Permanent Block Protection Settings (PBPS)

Configure Block
Protection Register 0

PBPSO e Flash Block 0 ou Configure Permanent
¢ Flash Block 1 Block Protection
¢ Flash Block 2 Register 0
e Flash Block 3
e Flash Block 4
¢ Flash Block 5
¢ Flash Block 6
¢ Flash Block 7
¢ Flash Block 8
e Flash Block 9
Clocks
HOCO FLL Function e Enabled Disabled Setting this option to
e Disabled Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.
The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.
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Enable inline BSP IRQ

functions

Startup C-Cache Line
Size

Main Oscillator Wait
Time

ID Code Mode

e Enabled
e Disabled

e 32 Bytes
e 64 Bytes

3 cycles

35 cycles
67 cycles
131 cycles
259 cycles
547 cycles
1059 cycles
2147 cycles
4291 cycles
8163 cycles

¢ Unlocked
(Ignore ID)

e Locked with All
Erase support

e Locked

Enabled

32 Bytes

8163 cycles

Unlocked (Ignore ID)

ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF
Characters) character long hex FFFFFFFFFFFF
string
Macros
#define BSP_ELC_PERIPHERAL_MASK
Enumerations
enum elc_event t

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not
available.

Using static inline
functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in
return.

Set the C-Cache line
size configured during
startup.

Number of cycles to
wait for the main
oscillator clock to
stabilize.

When set to 'Locked
with All Erase support’,
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.
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enum elc_peripheral _t

Macro Definition Documentation

¢ BSP_ELC_PERIPHERAL_MASK

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Note

Thislist is device specific.

Sources of event signals to be linked to other peripherals or the CPU

¢ elc_peripheral_t

enum elc_peripheral t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

5.1.3.10 RAAM1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for radm1l_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO0 register settings
OFSO0 register settings > Independent WDT
Start Mode e I[WDT is IWDT is Disabled
Disabled
e I[WDT is
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Timeout Period

Dedicated Clock

Frequency Divisor

Window End Position

Window Start Position

Reset Interrupt
Request Select

Stop Control

OFSO register settings > WDT

Start Mode Select

Timeout Period

automatically
activated after
a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

1024 cycles

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
(register-start mode)

16384 cycles
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e 4096 cycles
e 8192 cycles
e 16384 cycles

Clock Frequency e 4 128
Division Ratio * 64

e 128
e 512
e 2048
e 8192

Window End Position e 75% 0% (no window end
* 50% position)
e 25%
¢ 0% (no window
end position)

Window Start Position * 25% 100% (no window start
* 50% position)
e 75%
e 100% (no
window start
position)
Reset Interrupt e NMI Reset
Request ¢ Reset
Stop Control e Counting Stop counting when
continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings
Voltage Detection 0 e Voltage monitor Voltage monitor 0 reset
Circuit Start 0 reset is is disabled after reset
enabled after
reset
* Voltage monitor
0 reset is
disabled after
reset
Voltage Detection 0 e 3.84V 190V
Level e 282V
e 251V
e 190V
e 1.70V
HOCO Oscillation HOCO oscillation is HOCO oscillation is HOCO must be enabled
Enable enabled after reset enabled after reset out of reset because
the MCU starts up in
low voltage mode and
the HOCO must be
operating in low
voltage mode.
MPU
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Enable or disable PC
Region 0

PCO Start

PCO End

Enable or disable PC
Region 1

PC1 Start

PC1 End

Enable or disable
Memory Region 0

Memory Region 0 Start

Memory Region 0 End

Enable or disable
Memory Region 1

Memory Region 1 Start

Memory Region 1 End

Enable or disable
Memory Region 2

e Enabled
e Disabled

Value must be an
integer between 0 and
OXxO00FFFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxOOFFFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

e Enabled
e Disabled

Value must be an
integer between 0 and
OxO00FFFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxO0OFFFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

e Enabled
¢ Disabled

Value must be an
integer between 0 and
OxO00FFFFFC

Value must be an
integer between

0x00000003 and
OxO0FFFFFF

e Enabled
e Disabled

Value must be an
integer between

0x1FF00000 and

0x200FFFFC

Value must be an
integer between

Ox1FF00003 and

0x200FFFFF

e Enabled
e Disabled

Disabled

OxOOFFFFFC

OXOOFFFFFF

Disabled

OxO0OFFFFFC

OXOOFFFFFF

Disabled

OxOOFFFFFC

OXOOFFFFFF

Disabled

0x200FFFFC

0x200FFFFF

Disabled
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Memory Region 2 Start Value must be an Ox407FFFFC
integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC

Memory Region 2 End  Value must be an Ox407FFFFF
integer between
0x400C0003 and
O0x400DFFFF or
between 0x40100003
and Ox407FFFFF

Enable or disable e Enabled Disabled
Memory Region 3 e Disabled
Memory Region 3 Start Value must be an 0x400DFFFC

integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Memory Region 3 End  Value must be an Ox400DFFFF
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and 0x407FFFFF

Enable inline BSP IRQ e Enabled Enabled Using static inline

functions e Disabled functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in

return.
Use Low Voltage Mode e Enabled Disabled Use the low voltage
e Disabled mode. This limits the

ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least

4.

Main Oscillator Wait e 2 cycles 262144 cycles Number of cycles to
Time e 1024 cycles wait for the main

e 2048 cycles oscillator clock to

e 4096 cycles stabilize.

e 8192 cycles

e 16384 cycles

e 32768 cycles

e 65536 cycles

e 131072 cycles

e 262144 cycles
ID Code Mode ¢ Unlocked Unlocked (Ignore ID) When set to 'Locked
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(lgnore ID)
e Locked with All
Erase support
e Locked

ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF
Characters) character long hex FFFFFFFFFFFF
string
Macros
#define BSP_ELC PERIPHERAL MASK

Enumerations

enum elc_event_t

enum elc_peripheral _t

Macro Definition Documentation

& BSP_ELC_PERIPHERAL_MASK

with All Erase support’,
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Note

Thislist is device specific.

Sources of event signals to be linked to other peripherals or the CPU

R11UMO0155EU0420 Revision 5.20
Feb.28.2024

RLENESAS

Page 274 /5,010




Flexible Software Package User’s Manual

API| Reference > BSP > MCU Board Support Package > RA4M1

¢ elc_peripheral_t

enum elc_peripheral_t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

5.1.3.11 RA4M2
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for radm2_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration Options Default Description

Security

Security > Exceptions

Exception Response ¢ Non-Maskable Non-Maskable Interrupt Configure the result of
Interrupt a TrustZone Filter
¢ Reset exception. This

exception is generated
when the TrustZone
Filter detects access to
a protected region.

This setting is only
valid when building
projects with

TrustZone.
BusFault, HardFault, e Non-Secure Secure State Value for SCB->AIRCR
and NMI Target State register bit
e Secure State BFHFNMINS. Defines

whether BusFault and
NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with
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TrustZone.
Prioritize Secure e Enabled Disabled Value for SCB->AIRCR
Exceptions e Disabled register bit PRIS. When

enabled, all Non-secure
interrupt priorities are
automatically demoted
by right shifting their
priority by one then
setting the most
significant bit. As there
is effectively one less
bit care must be taken
to ensure the
prioritization of non-
secure interrupts is
correct.

This setting is only
valid when building
projects with

TrustZone.
Security > SRAM Accessibility
SRAM Protection e Both Secure Both Secure and Non- Defines whether
and Non-Secure Secure State SRAMPRCR is write
State accessible for the Non-
e Secure State secure application.

This setting is only
valid when building
projects with

TrustZone.
SRAM ECC e Both Secure Both Secure and Non- Defines whether SRAM
and Non-Secure Secure State ECC registers are write
State accessible for the Non-
e Secure State secure application.

This setting is only
valid when building
projects with

TrustZone.
Standby RAM e Regions 7-0 are config.bsp.fsp.tz.stbra  Defines whether

all Secure. msar.both Standby RAM registers

¢ Region 7 is Non- are accessible for the
secure. Regions Non-secure application.
6-0 are Secure.

e Regions 7-6 are This setting is only
Non-secure. valid when building
Regions 5-0 are projects with
Secure. TrustZone.

e Regions 7-5 are
Non-secure.
Regions 4-0 are
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Secure.

¢ Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.

e Regions 7-3 are
Non-secure.
Regions 2-0 are
Secure.

e Regions 7-2 are
Non-secure.
Regions 1-0 are
Secure.

¢ Regions 7-1 are
Non-secure.
Region 0 is
Secure.

e Regions 7-0 are
all Non-secure.

Security > BUS Accessibility

Bus Security Attribution ¢ Both Secure Both Secure and Non-  Defines whether the
Register A and Non-Secure Secure State Slave Bus Control
State Registers
e Secure State (BUSSCNT<slave>) are

write accessible for the
Non-secure application.

This setting is only
valid when building
projects with

TrustZone.
Bus Security Attribution e Both Secure Both Secure and Non-  Defines whether the
Register B and Non-Secure Secure State Bus and DMAC/DTC
State Error Clear Registers
e Secure State are write accessible for
the Non-secure
application.

This setting is only
valid when building
projects with

TrustZone.
System Reset Request e Both Secure Secure State Value for SCB->AIRCR
Accessibility and Non-Secure register bit
State SYSRESETREQS.
e Secure State Defines whether the

SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
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Cache Accessibility

System Reset Status
Accessibility

Battery Backup
Accessibility

Uninitialized Non-
Secure Application
Fallback

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Enable
Uninitialized
Non-Secure
Application
Fallback
Disable
Uninitialized
Non-Secure
Application
Fallback

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

Enable Uninitialized
Non-Secure Application
Fallback

projects with
TrustZone.

Defines whether the
Cache registers are
write accessible for the
Non-secure application.

This setting is only
valid when building
protjects with
TrustZone.

Defines whether the
reset status registers
(RSTSRnN) can be
cleared from the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
battery backup
registers are accessible
for the Non-secure
application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRn
registers which are
both read and write
protected.

This setting is only
valid when building
projects with
TrustZone.

If enabled, the secure
application checks if
the non-secure
application has been
programmed in non-
secure flash before
branching. If the non-
secure application has
not been programmed,
then the secure
application branches to
an infinite loop in non-
secure RAM. This
prevents an issue
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OFSO0 register settings
OFSO0 register settings > Independent WDT

Start Mode e IWDT is

Disabled
e IWDT is

automatically
activated after
a reset
(Autostart
mode)

Timeout Period e 128 cycles
e 512 cycles
e 1024 cycles

2048 cycles

1
16
32
64
128
* 256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

Dedicated Clock
Frequency Divisor

Window End Position

Window Start Position

Reset Interrupt e NMI request or
Request Select interrupt
request is
enabled
e Resetis
enabled

Stop Control e Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.

where the debugger
may not connect if the
MCU is configured in
the NSECSD lifecycle
state.

IWDT is Disabled

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby
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Device will
enter Software
Standby Mode)
¢ Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

OFSO register settings > WDT

Start Mode Select e Automatically Stop WDT after a reset
activate WDT (register-start mode)
after a reset
(auto-start
mode)

e Stop WDT after
a reset (register-
start mode)

Timeout Period 1024 cycles 16384 cycles
4096 cycles
8192 cycles

16384 cycles

4 128
64

128

512

2048

8192

Clock Frequency
Division Ratio

Window End Position 75% 0% (no window end
50% position)

25%

0% (no window

end position)

Window Start Position e 25% 100% (no window start
* 50% position)
e 75%
* 100% (no
window start
position)
Reset Interrupt e NMI Reset
Request ¢ Reset
Stop Control e Counting Stop counting when
continues entering Sleep mode

¢ Stop counting
when entering

Sleep mode
OFS1_SEL register settings
Voltage Detection 0 ¢ VDSEL setting VDSEL setting loads
Level Security loads from from OFS1_SEC
Attribution OFS1_SEC
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e VDSEL setting
loads from
OFS1

Voltage Detection 0 e LVDAS setting
Circuit Start Security loads from
Attribution OFS1 SEC
e LVDAS setting
loads from
OFs1

LVDAS setting loads
from OFS1_SEC

OFS1 register settings

Voltage Detection 0 e Voltage monitor Voltage monitor 0 reset
Circuit Start 0 reset is is disabled after reset

enabled after

reset

¢ Voltage monitor

0 reset is

disabled after

reset

Voltage Detection 0 e 294V 2.80V
Level e 287V
e 280V

HOCO Oscillation e HOCO
Enable oscillation is
enabled after
reset
e HOCO
oscillation is
disabled after
reset

HOCO oscillation is
disabled after reset

Block Protection Settings (BPS)

BPSO Refer to the RA ou
Configuration tool for
available options.

Configure Block
Protection Register 0

Permanent Block Protection Settings (PBPS)

PBPSO

Clocks
HOCO FLL Function

Refer to the RA
Configuration tool for
available options.

e Enabled
¢ Disabled

ou

Disabled

Configure Permanent
Block Protection
Register 0

Setting this option to
Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
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Enable inline BSP IRQ
functions

Startup C-Cache Line
Size

Main Oscillator Wait
Time

Macros

#define

Enumerations

enum

enum

Enabled Enabled

Disabled

32 Bytes
64 Bytes

32 Bytes

3 cycles 8163 cycles
35 cycles

67 cycles

131 cycles

259 cycles

547 cycles

1059 cycles

2147 cycles

4291 cycles

8163 cycles

BSP_ELC_PERIPHERAL_MASK

elc_event_t

elc_peripheral _t

Macro Definition Documentation

oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not
available.

Using static inline
functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in
return.

Set the C-Cache line
size configured during
startup.

Number of cycles to
wait for the main
oscillator clock to
stabilize.
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¢ BSP_ELC_PERIPHERAL_MASK

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist is device specific.

¢ elc_peripheral_t

enum elc_peripheral_t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

5.1.3.12 RAAM3
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for radm3_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description

Security

Security > Exceptions

Exception Response ¢ Non-Maskable Non-Maskable Interrupt Configure the result of
Interrupt a TrustZone Filter
¢ Reset exception. This

exception is generated
when the TrustZone
Filter detects access to
a protected region.
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BusFault, HardFault,
and NMI Target

Prioritize Secure
Exceptions

Security > SRAM Accessibility

SRAM Protection

SRAM ECC

* Non-Secure
State
e Secure State

e Enabled
e Disabled

e Both Secure

and Non-Secure

State
e Secure State

e Both Secure

and Non-Secure

State

Secure State

Disabled

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit

BFHFNMINS. Defines
whether BusFault and
NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit PRIS. When
enabled, all Non-secure
interrupt priorities are
automatically demoted
by right shifting their
priority by one then
setting the most
significant bit. As there
is effectively one less
bit care must be taken
to ensure the
prioritization of non-
secure interrupts is
correct.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
SRAMPRCR is write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether SRAM
ECC registers are write
accessible for the Non-
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Standby RAM

Security > BUS Accessibility
Bus Security Attribution

Register A

Bus Security Attribution

Register B

Secure State

Regions 7-0 are config.bsp.fsp.tz.stbra
all Secure. msar.both
Region 7 is Non-
secure. Regions
6-0 are Secure.
Regions 7-6 are
Non-secure.
Regions 5-0 are
Secure.
Regions 7-5 are
Non-secure.
Regions 4-0 are
Secure.
Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.
Regions 7-3 are
Non-secure.
Regions 2-0 are
Secure.
Regions 7-2 are
Non-secure.
Regions 1-0 are
Secure.
Regions 7-1 are
Non-secure.
Region 0 is
Secure.
Regions 7-0 are
all Non-secure.

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Both Secure Both Secure and Non-
and Non-Secure Secure State
State

secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
Standby RAM registers
are accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Slave Bus Control
Registers
(BUSSCNT<slave>) are
write accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Bus and DMAC/DTC
Error Clear Registers
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System Reset Request

Accessibility

Cache Accessibility

System Reset Status
Accessibility

Battery Backup
Accessibility

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

are write accessible for
the Non-secure
application.

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit
SYSRESETREQS.
Defines whether the
SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Cache registers are
write accessible for the
Non-secure application.

This setting is only
valid when building
protjects with
TrustZone.

Defines whether the
reset status registers
(RSTSRnN) can be
cleared from the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
battery backup
registers are accessible
for the Non-secure
application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRN
registers which are
both read and write
protected.
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Uninitialized Non-
Secure Application
Fallback

OFSO0 register settings

Enable
Uninitialized
Non-Secure
Application
Fallback
Disable
Uninitialized
Non-Secure
Application
Fallback

OFSO0 register settings > Independent WDT

Start Mode

Timeout Period

Dedicated Clock

Frequency Divisor

Window End Position

Window Start Position

IWDT is
Disabled
IWDT is

automatically
activated after

a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%
50%
25%

0% (no window

end position)

25%
50%

Enable Uninitialized
Non-Secure Application
Fallback

IWDT is Disabled

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

This setting is only
valid when building
projects with
TrustZone.

If enabled, the secure
application checks if
the non-secure
application has been
programmed in non-
secure flash before
branching. If the non-
secure application has
not been programmed,
then the secure
application branches to
an infinite loop in non-
secure RAM. This
prevents an issue
where the debugger
may not connect if the
MCU is configured in
the NSECSD lifecycle
state.
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e 75%

e 100% (no
window start
position)

Reset Interrupt e NMI request or Reset is enabled
Request Select interrupt
request is
enabled
e Resetis
enabled

Stop Control e Counting Stop counting when in
continues Sleep, Snooze mode, or
(Note: Device Software Standby
will not enter
Deep Standby
Mode when
selected.

Device will
enter Software
Standby Mode)
e Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

OFSO register settings > WDT

Start Mode Select e Automatically Stop WDT after a reset
activate WDT (register-start mode)
after a reset
(auto-start
mode)

e Stop WDT after
a reset (register-
start mode)

Timeout Period e 1024 cycles 16384 cycles
e 4096 cycles
e 8192 cycles

16384 cycles

4 128
64

128

512

2048

8192

Clock Frequency
Division Ratio

75% 0% (no window end
50% position)

25%

0% (no window

end position)

Window End Position

Window Start Position e 25% 100% (no window start
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Reset Interrupt
Request

Stop Control

OFS1 SEL register settings

Voltage Detection 0
Level Security
Attribution

Voltage Detection 0
Circuit Start Security
Attribution

OFS1 register settings

Voltage Detection 0
Circuit Start

Voltage Detection 0
Level

HOCO Oscillation
Enable

Block Protection Settings (BPS)
BPSO

50%

75%

100% (no
window start
position)

NMI
Reset

Counting
continues
Stop counting
when entering
Sleep mode

VDSEL setting
loads from
OFS1_SEC
VDSEL setting
loads from
OFS1

LVDAS setting
loads from
OFS1 _SEC
LVDAS setting
loads from
OFS1

Voltage monitor

0 reset is
enabled after
reset

Voltage monitor

O reset is
disabled after
reset

294V
287V
2.80V

HOCO
oscillation is
enabled after
reset

HOCO
oscillation is
disabled after
reset

Refer to the RA

Configuration tool for

position)

Reset

Stop counting when
entering Sleep mode

VDSEL setting loads
from OFS1_SEC

LVDAS setting loads
from OFS1_SEC

Voltage monitor 0 reset
is disabled after reset

2.80V

HOCO oscillation is
disabled after reset

ou Configure Block
Protection Register 0
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available options.

BPS1 Flash Block 32  0U Configure Block
Flash Block 33 Protection Register 1
Flash Block 34

Flash Block 35

Flash Block 36

Flash Block 37

Permanent Block Protection Settings (PBPS)

PBPSO Refer to the RA ou Configure Permanent
Configuration tool for Block Protection
available options. Register 0
PBPS1 e Flash Block 32 0U Configure Permanent
¢ Flash Block 33 Block Protection
e Flash Block 34 Register 1
e Flash Block 35
e Flash Block 36
e Flash Block 37

Clocks

HOCO FLL Function e Enabled Disabled Setting this option to
e Disabled Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not
available.

Enable inline BSP IRQ ¢ Enabled Enabled Using static inline

functions ¢ Disabled functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in
return.
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Startup C-Cache Line e 32 Bytes 32 Bytes
Size * 64 Bytes
Main Oscillator Wait e 3 cycles 8163 cycles
Time e 35 cycles

e 67 cycles

e 131 cycles

e 259 cycles

e 547 cycles

e 1059 cycles

e 2147 cycles

e 4291 cycles

e 8163 cycles
Macros

#define BSP_ELC _PERIPHERAL MASK

Enumerations

enum elc_event t

enum elc_peripheral_t

Macro Definition Documentation

¢ BSP_ELC_PERIPHERAL_MASK

Set the C-Cache line
size configured during
startup.

Number of cycles to
wait for the main
oscillator clock to
stabilize.

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist is device specific.

¢ elc_peripheral_t

enum elc_peripheral t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.
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5.1.3.13 RA4T1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra4tl_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description

Security

Security > Exceptions

Exception Response ¢ Non-Maskable Non-Maskable Interrupt Configure the result of
Interrupt a TrustZone Filter
e Reset exception. This

exception is generated
when the TrustZone
Filter detects access to
a protected region.

This setting is only
valid when building
projects with

TrustZone.
BusFault, HardFault, e Non-Secure Secure State Value for SCB->AIRCR
and NMI Target State register bit
e Secure State BFHFNMINS. Defines

whether BusFault and
NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with

TrustZone.
Prioritize Secure e Enabled Disabled Value for SCB->AIRCR
Exceptions e Disabled register bit PRIS. When

enabled, all Non-secure
interrupt priorities are
automatically demoted
by right shifting their
priority by one then
setting the most
significant bit. As there
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Security > SRAM Accessibility

SRAM Protection

SRAM ECC

Standby RAM

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Regions 7-0 are
all Secure.
Region 7 is Non-
secure. Regions
6-0 are Secure.
Regions 7-6 are
Non-secure.
Regions 5-0 are
Secure.
Regions 7-5 are
Non-secure.
Regions 4-0 are
Secure.
Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.
Regions 7-3 are
Non-secure.
Regions 2-0 are
Secure.
Regions 7-2 are

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

config.bsp.fsp.tz.stbra
msar.both

is effectively one less
bit care must be taken
to ensure the
prioritization of non-
secure interrupts is
correct.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
SRAMPRCR is write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether SRAM
ECC registers are write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
Standby RAM registers
are accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.
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Security > BUS Accessibility

Bus Security Attribution
Register A

Bus Security Attribution
Register B

System Reset Request
Accessibility

Cache Accessibility

Non-secure.
Regions 1-0 are
Secure.
Regions 7-1 are
Non-secure.
Region 0 is
Secure.
Regions 7-0 are
all Non-secure.

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Both Secure Both Secure and Non-
and Non-Secure Secure State

State

Secure State

Both Secure Secure State
and Non-Secure
State

Secure State

Both Secure Both Secure and Non-
and Non-Secure Secure State
State

e Secure State

Defines whether the
Slave Bus Control
Registers
(BUSSCNT<slave>) are
write accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Bus and DMAC/DTC
Error Clear Registers
are write accessible for
the Non-secure
application.

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit
SYSRESETREQS.
Defines whether the
SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Cache registers are
write accessible for the
Non-secure application.

This setting is only
valid when building
protjects with
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TrustZone.
System Reset Status e Both Secure Both Secure and Non-  Defines whether the
Accessibility and Non-Secure Secure State reset status registers
State (RSTSRn) can be
e Secure State cleared from the Non-

secure application.

This setting is only
valid when building
projects with

TrustZone.
Battery Backup e Both Secure Both Secure and Non-  Defines whether the
Accessibility and Non-Secure Secure State battery backup
State registers are accessible
e Secure State for the Non-secure

application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRN
registers which are
both read and write
protected.

This setting is only
valid when building
projects with

TrustZone.

Uninitialized Non- e Enable Enable Uninitialized If enabled, the secure
Secure Application Uninitialized Non-Secure Application application checks if
Fallback Non-Secure Fallback the non-secure

Application application has been

Fallback programmed in non-

e Disable secure flash before

Uninitialized branching. If the non-

Non-Secure secure application has

Application not been programmed,

Fallback then the secure

application branches to
an infinite loop in non-
secure RAM. This
prevents an issue
where the debugger
may not connect if the
MCU is configured in
the NSECSD lifecycle

state.
OFSO register settings
OFSO register settings > Independent WDT
Start Mode e |WDT is IWDT is Disabled
Disabled
R11UMO155EU0420 Revision 5.20 RLENESAS Page 295 / 5,010

Feb.28.2024



Flexible Software Package

API| Reference > BSP > MCU Board Support Package > RA4T1

User’s Manual

Timeout Period

Dedicated Clock

Frequency Divisor

Window End Position

Window Start Position

Reset Interrupt
Request Select

Stop Control

OFSO register settings > WDT
Start Mode Select

IWDT is
automatically
activated after
a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
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activate WDT (register-start mode)
after a reset
(auto-start
mode)
e Stop WDT after
a reset (register-
start mode)

Timeout Period 1024 cycles 16384 cycles
4096 cycles
8192 cycles

16384 cycles

4 128
64

128

512

2048

8192

Clock Frequency
Division Ratio

Window End Position 75% 0% (no window end
* 50% position)
e 25%
e 0% (no window
end position)

Window Start Position * 25% 100% (no window start
* 50% position)
e 75%
e 100% (no
window start
position)
Reset Interrupt e NMI Reset
Request ¢ Reset
Stop Control e Counting Stop counting when
continues entering Sleep mode

e Stop counting
when entering

Sleep mode
OFS1 register settings
Voltage Detection 0 e Voltage monitor Voltage monitor 0 reset
Circuit Start 0 reset is is disabled after reset
enabled after
reset
* Voltage monitor
0 reset is
disabled after
reset
Voltage Detection 0 e 294V 2.80V
Level e 287V
e 280V
HOCO Oscillation e HOCO HOCO oscillation is
Enable oscillation is disabled after reset
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enabled after
reset

e HOCO
oscillation is
disabled after

reset
Block Protection Settings (BPS)
BPSO Refer to the RA ou Configure Block
Configuration tool for Protection Register 0

available options.

Permanent Block Protection Settings (PBPS)

PBPSO Refer to the RA ou Configure Permanent
Configuration tool for Block Protection
available options. Register 0
Clocks
HOCO FLL Function ¢ Enabled Disabled Setting this option to
¢ Disabled Enabled improves

HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not

available.
Enable inline BSP IRQ e Enabled Enabled Using static inline
functions e Disabled functions will slightly

increase code size, but
will slightly decrease
cycles taken in ISRs in

return.
Startup C-Cache Line e 32 Bytes 32 Bytes Set the C-Cache line
Size e 64 Bytes size configured during
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TFU Mathlib e Disabled Enabled
e Enabled

Main Oscillator Wait
Time

3 cycles 8163 cycles
35 cycles

67 cycles

131 cycles

259 cycles

547 cycles

1059 cycles

2147 cycles

4291 cycles

8163 cycles

ID Code Mode e Unlocked Unlocked (Ignore ID)
(lgnore ID)
e Locked with All
Erase support
e Locked

ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF
Characters) character long hex FFFFFFFFFFFF
string

Macros

#define BSP_ELC_PERIPHERAL_MASK

Enumerations

enum elc_event_t

enum elc_peripheral t

Macro Definition Documentation

startup.

If enabled,
trigonometric library
functions sinf, cosf,
atan2f, and hypotf are
replaced with hardware
accelerated TFU
functions. Disable this
if reentrant access to
these functions is
required.

Number of cycles to
wait for the main
oscillator clock to
stabilize.

When set to 'Locked
with All Erase support’,
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked',
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.
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¢ BSP_ELC_PERIPHERAL_MASK

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Note

Thislist is device specific.

Sources of event signals to be linked to other peripherals or the CPU

¢ elc_peripheral_t

enum elc_peripheral_t

Note

Thislist is device specific.

Possible peripherals to be linked to event signals

5.1.3.14 RA4W1

BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for radwl_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration

Options

Default

Description

OFSO0 register settings

OFSO0 register settings > Independent WDT

Start Mode

e [WDT is
Disabled
e IWDT is

IWDT is Disabled

automatically
activated after

a reset

(Autostart

R11UMO0155EU0420 Revision 5.20
Feb.28.2024

RLENESAS

Page 300/ 5,010



Flexible Software Package

API| Reference > BSP > MCU Board Support Package > RA4W1

User’s Manual

Timeout Period

Dedicated Clock
Frequency Divisor

Window End Position

Window Start Position

Reset Interrupt
Request Select

Stop Control

OFSO register settings > WDT

Start Mode Select

Timeout Period

Clock Frequency

mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

1024 cycles
4096 cycles
8192 cycles
16384 cycles

4

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
(register-start mode)

16384 cycles

128
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Division Ratio

Window End Position

Window Start Position

Reset Interrupt
Request

Stop Control

OFS1 register settings

Voltage Detection O
Circuit Start

Voltage Detection O
Level

HOCO Oscillation
Enable

64
128
512
2048
8192

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

e NMI
e Reset

e Counting
continues

e Stop counting
when entering
Sleep mode

* Voltage monitor

0 reset is
enabled after
reset

¢ Voltage monitor

O reset is
disabled after
reset

282V
251V
190V

HOCO oscillation is
enabled after reset

0% (no window end
position)

100% (no window start
position)

Reset

Stop counting when
entering Sleep mode

Voltage monitor 0 reset
is disabled after reset

190V

config.bsp.fsp.OFS1.ho
co_osc.disabled

Feb.28.2024

MPU

Enable or disable PC e Enabled Disabled

Region 0 e Disabled

PCO Start Value must be an OXOOFFFFFC
integer between 0 and
Ox00FFFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

PCO End Value must be an OxOOFFFFFF
integer between
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Enable or disable PC
Region 1

PC1 Start

PC1 End

Enable or disable
Memory Region 0

Memory Region 0 Start

Memory Region 0 End

Enable or disable
Memory Region 1

Memory Region 1 Start

Memory Region 1 End

Enable or disable
Memory Region 2

Memory Region 2 Start

Memory Region 2 End

0x00000003 and
OxOOFFFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

e Enabled
¢ Disabled

Value must be an
integer between 0 and
OXxO00FFFFFC (ROM) or
between 0x1FF00000
and 0x200FFFFC (RAM)

Value must be an
integer between
0x00000003 and
OxOOFFFFFF (ROM) or
between 0x1FF00003
and Ox200FFFFF (RAM)

e Enabled
¢ Disabled

Value must be an
integer between 0 and
OxO00FFFFFC

Value must be an
integer between

0x00000003 and
OxOOFFFFFF

e Enabled
e Disabled

Value must be an
integer between

0x1FF00000 and

0x200FFFFC

Value must be an
integer between

0Ox1FF00003 and

0x200FFFFF

e Enabled
e Disabled

Value must be an
integer between
0x400C0000 and
O0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Value must be an
integer between
0x400C0003 and

Disabled

OxOOFFFFFC

OXOOFFFFFF

Disabled

OxO0OFFFFFC

OXOOFFFFFF

Disabled

O0x200FFFFC

0x200FFFFF

Disabled

0x407FFFFC

0x407FFFFF
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0x400DFFFF or
between 0x40100003
and Ox407FFFFF

Enable or disable e Enabled Disabled
Memory Region 3 e Disabled
Memory Region 3 Start Value must be an O0x400DFFFC
integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC
Memory Region 3 End  Value must be an Ox400DFFFF
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and 0x407FFFFF
Enable inline BSP IRQ e Enabled Enabled Using static inline
functions e Disabled functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in
return.
Use Low Voltage Mode e Enabled Disabled Use the low voltage
e Disabled mode. This limits the
ICLK operating
frequency to 4 MHz
and requires all clock
dividers to be at least
4.
Main Oscillator Wait e 2 cycles 262144 cycles Number of cycles to
Time e 1024 cycles wait for the main
e 2048 cycles oscillator clock to
e 4096 cycles stabilize.
e 8192 cycles
e 16384 cycles
e 32768 cycles
e 65536 cycles
e 131072 cycles

ID Code Mode

262144 cycles

Unlocked

(Ignore ID)

e Locked with All
Erase support

e Locked

Unlocked (Ignore ID)

When set to 'Locked
with All Erase support’,
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked',
all
erase/download/debug

R11UMO0155EU0420 Revision 5.20
Feb.28.2024

RLENESAS

Page 304 /5,010



Flexible Software Package User’s Manual

API| Reference > BSP > MCU Board Support Package > RA4W1

access is disabled
unless the ID Code is

provided.
ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF  Set the ID Code for
Characters) character long hex FFFFFFFFFFFF locking debug access.
string This setting is only

used when the ID Code
Mode is not set to

Unlocked.
Macros
#define BSP_ELC_PERIPHERAL MASK
Enumerations
enum elc_event t
enum elc_peripheral_t

Macro Definition Documentation
¢ BSP_ELC_PERIPHERAL_MASK

#define BSP_ELC_PERIPHERAL MASK

Positions of event link set registers (ELSRs) available on this MCU
Enumeration Type Documentation
¢ elc_event_t

enum elc_event_t

Sources of event signals to be linked to other peripherals or the CPU
Note

Thislist is device specific.

¢ elc_peripheral_t

enum elc_peripheral t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.
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5.1.3.15 RAGE1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra6el_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description

Security

Security > Exceptions

Exception Response ¢ Non-Maskable Non-Maskable Interrupt Configure the result of
Interrupt a TrustZone Filter
e Reset exception. This

exception is generated
when a the TrustZone
Filter detects access to
a protected region.

This setting is only
valid when building
projects with

TrustZone.
BusFault, HardFault, e Non-Secure Secure State Value for SCB->AIRCR
and NMI Target State register bit
e Secure State BFHFNMINS. Defines

whether BusFault and
NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with

TrustZone.
Prioritize Secure e Enabled Disabled Value for SCB->AIRCR
Exceptions e Disabled register bit PRIS. When

enabled, all Non-secure
interrupt priorities are
automatically demoted
by right shifting their
priority by one then
setting the most
significant bit. As there
is effectively one less
bit care must be taken
to ensure the
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Security > SRAM Accessibility

SRAM Protection

SRAM ECC

Standby RAM

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Regions 7-0 are
all Secure.
Region 7 is Non-
secure. Regions
6-0 are Secure.
Regions 7-6 are
Non-secure.
Regions 5-0 are
Secure.
Regions 7-5 are
Non-secure.
Regions 4-0 are
Secure.
Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.
Regions 7-3 are
Non-secure.
Regions 2-0 are
Secure.
Regions 7-2 are
Non-secure.
Regions 1-0 are
Secure.

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

config.bsp.fsp.tz.stbra
msar.both

prioritization of non-
secure interrupts is
correct.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
SRAMPRCR is write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether SRAM
ECC registers are write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
Standby RAM registers
are accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.
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e Regions 7-1 are
Non-secure.
Region 0 is
Secure.

e Regions 7-0 are
all Non-secure.

Security > BUS Accessibility

Bus Security Attribution ¢ Both Secure Both Secure and Non-  Defines whether the
Register A and Non-Secure Secure State Slave Bus Control
State Registers
e Secure State (BUSSCNT<slave>) are

write accessible for the
Non-secure application.

This setting is only
valid when building
projects with

TrustZone.
Bus Security Attribution e Both Secure Both Secure and Non-  Defines whether the
Register B and Non-Secure Secure State Bus and DMAC/DTC
State Error Clear Registers
e Secure State are write accessible for
the Non-secure
application.

This setting is only
valid when building
projects with

TrustZone.
System Reset Request e Both Secure Secure State Value for SCB->AIRCR
Accessibility and Non-Secure register bit
State SYSRESETREQS.
e Secure State Defines whether the

SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
projects with

TrustZone.
Cache Accessibility ¢ Both Secure Both Secure and Non-  Defines whether the
and Non-Secure Secure State Cache registers are
State write accessible for the
e Secure State Non-secure application.

This setting is only
valid when building
protjects with

TrustZone.
System Reset Status ¢ Both Secure Both Secure and Non-  Defines whether the
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Accessibility and Non-Secure Secure State reset status registers
State (RSTSRnN) can be
e Secure State cleared from the Non-

secure application.

This setting is only
valid when building
projects with

TrustZone.
Battery Backup ¢ Both Secure Both Secure and Non-  Defines whether the
Accessibility and Non-Secure Secure State battery backup
State registers are accessible
e Secure State for the Non-secure

application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRn
registers which are
both read and write
protected.

This setting is only
valid when building
projects with

TrustZone.
Flash Bank Select e Both Secure Both Secure and Non- Defines whether the
Accessibility and Non-Secure Secure State BANKSEL register is
State write accessible for the
e Secure State Non-secure application.

This setting is only
valid when building
projects with

TrustZone.

Uninitialized Non- e Enable Enable Uninitialized If enabled, the secure
Secure Application Uninitialized Non-Secure Application application checks if
Fallback Non-Secure Fallback the non-secure

Application application has been

Fallback programmed in non-

e Disable secure flash before

Uninitialized branching. If the non-

Non-Secure secure application has

Application not been programmed,

Fallback then the secure

application branches to
an infinite loop in non-
secure RAM. This
prevents an issue
where the debugger
may not connect if the
MCU is configured in
the NSECSD lifecycle
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OFSO register settings
OFSO register settings > Independent WDT

Start Mode e IWDT is

Disabled
e IWDT is

automatically
activated after
a reset
(Autostart
mode)

Timeout Period 128 cycles
512 cycles
1024 cycles

2048 cycles

1
16
32
64
128
256

Dedicated Clock
Frequency Divisor

75%

50%

25%

0% (no window
end position)

Window End Position

Window Start Position e 25%
* 50%
e 75%
e 100% (no
window start
position)

Reset Interrupt ¢ NMI request or
Request Select interrupt
request is
enabled
e Resetis
enabled

Stop Control ¢ Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)

e Stop counting

state.

IWDT is Disabled

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby
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OFSO register settings > WDT

Start Mode Select

Timeout Period

Clock Frequency
Division Ratio

Window End Position

Window Start Position

Reset Interrupt
Request

Stop Control

OFS1_SEL register settings

Voltage Detection 0

when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after

a reset (register-

start mode)

1024 cycles
4096 cycles
8192 cycles
16384 cycles

4
64
128
512
2048
8192

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI
Reset

Counting
continues
Stop counting
when entering
Sleep mode

VDSEL setting

Stop WDT after a reset
(register-start mode)

16384 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset

Stop counting when
entering Sleep mode

VDSEL setting loads

Level Security loads from from OFS1_SEC
Attribution OFS1 SEC
e VDSEL setting
loads from
OFS1
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Voltage Detection 0 ¢ LVDAS setting LVDAS setting loads
Circuit Start Security loads from from OFS1_SEC
Attribution OFS1 SEC
¢ LVDAS setting
loads from
OFS1

OFS1 register settings

Voltage Detection 0 ¢ Voltage monitor Voltage monitor O reset
Circuit Start 0 reset is is disabled after reset

enabled after

reset

e Voltage monitor

0 reset is

disabled after

reset

Voltage Detection 0 e 294V 2.80V
Level e 287V
e 280V

HOCO Oscillation e HOCO HOCO oscillation is
Enable oscillation is enabled after reset
enabled after
reset
e HOCO
oscillation is
disabled after

reset

Block Protection Settings (BPS)

BPSO Refer to the RA ou Configure Block
Configuration tool for Protection Register 0
available options.

BPS1 e Flash Block 32 0U Configure Block

¢ Flash Block 33 Protection Register 1
¢ Flash Block 34
e Flash Block 35
¢ Flash Block 36
e Flash Block 37
BPS2 Refer to the RA ou Configure Block

Configuration tool for Protection Register 2
available options.

Permanent Block Protection Settings (PBPS)

PBPSO Refer to the RA ou Configure Permanent
Configuration tool for Block Protection
available options. Register 0
PBPS1 e Flash Block 32 0U Configure Permanent
¢ Flash Block 33 Block Protection
e Flash Block 34 Register 1
e Flash Block 35
¢ Flash Block 36
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¢ Flash Block 37

PBPS2 Refer to the RA ouU
Configuration tool for
available options.

Clocks

HOCO FLL Function e Enabled Disabled
e Disabled

Enable inline BSP IRQ e Enabled Enabled
functions e Disabled

Startup C-Cache Line e 32 Bytes 32 Bytes
Size e 64 Bytes

Dual Bank Mode e Enabled Disabled
e Disabled

Configure Permanent
Block Protection
Register 2

Setting this option to
Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not
available.

Using static inline
functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in
return.

Set the C-Cache line
size configured during
startup.

Enabling dual bank
mode splits the flash
into two banks that can
be swapped by
programming the
BANKSEL non-volatile
register. When
enabled, one bank will
start at address 0x0
and the other will start
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at 0x200000. Each
bank contains exactly
half the capacity of the
entire code flash. When
Dual Bank mode is
enabled, Startup
Program Protection and
Block Swap functions
cannot be used.

3 cycles 8163 cycles Number of cycles to
35 cycles wait for the main
67 cycles oscillator clock to
131 cycles stabilize.

259 cycles

547 cycles

e 1059 cycles

2147 cycles

e 4291 cycles

e 8163 cycles

Main Oscillator Wait
Time

Macros

#define BSP_ELC_PERIPHERAL_MASK

Enumerations

enum elc_event_t
enum elc_peripheral _t

Macro Definition Documentation

& BSP_ELC_PERIPHERAL_MASK

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist is device specific.
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¢ elc_peripheral_t

enum elc_peripheral_t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

5.1.3.16 RAGE2
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra6e2_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration Options Default Description

Security

Security > Exceptions

Exception Response ¢ Non-Maskable Non-Maskable Interrupt Configure the result of
Interrupt a TrustZone Filter
¢ Reset exception. This

exception is generated
when the TrustZone
Filter detects access to
a protected region.

This setting is only
valid when building
projects with

TrustZone.
BusFault, HardFault, e Non-Secure Secure State Value for SCB->AIRCR
and NMI Target State register bit
e Secure State BFHFNMINS. Defines

whether BusFault and
NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with
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TrustZone.
Prioritize Secure e Enabled Disabled Value for SCB->AIRCR
Exceptions e Disabled register bit PRIS. When

enabled, all Non-secure
interrupt priorities are
automatically demoted
by right shifting their
priority by one then
setting the most
significant bit. As there
is effectively one less
bit care must be taken
to ensure the
prioritization of non-
secure interrupts is
correct.

This setting is only
valid when building
projects with

TrustZone.
Security > SRAM Accessibility
SRAM Protection e Both Secure Both Secure and Non- Defines whether
and Non-Secure Secure State SRAMPRCR is write
State accessible for the Non-
e Secure State secure application.

This setting is only
valid when building
projects with

TrustZone.
SRAM ECC e Both Secure Both Secure and Non- Defines whether SRAM
and Non-Secure Secure State ECC registers are write
State accessible for the Non-
e Secure State secure application.

This setting is only
valid when building
projects with

TrustZone.
Standby RAM e Regions 7-0 are config.bsp.fsp.tz.stbra  Defines whether

all Secure. msar.both Standby RAM registers

¢ Region 7 is Non- are accessible for the
secure. Regions Non-secure application.
6-0 are Secure.

e Regions 7-6 are This setting is only
Non-secure. valid when building
Regions 5-0 are projects with
Secure. TrustZone.

e Regions 7-5 are
Non-secure.
Regions 4-0 are
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Secure.

¢ Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.

e Regions 7-3 are
Non-secure.
Regions 2-0 are
Secure.

e Regions 7-2 are
Non-secure.
Regions 1-0 are
Secure.

¢ Regions 7-1 are
Non-secure.
Region 0 is
Secure.

e Regions 7-0 are
all Non-secure.

Security > BUS Accessibility

Bus Security Attribution ¢ Both Secure Both Secure and Non-  Defines whether the
Register A and Non-Secure Secure State Slave Bus Control
State Registers
e Secure State (BUSSCNT<slave>) are

write accessible for the
Non-secure application.

This setting is only
valid when building
projects with

TrustZone.
Bus Security Attribution e Both Secure Both Secure and Non-  Defines whether the
Register B and Non-Secure Secure State Bus and DMAC/DTC
State Error Clear Registers
e Secure State are write accessible for
the Non-secure
application.

This setting is only
valid when building
projects with

TrustZone.
System Reset Request e Both Secure Secure State Value for SCB->AIRCR
Accessibility and Non-Secure register bit
State SYSRESETREQS.
e Secure State Defines whether the

SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
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Cache Accessibility

System Reset Status
Accessibility

Battery Backup
Accessibility

Uninitialized Non-
Secure Application
Fallback

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Enable
Uninitialized
Non-Secure
Application
Fallback
Disable
Uninitialized
Non-Secure
Application
Fallback

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

Enable Uninitialized
Non-Secure Application
Fallback

projects with
TrustZone.

Defines whether the
Cache registers are
write accessible for the
Non-secure application.

This setting is only
valid when building
protjects with
TrustZone.

Defines whether the
reset status registers
(RSTSRnN) can be
cleared from the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
battery backup
registers are accessible
for the Non-secure
application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRn
registers which are
both read and write
protected.

This setting is only
valid when building
projects with
TrustZone.

If enabled, the secure
application checks if
the non-secure
application has been
programmed in non-
secure flash before
branching. If the non-
secure application has
not been programmed,
then the secure
application branches to
an infinite loop in non-
secure RAM. This
prevents an issue
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OFSO0 register settings
OFSO0 register settings > Independent WDT

Start Mode e IWDT is

Disabled
e IWDT is

automatically
activated after
a reset
(Autostart
mode)

Timeout Period e 128 cycles
e 512 cycles
e 1024 cycles

2048 cycles

1
16
32
64
128
* 256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

Dedicated Clock
Frequency Divisor

Window End Position

Window Start Position

Reset Interrupt e NMI request or
Request Select interrupt
request is
enabled
e Resetis
enabled

Stop Control e Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.

where the debugger
may not connect if the
MCU is configured in
the NSECSD lifecycle
state.

IWDT is Disabled

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby
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Device will
enter Software
Standby Mode)
¢ Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

OFSO register settings > WDT

Start Mode Select e Automatically Stop WDT after a reset
activate WDT (register-start mode)
after a reset
(auto-start
mode)

e Stop WDT after
a reset (register-
start mode)

Timeout Period e 1024 cycles 16384 cycles
e 4096 cycles
e 8192 cycles
e 16384 cycles

4 128
64

128

512

2048

8192

Clock Frequency
Division Ratio

Window End Position 75% 0% (no window end
50% position)

25%

0% (no window

end position)

Window Start Position e 25% 100% (no window start
* 50% position)
e 75%
* 100% (no
window start
position)
Reset Interrupt e NMI Reset
Request ¢ Reset
Stop Control e Counting Stop counting when
continues entering Sleep mode

¢ Stop counting
when entering

Sleep mode
OFS1 register settings
Voltage Detection 0 ¢ Voltage monitor Voltage monitor O reset
Circuit Start 0 reset is is disabled after reset

enabled after
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reset

¢ Voltage monitor
O reset is
disabled after
reset

Voltage Detection 0 e 294V 2.80V
Level e 287V
e 280V

HOCO Oscillation e HOCO HOCO oscillation is
Enable oscillation is disabled after reset
enabled after
reset
e HOCO
oscillation is
disabled after

reset
Block Protection Settings (BPS)
BPSO Refer to the RA ou Configure Block
Configuration tool for Protection Register 0

available options.

Permanent Block Protection Settings (PBPS)

PBPSO Refer to the RA ou Configure Permanent
Configuration tool for Block Protection
available options. Register 0
Clocks
HOCO FLL Function e Enabled Disabled Setting this option to
e Disabled Enabled improves

HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
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Enable inline BSP IRQ
functions

Startup C-Cache Line
Size

Main Oscillator Wait
Time

ID Code Mode

e Enabled
e Disabled

e 32 Bytes
e 64 Bytes

3 cycles

35 cycles
67 cycles
131 cycles
259 cycles
547 cycles
1059 cycles
2147 cycles
e 4291 cycles
e 8163 cycles

¢ Unlocked
(lgnore ID)

¢ Locked with All
Erase support

¢ Locked

Enabled

32 Bytes

8163 cycles

Unlocked (Ignore ID)

ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF
Characters) character long hex FFFFFFFFFFFF
string
Macros
#define BSP_ELC _PERIPHERAL MASK

Enumerations

enum elc_event t

enum elc_peripheral_t

modes are not
available.

Using static inline
functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in
return.

Set the C-Cache line
size configured during
startup.

Number of cycles to
wait for the main
oscillator clock to
stabilize.

When set to 'Locked
with All Erase support',
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.
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Macro Definition Documentation

¢ BSP_ELC_PERIPHERAL_MASK

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation

¢ elc_event_t

enum elc_event t

Note

Thislist is device specific.

Sources of event signals to be linked to other peripherals or the CPU

¢ elc_peripheral_t

enum elc_peripheral_t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

5.1.3.17 RA6M1
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for rabm1l_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description
OFSO register settings
OFSO0 register settings > Independent WDT
Start Mode e IWDT is IWDT is Disabled
Disabled
e [WDT is

automatically
activated after
a reset
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Timeout Period

Dedicated Clock

Frequency Divisor

Window End Position

Window Start Position

Reset Interrupt
Request Select

Stop Control

OFSO0 register settings > WDT
Start Mode Select

(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
(register-start mode)
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e Stop WDT after
a reset (register-
start mode)

Timeout Period e 1024 cycles 16384 cycles
e 4096 cycles
e 8192 cycles

16384 cycles

4 128
64

128

512

* 2048

8192

Clock Frequency
Division Ratio

Window End Position 75% 0% (no window end
50% position)

25%

0% (no window

end position)

Window Start Position e 25% 100% (no window start
* 50% position)
e 75%
* 100% (no
window start
position)
Reset Interrupt e NMI Reset
Request e Reset
Stop Control ¢ Counting Stop counting when
continues entering Sleep mode

e Stop counting
when entering
Sleep mode

OFS1 register settings

Voltage Detection 0 ¢ Voltage monitor Voltage monitor O reset
Circuit Start 0 reset is is disabled after reset

enabled after

reset

e Voltage monitor

0 reset is

disabled after

reset

Voltage Detection 0 e 294V 2.80V
Level e 287V
e 280V

HOCO Oscillation e HOCO HOCO oscillation is
Enable oscillation is disabled after reset
enabled after
reset
e HOCO
oscillation is
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disabled after

Feb.28.2024

reset
MPU
Enable or disable PC e Enabled Disabled
Region 0 * Disabled
PCO Start Value must be an OXFFFFFFFC
integer between 0 and
OXFFFFFFFC
PCO End Value must be an OXFFFFFFFF
integer between
0x00000003 and
OxFFFFFFFF
Enable or disable PC e Enabled Disabled
Region 1 e Disabled
PC1 Start Value must be an OXFFFFFFFC
integer between 0 and
OxXFFFFFFFC
PC1 End Value must be an OXFFFFFFFF
integer between
0x00000003 and
OxFFFFFFFF
Enable or disable e Enabled Disabled
Memory Region 0 e Disabled
Memory Region 0 Start Value must be an OXOO0FFFFFC
integer between 0 and
OxO00FFFFFC
Memory Region 0 End  Value must be an OXxOOFFFFFF
integer between
0x00000003 and
OxOOFFFFFF
Enable or disable e Enabled Disabled
Memory Region 1 ¢ Disabled
Memory Region 1 Start Value must be an Ox200FFFFC
integer between
0Ox1FF00000 and
0x200FFFFC
Memory Region 1 End  Value must be an Ox200FFFFF
integer between
0x1FF00003 and
Ox200FFFFF
Enable or disable e Enabled Disabled
Memory Region 2 ¢ Disabled
Memory Region 2 Start Value must be an O0x407FFFFC
integer between
0x400C0000 and
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0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Memory Region 2 End  Value must be an Ox407FFFFF
integer between
0x400C0003 and
0Ox400DFFFF or
between 0x40100003
and 0x407FFFFF

Enable or disable e Enabled Disabled
Memory Region 3 e Disabled
Memory Region 3 Start Value must be an O0x400DFFFC

integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC

Memory Region 3 End  Value must be an Ox400DFFFF
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and 0x407FFFFF

Clocks

HOCO FLL Function e Enabled Disabled Setting this option to
¢ Disabled Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not
available.
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Enable inline BSP IRQ e Enabled Enabled
functions e Disabled

Main Oscillator Wait
Time

35 cycles 8163 cycles
67 cycles

131 cycles

259 cycles

547 cycles

1059 cycles

2147 cycles

4291 cycles

8163 cycles

ID Code Mode

Unlocked Unlocked (Ignore ID)
(Ilgnore ID)
e Locked with All
Erase support
e Locked

ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF
Characters) character long hex FFFFFFFFFFFF
string

Macros

#define BSP_ELC_PERIPHERAL_MASK

Enumerations

enum elc_event_t
enum elc_peripheral _t

Macro Definition Documentation

& BSP_ELC_PERIPHERAL_MASK

Using static inline
functions will slightly
increase code size, but
will slightly decrease
cycles taken in ISRs in
return.

Number of cycles to
wait for the main
oscillator clock to
stabilize. Drive
capability automatic
switching function is by
default disabled.

When set to 'Locked
with All Erase support’,
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU
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Enumeration Type Documentation

¢ elc_event_t

enum elc_event_t

Note

Thislist is device specific.

Sources of event signals to be linked to other peripherals or the CPU

¢ elc_peripheral_t

enum elc_peripheral t

Possible peripherals to be linked to event signals

Note
Thislist is device specific.

5.1.3.18 RA6M2
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for rabm2_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family cfg.h:

Configuration Options

Default

Description

OFSO0 register settings
OFSO0 register settings > Independent WDT

Start Mode e |[WDT is IWDT is Disabled

Disabled

e IWDT is
automatically
activated after
a reset
(Autostart
mode)

Timeout Period
512 cycles

1024 cycles
2048 cycles

128 cycles 2048 cycles
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Dedicated Clock
Frequency Divisor

Window End Position

Window Start Position

Reset Interrupt

Request Select

Stop Control

OFSO register settings > WDT
Start Mode Select

Timeout Period

1
16
32
64
128
256

75%

50%

25%

0% (no window
end position)

25%

50%

75%

100% (no
window start
position)

NMI request or
interrupt
request is
enabled

Reset is
enabled

Counting
continues
(Note: Device
will not enter
Deep Standby
Mode when
selected.
Device will
enter Software
Standby Mode)
Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

Automatically
activate WDT
after a reset
(auto-start
mode)

Stop WDT after
a reset (register-

start mode)

1024 cycles
4096 cycles
8192 cycles
16384 cycles

128

0% (no window end
position)

100% (no window start
position)

Reset is enabled

Stop counting when in
Sleep, Snooze mode, or
Software Standby

Stop WDT after a reset
(register-start mode)

16384 cycles
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4 128
64

128

512

2048

8192

Clock Frequency
Division Ratio

Window End Position e 75% 0% (no window end
* 50% position)
e 25%
e 0% (no window
end position)

Window Start Position e 25% 100% (no window start
e 50% position)
e 75%
e 100% (no
window start
position)
Reset Interrupt e NMI Reset
Request ¢ Reset
Stop Control e Counting Stop counting when
continues entering Sleep mode

e Stop counting
when entering
Sleep mode

OFS1 register settings

Voltage Detection 0 e Voltage monitor Voltage monitor 0 reset
Circuit Start 0 reset is is disabled after reset

enabled after

reset

¢ Voltage monitor

0 reset is

disabled after

reset

Voltage Detection 0 e 294V 2.80V
Level e 287V
e 280V

HOCO Oscillation e HOCO HOCO oscillation is
Enable oscillation is disabled after reset
enabled after
reset
e HOCO
oscillation is
disabled after

reset
MPU
Enable or disable PC e Enabled Disabled
Region 0 e Disabled
PCO Start Value must be an OXFFFFFFFC
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PCO End

Enable or disable PC
Region 1

PC1 Start

PC1 End

Enable or disable
Memory Region 0

Memory Region 0 Start

Memory Region 0 End

Enable or disable
Memory Region 1

Memory Region 1 Start

Memory Region 1 End

Enable or disable
Memory Region 2

Memory Region 2 Start

Memory Region 2 End

integer between 0 and

OXFFFFFFFC

Value must be an
integer between

0x00000003 and
OxFFFFFFFF

e Enabled
e Disabled

Value must be an

integer between 0 and

OXFFFFFFFC

Value must be an
integer between

0x00000003 and
OxXFFFFFFFF

e Enabled
¢ Disabled

Value must be an

integer between 0 and

O0xO0FFFFFC

Value must be an
integer between

0x00000003 and
OxOO0FFFFFF

e Enabled
e Disabled

Value must be an
integer between

0x1FF00000 and

0x200FFFFC

Value must be an
integer between

Ox1FF00003 and

Ox200FFFFF

e Enabled
e Disabled

Value must be an
integer between
0x400C0000 and
0x400DFFFC or

between 0x40100000

and 0x407FFFFC

Value must be an
integer between
0x400C0003 and
0x400DFFFF or

between 0x40100003

OXFFFFFFFF

Disabled

OXFFFFFFFC

OXFFFFFFFF

Disabled

OxO0OFFFFFC

OXOOFFFFFF

Disabled

0x200FFFFC

0x200FFFFF

Disabled

O0x407FFFFC

0x407FFFFF
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and Ox407FFFFF

Enable or disable e Enabled Disabled
Memory Region 3 e Disabled
Memory Region 3 Start Value must be an O0x400DFFFC

integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and Ox407FFFFC

Memory Region 3 End  Value must be an Ox400DFFFF
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and 0x407FFFFF

Clocks

HOCO FLL Function e Enabled Disabled Setting this option to
¢ Disabled Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not

available.
Enable inline BSP IRQ e Enabled Enabled Using static inline
functions e Disabled functions will slightly

increase code size, but
will slightly decrease
cycles taken in ISRs in

return.
Main Oscillator Wait e 35 cycles 8163 cycles Number of cycles to
Time e 67 cycles wait for the main
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ID Code Mode

131 cycles
259 cycles
547 cycles
1059 cycles
2147 cycles
4291 cycles
8163 cycles

¢ Unlocked
(Ilgnore ID)

e Locked with All
Erase support

e Locked

Unlocked (Ignore ID)

ID Code (32 Hex Value must be a 32 FFFFFFFFFFFFFFFFFFFF
Characters) character long hex FFFFFFFFFFFF
string
Macros
#define BSP_ELC PERIPHERAL MASK

Enumerations

enum elc_event_t

enum elc_peripheral _t

Macro Definition Documentation

& BSP_ELC_PERIPHERAL_MASK

oscillator clock to
stabilize. Drive
capability automatic
switching function is by
default disabled.

When set to 'Locked
with All Erase support’,
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked’,
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation
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¢ elc_event_t

enum elc_event_t

Note

Thislist is device specific.

Sources of event signals to be linked to other peripherals or the CPU

¢ elc_peripheral_t

enum elc_peripheral t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

5.1.3.19 RA6M3
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra6m3_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options

Default

Description

OFSO0 register settings
OFSO0 register settings > Independent WDT

Start Mode e IWDT is

Disabled
e IWDT is

automatically
activated after
a reset
(Autostart
mode)

Timeout Period e 128 cycles
e 512 cycles
e 1024 cycles
e 2048 cycles

Dedicated Clock o1
Frequency Divisor e 16
e 32

IWDT is Disabled

2048 cycles

128
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* 64
* 128
* 256

Window End Position e 75% 0% (no window end
* 50% position)
e 25%
e 0% (no window
end position)

Window Start Position e 25% 100% (no window start
e 50% position)
e 75%

e 100% (no
window start
position)

Reset Interrupt ¢ NMI request or Reset is enabled
Request Select interrupt
request is
enabled
e Resetis
enabled

Stop Control e Counting Stop counting when in
continues Sleep, Snooze mode, or
(Note: Device Software Standby
will not enter
Deep Standby
Mode when
selected.

Device will
enter Software
Standby Mode)
e Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

OFSO register settings > WDT

Start Mode Select ¢ Automatically Stop WDT after a reset
activate WDT (register-start mode)
after a reset
(auto-start
mode)

e Stop WDT after
a reset (register-
start mode)

Timeout Period 1024 cycles 16384 cycles
4096 cycles
8192 cycles

16384 cycles

Clock Frequency e 4 128
Division Ratio * 64
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128
512
2048
8192

Window End Position 75% 0% (no window end
50% position)

25%

0% (no window

end position)

Window Start Position e 25% 100% (no window start
* 50% position)
e 75%

e 100% (no
window start

position)

Reset Interrupt e NMI Reset

Request ¢ Reset

Stop Control e Counting Stop counting when
continues entering Sleep mode

e Stop counting
when entering
Sleep mode

OFS1 register settings

Voltage Detection 0 ¢ Voltage monitor Voltage monitor O reset
Circuit Start 0 reset is is disabled after reset

enabled after

reset

¢ Voltage monitor

0 reset is

disabled after

reset

Voltage Detection O e 294V 2.80V
Level e 287V
e 280V

HOCO Oscillation e HOCO HOCO oscillation is
Enable oscillation is disabled after reset
enabled after
reset
e HOCO
oscillation is
disabled after

reset
MPU
Enable or disable PC e Enabled Disabled
Region 0 * Disabled
PCO Start Value must be an OxXFFFFFFFC
integer between 0 and
OxFFFFFFFC
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PCO End

Enable or disable PC
Region 1

PC1 Start

PC1 End

Enable or disable
Memory Region 0

Memory Region 0 Start

Memory Region 0 End

Enable or disable
Memory Region 1

Memory Region 1 Start

Memory Region 1 End

Enable or disable
Memory Region 2

Memory Region 2 Start

Memory Region 2 End

Enable or disable

Value must be an
integer between

0x00000003 and
OxFFFFFFFF

e Enabled
¢ Disabled

Value must be an
integer between 0 and
OxXFFFFFFFC

Value must be an
integer between

0x00000003 and
OXFFFFFFFF

e Enabled
e Disabled

Value must be an
integer between 0 and
OxOOFFFFFC

Value must be an
integer between

0x00000003 and
OxOOFFFFFF

e Enabled
e Disabled

Value must be an
integer between

Ox1FF00000 and

0Ox200FFFFC

Value must be an
integer between

0x1FF00003 and

Ox200FFFFF

e Enabled
e Disabled

Value must be an
integer between
0x400C0000 and
0x400DFFFC or
between 0x40100000
and 0x407FFFFC

Value must be an
integer between
0x400C0003 and
Ox400DFFFF or
between 0x40100003
and Ox407FFFFF

e Enabled

OXFFFFFFFF

Disabled

OXFFFFFFFC

OXFFFFFFFF

Disabled

OxO0OFFFFFC

OXOOFFFFFF

Disabled

0x200FFFFC

0x200FFFFF

Disabled

0x407FFFFC

O0x407FFFFF

Disabled
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Memory Region 3 * Disabled

Memory Region 3 Start Value must be an O0x400DFFFC
integer between
0x400C0000 and
O0x400DFFFC or
between 0x40100000
and Ox407FFFFC

Memory Region 3 End  Value must be an O0x400DFFFF
integer between
0x400C0003 and
0x400DFFFF or
between 0x40100003
and 0x407FFFFF

Clocks

HOCO FLL Function e Enabled Disabled Setting this option to
e Disabled Enabled improves
HOCO accuracy
significantly by using
the subclock, but
incurs certain
restrictions.

The FLL function
requires the subclock
oscillator to be running
and stabilized. When
enabled and running
the PLL or system clock
from HOCO, the BSP
will wait for both the
Subclock Stabilization
Time as well as the FLL
Stabilization Time
when setting up clocks
at startup.

When FLL is enabled
Software Standby and
Deep Software Standby
modes are not

available.
Enable inline BSP IRQ ¢ Enabled Enabled Using static inline
functions ¢ Disabled functions will slightly

increase code size, but
will slightly decrease
cycles taken in ISRs in

return.
Main Oscillator Wait e 35 cycles 8163 cycles Number of cycles to
Time * 67 cycles wait for the main
e 131 cycles oscillator clock to
e 259 cycles stabilize. Drive
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ID Code Mode

ID Code (32 Hex
Characters)

Macros

547 cycles

1059 cycles
2147 cycles
4291 cycles
8163 cycles

e Unlocked
(lgnore ID)

¢ Locked with All
Erase support

e Locked

Value must be a 32
character long hex
string

Unlocked (Ignore ID)

FFFFFFFFFFFFFFFFFFFF
FFFFFFFFFFFF

#define BSP_ELC_PERIPHERAL_MASK

Enumerations

enum

elc_event t

enum elc_peripheral t

Macro Definition Documentation

& BSP_ELC_PERIPHERAL_MASK

capability automatic
switching function is by
default disabled.

When set to 'Locked
with All Erase support’,
the ID Code must be
set in the debugger to
read or write data to
the MCU, but the All
Erase command is still
accepted regardless.
When set to 'Locked',
all
erase/download/debug
access is disabled
unless the ID Code is
provided.

Set the ID Code for
locking debug access.
This setting is only
used when the ID Code
Mode is not set to
Unlocked.

#define BSP_ELC_PERIPHERAL_MASK

Positions of event link set registers (ELSRs) available on this MCU

Enumeration Type Documentation
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¢ elc_event_t

enum elc_event_t

Sources of event signals to be linked to other peripherals or the CPU

Note

Thislist is device specific.

¢ elc_peripheral_t

enum elc_peripheral t

Possible peripherals to be linked to event signals

Note

Thislist is device specific.

5.1.3.20 RA6M4
BSP » MCU Board Support Package

Detailed Description

Build Time Configurations for ra6m4_fsp

The following build time configurations are defined in fsp_cfg/bsp/bsp_mcu_family_cfg.h:

Configuration Options Default Description

Security

Security > Exceptions

Exception Response ¢ Non-Maskable Non-Maskable Interrupt Configure the result of
Interrupt a TrustZone Filter
e Reset exception. This

exception is generated
when the TrustZone
Filter detects access to
a protected region.

This setting is only
valid when building
projects with

TrustZone.
BusFault, HardFault, ¢ Non-Secure Secure State Value for SCB->AIRCR
and NMI Target State register bit
e Secure State BFHFNMINS. Defines

whether BusFault and
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Prioritize Secure
Exceptions

Security > SRAM Accessibility

SRAM Protection

SRAM ECC

Standby RAM

e Enabled
e Disabled

e Both Secure
and Non-Secure
State

e Secure State

e Both Secure
and Non-Secure
State

e Secure State

e Regions 7-0 are
all Secure.
e Region 7 is Non-

Disabled

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

config.bsp.fsp.tz.stbra
msar.both

NMI exceptions are Non-
secure, and whether
exceptions target the
Non-secure HardFault
exception.

This setting is only
valid when building
projects with
TrustZone.

Value for SCB->AIRCR
register bit PRIS. When
enabled, all Non-secure
interrupt priorities are
automatically demoted
by right shifting their
priority by one then
setting the most
significant bit. As there
is effectively one less
bit care must be taken
to ensure the
prioritization of non-
secure interrupts is
correct.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
SRAMPRCR is write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether SRAM
ECC registers are write
accessible for the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether
Standby RAM registers
are accessible for the
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Security > BUS Accessibility

Bus Security Attribution
Register A

Bus Security Attribution
Register B

secure. Regions
6-0 are Secure.
Regions 7-6 are
Non-secure.
Regions 5-0 are
Secure.
Regions 7-5 are
Non-secure.
Regions 4-0 are
Secure.
Regions 7-4 are
Non-secure.
Regions 3-0 are
Secure.
Regions 7-3 are
Non-secure.
Regions 2-0 are
Secure.
Regions 7-2 are
Non-secure.
Regions 1-0 are
Secure.
Regions 7-1 are
Non-secure.
Region 0 is
Secure.
Regions 7-0 are
all Non-secure.

Both Secure Both Secure and Non-
and Non-Secure Secure State

State
Secure State

Both Secure Both Secure and Non-
and Non-Secure Secure State

State
Secure State

Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Slave Bus Control
Registers
(BUSSCNT<slave>) are
write accessible for the
Non-secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Bus and DMAC/DTC
Error Clear Registers
are write accessible for
the Non-secure
application.

This setting is only
valid when building
projects with

TrustZone.
System Reset Request Both Secure Secure State Value for SCB->AIRCR
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Accessibility

Cache Accessibility

System Reset Status
Accessibility

Battery Backup
Accessibility

Flash Bank Select
Accessibility

and Non-Secure
State

e Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure
and Non-Secure
State

Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

Both Secure and Non-
Secure State

register bit
SYSRESETREQS.
Defines whether the
SYSRESETREQ bit is
functional for Non-
secure use.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
Cache registers are
write accessible for the
Non-secure application.

This setting is only
valid when building
protjects with
TrustZone.

Defines whether the
reset status registers
(RSTSRN) can be
cleared from the Non-
secure application.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
battery backup
registers are accessible
for the Non-secure
application. If Secure
State is selected, all
battery backup
registers are read only
except for VBTBKRN
registers which are
both read and write
protected.

This setting is only
valid when building
projects with
TrustZone.

Defines whether the
BANKSEL register is
write accessible for the
Non-secure application.
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Uninitialized Non-
Secure Application
Fallback

OFSO0 register settings

Enable
Uninitialized
Non-Secure
Application
Fallback
Disable
Uninitialized
Non-Secure
Application
Fallback

OFSO0 register settings > Independent WDT

Start Mode

Timeout Period

Dedicated Clock

Frequency Divisor

Window End Position

Window Start Position

IWDT is
Disabled
IWDT is

automatically
activated after

a reset
(Autostart
mode)

128 cycles
512 cycles
1024 cycles
2048 cycles

1
16
32
64
128
256

75%
50%
25%

0% (no window

end position)

25%
50%

Enable Uninitialized
Non-Secure Application
Fallback

IWDT is Disabled

2048 cycles

128

0% (no window end
position)

100% (no window start
position)

This setting is only
valid when building
projects with
TrustZone.

If enabled, the secure
application checks if
the non-secure
application has been
programmed in non-
secure flash before
branching. If the non-
secure application has
not been programmed,
then the secure
application branches to
an infinite loop in non-
secure RAM. This
prevents an issue
where the debugger
may not connect if the
MCU is configured in
the NSECSD lifecycle
state.
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e 75%

e 100% (no
window start
position)

Reset Interrupt e NMI request or Reset is enabled
Request Select interrupt
request is
enabled
e Resetis
enabled

Stop Control e Counting Stop counting when in
continues Sleep, Snooze mode, or
(Note: Device Software Standby
will not enter
Deep Standby
Mode when
selected.

Device will
enter Software
Standby Mode)
e Stop counting
when in Sleep,
Snooze mode,
or Software
Standby

OFSO register settings > WDT

Start Mode Select e Automatically Stop WDT after a reset
activate WDT (register-start mode)
after a reset
(auto-start
mode)

e Stop WDT after
a reset (register-
start mode)

Timeout Period e 1024 cycles 16384 cycles
e 4096 cycles
e 8192 cycles

16384 cycles

4 128
64

128

512

2048

8192

Clock Frequency
Division Ratio

75% 0% (no window end
50% position)

25%

0% (no window

end position)

Window End Position

Window Start Position e 25% 100% (no window start
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Reset Interrupt
Request

Stop Control

OFS1 SEL register settings

Voltage Detection 0
Level Security
Attribution

Voltage Detection 0
Circuit Start Security
Attribution

OFS1 register settings

Voltage Detection 0
Circuit Start

Voltage Detection 0
Level

HOCO Oscillation
Enable

Block Protection Settings (BPS)
BPSO

50%

75%

100% (no
window start
position)

NMI
Reset

Counting
continues
Stop counting
when entering
Sleep mode

VDSEL setting
loads from
OFS1_SEC